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CS Product Registration

Name

Title

Firm

Street

City State Zip

Country

Tel Fax

Email

Serial No. Purchase Date

USER INFORMATION

1. Product you are registering (check one):
o ChemOffice o ChemDraw o Chem3D o Inventory o Other

o BioOffice o BioDraw o BioAssay o E-Notebook

o Chem &Bio Office Enterprise o Chem &Bio Office Workgroup

o The Merck Index o ChemACX

2. System running CS software (check one):
o Microsoft Windows o Apple Macintosh o Other

3. Please check one that best describes you:
o Commercial o Academic o Student o Gov’t/Non Profit o Other

4. Your discipline:
o Analytical Chem. o Inorganic Chem. o Biochemistry o Chemical Engineering
o Physical Chem. o Organic Chem. o Pharmacology o Biology
o Proteomics o Genomics o Information o Other

For faster response and accuracy, use the Web:
www.cambridgesoft.com/register/

QUESTIONNAIRE (OPTIONAL)

Register today and
receive free:

· Warranty technical support

· ChemBioNews.Com publica-
tion
for Scientists with Computers

· Information on new releases

Thank You! Enjoy your software!

Please remove this portion before mailing.

Please copy serial number from CS Installation Instructions.

Registering your 
CS Product

Please complete the
registration card at right.
Registering your product

makes you eligible to
receive update and

upgrade information,
technical support, and a

free subscription to
ChemBioNews.Com, a

publication for Scientists
with Computers.

www.cambridgesoft.com
Visit our homepage for

more information about
CS products and services.

Technical Support
Warranty technical

support available.
For details please see:

www.cambridgesoft.com/
services/contact/

US 1 617 588-9300 FAX 1 617 588–9390 WWW www.cambridgesoft.com
EU 00 800 875 20000 FAX +44 1223 464990 EMAIL info@cambridgesoft.com 
MAIL 100 CambridgePark Drive   Cambridge, MA  02140 USA
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Chem & Bio Draw
Chem & Bio Drawing Standard

®

CS Chem & Bio Draw 10.0
for Windows and Macintosh

Chem & Bio Draw is a standalone application within 
Chem & Bio Office, an integrated suite including 
Chem & Bio 3D for molecular modeling and analysis, 
BioAssay for biological data retrieval and visualization,
Inventory for managing and searching reagents,
E-Notebook for electronic journal and information,
Chem & Bio Finder for searching and information integration, and
ChemInfo for chemical and reference databases.

User’s Guide

   



License Information

ChemOffice, BioOffice ChemDraw, Chem3D, ChemINDEX, ChemFinder, and ChemInfo programs, all resources
in the ChemOffice, ChemDraw, Chem3D, ChemFinder, and ChemInfo application files, and this manual are
Copyright © 1986-2006 by CambridgeSoft Corporation (CS) with all rights reserved worldwide. MOPAC 2002 is
Copyright © 1993-2006 by Fujitsu Limited with all rights reserved. Information in this document is subject to
change without notice and does not represent a commitment on the part of CS. Both these materials and the right
to use them are owned exclusively by CS. Use of these materials is licensed by CS under the terms of a software license
agreement; they may be used only as provided for in said agreement.

ChemOffice, ChemDraw, Chem3D, CS MOPAC, ChemFinder, Inventory, E-Notebook, BioAssay, and ChemInfo
are not supplied with copy protection. Do not duplicate any of the copyrighted materials except for your personal
backups without written permission from CS. To do so would be in violation of federal and international law, and
may result in criminal as well as civil penalties. You may use ChemOffice, ChemDraw, Chem3D, CS MOPAC,
ChemFinder, Inventory, E-Notebook, BioAssay, and ChemInfo on any computer owned by you; however, extra
copies may not be made for that purpose. Consult the CS License Agreement for Software and Database Products for
further details.

Trademarks

ChemOffice, BioOffice, ChemDraw, Chem3D, ChemINDEX, ChemFinder, ChemInfo and ChemACX are
registered trademarks of CambridgeSoft Corporation (Cambridge Scientific Computing, Inc.).

The Merck Index is a registered trademark of Merck & Co., Inc.  ©2006  All rights reserved.

MOPAC 2002 is a trademark of Fujitsu Limited.

Microsoft Windows, Windows 2000, Windows XP, and Microsoft Word are registered trademarks of Microsoft Corp. 

Apple Events, Macintosh, Laserwriter, Imagewriter, QuickDraw and AppleScript are registered trademarks of Apple
Computer, Inc. Geneva, Monaco, and TrueType are trademarks of Apple Computer, Inc.

The ChemSelect Reaction Database is copyrighted © by InfoChem GmbH 1997.

AspTear is copyrighted © by Softwing.

InChI™ is a trademark of the International Union of Pure and Applied Chemistry. InChI™ Material in ChemDraw
is © IUPAC 2005.

SCHRÖDINGER® Jaguar

GAMESS is copyrighted © by Ames Laboratory

Copyright © 1986-2006 CambridgeSoft Corporation (Cambridge Scientific Computing, Inc.) All Rights Reserved.
Printed in the United States of America.

All other trademarks are the property of their respective holders.

 



CambridgeSoft End-User License Agreement for Software Products

Important: This CambridgeSoft Software License Agreement (“Agreement”) is a legal agreement between you, the
end user (either an individual or an entity), and CambridgeSoft Corporation (“CS”) regarding the use of CS Software
Products, which may include computer software, the associated media, any printed materials, and any “online” or
electronic documentation. By installing, copying, or otherwise using any CS Software Product, you signify that you
have read the CS End User License Agreement and agree to be bound by its terms. If you do not agree to the
Agreement’s terms, promptly return the package and all its contents to the place of purchase for a full refund.

CambridgeSoft Software License 

1. Grant of License. CambridgeSoft (CS) Software Products are licensed, not sold. CS grants and you hereby accept
a nonexclusive license to use one copy of the enclosed Software Product (“Software”) in accordance with the terms of
this Agreement. This licensed copy of the Software may only be used on a single computer, except as provided below.
You may physically transfer the Software from one computer to another for your own use, provided the Software is
in use (or installed) on only one computer at a time. If the Software is permanently installed on your computer (other
than a network server), you may also use the Software on a portable or home computer, provided that you use the
software on only one computer at a time. You may not (a) electronically transfer the Software from one computer to
another, (b) distribute copies of the Software to others, or (c) modify or translate the Software without the prior writ-
ten consent of CS, (d) place the software on a server so that it is accessible via a public network such as the Internet,
(e) sublicense, rent, lease or lend any portion of the Software or Documentation, (f ) modify or adapt the Software or
merge it into another program, (g) modify or circumvent the software activation, or (h) reverse engineer the software
activation so as to circumvent it. The Software may be placed on a file or disk server connected to a network, provid-
ed that a license has been purchased for every computer with access to that server. You may make only those copies
of the Software which are necessary to install and use it as permitted by this agreement, or are for purposes of back-
up and archival records; all copies shall bear CS’s copyright and proprietary notices. You may not make copies of any
accompanying written materials. 

With a fixed license, the software cannot be installed on more than the number of computers equivalent to the num-
ber of fixed licenses purchased. For example, a 10-user fixed license means the software can be installed on no more
than 10 different computers. A fixed license cannot be installed on a server. With a concurrent license, the software
can be installed on any number of computers at the organization, but the number of computers using the software at
any one time cannot exceed the number of concurrent licenses purchased. For example, a 10-user concurrent license
can be installed on 20 computers, but no more than 10 users can be using it at any one time. If the number of users
of the software could potentially exceed the number of licensed copies, then Licensee must have a reasonable mech-
anism or process in place to assure that the number of persons using the software does not exceed the number of
copies. CambridgeSoft reserves the right to conduct periodic audits no more than once per year to review the imple-
mentation of this agreement at the Licensee’s site. At CambridgeSoft’s request, Licensee will provide a knowledgeable
employee to assist in said audit

2. Ownership. The Software is and at all times shall remain the sole property of CS. This ownership is protected by
the copyright laws of the United States and by international treaty provisions. Upon expiration or termination of this
agreement, you shall promptly return all copies of the Software and accompanying written materials to CS. You may
not modify, decompile, reverse engineer, or disassemble the Software.

3. Assignment Restrictions. You may not rent, lease, or otherwise sublet the Software or any part thereof. You may
transfer on a permanent basis the rights granted under this license provided you transfer this Agreement and all copies
of the Software, including prior versions, and all accompanying materials. The recipient must agree to the terms of
this Agreement in full and register this transfer in writing with CS.



4. Use of Included Data. All title and copyrights in and to the Software product, including but not limited to any
images, photographs, animations, video, audio, music, text, applets, Java applets, and data files and databases (the
“Included Data”), are owned by CS or its suppliers.

· You may not copy, distribute or otherwise make the Included Data publicly available.

· Licensed users of ChemOffice Enterprise and Workgroup and the accompanying Plugin software products may
access, search, and view the Included Data and may transmit the results of any search of the Included Data to other
users of the licensed ChemOffice Enterprise and Workgroup software products within your organization only, provided
that such transmission is via an internal corporate (or university) network and is not accessible by the public.

· You may not install the Included Data on non-licensed computers nor distribute or otherwise make the Included
Data publicly available.

· You may use the Software to organize personal data, and you may transmit such personal data over the Internet pro-
vided that the transmission does not contain any Included Data.

· All rights not specifically granted under this Agreement are reserved by CS.

5. Separation of Components. The Software is licensed as a single product. Its component parts may not be sepa-
rated for use on more than one computer, except in the case of ChemOffice Enterprise. ChemOffice Enterprise
includes licenses for ChemDraw ActiveX and licenses for Chem3D ActiveX. The ActiveX software products may be
installed on computers other than that one on which ChemOffice Enterprise is installed. However, each copy of the
ActiveX is individually subject to the provisions of Paragraphs 1 through 4 of this Agreement.

6. Educational Use Only of Student Licenses. If you are a student enrolled at an educational institution, the CS
License Agreement grants to you personally a license to use one copy of the enclosed Software in accordance with the
terms of this Agreement. In this case the CS License Agreement does not permit commercial use of the Software nor
does it permit you to allow any other person to use the Software. 

7. Termination. You may terminate the license at any time by destroying all copies of the Software and documenta-
tion in your possession. Without prejudice to any other rights, CS may terminate this Agreement if you fail to com-
ply with its terms and conditions. In such event, you must destroy all copies of the Software Product and all of its
component parts.

8. Confidentiality. The Software contains trade secrets and proprietary know-how that belong to CS and are
being made available to you in strict confidence. ANY USE OR DISCLOSURE OF THE SOFTWARE, OR USE OF ITS
ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN STRICT ACCORDANCE WITH THIS LICENSE
AGREEMENT, MAY BE ACTIONABLE AS A VIOLATION OF OUR TRADE SECRET RIGHTS.

CS Limited Warranty

Limited Warranty. CS’s sole warranty with respect to the Software is that it shall be free of errors in program logic
or documentation, attributable to CS, which prevent the performance of the principal computing functions of the
Software. CS warrants this for a period of thirty (30) days from the date of receipt.

CS’s Liability. In no event shall CS be liable for any indirect, special, or consequential damages, such as, but not lim-
ited to, loss of anticipated profits or other economic loss in connection with or arising out of the use of the software
by you or the services provided for in this agreement, even if CS has been advised of the possibility of such damages.
CS’s entire liability and your exclusive remedy shall be, at CS’s discretion, either (A) return of any license fee, or (B)
correction or replacement of software that does not meet the terms of this limited warranty and that is returned to
CS with a copy of your purchase receipt. 



NO OTHER WARRANTIES. CS DISCLAIMS OTHER IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND IMPLIED WAR-
RANTIES ARISING BY USAGE OF TRADE, COURSE OF DEALING, OR COURSE OF PERFORMANCE. NOTWITH-
STANDING THE ABOVE, WHERE APPLICABLE, IF YOU QUALIFY AS A “CONSUMER” UNDER THE MAGNUSON-
MOSS WARRANTY ACT, THEN YOU MAY BE ENTITLED TO ANY IMPLIED WARRANTIES ALLOWED BY LAW FOR
THE PERIOD OF THE EXPRESS WARRANTY AS SET FORTH ABOVE. SOME STATES DO NOT ALLOW LIMITATIONS
ON IMPLIED WARRANTIES, SO THE ABOVE LIMITATION MIGHT NOT APPLY TO YOU. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.  

No Waiver. The failure of either party to assert a right hereunder or to insist upon compliance with any term or con-
dition of this Agreement shall not constitute a waiver of that right or excuse a similar subsequent failure to perform
any such term or condition by the other party. 

Governing Law. This Agreement shall be construed according to the laws of the Commonwealth of Massachusetts.

Export. You agree that the Software will not be shipped, transferred, or exported into any country or used in any man-
ner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations.

End-User License Agreement for CambridgeSoft Database Products

Important: This CambridgeSoft End-User License Agreement is a legal agreement between you (either an individual
or a single entity) and CambridgeSoft Corporation for the CambridgeSoft supplied database product(s) and may
include associated media, printed materials, and “online” or electronic documentation. By using the database prod-
uct(s) you agree that you have read, understood and will be bound by this license agreement.

Database Product License

1. Copyright Notice. The materials contained in CambridgeSoft Database Products, including but not limited to,
ChemACX, ChemIndex, and The Merck Index, are protected by copyright laws and international copyright treaties,
as well as other intellectual property laws and treaties. Copyright in the materials contained on the CD and internet
subscription products, including, but not limited to, the textual material, chemical structures representations, 
artwork, photographs, computer software, audio and visual elements, is owned or controlled separately by
CambridgeSoft Corporation (“CS”).

CS is a distributor (and not a publisher) of information supplied by third parties. Accordingly, CS has no editorial
control over such information. Database Suppliers (“Supplier”) individually own all right, title, and interest, includ-
ing copyright, in their database—and retain all such rights in providing information to Customers.

The materials contained in The Merck Index are protected by copyright laws and international copyright treaties, as
well as other intellectual property laws and treaties. Copyright in the materials contained on the CD and internet sub-
scription products, including, but not limited to, the textual material, chemical structures representations, artwork,
photographs, computer software, audio and visual elements, is owned or controlled separately by the Merck & Co.,
Inc., (“Merck”) and CambridgeSoft Corporation (“CS”). 

2. Limitations on Use. Except as expressly provided by copyright law, copying, redistribution, or  publication,
whether for commercial or non-commercial purposes, must be with the express permission of CS and/or Merck. In
any copying, redistribution, or publication of copyrighted material, any changes to or deletion of author attribution
or copyright notice, or any other proprietary notice of CS, Merck, or other Database producer are prohibited.



3. Grant of License, CD/DVD Databases. CambridgeSoft Software Products are licensed, not sold. CambridgeSoft
grants and you hereby accept a nonexclusive license to use one copy of the enclosed Software Product (“Software”) in
accordance with the terms of this Agreement. This licensed copy of the Software may only be used on a single com-
puter, except as provided below. You may physically transfer the Software from one computer to another for your own
use, provided the Software is in use (or installed) on only one computer at a time. If the Software is permanently
installed on your computer (other than a network server), you may also use the Software on a portable or home com-
puter, provided that you use the software on only one computer at a time. You may not (a) electronically transfer the
Software from one computer to another, (b) distribute copies of the Software to others, or (c) modify or translate the
Software without the prior written consent of CambridgeSoft, (d) place the software on a server so that it is accessi-
ble via a public network such as the Internet, (e) sublicense, rent, lease or lend any portion of the Software or
Documentation, or (f ) modify or adapt the Software or merge it into another program. The Software may be placed
on a file or disk server connected to a network, provided that a license has been purchased for every computer with
access to that server. You may make only those copies of the Software which are necessary to install and use it as per-
mitted by this agreement, or are for purposes of backup and archival records; all copies shall bear CambridgeSoft’s
copyright and proprietary notices. You may not make copies of any accompanying written materials.

4. Assignment Restrictions for CD/DVD databases. You may not rent, lease, or otherwise sublet the Software or
any part thereof. You may transfer on a permanent basis the rights granted under this license provided you transfer
this Agreement and all copies of the Software, including prior versions, and all accompanying materials. The recipi-
ent must agree to the terms of this Agreement in full and register this transfer in writing with CambridgeSoft.

5. Revocation of Subscription Access. Any use which is commercial and/or non-personal is strictly prohibited, and
may subject the Subscriber making such uses to revocation of access to this Paid Subscription Service, as well as any
other applicable civil or criminal penalties. Similarly, sharing a Subscriber password with a non-Subscriber or other-
wise making this Paid Subscription Service available to third parties other than the Authorized User as defined above
is strictly prohibited, and may subject the Subscriber participating in such activities to revocation of access to the Paid
Subscription Services; and, the Subscriber and any third party, to any other applicable civil or criminal penalties under
copyright or other laws. In the case of an authorized site license, a Subscriber shall cause any employee, agent or other
third party which the Subscriber allows to use the Paid Subscription Service materials to abide by all of the terms and
conditions of this Agreement. In all other cases, only the Subscriber is permitted to access the Paid Subscription
Service materials. Should CambridgeSoft become aware of any use that might cause revocation of the license, they
shall notify the Subscriber. The Subscriber shall have 90 days from date of notice to correct such violation before any
action will be taken.

6. Trademark Notice. THE MERCK INDEX ® is a trademark of Merck & Company Incorporated, Whitehouse
Station, New Jersey, USA and is registered in the United States Patent and Trademark Office. CambridgeSoft ® and
ChemACX are trademarks of CambridgeSoft Corporation, Cambridge,Massachusetts, USA and are registered in the
United States Patent and Trademark Office, the European Union (CTM) and Japan. 

Any use of the marks in connection with the sale, offering for sale, distribution or advertising of any goods and serv-
ices, including any other website, or in connection with labels, signs, prints, packages, wrappers, receptacles or adver-
tisements used for the sale, offering for sale, distribution or advertising of any goods and services, including any other
website, which is likely to cause confusion, to cause mistake or to deceive, is strictly prohibited.

7. Modification of Databases, Websites, or Subscription Services. CS reserves the right to change, modify, sus-
pend or discontinue any or all parts of any Paid Subscription Services and databases at any time.



8. Representations and Warranties. The User shall indemnify, defend and hold CS, Merck, and/or other Supplier
harmless from any damages, expenses and costs (including reasonable attorneys’ fees) arising out of any breach or
alleged breach of these Terms and Conditions, representations and/or warranties herein, by the User or any third party
to whom User shares her/his password or otherwise makes available this Subscription Service. The User shall cooper-
ate in the defense of any claim brought against CambridgeSoft, Merck, and/or other Database Suppliers. 

In no event shall CS, Merck, and/or other Supplier be liable for any indirect, special, or consequential damages, such
as, but not limited to, loss of anticipated profits or other economic loss in connection with or arising out of the use
of the software by you or the services provided for in this agreement, even if CS, Merck, and/or other Supplier has
been advised of the possibility of such damages. CS and/or Merck’s entire liability and your exclusive remedy shall be,
at CS’s discretion a return of any pro-rata portion of the subscription fee.

The failure of either party to assert a right hereunder or to insist upon compliance with any term or condition of this
Agreement shall not constitute a waiver of that right or excuse a similar subsequent failure to perform any such term
or condition by the other party.

This Agreement shall be construed according to the laws of the Commonwealth of Massachusetts, United States of
America.



Q: IS IT OK TO COPY MY COLLEAGUE’S
SOFTWARE?
NO, it’s not okay to copy your colleague’s

software. Software is protected by federal copyright law,
which says that you can't make such additional copies
without the permission of the copyright holder. By
protecting the investment of computer software
companies in software development, the copyright law
serves the cause of promoting broad public availability of
new, creative, and innovative products. These companies
devote large portions of their earnings to the creation of
new software products and they deserve a fair return on
their investment. The creative teams who develop the
software–programmers, writers, graphic artists and
others–also deserve fair compensation for their efforts.
Without the protection given by our copyright laws, they
would be unable to produce the valuable programs that
have become so important to our daily lives: educational
software that teaches us much needed skills; business
software that allows us to save time, effort and money;
and entertainment and personal productivity software
that enhances leisure time.

Q: That makes sense, but what do I get out of
purchasing my own software?

A: When you purchase authorized copies of software
programs, you receive user guides and tutorials, quick
reference cards, the opportunity to purchase
upgrades, and technical support from the software
publishers. For most software programs, you can read
about user benefits in the registration brochure or
upgrade flyer in the product box.

Q: What exactly does the law say about copying
software?

A: The law says that anyone who purchases a copy of
software has the right to load that copy onto a single
computer and to make another copy “for archival
purposes only” or, in limited circumstances, for
“purposes only of maintenance or repair.” It is illegal
to use that software on more than one computer or to
make or distribute copies of that software for any
other purpose unless specific permission has been
obtained from the copyright owner. If you pirate
software, you may face not only a civil suit for
damages and other relief, but criminal liability as well,
including fines and jail terms of up to one year

Q: So I'm never allowed to copy software for any other
reason?

A: That’s correct. Other than copying the software you
purchase onto a single computer and making another
copy “for archival purposes only” or “purposes only of
maintenance or repair,” the copyright law prohibits
you from making additional copies of the software for
any other reason unless you obtain the permission of
the software company.

Q: At my company, we pass disks around all the time.
We all assume that this must be okay since it was
the company that purchased the software in the
first place.

A: Many employees don’t realize that corporations are
bound by the copyright laws, just like everyone else.
Such conduct exposes the company (and possibly the
persons involved) to liability for copyright
infringement. Consequently, more and more
corporations concerned about their liability have
written policies against such “softlifting”. Employees
may face disciplinary action if they make extra copies
of the company’s software for use at home or on
additional computers within the office. A good rule to
remember is that there must be one authorized copy
of a software product for every computer upon which
it is run

Q: Can I take a piece of software owned by my
company and install it on my personal computer at
home if instructed by my supervisor?

A: A good rule of thumb to follow is one software
package per computer, unless the terms of the license
agreement allow for multiple use of the program. But
some software publishers’ licenses allow for “remote”
or “home” use of their software. If you travel or
telecommute, you may be permitted to copy your
software onto a second machine for use when you are
not at your office computer. Check the license care-
fully to see if you are allowed to do this.

Q: What should I do if become aware of a company
that is not compliant with the copyright law or its
software licenses?

A: Cases of retail, corporate and Internet piracy or non-
compliance with software licenses can be reported on
the Internet at http://www.siia.net/piracy/report.asp
or by calling the Anti-Piracy Hotline:
(800) 388-7478.



Q: Do the same rules apply to bulletin boards and user
groups? I always thought that the reason they got
together was to share software.

A: Yes. Bulletin boards and user groups are bound by the
copyright law just as individuals and corporations.
However, to the extent they offer shareware or public
domain software, this is a perfectly acceptable
practice. Similarly, some software companies offer
bulletin boards and user groups special demonstration
versions of their products, which in some instances
may be copied. In any event, it is the responsibility of
the bulletin board operator or user group to respect
copyright law and to ensure that it is not used as a
vehicle for unauthorized copying or distribution.

Q: I'll bet most of the people who copy software don't
even know that they're breaking the law.

A: Because the software industry is relatively new, and
because copying software is so easy, many people are
either unaware of the laws governing software use or
choose to ignore them. It is the responsibility of each
and every software user to understand and adhere to
copyright law. Ignorance of the law is no excuse. If
you are part of an organization, see what you an do to
initiate a policy statement that everyone respects.
Also, suggest that your management consider
conducting a software audit. Finally, as an individual,
help spread the word that users should be “software
legal.”

Q: What are the penalties for copyright infringement?

A: The Copyright Act allows a copyright owner to
recover monetary damages measured either by: (1) its
actual damages plus any additional profits of the
infringer attributable to the infringement, or (2)
statutory damages, of up to $150,000 for each copy-
righted work infringed. The copyright owner also has
the right to permanently enjoin an infringer from
engaging in further infringing activities and may be
awarded costs and attorneys’ fees. The law also
permits destruction or other reasonable disposition of
all infringing copies and devices by which infringing
copies have been made or used in violation of the
copyright owner’s exclusive rights. In cases of willful
infringement, criminal penalties may also be assessed
against the infringer.

SIIA also offers a number of other materials designed to
help you comply with the Federal Copyright Law. These
materials include:

"It's Just Not Worth the Risk" video.
This 12–minute video, available $10, has helped over
20,000 organizations dramatize to their employees the
implications and consequences of software piracy.

“Don’t Copy that Floppy” video
This 9 minute rap video, available for $10, is designed
to educate students on the ethical use of software.

Other education materials including, “Software Use
and the Law”, a brochure detailing the copyright law
and how software should be used by educational
institutions, corporations and individuals; and several
posters to help emphasize the message that unauthorized
copying of software is illegal.

To order any of these materials, please send your request to:

“SIIA Anti-Piracy Materials”
Software & Information Industry Association
1090 Vermont Ave, Sixth Floor,
Washington, D.C. 20005
(202) 289-7442

We urge you to make as many copies as you would like
in order to help us spread the word that unauthorized
copying of software is illegal.
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Introduction

This User’s Manual provides information on three 
CambridgeSoft products: ChemDraw, BioDraw, 
and ChemDraw/Excel. 

About ChemDraw
ChemDraw® is a desktop application that enables 
professional scientists, science students, and scien-
tific authors to communicate chemical structures. 
It is designed to work according to conventions 
that we have found to be most intuitive for such 
users. Our goal has been to make ChemDraw as 
easy to use as possible while providing superior 
drawing quality.
ChemDraw is integrated with the following 
CambridgeSoft products:

• ChemFinder
• Chem3D
• ChemDraw/Excel
• ChemOffice 2006

About BioDraw
BioDraw® is a desktop application for drawing and 
presenting biological pathways. Common pathway 
elements (membranes, DNA, enzymes, receptors, 
etc.) are built in, and other elements may be 
imported. The pathways you create with BioDraw 
can be exported for use in presentations, grant pro-
posals, and publications. 

About ChemDraw/Excel
The ChemDraw/Excel® add-in is an extension of 
Microsoft© Excel© for Windows. 
ChemDraw/Excel enables you to:
ChemDraw 10
• Add chemical structures and other data from 
ChemDraw or a ChemFinder database to an 
Excel spreadsheet. 

• Search using the same search features as Chem-
Finder.

• Perform calculations on chemical structures.
See the ChemOffice manual for information on 
other CambridgeSoft add-ins for Excel.

About This Manual
This User’s Manual contains information for the 
ChemDraw  application for Windows and Macin-
tosh. It assumes that you are familiar with the 
basics of your Windows operating system. If you 
are not, please refer to your system manual before 
using the applications. Some of the material 
describes tasks that must be performed in conjunc-
tion with other integrated CambridgeSoft prod-
ucts. The material on the Addins describes tasks 
that must be performed in conjunction with 
Microsoft Excel. If you are not familiar with this 
product, please consult the relevant User’s Manual 
for more detailed information.
The chapters in this guide are organized by task. 
They are intended to help you familiarize yourself 
with the ChemDraw  applications and start using 
them as quickly and efficiently as possible. 
New users should read the Introducing Chem-
Draw chapter to get an overview of the product 
GUI and how to use it. They may then continue 
with Chapter 2 Tutorials, which demonstrate 
most of the features of the application. Perform 
the tutorials in the order they are presented. 
Chapter 3 covers the basic structure drawing tech-
niques: bonds, atom labels, selecting and moving 
objects.
Introduction • 9
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Chapter 4 continues the discussion of structures 
with more advanced techniques: drawing reactions, 
joining and grouping structures, formatting and 
repeating labels, constrained bonds, and more.
Chapter 5 discusses the special ChemDraw fea-
tures that allow you to create query structures for 
searching databases.
Chapter 6 discusses ChemDraw’s chemistry fea-
tures: chemical analysis and properties, stere-
ochemistry, and the new Stoichiometry Grid.
Chapter 7 discusses ChemDraw’s naming algo-
rithms, Struct=Name and Name=Struct.
Chapter 8 discusses ChemNMR.
Chapter 9 describes the Drawing Objects you can 
add to your ChemDraw structures to produce 
drawings for publication or presentations.
Chapter 10 continues the topic of publication/ 
presentation with a detailed discussion of page lay-
out. 
Chapter 11 discusses sharing information, both 
importing other chemical and graphical formats 
and exporting to chemical software, spreadsheet, 
or publication software.
Chapter 12 discusses BioDraw.
Chapter 13 discusses ChemDraw/Excel.
The appendices discuss using the CambridgeSoft 
website, ChemDraw customization, details of 
ChemDraw’s chemistry features, file formats, doc-
ument setting, and troubleshooting.

What’s New in ChemDraw 
10.0
Enhancements to ChemDraw 10.0 include:

• New Lasso
• New Arrows (see also “Tutorial 2: Drawing an 

Intermediate” on page 31)
• Adjustable Drawing Objects
• Terminal Carbon Labels
10 • Introduction
•  Relative Stereochemistry

•  Improvements to Struct=Name

•  BioDraw

•  Stoichiometry Grid

•  Improved ISIS compatibility

• Improved Table tool behavior
• InChI™ support

Enhancements to PlugIns and ActiveX include:

• More Browser Support

Conventions
The following notations are used throughout this 
user’s guide:

 The Ultra symbol indicates that a feature 
is available in the Ultra version only.

 The Pro symbol indicates that a feature 

is available in both the Pro and Ultra versions. 
Features that are available in the Standard version 
are not indicated by a symbol.
NOTE: Notes such as this are used to highlight important 
information.
TIP: Tips supply useful, “nice to know”, information sup-
plemental to the main text.

CAUTION

Indicates important information that, if ignored, might 
lead to data loss or other serious problems.

When a shortcut key sequence is given, the Win-
dows OS sequence is listed first, with the Macin-
tosh OS sequence following, for example: “Use the 
command: Shift+Control+G or Shift+Command+G 
to ungroup objects.” 

ProPro

UltraUltra

UltraUltra

UltraUltra

ProPro

UltraUltra

ProPro
CambridgeSoft
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A special font is used to indicate labels or com-
mands in the GUI, for example: “Click the Help 
Contents. command on the Help menu.” The exact 
text you will see in the GUI is used in these refer-
ences.

Additional Information
Additional sources of ChemDraw  information are:

• The Quick Reference Cards.
• The Help system
• CambridgeSoft Web Pages.

http://www.cambridgesoft.com/

Quick Reference Card
The ChemDraw  Quick Reference Cards are 
located in the back of the manual. The cards pro-
vide summaries of ChemDraw  Desktop Applica-
tion commands and features. Because many of the 
instructions require knowledge of the interface ele-
ments, use the Quick Reference card as you per-
form the tutorials in Chapter 2: “Tutorials”.

Help System
ChemDraw  provides the following types of Help:

• ChemDraw Help. An HTML reference 
guide.

• Context-sensitive Help (Windows). Help 
topics related to user interface objects. To 
access Context sensitive Help type Shift+F1.

• ToolTips. Short descriptions of user interface 
objects displayed by pointing.

• Status Bar. The lower left corner of the GUI 
displays useful information as you work.
ChemDraw 10
CambridgeSoft Web Pages
The following table contains the addresses of 
ChemDraw-related web pages.

Installation and System 
Requirements
Before installation, see the “ReadMeFirst” and any 
other ReadMe documents on the installation CD-
ROM.

Microsoft®Windows® 
Requirements

• Windows 2000 or XP. 
• Microsoft®Office add-ins require Office 2000, 

2003, or XP.

Table 1: ChemDraw-related web pages 

For 
information 
about …

Access …

Technical 
Support

http://www.cambridge-
soft.com/services

ChemDraw 
Plugin

http://www.cambridge-
soft.com/services/documen-
tation/chemdrawplugin/

Chem3D 
ActiveX control

http://www.cambridge-
soft.com/services/documen-
tation/chem3dcontrol/

Software Devel-
oper’s kit

http://sdk.cambridge-
soft.com/

Purchasing 
CambridgeSoft 
products and 
chemicals

http://chemstore.cambridge-
soft.com/
Introduction • 11
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• Screen resolution must be 800 x 600 or higher.

ChemDraw plugins/ActiveX® controls support 
Microsoft IE 6.x, Netscape® 7.x and 8.x, Mozilla 
1.x, and Firefox 1.x. 
The Chem3D ActiveX control supports Microsoft 
IE 6.x, Netscape® 7.x and 8.0, Mozilla 1.x, and 
Firefox 1.x. 
NOTE: Windows XP Service Pack 2 includes security 
features that automatically block active content. This means 
that by default, Internet Explorer blocks ChemDraw and 
Chem3D ActiveX controls. To activate them, you must 
choose the option to “allow blocked content” from the bar 
appearing under the address bar notifying you that the secu-
rity settings have blocked some of the content of the page. IE 
does not remember this information, so you must repeat the 
12 • Introduction
activation each time you access the page.
If you visit a site frequently, you can add it to the list of 
trusted sites in IE’s security settings.

Macintosh® Requirements
• Mac®OS X 10.2.2-10.2.8, 10.3.x, or 10.4
• Screen resolution must be 800 x 600 or higher.

ChemDraw Plugin supports Safari 1.4 or higher, 
Mozilla 1.7.5 or higher, Firefox 1.x, and Netscape 
7.0.x 

Site License Network Installation 
Instructions
If you have purchased a site license, please see the 
following web site for network installation instruc-
tions:

http://www.cambridgesoft.com/services/sl/
CambridgeSoft
About ChemDraw
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Chapter 1: Introducing Chem & Bio Draw

Overview
This section introduces the new user to the 
ChemDraw GUI. It covers the following topics:

• Identifying the parts of the ChemDraw inter-
face.

• Creating, opening, and saving documents.
Figure 1.1: ChemDraw Windows Ultra GUI
ChemDraw 10
The ChemDraw Graphical 
User Interface
Although the Macintosh and Windows versions of 
the ChemDraw graphical user interface (GUI) dif-
fer slightly, the essential GUI consists of the same 
elements. The Windows version of ChemDraw is 
shown in Figure 1.1.
Title bar
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 Main tools
palette

General
 toolbar

Text style
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Object toolbarMagnification controls

Status bar
Resize
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Toolbar

Rotation handle
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Selection box
The Mac GUI is shown in Figure 1.2.
 Figure 1.2: ChemDraw Mac Ultra GUI
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14 • Introducing Chem & Bio Draw
 Main tool
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The Main Tools Palette
Use the main tools palette to create and manipulate 
drawings. The appearance of the toolbar is slightly 
different for the different versions of ChemDraw. 
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The toolbar for ChemDraw Ultra is shown in
Figure 1.3.
Figure 1.3: Main Tools Palette
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ChemDraw 10
Table 2 describes the functions of the tools for all 
versions. Some of the tools have multiple options 
that can be selected from a tool palette.

Table 2: Main Tools Palette

Tool Use to…

Selection Lasso. Select objects by dragging 
around them.

Marquee. Select objects by dragging 
diagonally across them. 

Selected objects can be further 
manipulated using menu commands.

Structure 
Perspective

Rotate a selected object in three 
dimensions.

Fragmenta-
tion toolbar

Fragmentation tool. Splits mole-
cules across specific bonds.

Dissociation tool. Breaks bonds and 
draws a reaction.

Retrosynthesis tool. Breaks bonds 
and draws a reaction.

Bond Draw bonds and set bond properties.

Eraser Delete objects. Click on an object to 
delete; drag to delete multiple objects. 
If you click a multiple bond, it will 
reduce the bond order. If you double-
click any part of a structure, it deletes 
the entire structure

Multiple 
Bond 
toolbar

Draw multiple bonds and set bond 
properties. Bonds of different types 
can be selected from the Multiple 
Bonds tool palette.
Introducing Chem & Bio Draw • 15
Overview



A
dm

inistrator
Text Create atom labels and captions.

Pen Draw freehand shapes such as 
custom arrows and orbitals. 

Arrows 
toolbar

Draw arrows. Arrows of different 
types can be selected from the Arrows 
toolbar.

Orbitals 
toolbar

Draw orbitals. Orbitals of different 
types can be selected from the 
Orbitals toolbar.

Drawing 
Elements 
toolbar

Draw annotations that lack chemical 
significance, such as boxes and lines. 
Drawing Elements of different types 
can be selected from the Drawing 
Elements toolbar.

Includes the Arc tools. 

Brackets 
toolbar

Draw brackets, parentheses, and 
braces. Brackets of different types can 
be selected from the Brackets tool 
palette.

Chemical 
Symbols 
toolbar

Draw chemically significant symbols 
such as charges, radicals, and lone 
pairs. Symbols of different types can 
be selected from the Symbols tool 
palette.

Table 2: Main Tools Palette

Tool Use to…

ProPro
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Arcs 
toolbar

Draw arcs. Arcs of different degrees 
can be selected from the Arcs tool 
palette.

The Arcs tool is a separate tool only 
on ChemDraw Standard.

Acyclic 
Chain 

Draw chains of any length.

Query 
Tools 
toolbar

Draw stereochemical flags, indicate 
free sites, alternative groups and 
correspondences between atoms in 
query structures. Various options can 
be selected from the Query tool 
palette.

Templates 
toolbars

Draw structures with templates 
stored in template documents. 
Templates can be selected from the 
Templates toolbars.

Rings Draw common structural compo-
nents. 

Table Draw tables with multiple rows and 
columns.

TLC Plate Draw TLC plates with multiple lanes 
and adjustable solvent front and 
spots.

Table 2: Main Tools Palette

Tool Use to…

ProPro
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Tearing Off Palettes
Some tools have toolbars extending from them, 
indicated by an arrow at the bottom right of the 
tool button. 
Figure 1.4: Tearing off the symbols palette

You can “tear off ” these toolbars and place them 
anywhere in the ChemDraw screen. You cannot 
dock torn off toolbars.
To tear off a toolbar:

• Click the arrow on the lower right of the tool.
• Holding the mouse button down, point to the 

title bar and release the mouse button.
Figure 1.5: Symbols as a floating toolbar

You can drag the toolbar by its title bar to repo-
sition it.

You can also show or hide a toolbar by selecting it 
from the Other Toolbars submenu on the View 
menu.

Optional Toolbars
ChemDraw provides a number of optional tool-
bars and information windows to facilitate produc-
tion of ChemDraw documents. These toolbars are 
accessed from the View menu. They are divided 
into three basic groups: Standard Toolbars and 
Show Windows, Tool Palettes, and Templates
ChemDraw 10
Figure 1.6: Optional toolbars on the View menu

Showing and Hiding Toolbars
To show or hide a toolbar:

• select a toolbar from the View menu.
A check mark appears next to the item when 
the toolbar is displayed.

Docking and Undocking Toolbars
The standard toolbars, can be docked or 
undocked. Docked toolbars can attach to any edge 
of the ChemDraw window. Undocked toolbars 
can float anywhere in the on your monitor screen.
To dock a toolbar do one of the following

standard
toolbars

templates

tool
palettes

information
windows
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• Drag the toolbar to the edge of the ChemDraw 
screen where you want it to dock. 

• Double-click the toolbar background. This will 
dock the toolbar in the default position. (All 
toolbars default to the top of the ChemDraw 
window, except for the Tools toolbar which 
defaults to the left side.)

To undock a toolbar do one of the following:

• Drag the toolbar into the position you want
• Double-click the toolbar.

The Status Bar or Message Area 
(Windows)
The status bar or message area displays informa-
tion about the menu or toolbar you are using.
Figure 1.7: Status bar

The Analysis Window
The Analysis window displays the chemical analy-
sis of the selected structure. If nothing is selected, 
the values shown are for the entire document.
Figure 1.8: Analysis window

See “Viewing Analysis Information” on page 111 
for information on the Analysis window.
The Paste button inserts all selected items into 
the document. The button shrinks the win-
dow to just the title bar.
18 • Introducing Chem & Bio Draw
The Chemical Properties 
Window 
The Chemical Properties window displays proper-
ties of the selected structure. When no structure is 
selected, properties will be displayed only if there is 
one (and only one) structure in the document. 
Figure 1.9: Chemical Properties window

The Paste button inserts all selected items into the 
document. The button shrinks the window to 
just the title bar, while leaving it active.
NOTE: CLogP and CMR values are displayed only in 
ChemDraw Ultra.

The Info Window
The Info window shows size/positioning informa-
tion about what's going on in ChemDraw.
Figure 1.10: Info window 

ProPro
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The fields are shown in Table 3.

Periodic Table
The Periodic Table window displays a floating 
periodic table. It can be used both for reference 
and to insert elements into structures. To show or 
hide the Periodic Table, select/deselect it in the 
View menu.
Figure 1.11: Periodic Table: 

Table 3: Info window fields 

Field Shows…

Pointer:
X/Y current mouse coordinates

Pointer:
dX/dY

change in X and Y coordinates 
of a moved selection

Selection:
X/Y
W/H

position of a selection
width/height of a selection

Angle: angle of a bond; rotation of a 
selection

Dist: length of a bond; distance a 
selection has been moved

% % of original size when resizing 
a selection
ChemDraw 10
Click an element symbol to highlight the element 
and activate the Text tool. Drag across the table to 
highlight each element in turn. Click the  but-
ton to show or hide the detailed information. 
After selecting an element, click in the document 
to add an atom label consisting of that element and 
the appropriate number of hydrogens. Labeling 
behavior is shown in Table 4.

Double-clicking on an existing atom will open it 
for editing without changing the label.
NOTE: Some element names conflict with ChemDraw 
Hotkeys, and may not be interpreted correctly by Chemical 
Warnings or Check Structure. For more information and 
troubleshooting see “Defining Nicknames” on page 82.

Character Map
The floating Character Map window displays the 
256 ASCII characters in any font. The default font 
is Symbol. Use it to add symbols or styled fonts to 
labels.‘

Table 4: Labeling with the Periodic Table

click on… to…

an existing 
unlabeled 
atom

label the atom

an existing 
labeled 
atom

cycle the hydrogen count (if it 
matches the selected element) 
or change the label

an empty 
space

create a new atom
Introducing Chem & Bio Draw • 19
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Figure 1.12: Character map 

The character map is active only when a text box is 
open for editing. It will appear grayed-out at all 
other times With a text box open, mouse over the 
character map to view a larger version of the char-
acters in the top right corner of the window. Click 
any character in the table to enter that character in 
the text box. The selected font (shown in the char-
acter map window) is applied to that character 
only. It does not change the active font in the text 
box.
NOTE: You can cancel a selection by dragging to some 
other character before releasing. 
The 8 most recently used characters are displayed 
at the top of the window. These characters retain 
their font and are not affected by changes to the 
window. A single character may appear more than 
once in this section if the versions use different 
fonts.
Click the back button to toggle between the 8 
most recently used characters and the entire 
character map.
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BioDraw
ChemDraw Ultra now incorporates BioDraw 
tools, allowing you to include drawings of meta-
bolic pathways in ChemDraw files. 
Figure 1.13: Partial depiction of the mechanism of 
action of glyceraldehyde 3-phosphate dehydroge-
nase1

The BioDraw tools palette is activated from the 
View menu. The toolbar contains special drawing 
tools such as enzymes and receptors. Standard 
shapes, such as circles or ellipses, can be added 
from the Drawing Elements tool palette. You can 
also use the Pen tool to create custom shapes.
Figure 1.14: BioDraw Toolbar

As with the Drawing Elements, you can change the 
color of an object with the Color menu, and the 
line and fill properties with the Curves menu. You 
can also rotate, or change the size, after selecting it. 
You create a BioDraw object by either clicking or 
dragging on the page where you want it to appear. 
Clicking gives you the default size and shape, drag-
ging allows you not only to enlarge the object, but 
to distort it as well by dragging differently on the x 

1. H. Lodish, et. al., Molecular Cell Biology, 
Scientific American Books, New York, NY, 
1995, p. 743.

N
R1 CONH2

C

R

H

OSH

Enzyme

N
CONH2R1

S C
H

R

OH

1-substrate enzyme
2-substrate enzyme
Receptor
Ion Channel
Helix Protein
Membrane (line)
Membrane (arc)
Golgi Body
Cloud

G-protein (alpha subunit)
G-protein (beta subunit)
G-protein (gamma subunit)
Immunoglobulin
DNA
Micelle
Membrane (ellipse)
Endoplasmic Reticulum
Mitochondrion
CambridgeSoft
Overview



and y axes. Linear objects elongate in the direction 
they are dragged. The membrane and protein tools 
(DNA and Helix) add more subunits as they are 
dragged; proteins display the subunit count.

Customizable Objects
Some of the BioDraw objects can be customized 
after being created. The table below describes the 
customization options.

Other Toolbars
The Other Toolbars command on the View menu 
gives a list of toolbars that can be opened from the 

Table 5: Customizable BioDraw Objects

Tool Customization 
Options

1-Substrate Enzyme size of the enzyme opening

Receptor width

Helix Protein height, width of the strands, 
width of the cylinders, 
spacing

DNA height, width of the strands, 
offset of the second strand, 
spacing

Membrane (line) size of subunit 

Membrane (arc) length, arc, size of subunit

Membrane (ellipse) size of subunit

Micelle size of subunit

Golgi part (long) length, width, curvature
ChemDraw 10
main Tools Palette and a list of structure and clip 
art templates that users may find useful.

Using Documents
Documents are the ChemDraw workspace where 
you create and manipulate structures. You can cre-
ate a new document or open an existing document 
and edit it.

Creating a Document
You can create a new, blank document using the 
ChemDraw default settings, or use a Style Sheet or 
Stationery Pad with customized settings.

Creating a New Document
To create a document:

Click the New Document command on the File 
menu.

Creating a Document Using a Style 
Sheet or Stationery Pad
To create a new document using a different Style 
Sheet or Stationery Pad:

Table 6: Structure and Clipart Templates

BioArt Clipware 1 Clipware 2 

Amino Acids Aromatics Bicyclics

Conformers Cp Rings Nanotubes

Amino Acid 
side chains

DNA 
templates

RNA 
templates

Functional 
groups

Hexoses Supramole-
cules

Ph Rings Polyhedra Stereocenters
Introducing Chem & Bio Draw • 21
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1. Click the Open Special command on the File 
menu.

2. Choose a Style Sheet or Stationery Pad from 
the list.
A new document is created with the settings 
(and objects) stored in the Style Sheet or Statio-
nery Pad.

ChemDraw provides pre-defined Style Sheets or 
Stationery Pads located in the ChemDraw Items 
folder. For example, the ACS Document 1996 is 
configured to create documents that are set with 
the bond lengths, bond width, spacing, and fonts 
used in the 2-column format of all American 
Chemical Society journals. For a list of the settings 
stored in these documents, see Appendix B: “Doc-
ument Settings”. For more information on publica-
tion guidelines, see 
http://www.cambridgesoft.com/services/down-
loads/stylesheets.cfm
NOTE: Predefined Style Sheets or Stationery Pads may 
restrict your options in unexpected ways. For example, not all 
Save As... format options are available in all Style Sheets or 
Stationery Pads. For general use, you should stay with the 
default Style Sheet or Stationery Pad.

Opening a Document
To open a document:

From the File menu, do one of the following:
• Choose Open, and in the Open dialog box, 

select the name and location of the file and 
click Open or OK.

• Choose the document from the list of previ-
ously opened documents at the bottom of 
the menu.

Discarding Recent Changes to a 
Document
To retrieve the last saved version of a file, click the 
Revert command on the File menu.
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All changes made to the file since it was 
saved last are discarded and the previous 
version of the file appears.

NOTE: You can use the Undo command in the Edit menu 
to remove each individual action since the last save.

Saving Documents
To save a ChemDraw document in the default 
ChemDraw CDX file format: 

1. Click the Save command on the File menu.
The Save dialog box appears. The appearance 
of the dialog box depends on the platform you 
are using. 

2. Choose a folder in which to store the file.
3. Type a file name in the File name (Windows) or 

Save As (Macintosh) text box. You may type 
up to 255 characters for a file name, including 
spaces. For example: “my first structure in 
ChemDraw”.

4. Click Save or OK to create the file.
The title of the document window changes to 
the name of the saved file. The file name is 
added to the bottom of the File menu.

CAUTION

ChemDraw uses the CDX file format to store chemical 
information accurately with a structure drawing. Other file 
formats may be capable of storing a picture of your 
drawing, but they might lose chemically relevant 
information about the structure. For example, if you save 
a ChemDraw drawing in the EPS file format, you will 
store only a picture of the structure without storing the 
chemical significance of the connections between atoms and 
bonds.

Saving a Document in a Different File 
Format
To save a ChemDraw document in another file 
format:
CambridgeSoft
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1. Click the Save As command on the File menu.
The Save As dialog box appears. 

2. Select a folder in which to save the document.
3. Type a file name in the in the File name or Save 

As box.
4. Select a file format from the File Format or 

Save as Format list.
NOTE: When you select some formats, the Options button 
becomes active. Click it to open a dialog box for setting 
options specific to these formats. For more information about 
these options, see Chapter 11: “Sharing Information”.

5. Click Save or OK.
If you type a name that already exists in the same 
directory, the existing document is replaced. If you 
do not want to replace the original ChemDraw 
document, use a different name. For information 
about other file formats, see Chapter 11: “Sharing 
Information”.

Reversing and Repeating 
Actions
ChemDraw keeps track of the actions you per-
form. You can reverse actions one at a time by 
ChemDraw 10
choosing the Undo command then restore them 
with the Redo command. The number of actions 
that can be undone or redone is limited only by the 
amount of memory (RAM and virtual memory) 
available for use by ChemDraw. When you save 
your document the Undo queue is reset and starts 
over.

Repeating Actions
If an action is repeatable, the name of the action 
appears next to the Repeat command on the Edit 
Menu.
To repeat an action:

Click the Repeat command on the Edit menu.
The last action performed is repeated.

The Window Menu 
The Window menu lists all open ChemDraw and 
Template documents. The document you choose 
from the Window menu becomes the active win-
dow. 
Introducing Chem & Bio Draw • 23
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Chapter 2: Tutorials

Overview
The tutorials are designed to teach you the funda-
mental drawing techniques available in Chem-
Draw. In addition to the major theme (“Reaction 
Schemes”, “Perspective Drawings”) each tutorial 
introduces new techniques, or variations of tech-
niques learned in previous tutorials. We therefore 
suggest that you do the tutorials in order.
Before you begin, you may want to review “Con-
ventions” on page 10 to familiarize yourself with 
the terminology used in the tutorials. You may also 
want to use your Quick Reference Card while you 
perform the tutorials.
ChemDraw automatically checks for correct chem-
ical syntax as you draw. If ChemDraw finds a 
potential problem, a red box is displayed around 
the erroneous object. The red box is displayed on 
screen only and does not print.
To disable the automatic warning on a specific 
object:

• Right-click the object and deselect the Display 
Warnings command on the context menu. 

NOTE: Some of the following tutorials make use of Hot-
Keys. They assume the default configuration, i.e. that none of 
the HotKey assignments have been changed.

Tutorial 1: Reaction 
Schemes
In this tutorial, you will draw the following (simpli-
fied) reaction scheme:
ChemDraw 10
Figure 2.15: Tutorial 1: Drawing a reaction scheme 

Create a ChemDraw Document:
1. Start ChemDraw.
2. Click the Save As command on the File menu.
3. Type tut1.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.
6. Click the Show General Toolbar command on 

the View menu.
7. Click the Show Info Window command on the 

View menu.
The Info window appears and displays drawing 
parameters as you draw.

Figure 2.16: The Info window 

8. Click the Object menu and make sure there is 
a check mark next to the Fixed Lengths and 
Fixed Angles commands. If either command is 
not checked, select it.

O

OH

O
OH

2-propanone
2 moles

4-hydroxy-4-methyl-2-pentanone
1 mole
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Figure 2.17: Checking fixed lengths and angles 

NOTE: Applying fixed lengths and fixed angles enables 
you to create structures with consistent bond lengths and 
angles. The fixed length dimension is set in the Drawing Set-
tings tab of the Document settings dialog box. The fixed 
angle dimension increments angles by 15 degrees.
Create a bond:

1. Select the Solid Bond tool .
2. Position the pointer (+) anywhere in the docu-

ment window and click.
The bond is extended to its fixed length at a 
30-degree angle.

Figure 2.18: Adding the first bond 

Add a second bond:
1. Point to the right atom of the bond.
2. Click the atom to add a bond.

Figure 2.19: Attaching a bond to an existing bond 

A second bond is drawn, forming a 120-degree 
angle between the bonds. 

NOTE: The angle used when clicking to add bonds is 
controlled by the Chain Angle setting in the Drawing 
Settings tab of the Document settings dialog box. If this 
bond angle cannot be established, the next smaller and 
logical bond angle is used. 

Add a third bond to the same atom: 
1. Continue pointing to the atom shown in Figure 

2.20 A.
2. Click the atom to add a bond.

A B
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Figure 2.20: Adding a third bond.

Change the single bond into a double bond:
1. Point to the atom shown in Figure 2.21 A and 

hold the mouse button down.
2. Drag as shown below over the existing single 

bond. Release the mouse button.
Figure 2.21: Adding a double bond 

Add labels to the structure:
1. Point to the atom shown in Figure 2.22 A, and 

double-click.
A text box appears on the atom position to 
allow you to create an atom label. See “Creating 
Text” on page 56 for an explanation of the dif-
ference between atom labels and captions.

2. Type an uppercase O in the text box that 
appears.

Figure 2.22: Adding an atom label

3. Close the text box by doing one of the follow-
ing:
• Use the Esc key.
• Click another tool. 

Next, you duplicate a structure and create another 
structure from the duplicate.
Duplicate the structure:

A B

A B

OA B C
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1. Click the Lasso tool . 
The last structure drawn is automatically 
selected. 

2. Point over the Selection Rectangle.
Figure 2.23: Selecting a structure

3. Press and hold the Ctrl or option key.

TIP: Just a reminder that instructions of this type give 
the PC function first, followed by the equivalent Mac 
function.

The hand pointer with a plus sign indicates that 
you are in the duplication mode of a selection 
tool.

Figure 2.24: The duplication hand icon 

4. Drag the Selection Rectangle to the right.
As you begin drag, a copy of the structure 
appears and the selection box is not visible. 
The original structure remains in its position. 
Release the mouse button when the copy is 
clear of the original.

O

O

ChemDraw 10
Figure 2.25: Duplicating a structure 

NOTE: When you create a copy as shown above you can 
drag it anywhere in the document window. If you want the 
copy to remain aligned with the original, hold Shift while 
dragging. 
Modify the duplicated structure:

1. Click the Solid Bond tool .
2. Point, in the copied structure, to the atom 

shown in Figure 2.26 A and click.
Figure 2.26: Adding more bonds 

Add several bonds to a single atom:
1. Point to the atom shown in Figure 2.27 A.
2. Click the atom three times, allowing a pause 

between each click.

NOTE: If you click too fast, the click is interpreted 
either as a double-click, which opens a text box or a 
triple-click, which duplicates your last atom label.

Figure 2.27: Adding multiple bonds to an atom 

Create another atom label, this time using Hot-
Keys. HotKeys are keys on your keyboard that are 
linked to specific atom labels. For more informa-
tion about HotKeys, see “Labeling Atoms with 
HotKeys” on page 60.

1. Point to the atom shown in Figure 2.28 A.

OO OO

A B

O OA B

O OA B
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2. Type O or o. 
Figure 2.28: Adding an atom label with a HotKey 

When you use HotKeys that represent a single ele-
ment, the correct number of hydrogen atoms is 
added to the label. 
Align the structures:

1. Select both structures with the Lasso or Mar-
quee.

2. Point to Align on the Object menu, and click 
the T/B centers command.

You structures should appear as shown in Figure 
2.29.
Figure 2.29: Tutorial intermediate status: two struc-
tures 

In the following steps, you use a different method 
for selecting structures and separate the structures 
to make room for an arrow.

1. Click the Marquee tool . 

NOTE: Alternatively, you can select the Lasso tool 
and hold Alt or option to use the Marquee tool. 

The last object drawn is selected.
Drag the selection to make room for an arrow:

• Press Shift to maintain the alignment of the 
structure and drag the Selection Rectangle to 
the right.

O O

OH

A B

O

OH

O
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Figure 2.30: Moving a structure 

Add arrows to the reaction scheme.
1. Click the Arrow tool  to display the Arrow 

palette.

NOTE: The triangle in the lower right corner of the 
Arrow icon indicates it contains a palette.

2. Holding the mouse button down, move the 
mouse to the palette title bar, then release the 
mouse button. 

Figure 2.31: Dragging a palette

The palette becomes a floating tool bar. Drag 
the palette to the location you want.

3. Click the third arrow from the left in the top 
row. 

Figure 2.32: Selecting an arrow 

O

OH

O

correct cursor 
position for 
dragging a palette
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4. After the arrow is selected, close the Arrows 
palette.

NOTE: The arrow you choose from the palette 
becomes the default arrow type. To change the arrow 
type, display the arrow palette and select the arrow type 
you want.

Draw the arrow you selected:
1. Point after the first structure and drag the 

arrow toward the second structure.
Figure 2.33: Adding an arrow to a drawing 

Use the Text tool to add line formula or other cap-
tions for representing reagents and reactions. 
Insert text in the drawing:

1. Click the Text tool .
2. Point above the arrow. A text insertion point 

appears. When you have positioned the text 
pointer where you want it, click to create a text 
box.

3. Type OH.
Figure 2.34: Adding a caption 

TIP: If you want to realign the caption, use a selection 
tool to drag the caption.

If Show Chemical Warnings is turned on 
(the default) a red box will appear around 
the OH label as soon as you change tools or open 
another text box indicating an error. Ignore this for 
now.
Add a charge symbol using the specialized symbols 
available in the Chemical Symbols tool palette:

1. Click the Chemical Symbol tool . 

O

OH

O

O

OH

O
OH

OH
ChemDraw 10
2. Holding the mouse button down, select the cir-
cled negative charge symbol, as shown in 
Figure 2.35.

Figure 2.35: Selecting a symbol 

3. Point to the center of the OH label. Moving the 
cursor slightly right or left will cause either the 
O or the H to be selected.

4. With the O selected, drag the charge symbol 
around the atom to the desired position.

Figure 2.36: Adding a symbol 

Objects added from the Chemical Symbols palette 
are associated chemically with the structure they 
are closest to. Note that the red valence error 
warning disappeared when you added the minus 
charge. To show this, try dragging the minus sign 
around to the other oxygen atoms in the drawing. 
What happens? Don’t forget to put it back when 
you’ve finished experimenting.
Some objects, such as arrows, are not associated 
automatically. You can manually group objects 
using the Group command. You can then select 
the grouped objects to manipulate or move them 
together. 
To group objects:

1. Click the Marquee tool.  
2. Do one of the following:

• Draw a box around the arrow, caption and 
symbol to select them.

• Click the arrow, then hold the shift key 
down while you click the OH caption and 
the charge symbol.

OH OH

A B
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Figure 2.37: Selecting multiple objects 

The Shift key allows you to add objects to a 
selection without deselecting other objects.

NOTE: If you click a selected object while holding 
Shift, that object is deselected.

3. Click the Group command on the Object 
menu.

Figure 2.38: Grouped objects

NOTE: You can still select individual objects within 
a group by clicking them.

Use the Text tool to create a caption containing the 
name and amount of reactant, and center the cap-
tion under the structure.

1. Click the Text tool .
2. Point below the first structure.
3. Click to create a text box. The default cursor is 

flush left.
4. Click the Centered command on the Text 

menu.
The cursor moves to the center of the text box.

Figure 2.39: Centering text in the textbox 

Type the caption: 
1. Type 2-propanone.

OH

OH

O OO
A B C
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2. Press the Enter or Return key to insert a new 
line.

3. Type 2 moles.
Figure 2.40: Adding a caption with two lines 

Create an aligned caption for the other structure.
1. Press the Tab key to create another Text box 

that is aligned adjacent to the first.
Figure 2.41: Aligning a second textbox 

NOTE: You can use the Tab key in the caption mode 
of the text tool to create multiple aligned captions with 
the same font, font size, style, and justification as the 
previous caption.

2. Type 4-hydroxy-4-methyl-2-pentanone, press 
the Enter or Return key, and type 1 mole.

If your captions are not aligned properly beneath 
the structures you can move them using a selection 
tool.

1. Click a Selection tool (Lasso or Marquee). 
The text box is automatically selected because 
it is the last object drawn. 

NOTE: The object that is automatically selected is set in 
the Preferences dialog box.

2. Press the Left or Right Arrow key to center the 
caption beneath its structure. This method 
maintains the alignment created by the Tab 
key.

O

2-propanone

O

2-propanone
2 moles

O

2-propanone
2 moles
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To complete the drawing, add a shadowed box 
around the scheme:

1. Click the Drawing Elements tool .
2. Select the shadowed box from the palette of 

drawing elements.
Figure 2.42: Shadowed box drawing element

3. Point to the upper left corner of the reaction 
scheme. Hold the down the mouse button and 
drag diagonally downward to the right to draw 
the box.

Figure 2.43: Adding a drawing element 

Save and close the document:
1. Click the Save command on the File menu.

Your document is saved.
2. Click the Close command on the File menu.

Tutorial 2: Drawing an 
Intermediate
In this tutorial you will draw the following interme-
diate structure starting from a ring and add arrows 
with customized shapes using the Pen tool.

Select Rectangle 150 dpi

O

OH

O
OH

2-propanone
2 moles

4-hydroxy-4-methyl-2-pentanone
1 mole
ChemDraw 10
Figure 2.44: Tutorial 2: Intermediate structure with 
arrows 

Create a new ChemDraw Document:
1. Click the New Document command on the File 

menu.
2. Click the Save As command on the File menu.
3. Type tut2.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.

Draw a ring:
1. Click the Cyclohexane Ring tool .
2. Point in the document window. The Cyclohex-

ane cursor appears.
3. Click to add a ring.

Figure 2.45: Using the cyclohexane ring tool 

Delete an atom and its bonds from the ring:
1. Click the Eraser tool .
2. Point to the atom shown in Figure 2.46 A.
3. Click the atom.

Figure 2.46: Erasing an atom 

NOTE: You can delete a bond individually by pointing at 
the center of the bond and clicking. 
You can also drag the eraser to make multiple deletions.

O-

OH

A B
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Add a bond:
1. Click the Solid Bond tool .
2. Point to the atom shown in Figure 2.47.
3. Click to add a bond.

Figure 2.47: Adding a bond 

Add second and third bonds:
1. Point to the atom shown in Figure 2.48, and 

click twice (slowly) to add two more bonds.
Figure 2.48: Adding two bonds to an atom 

Create a double bond. This is a different method 
than the one used in the first tutorial:

1. Point to the bond shown in Figure 2.49and 
click.
The double bond will initially form to the 
inside. Click twice more to move it to the out-
side, as shown in Figure 2.49 B.

Figure 2.49: Creating a double bond.

Add an atom label. This step will expand on your 
HotKeys knowledge from Tutorial 1.

1. Point to the atom to label shown in Figure 2.50 
and type the letter o.

Figure 2.50: Adding an atom label with a HotKey:

2. Without moving the cursor, type a “-” (minus).

A B

OHA B
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The OH label changes to O–.
Figure 2.51: Changing OH to O – with a HotKey

Complete the intermediate structure by adding 
another OH: 

1. Point to the atom shown inFigure 2.52 A.
2. Do one of the following:

• Type the letter o.
• Double-click the atom to open a text box, 

and type OH.
Figure 2.52: Completing the intermediate structure 

Next you will add arrows to indicate electron flow. 
The first arrow will demonstrate the new adjust-
able Arrows tool. The others will be created with 
the Pen tool. 
Add an arrow with the arrows tool:

1. Choose an upward curved arrow from the 
Arrows palette.

Figure 2.53: Selecting an arrow

2. Point near the double bond where you want to 
indicate the start of electron flow.

O-

O- O-

OH
A B
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3. Drag to the right. Don’t worry about the size of 
the arrow right now, just make it approximate.

Figure 2.54: Dragging an arrow

4. Point to the arrow.
Adjustment handles appear at the ends and in 
the middle.

5. Drag the center up to decrease the curve. You 
may also drag the ends or the point-width 
adjustment handles to adjust the arrow as nec-
essary.

Figure 2.55: Adjusting an arrow

The remaining arrows are created with the Pen 
tool.
To create a customized arrow using the Pen tool.

1. Select the Pen tool . 
2. Starting just to the right of the O – atom label, 

drag upward and to the right. Release the 
mouse button. 
The hand with a “+” cursor indicates that you 
are in the editing mode of the Pen tool.

3. Position the cursor where you want the arrow-
head to appear, and click.

O-

OH
O-

OH

O-

OH
O-

OH
ChemDraw 10
Figure 2.56: Drawing custom arrows

Refine the shape of the arrow:
1. Point to the handle at the lower end. You 

should see a plain hand without the plus sign.
2. Drag up to the right, as shown in Figure 2.57 A. 

This creates a tangent line that adjusts the cur-
vature.

3. Point to the end and drag it to the correct loca-
tion.

Figure 2.57: Adjusting a curve 

4. Add an arrow head. Click the Full Arrow at End 
command on the Curves menu.

Figure 2.58: The Curves menu

TIP: You may select more than one option, as long as 
they do not conflict. For example, you may specify 
arrows at both start and end.

O-

OH
O-

OH

O-

OH
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5. Press Esc when you are finished.

TIP: To edit a curve you have finished drawing, select 
it with a selection tool first, then click the Pen tool. 

6. Create the remaining arrow as described above 
to complete the intermediate as shown below.

Figure 2.59: Tutorial 2: final drawing 

NOTE: If you want to magnify the entire document so you 
can see arrows or other objects that are in small places, choose 
Magnify from the View menu.
Save and close the document:

1. Click the Save command on the File menu.
2. Click the Close command on the File menu.

Tutorial 3: Using Rings
In this tutorial you will draw more complex struc-
tures by using rings.
Figure 2.60: Tutorial 3: Using ring structures 

Create a ChemDraw Document:
1. Click the New Document command on the File 

menu.
2. Click the Save As command on the File menu.
3. Type tut3.cdx in the appropriate text box.
4. Select a folder in which to save the file.

O-

OH

CH

O
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5. Click Save.
Create a ring:

1. Click the Cyclohexane Ring tool .
2. Point in an empty area of a document window.
3. Click to add a ring.

Figure 2.61: Drawing with the ring tool 

Fuse a second ring to the first:
1. Point to the center of lower right bond in the 

ring.
2. Click to fuse another ring.

Figure 2.62: Fusing rings 

Fuse a third ring:
1. Point to the bond shown in Figure 2.63.
2. Click to fuse another ring. Your document 

should contain the structure shown in Figure 
2.63 B.

Figure 2.63: Fusing a third ring 

Fuse a fourth ring: 
1. Point to the bond shown below.
2. Click to fuse another ring.

A B
CambridgeSoft
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Figure 2.64: Adding a fourth ring 

Remove atoms and their bonds from the ring using 
the Eraser tool:

1. Click the Eraser tool .
2. Point to the atom shown in Figure 2.65.

A highlight box appears on the atom to be 
removed.

3. Click to delete the atom and its bonds.
Figure 2.65: Removing atoms and bonds with the 
eraser tool 

4. Click each of the atoms shown below to delete 
the bonds.
The resulting structure is shown in Figure 2.66.

Figure 2.66: Creating the final skeleton structure 
ChemDraw 10
Add double bonds to the structure. In Tutorial 1 
you turned a single bond into a double bond by 
dragging over the bond. In Tutorial 2, the method 
of clicking on the single bond was introduced. 
Here, you will learn two more methods.

1. Click the Solid Bond tool . (Actually, any 
bond tool will do.)

2. Point to the bond indicated in Figure 2.67.
3. Type the number 2 to change the single bond 

to a double bond. 

TIP: The numbers 1-4 are bond order HotKeys. 

Figure 2.67: Creating a double bond with a HotKey 

Add another double bond:
1. Point to the bond shown below.
2. Right-click, point to Double on the Bond Con-

text menu, and choose Plain.
Figure 2.68: Creating a double bond from the context 
menu 

Realign the double bond so it is centered:
1. Point to the center of the upper double bond.
2. Right-click, point to Bond position, and choose 

Centered.
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Figure 2.69: Centering a double bond 

Add a carbon atom label:
1. Point to the atom shown in Figure 2.70.

Figure 2.70: Adding an atom label with a HotKey 

2. Type the c key on your keyboard. Note that the 
Hotkey assigned to the atom label C is the 
lower case letter. Typing an uppercase C will 
create the atom label Cl.
The CH atom label appears with the correct 
number of hydrogen atoms.

Add an oxygen atom label to complete the struc-
ture:

1. Point to the atom shown in Figure 2.71.
2. Type the o key on your keyboard. By default, 

both upper and lower case O Hotkeys are 
assigned to the atom label O.

Figure 2.71: Completing the drawing 

Save and close the document:

CH

CH CH

O

36 • Tutorials
1. Click the Save command on the File menu.
2. Click the Close command on the File menu.

Tutorial 4: Fischer 
Projections
This tutorial demonstrates creating a Fischer pro-
jection of glucose (shown below) by drawing a lin-
ear series of bonds. You can also create the same 
drawing using a template. It also demonstrates the 
use of standard document Style sheets (Windows) 
or Sationery Pads (Mac).
Figure 2.72: Tutorial 4: Fischer projections 

1. Point to Open Special on the File menu, and 
choose ACS Document 1996. 
Special Documents are Style sheets or Sation-
ery Pads. They allow you to have pre-config-
ured settings for different tasks. 

NOTE: In this example, the ACS template provides the 
required settings for structures to be published in all ACS 
journals:
• One-column layout (Page Setting)
• Bonds with a Fixed length of 0.2 inches 

(Drawing Setting)
• Atom Labels in 10 point Arial or Helvetica font (Text 
Setting)

2. Click the Save As command on the File menu.
3. Type tut4.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.

Draw the first bond:

Fischer
Glucose
70%

CHO

CH2OH

OHH

HHO

OHH

OHH
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1. Click the Solid Bond tool .
2. Point in the document window. Drag down-

ward vertically to draw the first bond.
3. Point to the lower atom, and drag downward 

again to draw the second bond.
The red wavy box appears because Show 
Chemical Warnings flags colinear bonds. You 
can ignore it, or turn off warnings from the 
View menu. 

4. Repeat step 3 three more times to draw a total 
of five bonds. 

Figure 2.73: Drawing the backbone 

NOTE: When you drag the pointer along the length of the 
bonds, the pointer alternates between an arrow and a cross. 
The arrow indicates you are pointing over the center of a bond, 
and the cross indicates you are pointing to an atom.
Add horizontal bonds to the second atom in the 
string of bonds you created:

1. Point to C2 and click the atom to add a perpen-
dicular bond.
Note that the red wavy box disappears as soon 
as you add a bond.

2. Click again to add a horizontal bond in the 
opposite direction.

3. Repeat steps 1 and 2 with each successive back-
bone carbon until all horizontal bonds are 
added.

A B C D
ChemDraw 10
Figure 2.74: Adding horizontal bonds to the back-
bone 

Add labels to C1 and C6:
1. Select the Text tool. 
2. Click the C1 atom to create a text box, and type 

CHO.
3. Click the C6 atom, and type CH2OH.

Figure 2.75: Adding atom labels 

Add the repeating labels for the hydrogens and 
hydroxyls:

1. Click the atom shown in Figure 2.76 A and type 
the letter H.

2. Double-click each of the other atoms labeled as 
hydrogen in Figure 2.76 B.

TIP: Double clicking with the text tool repeats the last 
label.

Figure 2.76: Adding repeating atom labels 
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3. Click one of the remaining atoms and type 
OH.

4. Double-click the remaining atoms to repeat the 
label.

Figure 2.77: Completing the drawing 

View the basic properties of the structure you drew 
and paste the information into your document:

1. Click a selection tool to automatically select the 
last structure drawn. If the structure is not 
selected, double-click the structure.

2. Click the Analysis Window command on the 
View menu.
The Analysis window appears. You can drag 
the window to any position.

Figure 2.78: The Analysis window

3. Click Paste to paste the information as a cap-
tion below the structure.

CHO

CH2OH

OHH
H

H
H

CHO

CH2OH

OHH
HHO
OHH
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Figure 2.79: Fischer projection with analysis 

Save and close the document:
1. Click the Save command on the File menu.
2. Click the Close command on the File menu.

Tutorial 5: Perspective 
Drawings 
In this tutorial you will learn how to create a per-
spective drawing by creating a model of -D-glu-
cose as a Haworth projection.
NOTE: This tutorial was written before the Structure Per-
spective tool was added to the ChemDraw toolbar, to demon-
strate how to create perspective drawings without such a tool. 
If you want to use the Structure Perspective tool for this tuto-
rial, distort the ring before adding any bonds. Otherwise, the 
tutorial is the same. 
Figure 2.80: Tutorial 5: Perspective drawings 

Create a new document using the ChemDraw 
default style:

CHO

OHH

HHO

OHH

OHH

CH2OH

C6H12O6
Exact Mass: 180.06

Mol. Wt.: 180.16
m/e: 180.06 (100.0%), 181.07 (7.1%), 182.07 (1.4%)

C, 40.00; H, 6.71; O, 53.29
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CH2OH
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1. Point to Open Special on the File menu, and 
choose the New Document command. 

NOTE: If you are doing the tutorials in order, 
ChemDraw will remember that your last drawing used 
the ACS style sheet, and open that as the default. 
Step 1 resets the default to New Document.

2. Click the Save As command on the File menu.
3. Type tut5.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.

Draw a ring:
1. Click the Cyclohexane Ring tool .
2. Point in an empty area of a document window.
3. Click to add a ring.

Rotate the ring:
1. Click the Select All command on the Edit menu 

(or type Ctrl+A).
2. Drag the Rotation handle to the right about 30 

degrees. The amount of rotation is displayed 
on the screen and in the Info window.

Figure 2.81: Rotating the structure 

NOTE: The cursor changes to a curved double-sided arrow 
to indicate the rotation mode of a selection tool is activated.
Even though Fixed Angles is on, the angle is not 
constrained. The Fixed Angles feature constrains 
angles only when they are being drawn. For exam-
ple, if you created this ring by dragging instead of 
clicking, the angle would be constrained when 
Fixed Angles is on.
Change cyclohexane to tetrahydropyran:

1. Click outside the structure to deselect it.
ChemDraw 10
2. Point to the atom indicated in Figure 2.82, and 
type the lower case letter o.

Figure 2.82: Adding an atom label with a HotKey

Add vertical bonds:
1. Click the Solid Bond tool .
2. Point to the atom shown in Figure 2.83 and drag 

upward to create a bond. 
3. Point to the same atom, and drag downward to 

create another bond.
Figure 2.83: Adding a pair of vertical bonds 

4. Repeat this procedure three more times, adding 
the pairs of vertical bonds shown in Figure 2.84. 

Figure 2.84: Repeating the procedure 

The final pair of vertical bonds has to be drawn 
slightly differently:

1. Drag up from the last remaining carbon atom 
to form a bond. 

2. Point to the atom shown below. 
For the final downward bond, you must turn 
Fixed Lengths off. Otherwise, the bond will be 
joined to the upward bond of C3. 

3. Hold down the mouse button, press the Alt or 
option key, and drag downward from C5. Stop 
dragging about half the distance to the upward 
bond on C3. 

O

O

O O

O
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Figure 2.85: Adding the final pair of bonds 

Distort the structure to change its aspect ratio to 
give the perspective of viewing the structure along 
the Z-axis.

1. Click a selection tool, and select the entire 
structure. 

2. Drag the bottom center resize handle upwards 
until you have distorted the structure to about 
50%, as shown on the screen or in the Info 
window.

Figure 2.86: Distorting the structure 

NOTE: Even though you took precautions to make one of 
the bonds shorter than the others, you might still have a prob-
lem with proximity after distorting the structure. If this hap-
pens, delete the upward bond on C3 and redraw it, holding 
the Alt or option key to cancel fixed bond length.
Next, you create OH labels. You can use the 
repeating bond label technique in Tutorial 4, or use 
HotKeys. For the HotKey method, just point and 
type “o”. The Text tool method is repeated here, 
with a slight variation.

O
O

O

OH

O
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1. Select the Solid Bond tool, point to the atom 
shown in Figure 2.87 A and double-click to 
open a text box.

2. Type OH, move the pointer to the next atom as 
shown, and triple-click to repeat the atom label.

Figure 2.87: Adding the OH labels 

TIP: If you find it difficult to place the labels because 
of the size of the drawing, choose Magnify from the 
View menu.

NOTE: The third OH from the right is on the bond 
extending up from C3, not the bond extending down 
from C5. 

Add the CH2OH label:

1. Triple-click the upper atom of C5. 
2. Press the Enter or Return key to open the 

atom label text box. Type CH2 before the OH.
Figure 2.88: Adding the CH2OH label 

NOTE: When used with a bond tool active, Enter or 
Return is a Hotkey that opens a text box for the last 
atom labeled.

Change the type of the front bonds: 
1. Click the Bold Bond tool .
2. Point to the center of the bond shown below.
3. Click to change to the new bond type.

The cursor changes to a bold arrow as you 
point at the bond.
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Figure 2.89: Adding a bold bond 

4. Click the Bold Wedge bond tool .
5. Click each of the ring bonds adjacent to the 

bold bond.
For each bond, point slightly off center in the 
direction that you want the wide end of the 
wedge to be oriented and click.

TIP: If you move the pointer too far, the highlight box 
disappears. Choose Magnify from the View menu if you 
find it difficult to place the pointer.

NOTE: If the wedge is pointed in the wrong direction, 
click the bond again to flip its orientation.

The resulting structure is shown in Figure 2.90.
Figure 2.90: a-D--glucose, Haworth projection 

Save and close the document:
1. Click the Save command on the File menu.
2. Click the Close command on the File menu.

Tutorial 6: Newman 
Projections
This tutorial demonstrates how to draw a Newman 
projection. You can also create the same drawing 
using a template.
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Figure 2.91: Tutorial 7 Newman projection 

Create a ChemDraw Document:
1. Click the New Document command on the File 

menu.
2. Click the Save As command on the File menu.
3. Type tut6.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.

Create the first structure:
1. Click the Solid Bond tool .
2. In the document window, drag downward to 

create the first bond.
3. Point at the lower atom and click to add a sec-

ond bond.
4. Continue pointing at the same atom and click 

again to add a third bond.
Figure 2.92: Creating the initial structure 

Duplicate the structure:
1. Click a selection tool.

The last structure you drew is automatically 
selected.

2. Create a duplicate by holding the Ctrl or 
option key while dragging the Selection rectan-
gle upward to the right of the original.
The selection box disappears while you are 
dragging.
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Figure 2.93: Creating a duplicate structure 

Add a bond between the duplicated structures:
1. Click the Solid Bond tool .
2. Point to the central atom of the lower frag-

ment.
3. Drag to the central atom of the upper frag-

ment.

NOTE: When connecting existing atoms, the Fixed 
Length and Fixed Angles commands are ignored.

4. Release the mouse button when the highlight 
box over the central atom appears. 

Figure 2.94: Connecting the structures 

In this step, you will use the Orbital tool to draw 
the hollow circle that is particular to Newman Pro-
jections, rather than an orbital.

1. Click the Orbital tool, and select the 
unfilled s orbital.

Figure 2.95: The Orbitals tool palette 

2. Point to the left center carbon and drag out-
ward.
42 • Tutorials
The size of the orbital is constrained just like 
bonds are. The constraint is based on a per-
centage of the Fixed Length setting in the on 
the Drawing Settings tab of the Document set-
tings dialog box.

Figure 2.96: Adding an orbital

NOTE: Orbitals are not automatically grouped with 
the closest structure. If you want to group the orbital 
with the existing structure so you can move them as a 
unit, choose Group from the Object menu.

Move part of the structure to the front to overlap 
the orbital:

1. Click the Marquee tool .
The orbital is selected. Click in the worksheet 
to deselect it.

2. Point above the structure and drag around the 
upper fragment to select the three bonds. Do 
not select the bond connecting the two frag-
ments. You can Shift+click on each bond sep-
arately, if that is easier.

TIP: The new selection box makes it easy to tell which 
bonds are selected – selected bonds have a dot on them.‘

Figure 2.97: Selecting the fragment to overlay

Rotate the selection:
CambridgeSoft
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1. Double-click the rotation handle to open the 
Rotate dialog box.

2. Type 180 in the text box, select degrees CW, 
and click the Rotate button.

Figure 2.98: The Rotation dialog box 

Figure 2.99: After rotation

3. With the rotated bonds still selected, change 
the layering of the structure so that the selec-
tion is in front by clicking the Bring to Front 
command on the Object menu.
There is no visible change when you do this.

Orient the front part of the structure to create a 
Newman projection.

1. Point within the Selection Rectangle until the 
pointer changes to a hand. 

2. Drag the selection until the central atom of the 
selection is centered within the orbital.

RotateObjectsDB 150 dpi
ChemDraw 10
Figure 2.100: Overlaying the structure 

NOTE: If chemical warnings are turned on, you will 
see a red warning box when you overlay the structure, 
because the center atoms are “on top of ” each other.

3. Release the mouse button and click outside the 
Selection Rectangle to deselect the structure.

Figure 2.101: Completed Newman projection 

Save and close the document:
1. Click the Save command on the File menu.
2. Click the Close command on the File menu.

Tutorial 7: Showing 
Stereochemistry
This tutorial demonstrates using Stereochemistry 
markers and the flip command.
Create a new document.

1. Click the New Document command on the File 
menu.

2. Click the Save As command on the File menu.
3. Type tut7.cdx in the appropriate text box.
4. Select a folder in which to save the file.
5. Click Save.

Draw the following structure:
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Figure 2.102: S-(2,3)-dimethylbutanoic acid 

1. Click the Solid Bond tool .
2. The first three steps are identical to the previ-

ous tutorial: create an isobutane structure.
Figure 2.103: Beginning the structure

3. Point to the atom shown in Figure 2.104 and 
type the number 9.
When used with a bond tool, the number 9 is a 
HotKey for sprouting two bonds. The number 
8 sprouts three bonds. 

Figure 2.104: Sprouting bonds with a HotKey 

4. Point to the bond shown in Figure 2.105, and 
type 9 again to sprout two more bonds. 

Figure 2.105: Repeating the bond sprouting 

5. The upper bond on the right has to be made 
into a double bond. If you’ve gone through all 
the tutorials, you’ve learned four different ways 
of doing that. Use your preferred method. 

OH

O
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Figure 2.106: adding a double bond 

Now, the lower bond has to be changed to a solid 
wedge bond. In tutorial 5 you were introduced to 
the wedge bond tool. You can also use a HotKey.

6. Point to the bond shown in Figure 2.107 and do 
one of the following:
• Select the Wedge Bond tool, and click the 

bond.
• Point to the bond and type the letter w.

Figure 2.107: Adding a wedge bond

Add atom labels.
1. Double-click the atom shown below, and type 

NH2 in the text box that appears. Press the Esc 
key when you finish.

2. Add the O and OH with the text box or the 
HotKey o.

Figure 2.108: Adding the atom labels

Display the stereochemical markers.
1. Select the entire structure with the Lasso or 

Marquee.
2. Click the Show Stereochemistry command on 

the Object menu.
The S marker appears.

NH2

OH
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Figure 2.109: Showing stereochemistry

3. Select the structure and click the Flip Horizon-
tal command on the Object menu.
The R marker appears.

Figure 2.110: Flipping stereochemistry 
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4. With the structure selected, click the Rotate 
180° Vertical command on the Object menu.

Figure 2.111: Vertical rotation 

The Wedged bond becomes hashed and the 
(R) stereochemistry is preserved.

Save and close the document:
1. Click the Save command on the File menu.
2. Click the Close command on the File menu.
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Chapter 3: Drawing Chemical Structures

Overview
This section describes the use of bond and ring 
tools used to create chemical structures. 
ChemDraw provides the following tools for draw-
ing chemical structures: 

• Bond tools 

• Ring tools 

• An acyclic chain tool 

• Text tool 

These are the basic building tools for creating and 
labeling structures. In addition to these basic build-
ing tools, ChemDraw gives you two selection 
tools, a Marquee to select large contiguous areas 
and a Lasso for difficult shapes, and an Eraser tool. 
The remaining tools are for more advanced fea-
tures, described in other sections of this manual.
Especially useful when making multiple changes to 
structures, ChemDraw’s automatic error detection 
flags errors that you might otherwise overlook. See 
“Automatic Warnings” on page 55 for more infor-
mation.

Drawing Bonds
The Main Tools palette contains the bond tools 
shown below:
ChemDraw 10
Figure 3.112: Multiple bond tools

Drawing Constrained Bonds
You can draw any bond length or create any angle 
relative to the X-axis. Use the Info Window to 
display the bond length and angle as you drag the 
bond. 

However, it is generally more useful to draw bonds 
that are constrained to a fixed length and a fixed 
angle relative to the X-axis. This is the default 
setting.

Drawing with Fixed Lengths
To draw bonds that are constrained to a fixed 
length:

1. Click the Fixed Lengths command on the 
Object menu.

Solid Bond

Dashed Bond

Hashed Wedged Bond

Bold Wedged Bond

Hashed Bond

Bold Bond

Hollow Wedged Bond

Wavy Bond

Multiple Bonds
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A check mark appears next to the Fixed 
Lengths command indicating that it is selected. 
All bonds are constrained to the fixed length 
specified on the Drawing Settings tab of the 
dialog box.

2. Click a bond tool.
3. Drag from one end of the bond to the other.

The Info Window displays the bond length.

Drawing with Fixed Angles
To draw bonds with constrained angles that are 
multiples of 15 degrees relative to the X-axis:

1. Click the Fixed Angles command on the Object 
menu.
A check mark appears next to the Fixed Angles 
command indicating that it is on.

2. Click a bond tool.
3. Click in a document window. 

The bond appears at a standard 120° bond 
angle (relative to the x-axis).

4. Using a selection tool, move the end of the 
bond to other angles.
The Info Window shows that the bond angle is 
constrained to 15-degree increments.

Toggling Fixed Lengths and Fixed 
Angles
If fixed lengths or fixed angles are selected, you 
can temporarily deselect them. To suppress fixed 
lengths and fixed angles, press the Alt or option 
key as you drag the bond.

Multiple Bonds 
The Multiple Bond tool on the Main toolbar 
includes the palette shown in Figure 3.113.
Figure 3.113: Multiple bond palette
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You can use the tools on the Multiple Bond palette 
to create the following multiple bonds: 

TIP: You can also draw multiple bonds by right-clicking 
over a bond and selecting the bond type from the shortcut 
menu or by using the bond properties dialog box, or by using 
HotKeys. For more information on the Bond Properties dia-
log box, see “Bond Properties” on page 90. For more infor-
mation on HotKeys, see “Labeling Atoms with HotKeys” on 
page 60.

Double Bonds
There are three ways to draw a double bond:

• Use the Double bond tool.
• Using the Solid, Dashed, or Bold bond tool, 

click an existing single bond.
• Using any bond or selection tool, point to an 

existing bond and type the HotKey ‘2’. 

Table 7: Multiple bond types

Double

Bold Double

Tautomeric

Aromatic

Double Either

Dative

Triple

Quadruple
CambridgeSoft
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Double Either Bonds 
To draw a double either bond select the double 
either bond tool from the Multiple Bonds palette, 
or:

1. Draw a bond using the Wavy Bond tool. 
2. Point to the center of the bond and click to cre-

ate a double bond
3. Click again to create a double either bond.

Triple Bonds
You can draw a triple bond by drawing another 
single bond on top of a double bond. All bonds in 
a triple bond are solid bonds.

To draw a triple bond select the triple bond tool 
from the Multiple Bonds palette, or:

1. Click any bond tool.
2. Drag from one end of an existing double bond 

to the other.

Quadruple Bonds 
To draw a quadruple bond select the quadruple 
bond tool from the Multiple Bonds palette, or:

1. Click any bond tool.
2. Drag from one end of an existing triple bond to 

the other.
The triple bond changes to a quadruple bond.

To change a quadruple bond into a single bond:
1. Click any bond tool.
2. Drag from one end of an existing quadruple 

bond to the other.
The quadruple bond changes into a single bond 
corresponding to the tool used to draw over 
the bond. 

NOTE: You can also use the Eraser tool to reduce the bond 
order. For more information, see “Changing the Bond 
Order” on page 29.
ChemDraw 10
Dative Bonds and Wedged Bonds
Dative bonds and wedged bonds are drawn with a 
fixed orientation in a document window. 

To draw a dative bond:
1. Click the Dative Bond tool.

Figure 3.114: Dative bond tool

2. Drag from the positive to the negative end 
(arrow head) of the dative bond.

Figure 3.115: Drawing a dative bond

To draw a wedged bond:
1. Click one of the wedged bond tools.
2. Drag from the narrow end of the wedged bond 

to the wide end of the wedged bond.
Figure 3.116: Drawing a wedged bond

To change the orientation of the dative or wedged 
bond, click the center of the bond using the match-
ing bond tool.

Adding a Bond by Clicking
To add a fixed length bond:

1. Select a bond tool.
2. Click an atom.

A new bond is drawn and joined to the atom 
you clicked. 

drag direction

drag direction
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Figure 3.117: Adding a bond to an atom

Bonds drawn by this method are always drawn 
using the fixed length specified on the Drawing 
Settings tab of the Document settings dialog box. 
The angle that the deposited bond makes with its 
nearest neighbor is equal to the Chain Angle set on 
the Drawing Settings tab of the Document settings 
dialog box. If this angle cannot be established, a 
smaller angle is used.

Adding Bonds by Dragging
To control the orientation of bonds that you draw, 
you can add bonds by dragging. 

By using this dragging method for drawing the 
bond, you can control the orientation of the other 
end of the bond.

To add a bond by dragging:
1. Click a bond tool.
2. Point to an atom.

A highlight box appears over the atom indi-
cating where the bond will be joined.

3. Drag from the atom at which you are pointing 
in the direction you want the new bond to 
extend.
A new bond is drawn, joined to the atom where 
the highlight box appeared.

Figure 3.118: Adding a bond by dragging

Drawing Rings
The Main Tools palette contains the following ring 
tools that enable you to draw ring sizes and types:
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Figure 3.119: Ring tools

Drawing a Ring 
To draw a ring, select a ring tool. When you point 
in the document window, the pointer changes to a 
ring tool pointer. The highlight box on the ring 
tool pointer indicates the atom that is drawn first. 
The bond directly below the highlight box is the 
bond that is drawn first. 
Figure 3.120: Ring tool pointer

Click in the document window. A ring appears, 
centered around the pointer, and in the orientation 
shown on the ring tool icon. To draw a ring in a 
different orientation, drag the tool instead of click-
ing.
TIP: If Fixed Lengths is on when you draw a ring, the 
length of each bond in the ring is automatically set to the fixed 
length. If Fixed Angles is on, the angle the first bond in the 
ring makes with the X-axis is restricted to 15-degree incre-
ments. For more information, see “Drawing Constrained 
Bonds” on page 20.
If you click an atom, the ring is fused to that atom. 

Cyclopropane Cyclobutane

Cyclopentane Cyclohexane 

Cycloheptane Cyclooctane

Cyclohexane Chair (1) Cyclohexane Chair (2)

Cyclopentadiene Benzene

First atom drawn

First bond drawn
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Figure 3.121: Adding a ring to an atom

If you click a bond, the ring is fused to that bond. 
Figure 3.122: Adding a ring to a bond

If you click an atom in a ring, a spiro linkage is 
formed.
Figure 3.123: Adding a spiro linkage

NOTE: This behavior is controlled on the Building/ Dis-
play tab of the Preferences dialog box. See “Setting Prefer-
ences” on page 197 for more information.
You may change this default behavior to sprout a 
bond instead. 

1. Select Preferences on the File (Mac: Chem-
Draw) Menu.

2. On the Building/Display tab, check the box 
next to Sprout Rings Instead of Spiro When 
Clicking.
ChemDraw 10
Figure 3.124: Sprouting rings instead of spiro linkage

Drawing Cyclohexane Chair 
Rings
You can draw Cyclohexane chair rings in two 
orientations: horizontal and vertical.When you 
draw a cyclohexane chair ring by clicking, the chair 
is drawn in a horizontal orientation. 

To draw a cyclohexane chair ring in some other 
orientation, drag with the chair tool to the orienta-
tion you want.
Figure 3.125: Drawing a cyclohexane ring – drag-
ging and clicking 

Drawing Resonance Delocalized 
Rings
With the exception of the cyclohexane chairs, any 
of the ring tools can be used to draw a resonance 
delocalized form.

To draw a resonance delocalized ring:
1. Click a ring tool.
2. Press the Ctrl or command key and drag or 

click to draw the ring.
A circle appears inside the ring.

Horizontal Orientation Vertical Orientation
Drawing Chemical Structures • 51
Overview



A
dm

inistrator
Figure 3.126: Drawing a resonance delocalized ring

NOTE: The circle is automatically grouped with the ring 
when drawn. For more information on grouping objects, see 
“Grouping Objects” on page 112.

Drawing Cyclopentadiene and 
Benzene Rings
The double bonds in the cyclopentadiene or 
benzene ring tools can be drawn in either of two 
forms. 

When you draw a cyclopentadiene or benzene ring 
a double bond is drawn first (see Figure 22). The 
Cyclopentadiene and Benzene Ring tool pointers 
indicate this orientation. To shift the orientation so 
the first bond drawn is a single bond, hold down 
the shift key as you click or drag in the structure 
window.
Figure 3.127: Changing orientation with the shift key

Drawing Acyclic Chains
Use the Acyclic Chain tool to draw long 
hydrocarbon chains. The behavior of the 
Acyclic Chain tool is affected by the fixed lengths 

Orientation without
shift key

Orientation with
shift key

First 
bond

First 
bond
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and fixed angles switches on the Object menu, and 
by the chain angle setting on the Object Settings 
dialog box.

NOTE: Modifying the Chain Angle value for an existing 
object will have no effect on that object, but new bonds/chains 
sprouted from it will sprout at the specified angle.
To draw an acyclic chain:

1. Click the Acyclic Chain tool.
2. Drag in the direction you want the chain to 

grow in a document window.
A number appears at the end of the chain indi-
cating how many atoms you have drawn.

Figure 3.128: Drawing with the acyclic chain tool

When Fixed Lengths is on, the pointer on the 
acyclic chain tool can be dragged to make any angle 
relative to the X-axis. At a constant chain length, 
the positions of the first bond and all subsequent 
odd-numbered atoms depend on the direction you 
drag. Before releasing the mouse button, this posi-
tion can be changed by dragging in the opposite 
direction. When Fixed Angles is on, the angle the 
acyclic chain makes relative to the X-axis is 
constrained to 15-degree increments. 

Adding Chains
To add an acyclic chain to an existing atom:

1. Click the Acyclic Chain tool.
2. Point to the atom to which you want to attach 

the chain.
3. Drag in the direction you want the chain to 

grow.
CambridgeSoft
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Figure 3.129: Adding a chain to a bond

To specify a chain length:
1. Click the Acyclic Chain tool.
2. Click an existing atom or an empty area in a 

document window.
The Add Chain dialog box appears.

Figure 3.130: The Add Chain dialog box

3. Type the number of bonds in the chain.
4. Click Add.

To add another chain of the same length anywhere 
in a document window, Alt+click or 
option+click an existing atom or an empty area 
within the document window.

Changing Chain Direction
To change the direction of the chain as you draw, 
press the Ctrl or command key while drawing the 
chain in the direction you want.

TIP: Make sure to release the mouse button before you 
release the Ctrl or command key.
ChemDraw 10
Figure 3.131: Reversing chain direction

NOTE: If Fixed Lengths is off, use Ctrl+Alt or com-
mand+option to reverse chain direction. Fixed Angles 
must be on to reverse direction.

Editing Bonds
You can modify the appearance of chemical 
structures by:

• Changing Bond Types
• Changing bond alignment and orientation
• Moving Atoms 
• Layering bonds
• Changing the bond order

Changing Bond Types
To change a single bond from one type to another:

1. Click a bond tool.
2. Point at the center of an existing bond and 

click.
Figure 3.132: Changing a bond type

The bond that you click changes to the new 
bond type.

You can also change the bond type using HotKeys, 
see “Labeling Atoms with HotKeys” on page 60

Changing Double Bonds
To change one type of double bond to another:

1. Click the Bold, Dashed, or Solid Bond tool.
2. Point to one of the bonds in the double bond.
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Figure 3.133: Changing double bonds

3. Click the bond.
The double bond changes to the new bond 
type. One of the bonds in the double bond is 
always a solid or dashed bond.

NOTE: If you click a tautomeric bond (solid/dashed) a 
second time with the dashed bond tool, you create an aromatic 
double bond (dashed/dashed).

Editing Bonds With the Context 
Menu
You can change an existing bond by right-clicking 
or Control-clicking on it and selecting a different 
bond type from the context menu.

Changing Orientation of Wedged 
and Dative Bonds
When you draw or change a bond to a wedged or 
dative bond, the orientation of the bond is chosen 
appropriately. 

To change the orientation, click the dative or 
wedged bond with the tool used to create it.

The dative or wedged bond is changed to the 
opposite orientation.

Figure 3.134: Changing bond orientation

Changing Alignment of Double 
Bonds
The bonds in a double bond can have one of three 
alignments relative to other bonds: 

HO

COOH

CH3

H

HO

COOH

CH3

H
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• Above 

• Below 

• Centered 

To change the alignment of a double bond:
1. Click the bond tool used to create the existing 

double bond.
2. Do one of the following:

• Click the center of the double bond.
The alignment changes. Click the center of 
the double bond again to change to the next 
alignment.

• Right-click or Control-click, point to Bond 
Position on the context menu, and choose 
the alignment.

Moving Atoms With a Bond Tool
You can use any of the bond tools to move an 
atom within acyclic or cyclic structures. You 
cannot use a ring tool.

To move an atom in a chemical structure:
1. Click a bond tool.
2. Point at the atom to move.

A highlight box appears over the atom.
3. Shift+drag the atom.

Figure 3.135: Moving atoms

You can convert ring types by dragging one atom 
on top of an adjacent atom. For example, you can 
use this method if you want to convert a 
6-membered ring into a 5-membered ring.

To convert ring types:
1. With a bond tool selected, point to an atom 

and Shift+Drag.
CambridgeSoft
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2. Release when one atom is on top of the other.
The bond between the atoms disappears. 

Figure 3.136: Changing a ring type

NOTE: You can also move atoms using a selection tool. 
For more information see “Moving Objects” on page 107.

Changing Bond Crossings
When one bond crosses another, white space is 
used to indicate which bond is in front of the 
other. 

To change which bond is in front:
1. Click any bond tool.
2. Double-click the bond to bring it to the front.

Figure 3.137: Changing the bond layering

You can layer bonds using the Bring to Front and 
Send to Back commands. For more information, 
see “Front to Back Ordering” on page 193. You 
can also change the bond crossing using HotKeys, 
see “Labeling Atoms with HotKeys” on page 60.
TIP: To make changing the bond layering easier, magnify 
the view. See “Changing Perspectives” on page 190.

Changing the Bond Order
You can reduce or increase the order of bonds in a 
structure by using the Bond Properties dialog box 
or with the shortcut menus as follows.

To reduce the bond order:
1. Point to the bond to change and Right-click or 

Control-click.
ChemDraw 10
2. Choose the appropriate bond type from the 
context menu that appears.

To use the eraser tool to reduce the bond order:
1. Select the Eraser tool.
2. Click a single, double, or triple bond.

The bond order is reduced by one.
To change the bond order using HotKeys, see 
“Tutorial 3: Using Rings” on page 34.

Automatic Warnings
ChemDraw automatically checks for correct chem-
ical syntax as you draw. If ChemDraw finds a 
potential problem, a wavy red box is displayed 
around the questionable object. The red box is dis-
played on screen only and does not print. 
Displaying warnings is the default setting. You have 
two options for not displaying them:

• Turn off the automatic warnings option.

NOTE: This setting applies to all open documents. 

• Suppress warnings for a specific object.
To disable the automatic display of chemical 
warnings, deselect the Show Chemical Warnings 
command on the View menu.

To disable the automatic error checking on a spe-
cific object, right-click the object and deselect the 
Display Warnings command on the context menu. 
When Display Warnings is deselected for an object: 

• Red boxes are not displayed for questionable 
objects.

• Problems are reported by the Check Structure 
command.

To view a description of the problem, do one of the 
following:

• Point at the warning with the mouse to display 
a tool tip that describes the error.
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• Right-click on the warning and choose Explain 
This Warning.

• Select the structure, and choose Check Struc-
ture from the Structure menu.
For more information, see “Checking Chem-
istry” on page 129.

Warning Preferences
You can choose what Chemical Warnings will flag 
in the Preferences dialog box. The option list 
includes: 

To select which types of chemical warnings to dis-
play:

1. Click the Preferences command on the File 
menu.

2. Click the Display Warnings tab.
3. In the Chemical Warnings section, click the 

types of warnings you want to display.

Creating Text
Use the Text tool to create captions and atom 
labels. 

• Caption text—Create annotations, chemical 
names, chemical formulas, page titles, and 
information in tables. Default text formats are 
set in the Document Settings. See “Document 

Table 4: Chemical Warnings

Valence and Charge errors Isolated bonds

Unbalanced parentheses Invalid isotopes

Unspecified stereochemistry Linear atoms

Ambiguous stereochemistry Atoms near other 
bonds

Stereobond between chiral 
atoms

Miscellaneous 
warnings
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and Object Settings” on page 200 for more 
information. You may set different defaults for 
captions and labels. 

Figure 3.138: Caption text

• Atom label text—Identify atoms and sub-
structures by their chemical symbols and for-
mulas.

Figure 3.139: Atom label text

To change formatting for an individual caption or 
label: 

1. Select the text object with a selection tool.
2. Click the Object Settings command on the 

Object menu.
The Object Settings dialog box opens.

3. Click the Captions or Atom Labels tab, as 
appropriate, and change the setting.
The change affects on the selected caption or 
atom label only. 

The behavior of atom labels is controlled by the 
Automatic Atom Label Alignment and Automati-
cally Rectify Hydrogens in Atom Labels checkboxes 
on the Building/Display tab of the Preferences dia-
log box. The default is to have both of these pref-
erences selected.

phenol

OH

Caption Text

phenol

OHAtom Label 
Text
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When Automatic Atom Labels is selected, the 
alignment of atom labels will adjust according to 
the positions of any bonds attached to the atom 
label. 
For example, a CH3 atom label entered at the left 
end of a horizontal bond would reverse itself to 
H3C.
When Automatically Rectify Hydrogens in Atom 
Labels is selected, hydrogens will be added to or 
removed from atom labels as necessary to preserve 
standard valences when bonds are added or 
changed.
You can use HotKeys to label atoms. For more 
information see “Labeling Atoms with HotKeys” 
on page 60.
NOTE: ChemDraw does not install its own fonts. If you 
open a ChemDraw document containing fonts that are not 
available on your computer, they are substituted with avail-
able fonts.

Coloring Text
You can color captions and atom labels before or 
after they are typed, and as a whole or in part.
To color a caption or atom label:

1. Select the Text tool.
2. Click in the position where you want to place 

the text.
3. Choose a color from the Color menu.
4. Type the caption or atom label.

To color individual characters:
1. Select part of an existing caption or atom label 

using the Text tool.
2. Choose a color from the Color menu.

NOTE: Macintosh: Captions that contain multiple colors 
change to the foreground color when rotated. However, all col-
ors contained in the caption are printed.
To color several captions or atom labels at once:

1. Select the captions or labels using a selection 
tool.
ChemDraw 10
2. Choose a color from the Color menu.

Creating Captions
To create a caption:

1. Click the Text tool .
2. Point in an empty space in a document win-

dow.
A caption text box with a flashing insertion 
point appears. 

Figure 3.140: Caption text box

3. Type a caption.
The text box widens as you type to accommo-
date the caption.

4. To create a new line, press the Enter or return 
key.

5. To close the text box, click outside the text box 
or select another tool.

Entering Non-Roman Text
Use the Character Map for entering non-Roman 
text. (See “Character Map” on page 19 for details.) 
Any font available on the computer can be entered 
into a label using the Character Map.
NOTE: Two-byte fonts such as Chinese may not work reli-
ably with the Character Map.

Chemical Significance
By default, captions are considered to be chemi-
cally significant if possible. For example, if you cre-
ate a caption like CH3OH, you will be able to attach 
bonds to it (and it will be modified appropriately) 
even though you intended it to be a label, not a 
molecule. Moreover, its values are included in the 
Analysis Window, which could be confusing. If 
you try to label structures “A”, “B”, and “C”, the 
“B” and “C” labels will be marked with a red box 
because they have “incorrect valences”. You can 
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change this behavior for the entire document, or 
for an individual label.
To change a single label:

1. Select the label with the Lasso or Marquee tool.
2. Right+click or Control+click in the selec-

tion.
3. Deselect the Interpret Chemically command 

on the context menu.
To change the behavior of labels in the entire doc-
ument, deselect the Interpret Chemically When 
Possible option on the Captions tab of the Docu-
ment Settings dialog box.
NOTE: You can verify the chemical significance of a cap-
tion using the Check Structure command after selecting it 
with the Lasso or Marquee tool.

Editing a Caption
To open a caption for editing:

1. Click the Text tool .
2. Point to a caption and click to open the text 

box.
The caption text is highlighted.

3. To change all of the highlighted 
text within an open text box, type the 
new caption text over the highlighted 
text.
• If not all the text is highlighted and you want 

to select all of the caption text, click the 
Select All command on the Edit menu.

• To change part of the caption 
text, drag the insertion point 
over a part of the caption, then type in the 
new text.

Changing the Caption Width
To edit the width of a caption:

1. Select a caption using the Text tool.
58 • Drawing Chemical Structures
The Caption text box appears around the 
caption. The right side of the text box contains 
a Resize handle.

Figure 3.141: Caption box resize handle

2. Drag the Resize handle.
The point at which the text wraps is adjusted as 
you drag the Resize handle.

Adding Analysis Data to a 
Caption

You can add properties from the Analysis Window 
to a caption created by Struct=Name. If auto-
update is on (see “Auto Update” on page 122), the 
values will update as you modify the structure.
To add values to a label:

1. Point to the label.
2. Right-click, point to Analysis on the context 

menu, and choose a property from the list.
The property appears in the label displaying the 
current value.

TIP: You may need to update the window before you can see 
the new value. If you don’t see it immediately, it will appear 
with the next modification to the structure.
Figure 3.142: Displaying analysis data

Creating Atom Labels
The default format options of any new atom labels 
you create are specified in the Atom Labels tab of 
the Document Settings dialog box. You may edit 

Resize handle

UltraUltra

o-xylene
Chemical Formula: C8H10
Molecular Weight: 106.16
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these options at any time. The settings affect the 
current document only.

Labeling Atoms With the Text 
Tool
To place an atom label on an atom:

1. Click the Text tool .
2. Point to an atom.

The pointer changes when it is positioned 
correctly over an atom to indicate that you will 
create an atom label rather than a caption.

3. Click the atom.
An Atom Label text box appears over the 
atom.

Figure 3.143: Opening an atom label text box

4. Type an atom label.
Numbers are automatically subscripted. 

5. To close the text box, click outside the text box 
or select another tool. 

NOTE: You can use HotKeys to label an atom instead of 
using the Text tool. You can also label atoms using Nick-
names that are text representations of substructures. For 
more information, see “Labeling Atoms with HotKeys” on 
page 60 and “Using Nicknames” on page 81.

Editing Atom Labels
To edit an atom label:

1. Click an existing label using the Text tool.
The highlighted atom label text appears within 
the Atom Label text box.
ChemDraw 10
Figure 3.144: Editing an atom label

2. Type the new atom label text over the high-
lighted text.

Deleting an Atom Label
To delete an atom label, leaving the underlying 
bonds unchanged, do one of the following:

• Select the Eraser tool and click the atom label.
• With a selection, bond, or ring tool selected, 

point to the atom label and press the spacebar, 
Backspace, or Delete Key.

Labeling Atoms With a Bond or Ring 
Tool
To avoid switching back and forth between tools, 
you can label atoms with a bond or ring tool.
To label an atom using a bond or ring tool:

1. Select a bond or ring tool.
2. Point to an atom and double-click.

An atom text label appears over the atom.
Figure 3.145: Labeling an atom with a ring tool

3. Type the text.

Automatic Labeling of Terminal 
Carbons
You can set the default for document, or for a 
structure or group of structures, to insert terminal 
carbon labels. 
To set the default for a document:

1. Click Document Settings on the File menu.

CH2OH
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2. On the Atom Labels tab, check the box for 
Show Labels On Terminal Carbons.

To set the default for a structure:
1. Create a structure, or several structures.
2. Select the structure(s). Right-click, and click 

Object Settings from the context menu.
The Object Settings dialog box appears.

3. On the Atom Labels tab, check the box next to 
Show Labels On Terminal Carbons.

To add or remove a single terminal carbon label, 
point to the label and select or deselect the Show 
Terminal Carbons command on the atom context 
menu.

Hiding Implicit Hydrogens
By default, implicit hydrogen atoms are displayed. 
To hide implicit hydrogens:

1. Click Document Settings on the File menu.
2. On the Atom Labels tab, check the box next to 

Hide Implicit Hydrogens.

CAUTION

This feature is provided solely for those who need to produce 
ISIS-compatible documents. Documents produced with 
this setting will likely be unacceptable for publication. 

Repeating an Atom Label
You can repeat an atom label using the text, bond, 
or ring tools.
To label several atoms with the same text using the 
Text tool:

1. Click the Text tool.
2. Label a single atom.
3. Double-click another atom to repeat the previ-

ous label.
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To label several atoms with the same text using a 
bond, ring, or Acyclic Chain tool:

1. Click the tool.
2. Triple-click an atom to repeat the previous 

label.

Using the Text Tool With a Selection 
Tool
The Text tool used in conjunction with a selection 
tool enables you to perform additional edits, such 
as simultaneously changing several captions or 
atom labels. For more information about selection 
tools, see “New Selection Box” on page 61.
You can toggle between the Text tool and a selec-
tion tool as follows:

• After using the Text tool, press Ctrl+Alt+Tab 
or command+option+tab.
The last-used selection tool is selected. 

To switch from a selection tool to the Text tool 
when a caption or atom label is selected, press 
Ctrl+Alt+Tab or command+option+tab.

The Text tool is selected and the text box is 
opened for editing.

NOTE: Ctrl+Alt+Tab and com-
mand+option+tab will always toggle between the last 
selection tool used and last other tool used. 

Labeling Atoms with HotKeys
HotKeys™ is a major ChemDraw feature for rapid 
labeling of atoms. 
TIP: You can access HotKey Help directly from the Help 
menu in ChemDraw for Windows.
There are two basic methods for using HotKeys.
To label the last atom drawn:

1. Draw a bond.
2. Immediately type a HotKey.
CambridgeSoft
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The last atom drawn is labeled. Each time you 
draw a bond, the last atom drawn is the 
HotKey atom.

NOTE: HotKeys are case-sensitive. For example, the 
default for a carbon label is lower case ‘c’. Typing an upper 
case ‘C’ will create a ‘Cl’ label. For information on changing 
the defaults, see “Creating HotKeys” on page 223.
To label an atom by pointing:

1. Using a bond, ring, or Text tool, position the 
pointer over an atom.
A highlight box appears over the atom.

TIP: You may also use a selection tool, but you have to 
click the atom, not just point to it. You may use the 
Text tool for HotKey labeling only if there is no open 
text box.

2. Type a HotKey.
The label is added to the atom highlighted. If 
the label is a single element, such as C, then the 
appropriate number of hydrogen atoms are 
added to the label. Repeatedly typing the 
hotkey will cycle the number of hydrogens.

NOTE: HotKeys are “sticky”, that is, typing a HotKey 
will always label the last atom highlighted, even if you are no 
longer pointing to it. This is true if even you switch tools or 
switch documents. You can even open another application, 
type in it, and return to ChemDraw. If you then type a Hot-
Key, it will label the last atom highlighted. Only when you 
open a textbox is the behavior cancelled.

Labeling multiple atoms 
To label several atoms with the same label:

1. Select several atoms using a selection tool.
2. Type a HotKey. 

The selected atoms are labeled.
ChemDraw 10
Figure 3.146: Labeling several atoms at once

Using a Selection Tool
Use the Lasso or the Marquee selection tool to 
select any object. You use the Lasso for freehand 
selection and the Marquee to select rectangular 
regions. 

Toggling Between Selection Tools
You can set one selection tool to behave like the 
other by clicking the Lasso or Marquee tool while 
holding the Alt or option key down.

Toggling Between Other Tools
To toggle a selection tool and the last drawing tool 
used, press Ctrl+Alt+Tab or com-
mand+option+tab.
This command will toggle the last selection tool 
you have used with the last drawing tool you have 
used. If you haven’t used either selection tool, it 
defaults to the Lasso tool.

New Selection Box
ChemDraw 10 has a very obvious change in the 
selection tools, improving the visualization and 
behavior of the Lasso and Marquee. When you 
select a structure or object, the selection is dis-
played as a solid box in highlight color (blue 
against white background; white against blue back-
ground), with resize handles in the eight cardinal 
locations.

C
H2

H3C
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Figure 3.147: The selection rectangle

You have the following options while resizing:

• resize proportionately by dragging any corner
• resize with either X-axis or Y-axis distortion by 

dragging any side
• resize freely (X and Y axis distortion) by hold-

ing the Shift key down while dragging
The rotation handle is at the top. See “Rotating 
Objects” on page 65 for more information.
When you select multiple objects, each object dis-
plays a selection box, so that you can see exactly 
what is selected. For example, in Figure 3.148 you 
see clearly that the lower benzene ring was only 
partially selected. Note that in the partially selected 
ring, each selected atom and bond is marked.
Figure 3.148: Partial selection

Dragging any adjustment handle changes all of the 
selected objects in unison. To move the selected 
items, position the cursor inside a selection box to 
display a hand, then drag. Note that spaces 
between objects are “dead space” where you can-
not grab the selection to drag it. 

SH

SHS

O

O

Rotation handle

Resize 

Resize w/
distortion

handles
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Figure 3.149: Moving Objects

Attempting to drag the selection when the cursor is 
placed between objects will result in the objects 
being deselected. 
The new Lasso tool also gives you more control 
over objects. Most drawing objects can now be 
rotated as well as resized. 

Selecting Objects with the Lasso 
Tool
Use the Lasso tool to make freehand selection of 
irregular areas.
To select objects using the Lasso tool:

1. Select the Lasso tool .
2. Press the mouse button while the pointer is not 

over any object.
3. Drag around a portion of a chemical structure 

or other object.
Figure 3.150: Selection with the lasso

As you drag, a line appears which defines the 
Selection area. Bonds, structures, or other 
objects are selected only if they are entirely 

Cursor between
objects

Cursor correctly
positioned to drag
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within this area. The end points of the Lasso 
are automatically connected when you release 
the mouse button. 

Selecting Objects with the 
Marquee Tool
Use the Marquee tool to select objects and struc-
tures within a rectangular area. 
 To select objects using the Marquee tool:

1. Select the Marquee tool . 
The pointer becomes a Marquee.

2. Drag diagonally across the chemical structures 
or other objects.

Figure 3.151: Selecting with the marquee

As you drag, a rectangle appears which defines 
the Selection area. Bonds and other objects are 
selected only if they are entirely within the rect-
angle. 

You can use the Marquee to select several objects 
at once if they can be surrounded by a rectangle.

Selecting Entire Structures
To select an entire chemical structure, using a 
selection tool, double-click a bond or atom within 
the structure.

The entire chemical structure is selected.
ChemDraw 10
Figure 3.152: Selecting an entire structure

If the chemical structure or other object is part of a 
group, the entire group is selected. For more infor-
mation, see “Grouping Objects” on page 68.

Selecting Objects by Clicking
To select an object by clicking:

1. Select the Lasso or the Marquee tool.
2. Point to an object in a document window.

A highlight box appears over the selected 
object. If you point at a bond, the highlight box 
appears over the length of the bond.

3. Click the object.
Figure 3.153: Selecting by clicking

The selected objects appear within the Selec-
tion Rectangle and the cursor changes to a 
hand.

NOTE: If the bond or other object is part of a group you 
can select it as an individual object. For more information, see 
“Grouping Objects” on page 68.

Removing Objects from the Selection
To remove an object from the selection, press 
Shift and select an object contained within the 
Selection rectangle by clicking, double-clicking, or 
with a selection tool.

The object is removed from the selection. 
Drawing Chemical Structures • 63
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Figure 3.154: Removing selected objects

NOTE: Objects may appear within the borders of the Selec-
tion rectangle but not be selected. See the comment in Figure 
3.154, above.

Making Multiple Selections
To make multiple selections or add more objects 
to the selection: 

• Press Shift and select the other objects.
You can add objects to the Selection by clicking, 
double-clicking, or by using the selection tools. 

Selecting and Deselecting All Objects
To select all objects within a document window, 
click the Select All command on the Edit menu.
To deselect all selected objects, do one of the 
following:

• Click in any empty area in a document window 
that is outside the Selection rectangle.

• Press Esc.
• Select a different tool.
• Select another object without holding down 

Shift.
The selected objects are deselected.

Moving Objects
To move an object:

1. Select the object using a selection tool.
2. Point within the border of the Selection rectan-

gle.

The lack of a blue square on this
bond shows that it has been deselected
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3. Drag the object to a new location.
Figure 3.155: Moving an object

To constrain the movement to the horizontal or 
vertical direction, Shift+drag the selected objects.
Figure 3.156: Constraining movement to the axes

Small incremental movements are often useful for 
aligning objects.To move an object a small dis-
tance:

1. Select the object.
2. Press an arrow key.

The selected object moves 1 point in the direc-
tion of the arrow.

To move in a larger increment, press Alt or option 
plus an arrow key.

The selected objects move 10 points in the 
direction of the arrow. 

For more information about aligning objects, see 
Chapter 10: “Page Layout”.

Moving Atoms With a Selection Tool
You can move the atoms within a chemical struc-
ture using a selection tool. 
CambridgeSoft
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To move a single atom:
1. Point to an atom using a selection tool.
2. Drag the atom.

The bonds connected to the atom stretch.
Figure 3.157: Moving an atom with a selection tool

To move multiple atoms, select only the bonds 
that have atoms on both ends that you want to 
move.

The unselected bonds that are attached to the 
selected atoms are stretched.

NOTE: You can also move atoms using the bond tool that 
was used to draw the atom. For more information, see “Mov-
ing Atoms With a Bond Tool” on page 54.

Duplicating Objects
To duplicate objects with a selection tool: 

1. Click a selection tool.
2. Select the objects.
3. Ctrl+drag or option+drag to create a copy 

and position it.
A “+” appears in the hand to indicate duplica-
tion, and a copy of the selected object is moved 
to the new position.

Figure 3.158: Duplicating objects
ChemDraw 10
To duplicate the selected objects and constrain the 
alignment of the copy: 

1. Select the objects.
2. Ctrl+Shift+drag or option+shift+drag to 

create a copy and position it.
Movement is restricted to the vertical or hori-
zontal axis. 

Deleting Objects
To delete selected objects, do one of the following: 

• Press the Delete key.
• Press the Backspace key.
• Click the Clear command on the Edit menu,.

Rotating Objects
To rotate objects:

1. Select the objects to rotate using a selection 
tool.

The Rotation handle is located on the upper 
right corner of the selection rectangle

2. Drag the Rotation handle clockwise or coun-
terclockwise. 

The screen and Info window indicate the 
magnitude of the rotation around the center 
of the Selection rectangle. 

Figure 3.159: Rotating an object

By default, atom labels do not rotate with the 
structure.

NH

NH
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To rotate an atom label with a structure, press Ctrl 
or command while dragging the structure.

If a single atom is unselected when a structure is 
rotated, the structure rotates around the unselected 
atom.
To rotate the selected objects a specified number 
of degrees:

1. Do one of the following:
• Click the Rotate command on the Object 

menu.
• Double-click the rotation handle.
The Rotate Objects dialog box appears.

Figure 3.160: Rotate objects dialog box
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2. Enter a number and click either degrees CW 
for a clockwise rotation or degrees CCW for 
counterclockwise rotation.

3. If you want to rotate the atom label text, click 
the Rotate Atom Labels checkbox.

4. Click the Rotate button.
Objects are rotated around the center of the 
Selection rectangle. 

To repeat the same rotation on any object in the 
document window:

1. Immediately after performing a rotation, select 
the other objects to rotate.

2. Click the Repeat Rotate command on the Edit 
menu.
CambridgeSoft
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Chapter 4: Advanced Drawing Techniques

Overview
ChemDraw provides advanced drawing features 
that allow you to:

• Join objects
• Group objects
• Scale objects
• Create mirror images

• Contract and expand sections of 

structures

• Clean up structures

• Add bonds to specific characters in atom labels
• Create bonds whose attachment is not explic-

itly defined
• Add atom numbers
• View structure perspective
• Create Mass Fragmentation, Retrosynthesis, 

and Dissociation drawings
• Draw with Templates

• Create Templates

• Label functional groups with Nicknames.

Joining Objects
Use the Join command in the Object menu to fuse 
two chemical structures together. Once structures 
are joined they can be easily selected by dou-
ble-clicking. 

ProPro

ProPro

ProPro
ChemDraw 10
To join chemical structures along the length of a 
bond:

1. Select a bond or atom in one of the molecules
2. Shift+click to select the corresponding bond 

or atom on the second molecule that you wish 
to fuse.

3. Click the Join command on the Object menu.
The structures are joined.

Figure 4.161: Selecting bonds for joining structures 

NOTE: In some earlier versions of ChemDraw, structures 
had to be in close proximity before they could be joined. This 
is not longer the case.
To join chemical structures at one atom to create a 
spiro linkage:

1. Position the two chemical structures so that the 
atoms you wish to fuse are more or less oppo-
site each other.

2. Select the two atoms to be fused.
3. Click the Join command on the Object menu,.
Advanced Drawing Techniques • 67
Overview



A
dm

inistrator
Figure 4.162: Creating a spiro linkage 

TIP: While you no longer have to position the chemical 
structures exactly, attempts to fuse atoms that are not 
approximately lined up will lead to incorrect results.

NOTE: When you join two differently colored bonds or 
atom labels, the color of the front object becomes the color of 
the resulting joined object. When you join two atoms that are 
labeled, the front atom label becomes the atom label of the 
resulting atom. For more information about front to back 
ordering of objects, see Chapter 10: “Page Layout”.

Grouping Objects
You can group a number of objects drawn sepa-
rately. Grouping creates an association between 
objects so they can be easily selected. You can 
select all grouped objects by double-clicking with a 
selection tool. Objects within a group can be 
selected individually and manipulated while still 
remaining part of the group.
If you want to group objects so that the individual 
objects in the group cannot be accessed, you can 
create an Integral group. When you select any 
object in an Integral group, the entire group is 
selected.
Grouping does not lock the position or orientation 
of objects. Grouped objects maintain their relative 
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positions when they are centered on the page, 
aligned or distributed.
Atoms and bonds making up a single chemical 
structure are always grouped. If you group part of a 
structure with other objects, the resulting group 
contains the entire structure. If you add atoms or 
bonds to a grouped structure, the new atoms and 
bonds are part of the group.
To group several objects:

1. Select the objects to group using a selection 
tool.

2. Click the Group command on the Object 
menu.

To select an individual object within a group, move 
the selection tool over an object until it is high-
lighted and click once.

The object is selected, not the group.
Figure 4.163: Selecting part of a group

To select grouped objects, move the selection tool 
over an object until it is highlighted and double 
click

The entire group is selected.
Figure 4.164: Selecting a group

Ungrouping Objects
To ungroup objects that are grouped:

1. Select a group, as above.

H3C C

O

O Na

H3C C

O

O Na
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2. Click the Ungroup command on the Object 
menu.
All the objects previously grouped become 
individual objects.

Creating Integral Groups
To create a group in which individual objects can-
not be accessed:

1. Select the objects to group using a selection 
tool.

2. Click the Group command on the Object 
menu.

3. With the group selected, right-click, point to 
Group in the context menu, and click Integral.

To restore an Integral group to a regular group:
1. Select the Integral group.
2. Right-click, point to Group in the context 

menu, and deselect Integral.

Scaling Objects
To resize objects with the Scale command:

1. Select the objects to scale.
2. Do one of the following:

• Click the Scale command on the Object 
menu.

• Double-click one of the Resize handles.
The Scale Objects dialog box appears.

Figure 4.165: Scale objects dialog box

Use the first two options in the Scale Objects dia-
log box to scale all selected objects so that the 
ChemDraw 10
median selected bond has a specified length based 
on the following scale factor:

To scale bonds so that the Fixed Length becomes 
the new median bond length:

1. Select the top option.
The fixed length presently on the Drawing Set-
tings tab of the Document settings dialog box 
is shown in parentheses at the end of the line 
for this button.

2. Click the Scale button.
To scale the bonds to a new fixed length that you 
specify:

1. Select the middle option.
2. Type the new median bond length in the box to 

the right of the button.
3. The current median bond length for the selec-

tion is shown in the highlighted text box when 
the dialog box initially appears.

4. Click the Scale button.
To scale objects by a percentage:

1. Select the Scale by radio button.
2. Type the percentage in the box to the right of 

the button.
3. Click the Scale button.

This is the only available option when the selection 
does not contain any atoms or bonds.

Reflecting Objects Through 
Planes
You can reflect structures through planes perpen-
dicular to the X-axis or Y-axis using a selection 
tool. Used with duplicating, you can create mirror 
images of chemical structures for representing 
racemic mixtures and other stereoisomers. 

scale factor = new median bond length
current median bond length
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Flipping Objects
To reflect an object through a plane perpendicular 
to the X-axis:

1. Select the objects to reflect.
2. Click the Flip Horizontal command on the 

Object menu.
Figure 4.166: Horizontal flip

Atom labels and captions do not flip along with 
the object.
To reflect an object through a plane perpendicular 
to the Y-axis:

1. Select the objects to reflect.
2. Click the Flip Vertical command on the Object 

menu.
Figure 4.167: Flip vertical

Creating Mirror Images
You can create mirror images from structures with 
defined stereochemistry by duplicating the struc-
ture and rotating it.
To create a mirror image:

1. Draw a structure with defined stereochemistry, 
for example, wedged bonds.

2. Select the structure and make a copy with 
Ctrl+Drag or option+drag.
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3. While the copy of the structure is still selected, 
choose Flip Horizontal or Flip Vertical from the 
Object menu.

Figure 4.168: Flip

You can also preserve the absolute stereochemistry 
while flipping by using the Rotate 180º commands 
on the Object menu.
Figure 4.169: Rotate 180º

Expanding and 
Contracting Labels
If your structures contain defined nicknames, long 
atom labels, or contracted labels, ChemDraw can 
restore your structures to the fully expanded form.

H3C

OH H3C

OH

H3C

OH

CH3

HO

Flip Horizontal 

Flip Vertical

H3C

OH

CH3

HO

H3C

OH H3C

OH

Rotate 180° Horizontal

Rotate 180° Vertical

ProPro
CambridgeSoft
Overview



Figure 4.170: Expanded and contracted forms

When you expand a label containing a divalent 
nickname, for example H-Ala-OH, the first attach-
ment is to the character to the left of the nickname 
(H). The second attachment is to the character to 
the right of the nickname (OH).
To expand atom labels:

1. Select a selection tool.
2. Select the label to expand or double-click the 

structure to expand all possible labels.
3. Click the Expand Label command on the Struc-

ture menu.
Your structure is redrawn in its expanded form. 

Figure 4.171: Expanding labels

Contracting Labels
You can compress an area of a structure and 
replace it with a text label by using the Contract 
Label command. Contracted labels are similar to 
Nicknames, but they are for one-time use only, in 
the current document. 

Ph CH2CH2CHCH3

CH3

Contracted Form

Expanded Form

Ph CH2CH2CHCH3

CH3

Ph CH2CH2CHCH3

CH3

or

CH2CH2CHCH3

CH3

ProPro
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To create a contracted label:
1. Select the area of the structure to contract.

Figure 4.172: Selecting a structure to contract 

2. Click the Contract Label command on the 
Structure menu.
The Contract Label dialog box appears.

Figure 4.173: Contract label dialog box 

3. Type a label for the contracted structure and 
click the OK button.
The label replaces the selected portion of the 
structure.

Figure 4.174: Contracted label

NOTE: If the area of the structure you contract contains 
errors, an error dialog box appears. Click Ignore to view any 
other errors. Click Ignore All to ignore all errors or Stop to 
end the contract process.

Multi-Attached Labels
Multi-attached atom labels enable you to draw 
chemical structures more efficiently by allowing 
you to attach bonds anywhere along an atom label.

ContractLabel 150 dpi

Hexylbenzene
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Figure 4.175: Multi-attached labels

Adding Bonds to an Atom Label
To add bonds to an atom labels:

1. Draw the structure and attach any necessary 
atom label.

2. Select a Bond tool.
3. Position the cursor where you want to attach 

additional bonds.
The selected part of the atom label is high-
lighted.

4. Click or drag from the atom label to draw your 
bonds.

Figure 4.176: Adding bonds to a label

You can determine the orientation of the resulting 
bond by dragging. If you click to add a bond, there 

H2
C

CH2

NH

CH3

O

CH2CH2NHCH2CH3

O

Expanded structure

Compact structure with multi-attached atom labels

Ph CH2CH2CHCH3

Ph CH2CH2CH2CH3
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are several preferential orientations for the result-
ing bond:

• Adding from the end of an atom label creates 
bonds that are preferentially horizontal.

• Adding from the middle of an atom label cre-
ates bonds that are preferentially vertical.

• Adding from the start of an atom label creates 
bonds that try to attain the chain angle setting 
on the Drawing Settings tab of the Document 
Settings dialog box. If that angle cannot be 
attained, the next best angle is used.

Structure CleanUp

The Structure CleanUp command is used to neaten 
the appearance of molecules by regularizing bond 
lengths and angles. Graphic objects such as arrows 
and aromatic circles are not affected. Use Structure 
CleanUp to redraw structures that you may have 
drawn freehand or to neaten structures that you 
may have imported from another application.
Structure CleanUp may not create the best struc-
ture. Most structures have many “clean” forms, a 
problem that is particularly noticeable with 
straight-chain alkanes.
If you select only part of a structure when you 
choose Structure CleanUp, the other atoms and 
bonds are not be affected.
NOTE: For some compounds, the Structure CleanUp 
command produces a structure that extends beyond the 
bounds of the page. To view the entire structure, scale the 
structure or increase the size of the printed page. For more 
information, see “Scaling Objects” on page 69 and “Page 
Setup” on page 151.
General Rules for Structure CleanUp are:

• The Fixed Length setting on the Drawing Set-
tings tab of the Document Settings dialog box 
determines optimum bond lengths.

• A given ring is redrawn only if all of its bonds 
are selected.

ProPro
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• Multi-attached atom labels and variable attach-
ment points cannot be cleaned.

• Multi-center bonds cannot be cleaned.
• Structures are rotated so that as many bonds as 

possible are directed at a multiple of 15 
degrees.

• Structure CleanUp preserves stereochemical 
meaning rather than the precise identity of any 
wedged or hashed bonds, as shown below.

Figure 4.177: Preservation of stereochemical 
meaning

Using Structure CleanUp:
1. Select the structure or part of the structure you 

want to clean up with a selection tool.
Figure 4.178: Cleaning up a structure

2. Click the Structure CleanUp command on the 
Structure menu.

NOTE: Structure CleanUp does not position molecules rel-
ative to other objects. Overlap may occur.

Multi-Center and Variable 
Attachments
You can draw polyhapto structures such as fer-
rocene ((Cp)2Fe), or an abbreviated notation for 
different positional isomers of a compound, using 

 Before
     After

O

OH
Cl

OHO Cl
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attachment centers. The procedure is similar, and 
in both cases, the structure retains chemical signifi-
cance.
Figure 4.179: Drawing a polyhapto structure

Figure 4.180: Isomers of dibromobenzene

Creating a Multi-Center Bond
To create a multi-center attachment point:

1. Select the structure whose center you want 
defined as a multi-center attachment point.

2. Click the Add Multi-Center Attachment com-
mand on the Structure menu.
An asterisk is displayed with the fragment to 
show that it contains a multi-center node. 

Figure 4.181: Adding the multi-center attachment 
point

Fe

Br

Br

Br

Br

Br

Br

1,4-dibromobenzene

1,3-dibromobenzene1,2-dibromobenzene

Br

Br

abbreviated 
notation for:
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The asterisk is not visible once a bond is drawn to 
it. You can view the attachment point with a bond 
or selection tool. For more information, see 
“Viewing Attachment Points” on page 74.
To draw a bond to a multi-center attachment 
point:

1. Click the Bond tool.
2. Point to the asterisk and either click or drag to 

create a bond.
Figure 4.182: Adding a bond to the multi-center point

TIP: Either disable or toggle Fixed Lengths to draw 
the bond so that it extends from the ring.

Creating a Variable Attachment 
Point
To create a variable attachment point:

1. Draw the structural fragment to which you 
want to assign a variable attachment node.

2. Select the fragment using a selection tool.
3. Click the Add Variable Attachment command 

on the Structure menu.
An asterisk appears in the center of your frag-
ment.

4. Point to the asterisk and drag to draw a bond.

TIP: Either disable or toggle Fixed Lengths to draw 
the bond so that it extends from the ring.

You can treat this attachment node as you 
would treat the end of a normal bond. 

5. Click a Bond tool.
After you draw a bond from the attachment 
node, the asterisk disappears. 

Fe

1 2
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Figure 4.183: Using a variable attachment point

Viewing Attachment Points
After you draw a bond from a variable or multi-
center attachment point, the asterisk disappears. 
You can verify the node is present with a bond or a 
selection tool. This provides a way to check the 
definition of pre-existing attachment points.
To view a node with a selection tool, select the 
selection tool and position the cursor over to 
attachment point.

The attachment node is highlighted.
Figure 4.184: Highlighting with a selection tool

To view a node with a bond tool, select the bond 
tool and position the cursor over the attachment 
point.

The attachment node and all the atoms it rep-
resents are highlighted.

Figure 4.185: Highlighting with a bond tool
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Atom Numbering
You can add sequential numbering indicators to the 
atoms in a structure. ChemDraw recognizes the 
following types of indicators:

• Numbers (1, 2, 3, and so on)
• Text ending with a number (atom1)
• Greek letters in the Symbol font
• Letters (a, b, c, and so on)

The default indicator is numbers.
TIP: To use text instead of numbers, number an atom then 
edit the number. See “Editing Atom Numbers” on page 75.

Showing and Hiding Atom 
Numbers
To add Atom Numbering to an entire structure:

1. Select the structure.
2. While pointing to the selected structure, do one 

of the following:
• Right-click or control+click, point to Atom 

on the context menu, and click the Show 
Atom Number command.

• Type the HotKey ‘ (single quote).
To number individual atoms

1. Select the atom.
2. Do one of the following:

• Right-click (Mac: control+click), and click 
the Show Atom Number command.

• Type the HotKey ‘ (single quote).
To hide Atom Numbering in a structure:

1. Select the structure.
2. Right-click or control+click, point to Atom, 

and deselect Show Atom Number.
To hide an individual atom number, do one of the 
following:
ChemDraw 10
1. Point to or select the atom, right-click or con-
trol+click, and deselect the Show Atom Num-
ber.

2. Point to or select the atom number, right-click, 
and select Hide Indicator.

To remove an atom number indicator, do one of 
the following:

• Click the indicator with the Eraser tool.
• Point to the indicator with a Bond tool and 

type Backspace or Delete.

Editing Atom Numbers
You can edit the text and style of atom number 
indicators. 
To edit atom number text:

1. Select the Text tool.
2. Select the atom number indicator and type the 

changes.
NOTE: When you type in a new indicator, you reset the 
counter for that structure to a new style. You may then con-
tinue numbering in that style with the standard means. For 
example, if you type α in a text box, then point to another 
atom and use the context menu or HotKey, the atom will be 
labeled β. Switching to another structure resets the counter.
To edit the atom number style, select the atom 
number indicator with the Text tool and use the 
Text menu or Text formatting toolbar.

Positioning Atom Number 
Indicators
Atom number indicators are positioned automati-
cally and move appropriately if a structure is modi-
fied. You can reposition them by dragging them to 
the desired position or use the Position Indicators 
dialog box.
To reposition an indicator:

1. Right-click the indicator to move and click the 
Position command on the context menu.
The Position Indicators dialog box appears.
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Figure 4.186: Position Indicators dialog box 

2. Click the appropriate position option, and 
enter a value. 

Structure Perspective
You can rotate molecules or portions of molecules 
through three dimensions with the Trackball tool 

. The Structure Perspective tool behaves simi-
larly to the Marquee tool. 
To rotate a structure:

1. Select the structure by dragging over it with the 
Trackball tool.

Table 8: Positioning atom number indicators

To position … Type a value 
for Position …

from the atom or bond 
center to the indicator 
center

by angle or by clock

from the atom or bond 
center to bottom left of 
indicator baseline

by offset—hori-
zontal and vertical

at specified coordinates absolute—hori-
zontal and vertical
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2. Place the cursor inside the marked rectangle 
and drag in any direction.
The structure will rotate on the X or Y axis, or 
a combination of X and Y.

3. Use Shift+drag to limit the rotation to the X or 
Y axes only.

You can also select part of a complex molecule and 
rotate it around a particular bond. 
NOTE: Do not try to use the Trackball to rotate objects 
such as orbitals or boxes. It was designed to manipulate 
chemical structures only.

Flatten Command
Although the Structure Perspective tool is not 
intended to be a 3D modeling tool, it does intro-
duce z-coordinate information that is saved in 
CDX files. This pseudo-3D structure can be con-
fusing when opening files that have been saved 
after perspective manipulation.
To remove perspective information:

1. Select a structure with the Marquee or Lasso 
Tool.

2. Click the Flatten command on the Object 
menu.
All z-coordinate information is removed from 
the structure.

Mass Fragmentation 

Tool 

The Mass Fragmentation tool allows you to 
break existing structures across one or more 
bonds. This mimics the molecular fragmentation in 
a mass spectrometer, but does not have any predic-
tive qualities: you must specify what bonds are to 
be broken.
To fragment a structure, drag the mouse across 
one or more bonds.

ProPro
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A line is drawn across the bonds that disap-
pears when you release the mouse button. The 
operation is not final until the mouse is 
released. This means you can drag the line 
around holding the mouse button down to see 
different possibilities, and still back out with-
out breaking any bonds. When the mouse but-
ton is released, any bonds crossed by the line 
are broken 

Figure 4.187: Using the mass fragmentation tool

If you want the line to remain on display, hold 
down the Alt or option key after drawing the line.
Figure 4.188: Mass fragmentation tool: displaying 
the line 

NOTE: The order in which you release the mouse button 
and the Alt or option key determines whether the line 
remains displayed or not. Releasing the mouse button first 
leaves the line displayed.
The Alt or option key also allows you to “turn cor-
ners” and cut more than one bond.
Figure 4.189: Mass fragmentation tool: turning 
corners

Chemical Formula:
C6H12

••

Exact Mass: 84.09

Chemical Formula: C3H7
•

Exact Mass: 43.05

Chemical Formula: C3H7
•

Exact Mass: 43.05

Chemical Formula: C3H6
••

Exact Mass: 42.05

Chemical Formula: C3H6
••

Exact Mass: 42.05

Chemical Formula: C2H4
••

Exact Mass: 28.03

Chemical Formula: C4H8
••

Exact Mass: 56.06
ChemDraw 10
When the line crosses a bond, the formula and 
exact mass for the fragments on either side of the 
bond are displayed as if the bond were homolyti-
cally broken. That is, a single bond turns into a 
monoradical on each fragment; a double bonds 
turns into a pair of diradicals. If more than one 
bond is crossed, all fragments on each side of the 
line are considered together. If the only bond 
crossed is a ring bond, a single formula/mass pair 
is displayed. 
NOTE: It is possible to draw lines that tie themselves in 
knots. Use this tool with caution to avoid unrealistic frag-
mentation.
You can reposition the formula and mass displays 
(they are text objects), or delete them altogether.

Table 9: Mass Fragmentation tool procedures

operation behavior

drag Breaks bond(s). The action 
does not take place until you 
release the mouse button, so 
you can “test alternatives”.

drag, holding 
down the Alt or 
option key

Draws a freehand line. If you 
release the mouse button 
before releasing the Alt or 
option key, the dashed line 
display remains.

drag across a 
bond, then 
press the Alt or 
option key.

Allows you to change direction 
and draw a polyline. If you 
release the mouse button 
before releasing the Alt or 
option key, the dashed line 
display remains.
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Drawing Reactions
Two new tools speed the drawing of synthesis 
reactions. Both tools are used in a similar manner 
to the Mass Fragmentation tool: they are used to 
cut a bond or bonds in a product. The Synthesis 
tool  draws the resulting fragments as a stan-

dard reaction. The Retrosynthesis tool  draws 
the reaction with the product on the left and a 
broad arrow pointing to the reactants, as is cus-
tomary in retrosynthetic analyses. In most cases, 
you will have to clean up the reaction by adding or 
deleting atoms or bonds.
Figure 4.190 shows how to use the tools for a dem-
onstration of the Beyer Method for quinolines, 
with the simple clean up.
Figure 4.190: Using the reaction drawing tools

These tools are found in the Fragmentation tools 
section of the Main tools palette.

Drawing with Templates
Template documents are collections of structures 
organized by structural type or functionality. A 
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structure in a Template document is named a tem-
plate. Use an existing template instead of drawing 
the structure to shorten the time required to create 
documents.
The Template documents distributed with Chem-
Draw are stored in the ChemDraw Items folder in 
the same folder as the ChemDraw application.
NOTE: In ChemDraw Pro, you can define your 
own commonly used structures as templates. Any Template 
documents in the ChemDraw Folder are listed in the Win-
dows menu (Macintosh) or Open Special on the File menu 
(Windows).

The Templates Tool 
The Templates tool contains a palette from which 
you can select different types of structures or 
objects. The Templates tool has two levels: 

• The first level displays the available Template 
documents.

• The second level displays the templates within 
each Template document. 

Figure 4.191: Using the template tool

NOTE: In ChemDraw Pro the pop-up menu is 
segmented if any Template documents are open for editing. 
The upper segment contains Template documents that are 
currently open for editing.

Choosing a Template 
To choose a template from the Template palette:

Pro
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1. Hold down the mouse button over the Tem-
plates tool .
A menu listing the Template documents 
appears. 

2. Point to a Template document name.
A palette containing the available templates 
appears.

3. Choose a template from the palette.

Using Templates 
When you draw with templates, the first bond 
drawn determines the position of the template in a 
document window. All remaining bonds are drawn 
counterclockwise. The most nearly vertical bond 
on the far-left atom is drawn first, from top to bot-
tom. If there are two equivalent bonds, the atoms 
that are at a lower position are used to draw the 
first bond.
Figure 4.192: Drawing direction of template struc-
tures

Templates are automatically scaled to the docu-
ment settings of the current document in the active 
window. For more information, see “Autoscaling” 
on page 165.
After a template is drawn in a document window, 
the structures or objects can be manipulated by 
standard drawing and editing methods.

Drawing a Template
To draw a template, click in a document window. 

The template is drawn centered around the 
pointer in the orientation that it appears in the 
Templates palette.
ChemDraw 10
Fusing a Template With an Existing 
Structure
To draw a template and fuse it with an existing 
structure, click an existing bond in a document 
window.
To deposit a template and create a spiro-linkage 
with an existing structure, click an existing atom in 
a document window. 
To draw a template in a document window and 
control the size and orientation, drag from the 
beginning of the first bond in the template to the 
end of the first bond.

When you drag upwards the bulk of the tem-
plate is drawn to the left, and when you drag 
downwards the bulk of the template is drawn 
to the right. Templates must contain at least 
one bond in order to be drawn by the dragging 
method.

Drawing with the Same Template
To draw another template of the same type:

1. Click the Templates tool .
2. Draw the template in a document window.

Creating Templates 
and Template Documents 
In ChemDraw Pro you can create new templates 
and add them to existing Template documents or 
create new Template documents. 
To create a new Template document, open the File 
menu, point to Open Special, and choose New 
Templates. 
A new and untitled Template window appears. The 
Template window is similar to a document win-
dow, but is divided in half by a moveable, horizon-
tal line.

ProPro
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• Template panel—Top half of the window 
consists of individual panes where newly cre-
ated templates appear. 

• Drawing area—Bottom half of the window 
where you can draw new templates. 

Figure 4.193: Template panel and drawing areas

The templates you define are not limited to atoms 
and bonds. Templates can contain any ChemDraw 
objects such as captions, boxes, arcs, orbitals, 
arrows, reaction mechanism symbols, and curves. 
The ChemDraw objects in Template documents 
can be colored. However, the colors do not appear 
in the Templates tool palette. You can paste pic-
tures from other applications into a Template 
pane. Pasted objects are scaled to the current Tem-
plate document settings. For more information, 
see “Autoscaling” on page 165.

Creating Templates 
To create a new template:

1. Point to Open Special on the File menu, and 
choose the New Templates command.

2. Select a Template pane by clicking it. 
3. Draw a structure or object in the drawing area 

of the Template window.
The structure appears in the Template pane as 
you draw. The tools in the Tools palette are 
used to draw a template in the drawing area of 

Drawing Area

Resize 
Handle

Template Panel
Pane

ProPro
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the Template window exactly as they are used 
to draw structures in the drawing area of a doc-
ument window.

To select a different Template pane, click another 
Template pane.

When you select a Template pane, the contents 
of the pane appear in the drawing area. 

Figure 4.194: Adding a drawing to a panel

As you define templates they become available for 
use in your document without having to save the 
Template document.
To view the newly-defined Template, point at the 
Templates tool  and hold down the mouse 
button.

The name of the new Template document 
appears in the menu.

TIP: If you haven’t saved it yet, the name will be 
“Untitled Template”.

Orientation of Templates
To make the templates that you create as easy to 
draw with as possible, it is recommended that you 
orient your structures so that the bond that estab-
lishes the position of the template, for example, the 
bond used for fusing is left and vertical. The most 

Templates2 250 dpi
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vertical left bond is drawn first. For examples, see 
“Using Templates” on page 79. 

Resizing Template Panes 
To resize the Template panes in the Template 
panel, drag the lower right corner of the Template 
panel.
Figure 4.195: Resizing a template

TIP: If you have the Info window open, the height and width 
are displayed.

Template Panels 
To increase the size of the Template panel, drag 
the Template dividing line.
To add a row of panes to the Template panel:

1. Select a Template pane.
2. Click either the Add Row Before or the Add 

Row After command on the Edit menu.
The new row is added before or after the Tem-
plate pane you selected.

To add a column to the Template panel:
1. Select a Template pane.
2. Click either the Add Column Before or the Add 

Column After command on the Edit menu.
The new column is added to the right or left of 
the Template pane you selected.

To delete a row of Template panes from the Tem-
plate panel:

1. Select a Template pane in the row you want to 
delete.

Grab this corner and drag
ChemDraw 10
2. Click the Delete Row command on the Edit 
menu.

To delete a column of Template panes from the 
Template panel:

1. Select a Template pane in the column you want 
to delete.

2. Click the Delete Column command on the Edit 
menu.
The column is removed and all other columns 
are moved to the left.

Saving Template Documents 
To save a Template document and have it available 
in the Template pop-up menu and the Window 
menu:

1. Click the Save As command on the File menu. 
The Save As dialog box appears.

TIP: Saving a Template document in the ChemDraw 
Items folder makes it accessible in the Open Special 
submenu and in the Templates tools palette.

2. Type a name for the Template document and 
click the OK or Save button.

Using Nicknames
Nicknames allow you to create short names for 
functional groups to use as an atom label or part of 
a label. When an atom is labeled with a Nickname, 
the chemical significance of the expanded structure 
is retained. 
Commonly used Nicknames, such as Me, Et, and 
Ph are provided with ChemDraw in the Chem-
Draw Nicknames file located in your ChemDraw 
Items folder. You can edit this list using tools in 
ChemDraw. You should not attempt to edit this 
file directly.
You can assign HotKeys to Nicknames. For exam-
ple, in the Nicknames and HotKeys provided with 
ChemDraw, the Hotkey, “4” labels an atom with 
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“Ph” which is a Nickname representing a phenyl 
group. For more information, see “Labeling 
Atoms with HotKeys” on page 60.
You can use Generic Nicknames when drawing 
query structures. For more information, see 
“Generic Nicknames” on page 97.

Applying Nicknames
You may select a Nickname from the Nicknames 
dialog box or type it in manually. In either case, 
ChemDraw recognizes it as being chemically sig-
nificant.
To select a Nickname to apply to an atom using a 
Hotkey:

1. Point to an atom.
2. Press the Hotkey “=” (equal sign).

The Choose Nickname dialog box appears.
Figure 4.196: Nickname dialog box

3. Select a Nickname from the list.

TIP: You can jump to the approximately correct place 
in the Nickname list by typing the first letter of the 
Nickname.

4. Click the OK button.
To enter a Nickname as an atom label:

1. Double-click an atom with a bond tool or click 
an atom with the Text tool. 
An atom label text box appears.

2. Type a Nickname label such as Et or Tos.
NOTE: Nicknames are tokens and do not flip orientation 
when applied to the left side of a structure when using Auto-
matic Justification. For example, in the absence of a defined 

ChooseNickname 150 dpi
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Nickname, the label “OTHP” appears as “PHTO” when 
applied to the left side of a structure. However, since the 
Nickname “THP” is defined, the label appears as 
“THPO”. For more information, see “Aligning Text” on 
page 207. 

Defining Nicknames
You can define Nicknames with one or two attach-
ment points. The attachment points must be single 
bonds.
To define a new Nickname:

1. Create a structure containing the functional 
group you want to define as a Nickname.

2. Select the functional group.
You must indicate the connection point for the 
functional group by selecting the new fragment 
without the bond connected to the attachment point.
Figure 4.197: Adding a nickname

NOTE: If stereochemistry is indicated in a structure that 
you are defining as a Nickname, the stereochemistry is 
retained.

3. Click the Define Nickname command on the 
Structure menu.
The number of connection points is shown by 
radicals in the Formula. You can have only one 
or two connection points in a nickname.
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Figure 4.198: Define nickname dialog box

4. Type a short name for the Nickname.
5. Click the OK button.

The Nickname is defined.
Figure 4.199: Viewing the new nickname

If you use a Nickname that is the same as an ele-
ment name, a message indicates that the element is 
replaced with the Nickname. For example, using 
Ac for an acetyl group replaces the element Actin-
ium. The Check Structure command recognizes 
the label as an acetyl group rather than Actinium. 
ChemDraw provides the following default Nick-
name/Element conflicts:

To remove the overriding Nicknames, choose List 
Nicknames from the File menu and delete the 
overriding Nickname definition.

Deleting Nicknames
To delete a Nickname:

Table 10: Nickname-element conflicts 

Symbol Nickname Element

Ac Acetyl Actinium

Am Amyl Americium

Np para-Nitro-
phenyl

Neptunium

Pr Propyl Praeseodymium

DefineNickname 150 dpi
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1. Click the List Nicknames command on the File 
menu.

2. Select the Nickname that you want to delete 
from the list.

3. Click the Delete button.
The Nickname is removed from the list.

Defining Peptides with 
Nicknames
The definition in the figure below was used for the 
amino acid alanine. The unselected bond at each 
end of the structure indicates the connection 
points—Nitrogen on the left and Carbon on the 
right.
Figure 4.200: Creating an amino acid nickname 

You can draw a peptide chain by:
• Stringing Nicknames together, 
• Stringing Nicknames together in an atom 

label as long as there is a bond attached. or
• Stringing Nicknames together and not 

including bonds.
Figure 4.201: Creating peptides with nicknames 

Troubleshooting Nicknames
If the Define Nicknames command is disabled, 
check for the following:

• A connection point is not present 
• More than 2 connection points are defined 

H
N C

H

CH3

C

O

H Gly Ala OH

H GlyAlaOH

HGlyAlaOH

a.

b.

c.
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• The connection point is not a single bond
In Figure 4.202a, the entire functional group was 
selected. Because there is no atom that indicates a 
connection point, you cannot define a Nickname. 
When the sulfonamide group is attached to an 
unselected bond, you can define a Nickname.
In Figure 4.202b, there is more than one attachment 
point on a single atom in a nickname.
Figure 4.202c attempts to define more than two 
selection points.
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Figure 4.202: Troubleshooting nicknames 
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Chapter 5: Query Structures

What Are Query Structures?
Using a query structure to specify properties for 
atoms and bonds provides an efficient way to 
search chemical databases such as ChemFinder, 
DARC, RS3, or ISIS/Base. You can use a query 
structure to narrow or broaden your search. 
For example, creating a query structure indicating a 
bond as either double or single might broaden your 
search. Indicating atom properties where a particu-
lar atom must have a charge of +3 might narrow 
your search.
Because ChemDraw is not a chemical database 
application, the interpretation of query structures 
involves other programs. Not all databases support 
the same query properties. If you use a query struc-
ture containing properties not understood by a 
given database, one of the following may happen:

• An error message appears
• The unsupported properties are ignored

To use query structures for searching you may do 
either of the following:

• Paste the query structure into a database search 
window and initiate a search.

• Save the structure in an appropriate file format 
and open the file in the database application.

For more information on query properties see 
“Query Properties” on page 236, or consult the 
documentation for your chemical database.
NOTE: ChemOffice 2006 does not prevent or warn you if 
you try to assign conflicting or nonsensical properties. For 
example, you can require that one of the atoms in benzene is 
not part of any ring, which is inherently impossible. The 
results of such a search depend on the query system used, but 
usually no matches are found.
ChemDraw 10
Atom Properties
To assign properties to selected atoms in a struc-
ture:

1. Do one of the following:
Select a single atom by clicking it with a selection 
tool.

• Select multiple atoms by Shift+clicking the 
atoms.

2. Then do one of the following:
• Right-click, select the property you want, 

and click the appropriate option. 
• Click the Atom Properties command on the 

Structure menu. The Atom Properties dialog 
box appears.

• Press the Hotkey “/ ”. The Atom Properties 
dialog box appears.

Figure 5.203: Atom Properties dialog box 

In the Atom Properties dialog box, select the 
properties to associate with the selected 
atom(s). Click the OK button.
Query indicators appear next to atoms that 
have associated atom properties.
Query Structures • 85
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Figure 5.204: Displaying query indicators 

The character that appears depends on which 
query properties have been assigned. If more than 
one property is assigned, more than one character 
appears adjacent to the atom. For more informa-
tion, see “Query Indicators” on page 96.

Table 11: Atom properties indicators

Indicator Query Property

* Substituents: Free Sites (followed 
by the number of free sites)

U Substituents: Up to (followed by 
the maximum number of substitu-
ents)

X Substituents: Exactly (followed by 
the number of substituents)

H Implicit Hydrogens 

R Ring Bond Count

S Unsaturation

C Reaction Change

T Reaction Stereo

L Translation

T

C

S

R

∗2HS

X3
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Viewing Atom Property Values
Except for the three Substituents query properties, 
the characters indicate that a given property is 
applied, but not the value of that property. 
To find the value of a query property setting:

1. Select the atom.
2. Do one of the following:

• Right-click, point to an atom, and point to 
the appropriate property.

• Click the Properties command on the Struc-
ture menu and view the settings on the Atom 
Properties tab.

Removing Atom Properties
To remove all atom properties from an atom:

1. Select the atom.
2. Click the Properties command on the Structure 

menu.
3. Click Use Defaults.

The atom properties are removed and the char-
acters no longer appear. 

To remove specific atom properties:
1. Select the atom.
2. Do one of the following:

• Right-click, point to an atom, point to the 
property you want, and choose the appro-
priate option. 

3. Click the Properties command on the Structure 
menu and click the atom property to remove.

I Isotopic Abundance

(none) Abnormal Valence

Table 11: Atom properties indicators

Indicator Query Property
CambridgeSoft
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Atom Property Options
The following topics describe the atom properties 
you can associate with an atom.

Substituents
The three Substituents properties specify the num-
ber of substituents that may be bonded to the 
selected atoms. In ChemDraw, a substituent is 
defined as a non-hydrogen atom connected by a 
bond of any order. 
For example, in the figure below, the carbonyl car-
bon, indicated by the arrow, has a substituent 
count of two: the alpha carbon and the aldehyde 
oxygen. The double bond to the aldehyde oxygen 
counts as only one substituent and hydrogen atoms 
never count as substituents.
Figure 5.205: Substituent count 

The substituent count atom property allows you to 
specify the number of bonds to an atom in the tar-
get structure. This includes bonds already drawn in 
the query structure.

Table 12: Substituent options

Option Search Result

Unspecified Default. Search is determined by 
the target database. Some data-
bases (including ISIS) find 
compounds with any substitu-
tion at this atom and some data-
bases (including DARC) find 
only compounds with substitu-
tion exactly as drawn.

α carbon
H

O

ChemDraw 10
Implicit Hydrogens
The Implicit Hydrogens property specifies whether 
additional, implicit hydrogen atoms may be 
attached to the selected atoms. If implicit hydrogen 

Free Sites Finds compounds in which the 
selected atoms may contain a 
range of substituents up to the 
number specified plus the 
number of bonds as drawn. A 
value of zero finds a substituent 
count as drawn. You can also use 
the Free Sites symbol in the 
Chemical Symbols palette to 
apply free sites. For more infor-
mation, see “The Chemical 
Symbols Tools Palette” on page 
134.

Up to Finds compounds in which the 
selected atoms may contain a 
range of substituents up to the 
number specified.

Exactly Finds compounds in which the 
selected atoms contain the exact 
number of substituents as speci-
fied, up to 15 substituents.

Table 12: Substituent options

Option Search Result
Query Structures • 87
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atoms are not allowed, all valences to that atom 
must be filled by bonds to non-hydrogen atoms.

Ring Bond Count
The Ring Bond Count specifies the number of 
bonds attached to an atom that are part of rings of 
any size. For simple cases, this also specifies the 
maximum number of rings in which an atom can 
reside.

Table 13: Implicit hydrogen options

Option Search Result

Allowed Default. Finds compounds 
regardless of whether hydrogen 
atoms are attached to the 
selected atoms.

Not allowed Finds compounds with no 
additional hydrogen atoms 
attached to the selected atoms.

Table 14: Ring bond count options

Option Search Result

Any Default. Finds compounds in 
which the selected atoms can be a 
member of any type of ring, or a 
member of no ring at all.

No ring 
bonds

Finds compounds in which the 
selected atoms are acyclic.

As drawn Finds compounds in which the 
selected atoms reside in the same 
type and number of rings as 
drawn.
88 • Query Structures
Unsaturation
The Unsaturation property specifies whether a 
multiple bond is attached to the selected atoms. 

Simple ring Finds compounds in which the 
selected atoms is a member of only 
one ring (the atom has two ring 
bonds).

Fusion Finds compounds in which the 
selected atoms lies at ring fusions 
(the atom has three ring bonds).

Spiro or 
higher

Finds compounds in which the 
selected atoms is a member of a 
spiro or higher linkage (the atom 
has four or more ring bonds).

Table 15: Unsaturation options 

Option Search Result

Unspecified Default. Finds compounds 
regardless of whether a multiple 
bond is attached to the selected 
atoms.

Must be absent Finds compounds that do not 
have a multiple bond attached to 
the selected atoms.

Must be 
present

Finds compounds that have at 
least one multiple bond (double, 
triple or aromatic) attached to 
the selected atoms.

Table 14: Ring bond count options

Option Search Result
CambridgeSoft
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Reaction Change
The Reaction Change property specifies whether a 
change occurs at selected atoms after a reaction. 
This property is only meaningful when searching a 
database containing chemical reactions. In Chem-
Finder, only the product atom is checked. The ste-
reo designation is ignored on reactants.

Figure 5.206: Indicating reaction change

Reaction Stereo
The Reaction Stereo property specifies that the 
selected atoms are stereo-centers in a reaction. 
This property is only meaningful when searching a 
database containing chemical reactions.
Figure 5.207: Indicating reaction stereo

Table 16: Reaction change options

Option Search Result

May be 
anything

Default. Finds all reactions regard-
less of any change to selected 
atoms after a reaction.

Must be as 
specified

Finds all reactions that are 
changed at the selected atoms 
exactly as specified by the reaction 
center property in the Atom 
Properties dialog box.

NH2 Cl
Rxn

R2

Br

R1
N
H

C
Rxn

R2Br

R1

+

Reaction change indicator

NH2 Cl
Rxn

R2

Br

R1
N
H

T
Rxn

R2Br

R1

+

Reaction stereo indicator
ChemDraw 10
Translation
The Translation property specifies what is required 
to match in the structure query and possible data-
base hits in a Markush DARC query.

Table 17: Reaction stereo options

Option Search Result

Any Default. Finds all compounds 
regardless of the stereochemistry 
at the selected atoms.

Inversion Finds compounds in which the 
selected atoms have an inverted 
stereo configuration after a reac-
tion.

Retention Finds compounds whose selected 
atoms have an unchanged stereo 
configuration after a reaction.

Table 18: Translation options

Option Definition

Equal Default. Matches specific to specific 
or generic to generic terms. 

Broad Translates specific query atoms to 
corresponding superatoms in the 
database.

Narrow Translates query superatoms to 
corresponding specific atoms or 
groups in the database.

Any Translates generic or specific terms 
to any term.
Query Structures • 89
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For more information, refer to the Markush 
DARC User Manual.

Isotopic Abundance
The Isotopic Abundance property gives you the 
ability to distinguish between different isotopic 
compounds—for example between mono- and 
hexa-deuterobenzene—by specifying a nuclide at 
any location.

Abnormal Valence
The Abnormal Valence property specifies whether 
selected atoms can have a valence other than nor-

Table 19: Isotopic abundance options

Option Search results

Unspecified Default

Any For ChemFinder, the same as 
default. Included for compati-
bility with other systems where 
the default may be different.

Natural Indicates an isotopically 
unmodified nuclide.

Enriched Indicates a mixture of isotopi-
cally substituted and isotopi-
cally unmodified nuclides.

Deficient Indicates a depleted label, that 
is, the nuclide is present in less 
than the natural ratio.

Nonnatural Indicates an isotopically substi-
tuted nuclide, that is, essentially 
all the molecules of the 
compound have only the indi-
cated nuclide.
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mal. “Normal” valences for each element are 
defined in the Isotopes Table file in the Chem-
Draw Items folder.
NOTE: The Abnormal Valence atom property does not 
provide a visual indicator.

NOTE: If Abnormal Valence is Allowed, any Invalid 
Valence messages for those atoms are ignored automatically 
by the Check Structure command.

Bond Properties
To define bond properties of selected bonds in a 
structure:

1. Do one of the following:
• Select a bond using a selection tool.
• Shift+click to select multiple bonds.

2. Then do one of the following: 
• Right-click, point to Bond on the context 

menu, point to the property you want, and 
choose the appropriate option. 

Table 20: Abnormal valence options

Option Search Result

Not allowed Default. Finds compounds where 
the selected atoms only have 
valences that are normal for that 
element. If necessary, hydrogen 
atoms are automatically added to or 
removed from the atom before 
transferring it to the chemical data-
base. If the Check Structure When 
Copying to Clipboard or Exporting 
preference is turned on, an error 
message warns of abnormal 
valences.

Allowed Finds compounds with the specific 
valence drawn.
CambridgeSoft
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• Click the Properties command on the Struc-
ture menu. On the Bond Properties tab, 
select the bond properties to associate with 
the selected bonds from the drop-down 
lists. Click OK.

• Point to an bond and press the Hotkey “/ ”. 
The Bond Properties dialog box appears.

Figure 5.208: Bond property dialog box

In the Bond Properties dialog box, select the 
properties to associate with the selected atoms. 
Click OK.
Query indicators appear next to bonds that 
have associated bond properties.

Figure 5.209: Displaying bond properties

The characters that appears depends on which 
query properties have been assigned. If more than 
one property is assigned, more than one descriptor 
appears adjacent to the atoms. For more informa-
tion, see “Query Indicators” on page 96.
The indicators are described in the following table.

Table 21: Bond property descriptors

Indicator Bond Query Property

Any Bond Type: Any

one bond many bonds
ChemDraw 10
Viewing Bond Property Values
The descriptor for the Reaction Center query 
property indicates that the property is applied, but 
not the value of the property. 
To find the value of a query bond property setting:

1. Select the bond.
2. Do one of the following: 

• Right-click, point to Bond, and point to the 
appropriate property.

• Click the Bond Properties command on the 
Structure menu, and view the settings of the 
drop-down list boxes.

Removing Bond Properties
To remove all bond properties from selected 
bonds:

1. Select the bonds.
2. Click the Properties command on the Structure 

menu.
3. Click Use Defaults.

S/D Bond Type: Single/Double

D/A Bond Type: Double/Aromatic

S/A Bond Type: Single/Aromatic

Rng Topology: Ring

Chn Topology: Chain

R/C Topology: Ring or Chain

Rxn Reaction Center

Table 21: Bond property descriptors

Indicator Bond Query Property
Query Structures • 91
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The bond properties are removed and the indi-
cators are no longer adjacent to the selected 
bonds. 

To remove specific bond properties:
1. Select the bond.
2. Do one of the following:

• Right-click, point to the appropriate prop-
erty, and click the property to remove.
92 • Query Structures
• Click the Properties command on the Struc-
ture menu, and click the bond property to 
remove.

Bond Property Options
The following are the atom properties that you can 
associate with an atom:

Bond Type
This property specifies the bond type of the 
selected bonds. The default bond type corresponds 
CambridgeSoft
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to the current type of the bond (single, double, 
etc.) as drawn.

Table 22: Bond type options

Option Search Result

Single (all) and 
Dative

Finds compounds with the bond 
type you select for the selected 
bonds.

Double or 
Double Bold

Finds compounds whose 
selected bonds are double.

Double Either Finds compounds whose 
selected bonds are double bonds 
and have either cis/trans stere-
ochemical configuration.

Aromatic Finds compounds whose 
selected bonds are aromatic.

Tautomeric Finds compounds whose 
selected bonds are tautomeric.

Triple Finds compounds whose 
selected bonds are triple.

Quadruple Finds compounds whose 
selected bonds are quadruple.

Any Finds compounds regardless of 
the bond type of the selected 
bonds.

S/D Finds compounds whose 
selected bonds are single or 
double.
ChemDraw 10
NOTE: Not all bond types are supported in all file for-
mats. When an unsupported bond type is saved to a given file 
format, it is converted to the closest equivalent that is sup-
ported.

Topology
The Topology property specifies the ring environ-
ment of the selected bonds.

D/A Finds compounds whose 
selected bonds are double or 
aromatic.

S/A Finds compounds whose 
selected bonds are single or 
aromatic.

Table 23: Topology options

Option Search Result

Unspecified Default. Finds compounds 
regardless of environment.

Ring Finds compounds where the 
selected bonds are part of a 
ring.

Chain Finds compounds where the 
selected bonds are part of a 
chain (and are specifically not 
part of a ring).

Ring or Chain Finds compounds where the 
selected bonds are part of 
either a ring or a chain.

Table 22: Bond type options

Option Search Result
Query Structures • 93
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Reaction Center
The Reaction Center property specifies how the 
selected bonds are affected in a reaction. This 
property is only meaningful when searching a data-
base containing chemical reactions.

Table 24: Reaction center options

Option Search Result

Unspecified Default. Finds compounds regard-
less of whether the selected bonds 
are affected by the reaction.

Center Finds compounds where the 
selected bonds are affected by a 
reaction, but the type of change is 
unspecified.

Make/Break Finds compounds where the 
selected bonds are either broken 
or created in a reaction.

Change Finds compounds where the bond 
order of the selected bonds 
changes in a reaction.

Make&
Change

Finds compounds where the 
selected bonds are formed, 
broken, or undergo a change in 
bond order.

Not Center Finds compounds where the 
selected bonds are not part of the 
reaction center.

Not Modified Finds compounds where the 
selected bond’s orders do not 
change, but which may or may not 
be part of the reaction center.
94 • Query Structures
3D Properties
3D queries are particularly useful in pharmacoph-
ore searching where the user is looking for a partic-
ular 3D relationship among atoms and bonds, for 
example in a series of potential receptor ligands. 
To create a 3D query, you add geometries (lines, 
planes, etc.) and constraints (specified as ranges) to 
a query structure. For example, you might specify 
that two atoms must be between 4 and 5 Å apart, 
or that two planes must be separated by 80-100 
degrees. 
To assign 3D properties to a structure, select the 
structure or sub-structure and select one of the fol-
lowing options from the Add 3D Property com-
mand on the Structure menu. 
NOTE: Because some 3D properties specify an order, you 
should use Shift+Click to select them in the proper order 
rather than using the Marquee or Lasso tool to select them 
all at once.
In the table below, points are may be atoms, cen-
troids or points. Lines may be lines or Normals.

Unmapped Finds all compounds.

Table 25: 3D property options

Option Search Result

Angle Defines an angle constraint 
between three points (in order). 
Indicated as a range.

Table 24: Reaction center options

Option Search Result
CambridgeSoft
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Dihedral Defines a dihedral (torsional) 
angle constraint among four 
points (in order), between two 
lines, or two planes. Indicated as a 
range.

Distance Defines a distance constraint 
between two points, a point and a 
line, or a point and a plane. Indi-
cated as a range, in Angstroms.

Line Defines the best-fit line for the 
selected points.

Plane Defines the best-fit plane for the 
selected points, or for a point and 
a line.

Exclusion 
Sphere

Defines an exclusion sphere 
around a point. If more than one 
point is selected, the exclusion 
sphere is around the first selected 
point, and the subsequent points 
are allowed within the exclusion 
sphere when the query is evalu-
ated. Indicated as a range, in Å, 
beginning at 0.

Normal Defines the normal from a defined 
plane in the direction of a point. 

Point Defines a point positioned at a 
specified distance from a first 
point in the direction of a second 
point (in order), or in the direction 
of the normal.

Table 25: 3D property options

Option Search Result
ChemDraw 10
All constraint values can be edited with the text 
tool. Only exclusion spheres show the change visu-
ally.
When you create a point, a dialog box is displayed. 
Specify the distance from the first selected point to 
the calculated point. The distance may be specified 
as an absolute value in Å or as a percentage of the 
distance between the selected points. Negative val-
ues indicate that the calculated point is further 
from the second point than the first point is, rather 
than being between them.

Geometry and constraint objects update dynami-
cally when you change the structure; they cannot 
be moved independently. They may be used with 
CDX, MOL, SKC, and TGF files (full read-write 
compatibility); they are not compatible with other 
formats. They can, however, be saved in print-only 
formats such as TIFF.

Query Tools Palette
ChemDraw provides Query tools to enable you to 
draw query structures.
To display the Query tools, select Show Query 
Tools from the Other Tools command on the View 
menu, or click the Query Tools icon on the Main 
Tool Palette:

• Click .

The Query tools palette appears. 

Centroid Defines a point positioned at the 
average position of all other points 
selected.

Table 25: 3D property options

Option Search Result
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Figure 5.210: Query tools palette

Query Indicators
You can display small characters to indicate query 
properties you assign to atoms and bonds.

Viewing Query Indicators
To display query indicators for a structure, select a 
structure to which query indicators are assigned, 
right-click, point to Atom or Bond on the context 
menu, and click the Show Query Indicator com-
mand.
To display query indicators for individual atoms or 
bonds, select the atom or bond, right-click, and 
choose the Show Query Indicator command on the 
context menu.

Hiding Query Indicators
To hide an individual indicator:

1. Select the indicator to hide.
2. Right-click and select Hide Indicator.

Removing Query Indicators
To delete a query indicator:

1. Click the indictor.
2. Click the eraser tool and click the indicator.

Positioning Query Indicators
Query indicators are positioned automatically and 
move appropriately if a structure is modified. You 
can reposition them by dragging them to the 
desired position or with the Indicator Position dia-
log box.

Alternative 

Reaction 

Relative 

Racemic 
Stereochemistry

Free Site

Stereochemistry
Absolute Stereochemistry

Atom-Atom

Group 

Map
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To reposition an indicator numerically:
1. With a selection tool, click the indicator to 

move.
2. Right-click and choose Position.

The Position Indicator dialog box appears.
Figure 5.211: Position Indicators dialog box

3. Click the appropriate Position option, and type 
a value:

Drawing Stereochemical 
Symbols
ChemDraw provides three types of stereochemical 
flags that indicate that the molecule with which they 
are associated represents one of the following:

Table 26: Position options

To Position … Type a value 
for…

from the atom or bond 
center to indicator 
center

angle, degrees or 
clock, o’clock

from the atom or bond 
center to bottom left of 
indicator baseline

offset, horizontal and 
vertical

at specified coordinates absolute, horizontal 
and vertical
CambridgeSoft
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• Racemic—A racemic mixture. 
• Absolute—A pure enantiomer of known con-

figuration.
• Relative—A pure enantiomer of unknown 

configuration.
See “Relative Stereochemistry” on page 114 for 
changes in ChemDraw 10.
The font and size for stereochemical flags is deter-
mined by the default Atom Label size for the docu-
ment.
To draw a stereochemical flag: 

1. Click the tool for the flag you want to use on 
the Query tools palette.

2. Position the pointer next to the structure to 
which you want to assign the flag.

3. Click to deposit the symbol.

Drawing Free Sites
Use the Free Sites tool to increment or decrement 
the number of free sites in a query structure. 
To increment the number of Free Sites: 

1. Click the Free Site tool on the Query tools pal-
ette.

Figure 5.212: Free site tool

2. Position the pointer over the atom to which 
you want to apply free sites.

3. Click to add the symbol.
4. Continue to click the atom to increment the 

free site number.
To decrement the number of free sites, hold the 
Alt or option key while clicking the atom.
You can also change the free sites by using the 
Atom Properties dialog box or the shortcut menu. 
For more information see “Atom Properties” on 
page 85.

Free Site tool
ChemDraw 10
Generic Nicknames
Generic nicknames represent a class of elements or 
structural moieties. The generic nicknames recog-
nized as chemically significant by ChemDraw are:

• A: used to represent any moiety
• M: used to represent metal
• Q: used to represent a non-hydrogen heteroa-

tom
• X: used to represent any halide
• R: undefined; used in the usual way

If you are using a query system that recognizes 
generic nicknames, you can use these nicknames in 
your ChemDraw query structure. 
To label an atomic position with a generic 
nickname, do one of the following:

• Double-click on the atom to open a text box, 
and type in the nickname.

• Right-click on the atom, point to Insert 
Generic Label on the context menu, and click 
the label you wish to insert on the sub-menu.

You can assign Generic nicknames, like other nick-
names, to HotKeys. For information on assigning 
a Hotkey to a nickname, see “Creating HotKeys” 
on page 210.
You cannot define the meaning of a generic nick-
name in ChemDraw because generic nicknames 
represent multiple (and perhaps an infinite number 
of) substituents. Generic nicknames have meaning 
only in the context of the search system you are 
using.
The generic nicknames recognized as chemically 
meaningful to ChemDraw are listed in Generic 
Nicknames file in the ChemDraw Items folder. 
To edit the generic nickname files, open the 
Generic Nicknames file in a text editor and make 
your changes. Follow examples in the file for the 
correct format.
Query Structures • 97
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NOTE: If you perform Check Structure on a structure with 
a generic nickname, a message is displayed because the struc-
ture contains variable substituents. If you ignore this message, 
the generic nicknames are ignored and ChemDraw reports 
the chemical formula, mass, and so on as if the atom label 
containing the generic nickname were not selected.

Element Lists
You can define your search query more concisely 
with the element list. By labeling an atom position 
as a list of elements you specify that one of these 
elements must match in the structure for which 
you are searching. The elements in the element list 
must be separated by commas. A space after each 
comma and brackets are optional. An example of 
an element list is shown below.
Figure 5.213: Element list

NOTE: An element list may contain only atomic symbols, 
plus D (deuterium) and T (tritium).
To create an element list:

1. Open an atom label text box.
2. Type an open bracket (“[“) followed by a list of 

elements separated by commas (“Cl, Br, I”), 
followed by a close bracket (“]”).

3. Close the text box.
Figure 5.214: Adding an element list to an atom label

Figure 5.215 shows a query structure created to find 
compounds matching the following criteria: 

• Non-oxygen chalcogenide bonded to 
another atom.

• Not necessarily carbon (a generic nick-
name).

[S,Se,Te]

[Br, I, Cl] [Br, I, Cl]
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• The bond type between the chalcogenide 
and the other atom to be a single or double 
bond.

Figure 5.215: Query example

The “A” label indicates that the atom may match 
any atom except hydrogen. The mark near the 
bond indicates that the bond has special properties. 
The bond type specified in the Bond Properties 
dialog box must be single or double, S/D. The 
“[S,Se,Te]” specifies that one of these elements 
must match in the target structures.

Element Not-Lists
The element not-list specifies that the elements in 
the list match must not match in the structure for 
which you are searching. Commas must separate 
the elements in the element not-list. A space after 
each comma and brackets are optional. 
The word NOT must be in all-caps and must be 
followed by a space. Alternatively, the word NOT 
may be replaced with a minus sign.
For example:
Figure 5.216: Element NOT lists

NOTE:  An element not-list may contain only atomic ele-
ments, plus D (deuterium) and T (tritium).
To create an element not-list:

1. Open an atom label text box.
2. Type an open bracket, the word NOT, and a 

space (“[NOT”) followed by a list of elements 
separated by commas (“Cl, Br, I”), followed by 
a close bracket (“]”).

(b)
(c)

(a)
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Link Nodes
You can specify a variable-length chain or ring by 
indicating that one of the atoms can be repeated 
some number of times using link nodes.
Link nodes must have exactly two connecting 
bonds. The atom label must conform to the 
following conditions:

• No more than a single element symbol or a 
generic nickname

• The last part of the label in the form: number 
hyphen number, with the number and hyphen 
subscripted

• Parentheses or braces may be used instead of 
brackets

• Brackets can be omitted if not needed for clar-
ity, for example with O1-3

To create a link node:
1. Open an atom label text box.
2. Type in the following format:

Figure 5.217: Link node

Representing Polymers and 
Other Repeating Units
Brackets, parentheses, and braces enclose struc-
tures or structural fragments that are to be 
repeated a number of times. The bracket proper-
ties in ChemDraw allow you to specify the context 
and orientation of the repeating units. 
To enclose structures with brackets:

1. Click the Bracket tool  and select one of 
the double bracket tools.

2. Drag across the structure to draw the brackets.
3. Right-click or control-click and select the 

appropriate bracket properties from the menu 
that appears.
ChemDraw 10
The bracket properties are described in the follow-
ing sections.
NOTE: This method will give a default value for compo-
nent order, multiple group repeat count, or SRU label. To 
change a default value, use the Bracket Properties dialog box.

Setting Bracket Properties
You can change the properties of brackets by the 
context menus or Bracket Properties dialog box.
To use the Bracket Properties dialog box:

1. Select the right bracket with a selection tool.
2. Click Bracket Properties on the Structure 

menu.
The Bracket Properties dialog box appears.

Figure 5.218: Bracket properties dialog box

The Flip Type option appears only for brackets 
with exactly two crossing bonds, and is disabled in 
other cases.
You can customize the text that appears to the bot-
tom right of the bracket for the following bracket 
types.

• Component (c#)—the Component Order 
must be a non-negative integer, and is dis-
played as the letter “c” followed by that integer 
(or “c” alone if an order of zero is specified).

• Multiple Group (#)—the Repeat Count must 
be a positive integer.

• SRU (n)—the SRU label can be any text.
You can also edit the text for these Bracket Usage 
types directly in the document using the Text tool. 
Query Structures • 99
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You cannot edit the text displayed for the other 
Bracket Usage types.

Bracket Usage
Representations of polymers are either struc-
ture-based or source-based. The type of bracket 
you use depends on which type of representation 
you need. For references, see “Polymer Represen-
tations” on page 235.

Structure-based Polymer 
Representations
Structure-based polymer representations enclose 
only a portion of a structure within brackets. One 
or more bonds cross each of the enclosing brack-
ets. The crossing bonds “match up”, making the 
polymer structure more explicit. 
You create a structure-based polymer representa-
tion by enclosing a portion of a structure in brack-
ets with a bracket type of SRU (n). The subscript 
“n” is recommended by IUPAC to notate struc-
ture-based representations of unknown size, but 
you can edit the text using the text tool.
A structure-based representation of 
poly(vinyl chloride) is shown in Figure 5.219.
Figure 5.219: Structure-based polymer representation

You can also use the Bracket Usage types 
“Crosslink (xl)”, “Graft (grf)”, and “Modification 
(mod)” to represent specific types of repeating 
units in a structure-based representation, but they 
are rarely encountered and using them is discour-
aged.

Source-based Polymer Representations
Source-based polymer representations enclose an 
entire discrete chemical substance in brackets. The 

*
*

Cl

n
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mode of polymerization may be obvious from con-
text, or it might be unknown. Source-based repre-
sentations are useful when describing processes 
where the starting materials are known, but the 
exact structure of the reaction product is not. 
You can create a source-based representation by 
enclosing a structure in “Monomer (mon)” brack-
ets.
A source-based representation of poly(vinyl chlo-
ride) is shown in Figure 5.220.
Figure 5.220: Source-based polymer representation

You can use “Mer (mer)” brackets for components 
of a copolymer where those individual compo-
nents are known not to repeat themselves or alter-
nate with the other components. An example is 
shown in Figure 5.221.
Figure 5.221: Copolymer representation

Copolymers represent substances with more than 
one repeating unit. In general, you can use bracket 
type “Component (co)”. You can also use “Copol-
ymer, alternating (alt)”, “Copolymer, random 
(ran)”, and “Copolymer, block (blk)” to represent 
different specific types of copolymers in a source-
based representation, but they are rarely used and 
their use is discouraged.

Cl

mon

HO

O

O

OH
HO

OH

mer

mer

co
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The bracket type, “Mixture, unordered (mix)” is 
not for polymers, but to represent a collection of 
substances that may all be present, but not neces-
sarily in known amounts. Bracket type “Compo-
nent (c)” indicates individual mixture elements. An 
example is shown in Figure 5.222.
Figure 5.222: Brackets used to indicate mixtures 

Bracket type “Mixture, ordered (f)” is primarily 
used to describe manufacturing processes, where 
the ordering of components is a critical part of the 
process (and where a different ordering might pro-
duce a different final product. As with Unordered 
Mixtures, individual elements of an ordered mix-
ture should be surrounded by brackets with a 
bracket usage of “Component (c)”. Unlike with 
Unordered Mixtures, however, components of 
Ordered Mixtures must represent their ordering. 
You can do this by editing the “c” label with the 
text tool to include a number (“c1”, “c2”, and so 
on.)
You use the bracket type, “Multiple Group (#)” to 
indicate that the enclosed items are repeated a spe-
cific known number of times. Multiple Group 
brackets may enclose entire structures, or may 
enclose a portion of the structures only. You can 
edit the numeric repeat count with the text tool. 
Examples are shown in Figure 5.223.

COOH

O

COOH

O O

O

COOH

COOH
c1

c3

c2

c4

mix
ChemDraw 10
Figure 5.223: Brackets used to indicate multiple 
groups 

Because Multiple Group brackets represent a spe-
cific repeat count (unlike the unknown repeat 
count of the other bracket types), it is possible to 
calculate accurate molecular weights (and related 
data) for such structures. That data is displayed in 
the Analysis window as with any other structure.
Figure 5.224: Analysis with multiple groups.

Repeat Pattern
For simple linear polymers, the repeating units may 
connect head-to-tail or head-to-head (or their 
repeat pattern might be a mixture or unknown). 
You can also assign this property to brackets.
Because of its prevalence, the Head-to-Tail type is 
assumed to be the default Repeat Pattern, and does 
not receive any special annotation on the brackets, 
as shown in Figure 5.225.
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Figure 5.225: Head-to-tail repeat pattern

Flip Type
For ladder-type polymers (those polymers with 
two connecting bonds on each side), there is a 
potential ambiguity in the order of the connec-
tions. You can assign the Flip Type property to 
resolve that ambiguity. This property is appropriate 
only for brackets with exactly two crossing bonds, 
and is disabled in other cases.
Because of its prevalence the No Flip type does 
not receive any special annotation.
Figure 5.226: Indicating flip type in ladder-type poly-
mers

Alternative Groups
You can create a search query that contains vari-
able functional groups or substructures. Instead of 
submitting multiple queries on structures that 
share a common substructure, you can submit a 
single query with the parent structure. The parent 
structure can have attachment points to a list of 
alternative groups that you can define. 
Alternative groups, sometimes called R-Groups or 
G-Groups (Generic Groups), are shown below.
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Figure 5.227: Alternative groups 

Defining an Alternative Group
In ChemDraw Pro, you can create alternative 
group definitions (R, G, etc.) that represent a set of 
substituents, any one of which will match the 
query.
To define an alternative group:

1. Click the Alternative Group query tool  
and drag with the tool to create an area large 
enough to draw the alternative groups.

2. Type a title, such as R1, in the Alternative 
Group Title box, then draw the substructure 
fragments in the Alternative Group box.

Figure 5.228: Defining an alternative group

Specify where the fragments should bond to the 
parent structure on the alternative group label by 
defining Attachment Points

21
CambridgeSoft
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3. Do one of the following:
• Select the diamond shaped Attachment 

Point tool  on the Chemical Symbols 
palette, and click a substructure fragment 
where you want to place the attachment 
point.

• Point to a substructure fragment where you 
want to place the attachment point and press 
the Hotkey “.” (period).

An attachment point symbol appears.
4. Repeat for all fragments.

Figure 5.229: Adding attachment points 

When you create a parent compound that contains 
an alternative group you defined, an attachment 
point symbol appears next to the label. The attach-
ment point number matches that found in the defi-
nition.
Figure 5.230: Structure with R-group table 

The number displayed in the attachment point 
symbol is the attachment rank order. See the exam-
ple in “Multiple Attachment Points” on page 103. 

Attachment 
point symbol

R1

NH2

OH

F

1

1

1

R1
1

ChemDraw 10
Multiple Attachment Points
If you have well-defined multiple attachment 
points on your structure fragments, you can per-
form searches for specific materials. This type of 
search is especially useful for searching for confor-
mationally similar structures. 
For example, you want to find the two compounds 
in Figure 5.231A. However, you are not interested 
in the two compounds in Figure 5.231B.
Figure 5.231: Multiple attachment points 

By specifying the attachment point order, you can 
exclude the unwanted compounds. The parent 
structure in Figure 5.232 satisfies the necessary 
requirements.
To specify the attachment points order:

1. Draw the parent structure shown below.
Figure 5.232: Specifying the attachment point order 

2. Create an Alternative Group Box labeled “R1”.
3. Draw the structure fragments and label them 

with attachment points.

NH2

O

NH2

NH2

O

NH2

A

B
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When the alternative group definition is 
complete, the attachment point symbols 
appear in the parent compound.

Figure 5.233: R-groups with multi-attachment points 

By numbering your attachment points, you have 
unambiguously specified that the methyl group 
must be adjacent to the amine group. The confor-
mations that are not of interest are excluded.

Showing Attachment Rank 
Indicators
You can hide the attachment rank indicators if 
required. For example, sometimes—particularly in 
publication-quality drawings—the numbering of 
attachment points is implicit and the numbered 
attachment rank indicators are superfluous. 
To hide the attachment rank indicators and 
remove the numbers from the attachment points:

1. Click the Preferences command on the File 
menu.

2. In the Preferences dialog box, click Display.
3. Deselect Show Attachment Rank Indicators.

Figure 5.234 shows an alternative group definition 
and a parent structure with the attachment rank 
indicators hidden.

R1

O

1 2

1 2
104• Query Structures
Figure 5.234: Hidden attachment rank indicators 

This change affects all documents. 

Attachment Point Numbering
Numbered attachment points allow you to specify 
precisely how the structure fragments are con-
nected to your parent structure.
The numbering of the attachment points is related 
to the front to back order of the attachment points.
To set the order of the attachment points, click the 
ends of the bonds in order. 

The last point clicked has the highest number.
To change the ordering of the attachment points do 
one of the following:

• Click the attachment points with the Attach-
ment Point tool. 

• Select an attachment point with a selection 
tool, and click either the Bring to Front or the 
Send To Back command on the Object menu. 
The attachment point numbers are highest in 
the front.

Anonymous Alternative 
Groups
An anonymous alternative group is a cross 
between an element list and an alternative group. 
Element lists are restricted to single elements, but 
anonymous alternative groups can contain any 
structure that can be represented by text. Nick-
names and generic nicknames are allowed in anon-

R1

NH2

R1

O
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ymous alternative groups. Anonymous alternative 
groups are shortcut notation for regular alternative 
groups, eliminating the need to specify a name 
such as “R1”.
You can define your search query more concisely 
with the anonymous alternative group. By labeling 
an atom position as a list of substructures you 
specify that one of these substructures must match 
in the structure for which you are searching. Com-
mas must separate the items in the anonymous 
alternative group. A space after each comma and 
the brackets are optional. Examples of anonymous 
alternative groups are shown in Figure 5.235.
Figure 5.235: Anonymous alternative groups 

To create anonymous alternative groups:
1. Open an atom label text box.
2. Type an open bracket “[”followed by a list of 

elements, fragments, nicknames, or generic 
nicknames separated by commas, followed by a 
close bracket “]”.

Atom-to-Atom Mapping
You can create correspondences between atoms in 
different structures for use in creating queries for 
searching a reaction database. The reactions 
mapped can be single or multi-step. You can assign 
atom-to-atom mapping for creating records for a 
reaction database and for creating queries for 
searching a reaction database. You can assign atom 
mapping in two ways:

• Automatic mapping, using the Map Reaction 
Atoms command from the Structure menu. 

• Manual mapping, using the Reaction 
Atom-Atom Map tool  on the main tools 

palette.
ChemDraw 10
During either type of mapping process, the map-
ping algorithm perceives and assigns a reaction 
center for the reactants and products.
When a reaction map is established, you can point 
to an atom in one structure with the Reaction 
Atom-Atom Map tool selected to highlight the 
mapped atom in the other structure.

Always Display and Print Atom 
Mapping
To make the symbols always appear and print on 
the atoms when reaction mapping has been per-
formed:

1. Click the Preferences command on the File 
menu.

2. In the Preferences dialog box, click Display.
3. Select Always Display and Print Reaction Map-

ping.
4. Click OK.

Deselect Always Display and Print Atom Mapping 
to show the symbols only when you select the 
Reaction Atom-Atom Map tool. When this option 
is deselected, atom mapping symbols do not print, 
even though a reaction map has been created.

Automatic Mapping
To automatically create a reaction map:

1. Draw the reaction you want to map and select 
the reactants and products.

TIP: Double-click the arrow with a selection tool to 
select the entire reaction.

2. Click the Map Reaction Atoms command on 
the Structure menu.
The symbol Rxn appears next to the bonds in 
the reactant and product that are perceived by 
the algorithm as being modified by the reac-
tion. These symbols are bond properties that 
Query Structures • 105
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are automatically applied. For more informa-
tion about the Reaction Center bond property, 
see “Bond Properties” on page 90.

Figure 5.236: Automatic reaction mapping 

Manual Mapping
In situations that require manual mapping of 
atoms, you can use the Reaction Atom-Atom Map 
tool. This might be necessary when the automatic 
mapping is applied to complicated reactions, and 
gives incorrect results. In these cases you can man-
ually readjust the reaction mapping.
Figure 5.237 shows the initial mapping being 
ammended by using the Reaction Atom-Atom 
Map tool.
Figure 5.237: Automatic mapping to be ammended

When you perform manual mapping with the 
Reaction Atom-Atom Map tool, you can suppress 
automatic re-mapping of atoms other than your 
target atom. 
To suppress automatic re-mapping:

1. Click the Preferences command on the File 
menu.

2. Select Automatic Reaction Mapping on the 
General tab.

Ph

Rxn

OSiMe3
Rxn

Rxn

O
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Rxn
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Rxn Rxn
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6
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7
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3. Click OK.
To use the Reaction Atom-Atom Map tool to sup-
plement the automatic mapping:

1. Click the Reaction Atom-Atom Map tool .
2. Point to the atom in the reactant whose map-

ping you want to establish. For example, in the 
following drawing you would point to the acy-
clic carbon adjacent to the ether oxygen.

3. Drag from the reactant atom to the corre-
sponding product atom.
The remaining atoms are automatically 
mapped based on the manual mapping you 
performed. 

Figure 5.238: Finalized mapping

You can continue to set or change the mapping for 
other atoms in the reaction if necessary until you 
get exactly the mapping you want. For this example 
additional manual mapping is not necessary.

Clearing Reaction Mapping
To clear all reaction mapping:

1. Select the structures whose mapping you want 
to remove.

2. Click the Clear Reaction Map command on the 
Structure menu.
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Exporting Reaction Mapping
Reaction mapping and reaction center perception 
information are stored in the native ChemDraw 
file format (*.cdx) for reopening in ChemDraw 
and the ISIS Reaction file format for transfer to 
other applications that read atom mapping, such as 
ChemFinder and ISIS/Base. You can also copy 
mapped reactions to these same applications using 
the Clipboard.

Export Compatibility
Because query properties are only useful in a chem-
ical database, you must transfer your structures 
from ChemDraw into your search system. Not all 
file formats support the same query properties and 
not all chemical databases support the same file 
formats. Consult the documentation for your data-
base to see which file formats are supported.
The following table lists the query properties that 
ChemDraw writes to ISIS (SKC, TGF, and Clip-
board) file formats. All query properties are written 
to the ChemDraw (CDX) file format. CDX is the 
preferred format to use to retain all query proper-
ties in a drawing.

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn

Atom Properties

Substituents

Unspecified X X X

Free Sites b b b

Up to a a a
ChemDraw 10
Exactly Xc Xc Xc

Implicit Hydrogens

Not allowed X X X

Allowed X X X

Ring Bond Count

Any X X X

No ring bonds X X X

As drawn X X X

Simple ring X X X

Fusion X X X

Spiro or higher X X X

Unsaturation

Unspecified X X X

Must be absent

Must be 
present

X X X

Reaction Change

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn
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May be 
anything

X X

Must be as 
specified

X X

Reaction Stereo

Any X X

Inversion X X

Retention X X

Translation

Equal

Broad

Any

Narrow

Abnormal Valence

Not Allowed X X X

Allowed X X X

Bond Properties

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn
108• Query Structures
Bond Type

Single X X X

Dashed X X X

Hashed d d d

Wedged 
Hashed

X X X

Bold X e e

Wedged X X X

Wavy X X X

Hollow 
Wedged

e e e

Dative f f f

Double Xg Xg Xg

Double Either X X X

Double Bold h h h

Aromatic X X X

Tautomeric i i i

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn
CambridgeSoft
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Triple X X X

Quadruple l l l

Any X X X

S/D X X X

D/A X X X

S/A X X X

Topology

Unspecified X X X

Ring X X X

Chain X X X

Reaction Center

Unspecified X X

Center X X

Make/Break X X

Change X X

Make&Change X X

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn
ChemDraw 10
Not Center X X

Other Query Attributes

Generic 
Nicknames

Xj Xj Xj

Element Lists Xko Xko Xko

Element Not-
Lists

Xk Xk Xk

Alternative 
Groups

X Xm

Anonymous 
Alternative 
Groups

n n

Link Nodes p p p

Bracket 
properties

X X X

Atom-Atom 
mapping

X X

Variable 
Attachment 
Positions

3D query proper-
ties

Table 27: Query properties by export format

Exported 
Query 
Properties

ISIS Mol Rxn
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aConverted to the appropriate number of exact 
substituents
bFree Sites counts of zero translated to “Substitu-
tion as drawn”; all other Free Sites values written 
as substitution counts equal to the total current 
valence plus the free sites value.
c Substituent counts of greater than 5 are translated 
to “6 or more”
dConverted to Wedged Hashed
eConverted to Wedged
f Converted to a Single, with a positive charge 
applied to that atom at the base of the dative bond 
and a negative charge applied to the atom at the 
point of the dative bond
110• Query Structures
gInterpreted by ISIS as unspecified cis/trans stere-
ochemistry
hConverted to Double
iConverted to S/D
jOnly M, X, Q, A; others written as aliases
kTruncated to the first 5 elements
lConverted to single.
mAn RGFile will be created automatically.
nConverted to non-anonymous alternative groups.
oLists of greater than 5 elements converted to 
alternative groups.
pThe low end of the repeat range is always treated 
as 1.
CambridgeSoft
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Chapter 6: Chemistry Features

Checking Chemistry

Check Structure
You can check the chemistry of a selected struc-
ture, part of a structure, or caption (in Formula 
style). The Check Structure command identifies 
errors in valences, labels and defined Nicknames.
To check the valences of all selected atoms in a 
structure:

1. Select a structure, part of a structure, or caption 
with a selection tool.

2. Click the Check Structure command on the 
Structure menu.
Each label in the structure is checked. sequen-
tially. When a label is incorrect, a message win-
dow appears. 

Figure 6.239: Check structure information window

To continue checking the structure when a mes-
sage appears, click Ignore.
To ignore all subsequent errors in a structure, click 
Ignore All.
To stop checking a structure when a message 
appears, click Stop. 
ChemDraw 10
Check Structure when Copying to 
Clipboard or Exporting
To have ChemDraw perform a check structure 
analysis on any structure copied to the Clipboard:

1. Click the Preferences command on the File 
menu.

2. Click the Check Structure When Copying to 
Clipboard or Exporting check box.

This change affects all documents. 

Viewing Analysis 
Information
The Analysis window displays the chemical for-
mula, exact mass, molecular weight, m/z, and ele-
mental analysis for the entire document, a 
structure, part of a structure, or a caption in For-
mula style.
To view analysis information, click the Show Anal-
ysis Window command on the View menu.

The Analysis window appears. 
Figure 6.240: Analysis window

Values for selected objects in the document win-
dow are shown. If no structure is selected in your 
document, values for the entire document are 
shown.
You can have this window open as you draw in the 
document. It shows the current values as you draw.

Analysis Toolbar 150 dpi
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The Decimals setting applies to Exact Mass, 
Molecular Weight, and m/z only.

Table 28: Analysis properties

Property Description

Formula The molecular formula showing the 
exact number of atoms of each 
element in the molecule and charges, 
radicals, and isotopes.

Exact Mass The exact molecular mass of the 
structure, where atomic masses of 
each atom are based on the most 
common isotope for the element.

Molecular 
Weight 

The average molecular mass of the 
structure, where atomic masses are 
based on the natural abundance of all 
isotopes of the element.

m/z Mass/charge, where charge =1. The 
weights of the most common 
isotopes and a graphical representa-
tion of the isotopic abundance is 
shown.

The molecular weight shown takes 
the isotopes for each atom and their 
natural abundance into account. 
Where there is more than one abun-
dant isotope, ChemDraw computes 
multiple molecular weights. Low 
abundance combinations (whether 
because the isotope is in low abun-
dance or because it includes many 
moderate-abundance contributions) 
are not taken into account. 

You cannot paste the graph in a 
document.
112• Chemistry Features
To paste information about a structure as a cap-
tion:

1. Click the check boxes for the information that 
you want to paste.

2. Click Paste.
The information appears as a multiline caption 
below the structure. You can edit this information 
with the text tool.
Figure 6.241: Adding analysis information to a struc-
ture

The information in the label updates automatically 
as you edit the structure. You can show or hide the 
information as follows:

1. Right-click in the label. It does not matter 
which tool you are using.

2. Point to Analysis, and select or deselect the 
item you want to show/hide.

Elemental 
Analysis

The percent by weight of each 
element in the structure.

Table 28: Analysis properties

Property Description

O

HO OH

HO OH

HO

Chemical Formula: C6H12O6
Exact Mass: 180.06

Molecular Weight: 180.16
m/z: 180.06 (100.0%), 181.07 (6.9%), 182.07 (1.4%)

Elemental Analysis: C, 40.00; H, 6.71; O, 53.29

glucose
CambridgeSoft
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Figure 6.242: Analysis context menu 

Showing Stereochemistry
When the Show Stereochemistry option is selected, 
ChemDraw calculates the absolute stereochemistry 
for tetrahedral atoms and double bonds according 
to the Cahn-Ingold-Prelog (CIP) priority rules. For 
more information about the CIP rules, see “Stere-
ochemistry” on page 234.
Only tetrahedral and double-bond stereochemistry 
are supported, and only non-racemic stereochemis-
try is interpreted. Stereochemical indicators for 
aromatic bonds are not shown.
ChemDraw calculates and displays the following 
stereochemical terms:

• (R), (S)—Standard tetrahedral stereochemis-
try

• (r), (s)—Tetrahedral stereochemistry deter-
mined by other stereochemical centers. For 
example: cis-decalin and myo-inositol.

• (E), (Z)—Standard double-bond stereochem-
istry

The atom label settings determine the font style 
and size of the terms. A setting on the Build-
ing/Display tab of the Preferences dialog box 
determines whether or not the term will be dis-
played in parentheses. (The default is to display 
parentheses.)

Stereochemistry Indicators
To show the stereochemistry of a structure:
ChemDraw 10
1. Select the entire structure.
2. Right-click and click Object Settings.
3. Check the appropriate boxes for atom and 

bond stereochemistry.
The stereo-centers are marked as shown in the 
following example.

Figure 6.243: Stereochemistry indicators 

If you make changes to the drawing that affect the 
stereochemistry, the stereochemistry is recalcu-
lated.

Hiding Indicators
To hide an individual indicator:

1. Select the indicator to hide.
2. Right-click and choose Hide Indicator.

Removing Indicators
To delete an indicator:

1. Click the indicator.
2. Click the eraser tool and click the indicator.

Positioning Indicators
Stereochemistry indicators are positioned automat-
ically and move appropriately if a structure is mod-
ified. You can reposition them by dragging them to 
the desired position or with the Indicator Position 
dialog box.
To reposition an indicator numerically:

Cholesterol 60%

cholesterol

(S)

(S)

(S)

(R)

(R)

(R)

(S)

(R)

HO

H

H

H

(Z)
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1. With a selection tool, click the indicator to 
move.

2. Right-click and choose Position.
The Position Indicator dialog box appears.

Figure 6.244: Position Indicators dialog box 

3. Click the appropriate Position option, and type 
a value:

Relative Stereochemistry
Stereochemical representation has been enhanced 
to allow specification of relationships between 
groups of stereo-centers within a molecule. The 

Table 29: Indicator positioning options

To Position … Type a value for 
the position 
by…

from the atom or bond 
center to indicator 
center

angle, in degrees 
or
clock, in clock time

from the atom or bond 
center to bottom left of 
indicator baseline

offset, horizontal 
and vertical

at specified coordinates absolute, horizontal 
and vertical

Position Indicators 150 dpi 

ProPro
114• Chemistry Features
new notation gives you the ability to describe com-
plex enantiomers in a compact form. 

The new notation is added to a structure by select-
ing an atom and choosing Enhanced Stereochem-
istry from the Structure menu. 
Figure 6.245: Adding Stereochemistry

See “Stereochemistry Indicators” on page 113 for 
information on showing and hiding indicators.
The power of this new notation becomes clear 
when you draw complex enantiomers. For exam-
ple, beta-Cypermethrin is a mixture of four distinct 
stereo isomers consisting of two enantiomeric 

Table 30: Stereochemical Notation

New Notation Old Notation

abs

OH OH Abs

&1

OH OH Rac

or1

OH OH Rel
CambridgeSoft
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pairs. Drawing this with the old notation requires 
two structures.
Figure 6.246: beta-Cypermethrin

Both stereo-centers marked with arrows in Figure 
6.246 have the &1 designation because of their 
fixed relative configuration: when one is (R) the 
other must be (S). In other words, they form a 
group. 
To indicate stereochemistry for a group: 

1. Select all atoms in the group using Shift + click. 
2. Select the appropriate Enhanced Stereochem-

istry from the Structure menu. 
The third stereo center varies independently, and 
thus gets the &2 designation. Group numbers are 
incremented automatically, but can be edited man-
ually.
ChemDraw Enhanced Stereochemistry can be 
saved in the following formats:

• CDX
• CDXML

Cl Cl

&2
(S)

&1
(S)

O

O

(R)
&1

O

N

O

O(S)

O

(S)

Cl Cl
N

O

(R)
O(S)

O

(R)

Cl Cl
N

and

(R)

Rac

Rac

Old notation

New notation
ChemDraw 10
• MOL V3000
• RXN V3000
• SKC
• TGF 

When saving to SKC or TGF format, the indica-
tors are converted into corresponding Data 
SGroups. When ChemDraw opens SKC or TGF 
files containing such Data SGroups, they are con-
verted into true Enhanced Stereochemistry values. 

Converting Structures to 3D
You can convert a two-dimensional structure 
drawn in ChemDraw to a three-dimensional struc-
ture. To use this feature, you must have Cam-
bridgeSoft Chem3D installed on your computer.
To convert a structure to 3D:

1. Select the structure to convert.
2. Click the Get 3D Model command on the Edit 

menu.
The 3D structure appears in the document 
window.

NOTE: 3D Objects inserted in this way cannot be trans-
ferred between platforms. For more information see “File 
Formats” on page 170.
To edit the 3D structure:

1. Double-click the 3D structure.
Chem3D opens.

2. Edit the structure and close Chem3D when 
you are finished.
The edited structure appears in the ChemDraw 
document window.

Viewing Chemical 
Properties 
ChemDraw Pro and Ultra, using an add-on, 
ChemProp, calculate predicted values for the phys-
ical and thermodynamic properties of a selected 

ProPro
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structure of up to 100 atoms. You can view the val-
ues in the Chemical Properties window.
The properties are calculated using the most reli-
able methods for calculation for the given struc-
ture. Log P and MR values based on literature 
values rather than a calculation are included in the 
report file.

Viewing the Chemical Prop-
erties Window
To view predicted properties for a selected struc-
ture:

1. Select the structure to analyze.
116• Chemistry Features
2. Click the Show Chemical Properties Window 
command on the View menu.
The Chemical Properties window appears. 

Figure 6.247: Chemical properties window 

ChemProperties
150 dpi
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The following basic values are displayed.

Table 31: ChemDraw chemical properties 

Property Description

Boiling Point The boiling point for the 
structure. Reported in Kelvin 
at 1 atm. 

Melting Point The melting point for the 
structure. Reported in Kelvin 
at 1 atm. 

Critical Tempera-
ture

The temperature above 
which the gas form of the 
structure cannot be liquefied, 
no matter the applied pres-
sure (Tc). Reported in Kelvin.

Critical Pressure The minimum pressure that 
must be applied to liquefy the 
structure at the critical 
temperature (Pc). Reported in 
bars. 

Critical Volume The volume occupied at the 
compound’s critical tempera-
ture and pressure (Vc). 
Reported in cm3/mol.

Gibbs Energy The Gibbs free energy, ΔG, 
for the structure. Reported in 
kJ/mol at 1 atm and 298.15K.

Henry’s Law The inverse of the logarithm 
of Henry’s law constant 
[-log (H)] (no units).
ChemDraw 10
NOTE: The CLogP and CMR algorithms incorporated in 
ChemDraw are licensed from BioByte Corp, and have been 
extensively tested and peer-reviewed as providing highly accu-
rate results. The values produced by these algorithms in 
ChemDraw should be exactly the same as values produced by 
the standalone CLogP and CMR applications from Bio-
Byte.
For further information about CLogP and CMR, please 
refer to the BioByte web site at:
http://www.biobyte.com
To paste the basic properties into your document:

• Click Paste.
To create a report and view results for other frag-
mentation methods including the Broto, Crippen, 
Viswanadhan, Joback, and Joback/Stein methods:

• Click Report.
When you create a report, a detailed list of infor-
mation used for performing the calculation is 
shown in a text file. The list includes additional 

Heat of Forma-
tion

The heat of formation, ΔHf, 
for the structure. Reported in 
kJ/mol at 1 atm and 298.15K.

tPSA Calculation of polar surface 
area based on fragment 
contributions.

CLogP The calculated 
n-octanol/water partition 
coefficient (log Pow).

CMR The calculated Molar Refrac-
tivity 

Table 31: ChemDraw chemical properties 

Property Description

UltraUltra

UltraUltra
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properties and literature references used to per-
form the calculation.
Figure 6.248: Fragmentation tools palette 

Stoichiometry Grid
The Stoichiometry Grid is a tool that calculates 
stoichiometric data for a reaction. It is filled in 
automatically as you modify a reaction drawing.
To create a Stoichiometry Grid:

1. Draw a reaction, or open a file containing a 
reaction, and select the entire reaction.

2. Click the Analyze Stoichiometry command on 
the Structure menu. 
The Grid appears under the reaction.

UltraUltra
118• Chemistry Features
Figure 6.249: Stoichiometry Grid

TIP: If you have a chemical label on the arrow that does not 
enter in the reaction, but rather indicates a catalyst or condi-
tion, right+click on the label and deselect Interpret Chem-
ically in the context menu before creating the grid. 
To enter data in the grid:

1. Select the Text tool, and click in the empty col-
umn to enter a value.

Figure 6.250: Entering data in the Grid

2. Set the limiting compound. If the default set-
ting is incorrect, point to the word “No” in the 
correct column, right-click or control-click, 
and select Set Limiting from the context menu.

H3C H

O
catalyst

H3C

OH

CN
CN

R e a c t a n t s P r o d u c t s
Formula
MW
Limiting?
Equivalents
Sample Mass
%Weight
Molarity
Density
Volume
Reactant Moles
Reactant Mass

Formula
MW
Equivalents
Expected Mass
Expected Moles
Measured Mass
Purity
Product Mass
Product Moles
%Yield

C3H3N
53.06
Yes

C2H4O
44.05
No

C5H7NO
97.12
CambridgeSoft
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3. Enter values for all reactants, as applicable. If 
you are using units other than the defaults, type 
in the units along with the values (no space 
required).

As soon as you have entered the minimum amount 
of information required, ChemDraw will calculate 
values. As you continue entering information, or 
edit inputs, the values are re-calculated. Entered 
values are in bold-face; calculated values are in nor-
mal font.
Figure 6.251: Calculated stoichiometric values

Table 32: Stoichiometry Input Values

Value Comments

Limiting reac-
tant

Only one reactant may be specified 
as limiting. 

Sample Mass Weight of reactant. Default units: 
g. 

%Weight Reactant purity. Defaults to 100%.

Volume Default units: ml Requires either a 
Molarity or a Density value to also 
be entered. 

Molarity Default units: M

Density Default units: g/ml

R e a c t a n t s P r o d u c t s
Formula
MW
Limiting?
Equivalents
Sample Mass
%Weight
Molarity
Density
Volume
Reactant Moles
Reactant Mass

Formula
MW
Equivalents
Expected Mass
Expected Moles
Measured Mass
Purity
Product Mass
Product Moles
%Yield

C3H6O2S
106.14
Yes

807.50g/l
100.00ml
760.76mmol

80.75g

C2H4O
44.05

No

788.00g/l

760.76mmol

33.51g

C5H10O3S
150.20

114.26g

760.76mmolEntered values
ChemDraw 10
You can edit the grid for presentation with the 
context menu, showing or hiding either rows or 
columns. You can also change the color of the text.

Expand Generic 
Structures
You can generate multiple structures from an 
abbreviated combinatorial structure with Chem-
Draw’s Expand Labels tool. The tool is designed 
for “small” expansions, and is limited to a maxi-
mum of 500 generated structures. For large combi-
natorial expansions, use CambridgeSoft’s 
CombiChem for Excel. Four kinds of abbreviated 
combinatorial definitions may be used:

Table 33: Combinatorial definition types 

definition example

Alternative 
Groups and 
R-tables

Anony-
mous Alter-
native 
Groups

ProPro

R1
1

R1

F1

Cl1

Br1

NH21

[OMe, OH, NH2]
Chemistry Features • 119
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Definitions are expanded into multiple complete 
molecules. If more than one site is present in the 
selection, the expansion will include all permuta-
tions of substitutions. Expansions are generated 
into a new document.
To generate a combinatorial library:

1. Select at least one combinatorial substitution 
definition.

Element 
Lists

Variable 
Attachment

Table 33: Combinatorial definition types 

definition example

[I, Br, Cl, F]

1

CH3
120• Chemistry Features
Figure 6.252: Selecting a generic structure 

NOTE: For alternative group/R-tables, both the 
alternative group label and the table must be selected. If 
the label is selected but not the table, the label will not 
be modified by the expansion, and will appear as a label 
in all generated structures.

2. Choose Expand Generic Structure from the 
Structure menu.
The structures are generated to a new docu-
ment.

Figure 6.253: Expanded generic structure 

CH3

1

1

CH3

1

CH3

1

CH3
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Chapter 7: Struct<=>Name

Overview
Struct<=>Name is CambridgeSoft’s package of 
structure-to-name and name-to-structure algo-
rithms included with ChemDraw Ultra. Together, 
they give you unprecedented power and conve-
nience in creating and naming structures.
Struct=Name generates systematic names for 
chemical structures with support for the Cahn-
Ingold-Prelog rules for stereochemistry. It is under 
continuing development to improve the range of 
compounds covered. 
Name=Struct is a comprehensive algorithm for 
converting English chemical names into chemical 
structure diagrams. It is designed to interpret 
chemical names as they are actually used by chem-
ists. In other words, it recognizes the shorthand 
and slang of everyday usage, in addition to recog-
nizing most of the official IUPAC, IUBMB, and 
CAS rules and recommendations. In addition, it 
has an extensive algorithm for the identification of 
common “typos” (typing errors, such as “mehtyl”) 
to increase the odds of generating structures for 
the names it is given.

Improvements to Struct=Name
In ChemDraw 10, Struct=Name has added support 
for the following nomenclature types:

• Ring assemblies of two ring systems of any 
type, such as binaphthyl. (added in 9.0.1)

• Spiro fusions between two ring systems of any 
type. (added in 9.0.1)

• Ring fusions involving multiple rings attached 
to a single core, such as dibenzo[b,d]furan.
ChemDraw 10
 Struct=Name 
You can insert the name of a selected structure as a 
caption using the Convert Structure to Name com-
mand from the Structure menu.
The Struct=Name algorithm in use since Chem-
Draw 8.0 is a new proprietary naming algorithm 
developed by CambridgeSoft. It replaces Beil-
stein’s AutoNom algorithm used in earlier versions 
of ChemDraw. In ChemDraw 10.0, an auto-update 
feature has been added that renames the structure 
as you modify it.
The conversion of a structure to a name is limited 
by many factors. Specifically, Struct=Name makes 
little or no attempt to name the following:

• Bridged ring systems with more than one 
bridge (for example, tricycles.)

• Radicals. 
• Compounds with non-standard valence states.
• Spiro ring systems.
• Isotopically modified compounds.
• Polymers.
• Biochemicals. including specialized nomencla-

ture for amino acids, carbohydrates, and ste-
roids. For such compounds, only the fully 
systematic organic name is produced. 

Nomenclature types added in ChemDraw 10.0 
include:

• Most of the most-common fused ring systems, 
both those with trivial names (naphthalene, 
indole) and those with systematic names 
(benzo[e][1,4]diazepine, thieno[3,2-
b]thiophene).

• Most salts.
• Structures with a net charge.
Struct<=>Name • 121
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• Simple mixtures and multicomponent systems.
• Heterochains.
• Multiplicative nomenclature.
• Ring assemblies.
• Bicyclics.
• Basic inorganics.

Nomenclature types added in ChemDraw 10.0 
include:

• Ring assemblies of two ring systems of any 
type, such as binaphthyl. (added in 9.0.1)

• Spiro fusions between two ring systems of any 
type. (added in 9.0.1)

• Ring fusions involving multiple rings attached 
to a single core, such as dibenzo[b,d]furan.

Struct=Name generates names with proper CIP 
stereochemistry descriptors. It has no theoretical 
limits to the size of the structures that can be 
named.
To insert the name of a structure into your draw-
ing:

1. Select the drawing for which you want to insert 
a name.

Figure 7.254: Selecting the drawing

2. Click the Convert Structure to Name command 
on the Structure menu.

Figure 7.255: Adding a name

cyclohexane
122• Struct<=>Name
The name of the structure appears as a caption 
under your drawing.

 Auto Update
ChemDraw 10.0 captions include a “hot-link” fea-
ture. Chemical properties, including the chemical 
name and analysis, can be included in a caption, 
and will update automatically when you modify the 
structure. For more information on adding data to 
captions, see “Adding Analysis Data to a Caption” 
on page 58.
To toggle the hot-link feature:

1. Point to the label.
2. Right-click and select Auto-update.

A check mark appears next to the command 
when it is selected. Successive clicks toggle the 
command on and off.

When auto-update is on (default) the label updates 
each time you modify the structure. 
NOTE: For large complex structures, it may take the new 
label a few seconds to appear on the screen, depending on the 
speed of your processor. You do not have to wait for the new 
label to appear before continuing to modify your structure.

 Name=Struct
You can draw a structure automatically from a 
chemical name using Name=Struct. 
Name=Struct recognizes most organic nomencla-
ture. Inorganic chemistry is also usually recog-
nized, especially when the rules closely match 
those for organic chemistry. 
The following are not supported:

• Coordination complexes
• Polyboranes
• Polymers
• Some highly-bridged ring systems, including 

fullerenes and porphyrins/porphines
• Some stereochemistry designators: +, -, +/-, 

+-, D, L, DL, endo, exo, syn, anti, r, t, c
CambridgeSoft
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Although some trade names are supported, 
Name=Struct is not intended to interpret trade or 
common names. A chemical database, such as 
chemfinder.com, is more appropriate for obtaining 
structures for trade or common names. See “Find-
ing Information on ChemFinder.com” on page 
272 for more information.
NOTE: Because the syntax of German is very similar to 
that of English, Name=Struct can also interpret many Ger-
man names. Chemical names in other languages, however, 
will generally not be recognized.

 Converting Names to Structures
There are two ways to insert a name into the 
document window as a structure:

• Insert Structure dialog box 
• Paste Special command

Insert Structure
Insert Structure is designed for typed-in entries. 
For example, to insert 2-bromobenzoic acid:

1. Choose Convert Name to Structure from the 
Structure menu.
The Insert Structure dialog box appears.

2. Type 2-bromobenzoic acid.
Figure 7.256: Insert Structure dialog box 

NOTE: You can also copy a name to the clipboard 
and type Crtl+V or Command+V to paste the name 
into the dialog box.

3. Click OK.
The molecular structure and name (if “Paste 
name below structure” is selected) appear in 
the drawing area.
ChemDraw 10
Figure 7.257: Inserting a named structure 

If you should happen to type the name incorrectly, 
Insert Structure will try to correct the error.
Figure 7.258: Typographical error warning 

Click OK to accept the suggested spelling, or click 
Cancel and start again to make a manual correc-
tion.

Paste Special
The Paste Special command allows you to paste a 
name, copied to the clipboard from another appli-
cation, as a structure in ChemDraw.
To paste a name from the clipboard:

1. Click in the document window.
2. Point to Paste Special on the Edit menu, and 

choose Name as Structure.
The structure appears in your document.

 Converting Captions to Struc-
tures
If a caption is already present in the drawing area 
you can convert it to a structure as follows:

1. Select the caption.
Figure 7.259: Selecting a caption

Br

OH

O

2-bromobenzoic acid

2-bromobenzoic acid
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2. Choose Convert Name to Structure from the 
Structure menu.
The molecular structure and name appear in 
the drawing area.
124• Struct<=>Name
 Types of Structures Supported by 
Struct=Name
Struct=Name can name compounds in the follow-
ing classes of structures:
Table 34: Struct=Name supported structure types

category ChemDraw 8 supports... ChemDraw 9 adds...

principal groups in both rings 
and chains

Acid Halides Amide derivatives of acids

Alcohols and chalcogen analogs Anhydrides

Aldehydes and chalcogen analogs Carbonic acids

Amides Imides 

Amines and Imines Nitric acids

Carboxylic Acids Peroxy acids

Carboxylic Esters Salts

Heteroatomic acid halides Sulfides and chalcogen analogs 

Heteroatomic acids (P, B, As) Sulfoxides and chalcogen analogs

Heteroatomic esters

Hydrazides

Hydrazines

Hydroperoxides

Ketones and chalcogen analogs

Nitriles

Peroxides

S, Se and Te Amides

S, Se, and Te Acid Halides

S, Se, and Te Acids

S, Se, and Te Esters

Ringed structures Carbomonocyclic structures Bridged monocyclic structures

Heteromonocyclic structures
CambridgeSoft
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Fused polycyclic trivially-named 
structures

Ring fusions of only two rings

Ring fusions of two multiple ring 
systems

Other compounds Phosphorous and Arsenic 
compounds

Si, Ge, Sn, and Pb compounds

Boron compounds

Organometallic compounds 

Table 34: Struct=Name supported structure types

category ChemDraw 8 supports... ChemDraw 9 adds...
ChemDraw 10
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Chapter 8: ChemNMR
Spectrum-Structure 
Assignments 
ChemDraw Ultra enables you to assign structures 
to spectra.You can then display the structure asso-
ciated with a specific peak by placing the pointer 
on that peak.

Assigning Structures to Spectra
To assign structures to a spectrum:

1. Open a spectral file.
2. Draw the structure or structures you want to 

assign to the spectrum.
3. Select specific atoms and bonds in the struc-

ture.
4. Shift-click the peak or peaks to which you want 

the structure assigned.
The selection rectangle surrounds the selected 
objects.

UltraUltra
ChemDraw 10
Figure 8.260: Selecting the structure and related spec-
trum

5. Click the Make Spectrum-Structure Assign-
ment command on the Structure menu.
The selected atoms and bonds in the structure 
are associated with the selected spectral peaks.

Viewing Spectral Assignments
To view the spectral assignments:

1. Click the Lasso or Marquee tool.
2. Place the pointer over a peak.

The assigned atoms or bonds are highlighted.

0246810
PPM

O

ChemNMR • 127
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Figure 8.261: Viewing spectrum-structure assignments 

Removing Spectral Assignments
To remove spectrum to structure assignments:

1. Click the Lasso or Marquee tool.
2. Select the objects from which to remove the 

assignment.
3. Click the Clear Spectrum-Structure Assign-

ment command on the Structure menu.
128• ChemNMR
NMR Shift Informa-
tion—ChemNMR 
ChemNMR is a feature of ChemDraw Ultra only. 
ChemNMR estimates and displays proton and car-
bon-13 chemical shifts in ppm for a selected mole-
cule.

To view 1H or 13C NMR information:
1. Select the target chemical structure.

Figure 8.262: Selecting a target 

2. Click the 1H-NMR Shifts or 13C-NMR Shifts 
command on the Structure menu.
ChemNMR redraws the molecule with the esti-
mated shifts and displays the information and 
line spectrum in a new window as shown 
below. 

UltraUltra
CambridgeSoft
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Figure 8.263: Displaying the NMR spectrum 

H

H

7.02

7.02

7.18

7.01 3.22

6.58

6.39

ChemNMR H-1 Estimation

Estimation Quality: blue = good, magenta = medium, red = rough

Protocol of the H-1 NMR Prediction:

Node   Shift    Base + Inc.   Comment (ppm rel. to TMS)

  CH    7.02        7.26      1-benzene
                   -0.12      1 -C=C
                   -0.12      1 -C
  CH    7.02        7.26      1-benzene
                   -0.05      1 -C=C
                   -0.19      1 -C
  CH    7.18        7.26      1-benzene
                    0.04      1 -C=C
                   -0.12      1 -C
  CH    7.01        7.26      1-benzene
                   -0.05      1 -C=C
                   -0.20      1 -C
 CH2    3.22        1.37      methylene
                    1.22      1 alpha -1:C*C*C*C*C*C*1
                    0.63      1 alpha -C=C
   H    6.58        5.25      1-ethylene
                    1.65      1 -1:C*C(R)*C*C*C*C*1 gem
                   -0.32      1 -C-1:C*C*C*C*C*C*1 trans
   H    6.39        5.25      1-ethylene
                    0.09      1 -1:C*C(R)*C*C*C*C*1 trans
                    1.05      1 -C-1:C*C*C*C*C*C*1 gem

01234567
PPM
ChemDraw 10
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Chapter 9: Drawing Objects

Overview
ChemDraw provides the following tools and tool 
palettes that enable you to add chemical symbols 
and shapes to your documents (A tool palette is 
indicated by a in the lower right corner of the 
tool.):

• Orbital tools palette —to draw orbitals.

• Chemical Symbols tools palette —to 
draw charges, radicals, and other symbols.

• Arrow tools palette —to draw arrows.

• Drawing Elements tools palette —to 
draw boxes, circles, and lines.

• Brackets tools palette —to draw brack-
ets, braces, parentheses, and daggers.

• Arc tools palette —to draw arcs.

• Pen tool —to draw freehand shapes.

• TLC tool . to reproduce TLC experi-

ments.

You can use the tool palettes as extensions of the 
Main Tool Palette, or you can tear them off and 
place them anywhere on your screen.
Object behavior has improved in ChemDraw 10.0. 
Most objects, with the exception of daggers and 
some symbols, can be now be rotated as well as 
scaled. Arrows have been completely revamped.
ChemDraw 10
Selecting Tools From a 
Palette
Some tools have a palette containing different 
types of that tool. When you choose a tool type 
from the palette, it becomes the default tool. To 
use a different tool type, select it.
To select a tool and use its default tool type, click 
the tool’s icon to select it.
To choose a different tool type from the palette:

1. Click the tool’s icon and hold down the mouse 
button.
The palette appears.

2. Drag to select a tool type from the palette.
3. Release the mouse button over the tool you 

want to select. 
The selected tool is now displayed on the Main 
Tools Palette.

To display a tools palette, do one of the following:

• Select the Other Toolbars command on the 
View menu, then select one of the palettes.

• Click the tool’s icon and drag to the palette’s 
title bar. Release the mouse button over the 
title bar.
The selected palette is displayed, and can be 
dragged anywhere on the screen.

The Orbital Tools Palette
Use the Orbital tools to add orbitals to your chem-
ical structures.
Drawing Objects • 131
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Figure 9.264: Orbital tools palette 

You draw orbitals so that the node appears first. 
Depending on the orbital type, available fill pat-
terns are:

• Background color
• Shaded
• Solid color

You can modify the fill colors with the Color 
menu.
Display the Info window to view the orbital’s 
length and angle relative to the X-axis while you 
draw it. You can constrain the length and angle of 
an orbital by selecting Fixed Lengths and Fixed 
Angles on the Object menu.
NOTE: Orbitals are not normally part of the structure they 
are drawn near and are not selected when you double-click a 
bond, atom, or atom label with a selection tool. To group the 
orbitals with the structure, use the Group command from the 
Object menu. For more information, see “Grouping Objects” 
on page 68.

s-orbitals
The s-orbital tools are shown in Figure 9.265:
Figure 9.265: s-orbital tools

To draw an s-orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the s-orbital tool 
from the palette.

2. Point to an atom where the orbital will be cen-
tered.

3. Drag outward.
132• Drawing Objects
Figure 9.266: Adding an s-orbital to an atom

Sigma Orbitals
The σ-orbital tools are shown in Figure 9.267:
Figure 9.267: Sigma orbital tools 

To draw a σ-orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the σ-orbital tool 
from the palette.

2. Point where the orbital will be centered.
3. Drag outward along the long axis of the orbital.

Figure 9.268: Adding a sigma orbital to an atom 

Single Lobe Orbitals
Single lobe orbitals are commonly used for indicat-
ing a lone pair. The single lobe orbital tools are 
shown in Figure 9.269:
Figure 9.269: Single lobe orbital tools 

To draw a single lobe orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the single lobe 
orbital tool from the palette.

2. Point to an atom where the narrow end of the 
orbital is to be attached.
CambridgeSoft
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3. Drag from the narrow end of the lobe to its 
wide end.

Figure 9.270: Adding a single lobe orbital

p-orbitals
The p-orbital tools are shown in Figure 9.271:
Figure 9.271: p-orbital tools 

To draw a p-orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the p-orbital tool 
from the palette.

2. Point to an atom where the node of the orbital 
is to be attached.

3. Drag from the orbital node to the wide end of 
the filled lobe.

Figure 9.272: Adding a p-orbital to an atom 

Hybrid Orbitals
The hybrid-orbital tools are shown in Figure 9.273:
Figure 9.273: Hybrid orbital tools 

To draw a hybrid orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the hybrid-orbital 
tool from the palette.
ChemDraw 10
2. Point to an atom where the node of the orbital 
is to be attached.

3. Drag from the orbital node to the wide end of 
the major lobe of the orbital.

Figure 9.274: Adding a hybrid orbital to an atom 

d-orbitals
The d-orbital tools are shown in Figure 9.275:
Figure 9.275: d-orbital tools 

To draw a d-orbital:
1. Hold down the mouse button over the Orbital 

tool  and drag to select the d-orbital tool 
from the palette.

2. Point to an atom where the node of the orbital 
is to be attached.

3. Drag from the center of the orbital to the wide 
end of a filled lobe.

Figure 9.276: Adding a d-orbital to an atom 

dz2-orbitals
The dz2-orbital tools are shown in Figure 9.277:

Figure 9.277: dz2-orbital tools 

To draw a dz2-orbital:
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1. Hold down the mouse button over the Orbital 
tool  and drag to select the dz

2-orbital tool 
from the palette.

2. Point to an atom where the node of the orbital 
will be attached.

3. Drag from the center of the orbital to the wide 
end of a lobe.

Figure 9.278: Adding a dz2-orbital 

The Chemical Symbols Tools 
Palette

Use the Chemical Symbols tools  to add 
chemical symbols to your structure. When you 
click the Chemical Symbols tool, the palette shown 
in Figure 9.279 appears:
Figure 9.279: Chemical symbols palette 

When you attach a symbol (other than H-dot or H-
dash) to an atom, it remains at a fixed distance 
from the central character of the atom label. If you 
drag the symbol, it will maintain that fixed distance 
as it moves around the atom. 
You can, however, use a symbol without attaching 
it to an atom, place or move it anywhere, and resize 
it.

H-dot and H-dash
To represent a hydrogen atom that is coming out 
of the plane toward you along the Z-axis, use the 
H-dot symbol .

Symbols 94 dpi
134• Drawing Objects
To represent a hydrogen atom that is directed 
backwards into the plane away from you along the 

Z-axis, use the H-dash symbol . You can draw 
H-dots and H-dashes only by clicking atoms.
 To draw an H-dot or an H-dash:

1. Hold down the mouse button over the Chem-
ical Symbols tool  and drag to select the 
symbol from the palette.

2. Click an atom.
Figure 9.280: Adding an H-dot symbol to an atom 

Lone Pair 

Use the lone pair symbol  to indicate a lone 
pair of electrons common in Lewis structure repre-
sentations.
To draw a lone pair:

1. Hold down the mouse button over the Chem-
ical Symbols tool  and drag to select the 
lone pair from the palette.

2. Click the atom where you want the lone pair 
located, or drag in the appropriate direction to 
position it.
The lone pair is offset from the atom at a fixed 
position.

Figure 9.281: Adding a lone pair to an atom

O

O

O

H-dot symbol

OH
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Radical 

Use the radical symbol  to indicate a single 
non-bonded electron.
To draw a radical symbol:

1. Hold down the mouse button over the Chem-
ical Symbols tool  and drag to select the 
radical from the palette.

2. Point to the atom where you want the radical 
symbol to appear.

3. Click to draw the symbol.

Radical Cation and Radical Anion

Use the charge radical symbols   to repre-

sent radicals that are charged.
To draw a radical cation or radical anion symbol:

1. Hold down the mouse button over the Chem-
ical Symbols tool  and drag to select the 
symbol from the palette.

2. Point to the atom where you want the symbol 
to appear.

3. Drag from the charge portion of the symbol to 
the radical portion of the symbol.

To add a radical cation or radical anion symbol in a 
horizontal orientation, click an atom.

Charge Symbols
Use the charge symbols to represent charges on 

structures.     

To draw a charge and associate it with a structure:
1. Hold down the mouse button over the Chem-

ical Symbols tool  and drag to select the 
charge symbol from the palette.

2. Click to the atom to which you want the charge 
to correspond.
The number of hydrogen atoms increases or 
decreases as appropriate for the addition of the 
charge. 
ChemDraw 10
Figure 9.282: Adding a charge symbol 

Attachment Points
The ability to indicate an attachment point is useful 
in polymer-bound combinatorial synthesis, pro-
tein chemistry, and other situations. ChemDraw 
has four standard attachment point drawing tools 
that allow you to indicate a point of attachment 
while maintaining chemical meaning.
Figure 9.283: Attachment point symbols 

The bead tool is specifically intended to indicate 
attachment to a resin, but the tools are inter-
changeable. Any if these tools may be used for 
variable attachments in queries (see “Multi-Center 
and Variable Attachments” on page 73), but only 
the diamond tool will show rank numbers. That is, 
if you add more than one diamond to a structure, 
the points will automatically number sequentially.

H2N

H

NH3

O

OH

H3N

H

NH3

O

OH

∗
1
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Rotating a Symbol
You can rotate the radical anion, cation, and lone 
pair symbols by dragging the rotation handle on 
the selection Rectangle. All symbols are rotated 
around the same end from which they were origi-
nally drawn. For example, the radical cation sym-
bol is rotated and resized from the charge. The 
Info window shows the angle that one of the ends 
of a symbol makes with the X-axis as you rotate 
symbols. 
To rotate a chemical symbol: 

1. Select the chemical symbol with a selection 
tool.

2. Drag the rotation handle on the chemical sym-
bol.

For more information about rotating and resizing, 
see “Rotating Objects” on page 65.

The Arrow Tools Palette
Arrows are now customizable not only for length 
and angle, but for arrowhead width and shape. You 
can drag an arrow from the middle to create an arc, 
allowing you to create arcs of any length.
When you mouse-over an arrow with the Lasso, 
Marquee, or an Arrow tool selected, ChemDraw 
switches into edit mode and adjustment handles 
appear on the arrow. 
Figure 9.284: Arrow adjustment handles

Drag the adjustment handles to change the arrow 
length, angle, or shape. Two different cursors 
appear, one for arcs and arrowhead shape , the 

length adjustment

arc 
adjustment

arrowhead length and width
arrowhead shape
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other for arrow length or arrowhead length and 
width.  When changing the angle of an arrow, 
you are restricted to multiples of 15° if the Fixed 
Angles option in the Object menu is selected. Hold 
down the Alt or option key to drag to any angle.
Figure 9.285: Arrow Cursors

There are three basic arrowhead shapes, solid, hol-
low, and angled. Change the arrowhead type from 
the context menu (see Figure 9.292) after creating 
an arrow .
Figure 9.286: Arrow head types

Angled-head, or “line segments”, was a user-
requested feature. Another user-requested feature 
is “square” heads. 
Figure 9.287: Square arrow head 

ChemDraw 10.0 introduces four new arrow types: 
two types of crossed (no-go) arrows, equilibrium 
arrows of unequal lengths, and elliptical arcs. In 
addition, you can create several new arc types (see 
Figure 9.290). 
For equilibrium arrows, changing the length 
changes both arrows proportionately; changing the 
shape of the arrowhead changes both arrowheads 
identically. To change the length of only one 
arrow, hold down the Alt or option key. Two new 
CambridgeSoft
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adjustment handles appear. When you have created 
a disequilibrium arrow, only the shorter side can be 
adjusted further.
Figure 9.288: New Arrow Types

Dragging the adjustment handle on the line seg-
ment creates an arc of increasing radius. After 
choosing a radius, you can then adjust the arc from 
1° to 359° by dragging the length. (At 360°, the line 
becomes a point, and the arc starts over again.) 
The assortment of pre-drawn arcs on the Arrows 
Palette are for your convenience, and are customiz-
able like other arrows. Figure 9.289shows an arrow 
and two arcs created from it.
ChemDraw 10
Figure 9.289: Arc Variations from a Single Arrow

All arrows, except hollow or equilibrium arrows, 
can be made into arcs. This means that dashed, 
thick, double-headed, and crossed (no-go) arrows 
can all be arcs.
Figure 9.290: Arc Variations 

Click a modified arrow (with the same arrow tool) 
to undo all changes to the shape, but not length, of 
the arrow. Use Undo (Ctrl+Z) to step back 
through multiple changes, or to undo changed 
length. Click an unmodified arrow, or one that has 
had only its length changed, to reverse its direction.
Hollow arrows have only two types of adjustment 
handle—length and width. Changing the arrow-

drag here to increase the diameter of an arc

drag here to lengthen an existing arc
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head width also changes the width of the line seg-
ment.
Figure 9.291: Hollow Arrow adjustment handles

You can modify arrows with a Context menu. 
Some of the context menu commands are also 
available on the Curves menu. Use the Context 
menu to create arrows for which there are no tools, 
such as bold-dashed or dipole.
Figure 9.292: Arrows Context Menu 

Arrows “snap” together at their end or midpoints. 
To snap an arrow to an existing arrow, hold the 
Shift key down to disable the adjustment handles 
on the original arrow.
NOTE: The terms “left” and “right” in the context menu 
are relative, and refer to the direction the arrowhead is point-
ing.
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Figure 9.293: Snapping arrows

You can also drag existing arrows and snap them. 
This method allows you to connect two arrows at 
their midpoints.
Figure 9.294: Arrow Combinations 

Finally, arrows can be rotated with the Structure 
Perspective tool as well as the Lasso or Marquee. 
Combining these methods allows you to draw an 
unlimited number of arrows that are otherwise dif-
ficult to create.

The Drawing Elements Tools 
Palette
The Drawing Elements tools provides shapes you 
can add to your drawing.
Drawing elements are not a part of the structure 
they are drawn near. If you double-click on a bond, 
atom, or atom label with a drawing tool, they are 
not selected. To group drawing elements with a 

1. Hold the Shift key down. This disables the adjust
 handle and displays the snap point.

2. Continue to hold the Shift key down as you drag 
arrow up.
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structure, use the Group command in the Object 
menu. For more information, see “Grouping 
Objects” on page 68.
Some drawing element types are available with fill 
patterns: hollow (no fill pattern), gray, and black. 
You can change the type of box, circle, or oval 
using the Curves menu.
The Info window indicates the length and angle 
relative to the X-axis while you use any of the 
drawing element types.
Figure 9.295: Drawing elements palette 

Drawing Boxes
To draw a box:

1. Select one of the box tools.
Figure 9.296: Box tools 

2. Point where you want a corner of the box to be 
located.

3. Drag from one corner of the box diagonally to 
the opposite corner.

Drawing Circles and Ovals
To draw a circle or oval:

1. Select one of the circle or oval tools.
Figure 9.297; Circle and oval tools 
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2. Point where you want the center of the circle to 
be located.

3. Drag outward from the center. 

Resizing or Rotating Drawing 
Elements
Rectangles, circles, and ovals can now be adjusted 
in a similar manner to the new arrows. You no 
longer need to delete them and redraw from 
scratch. 
Pointing to a rectangle, circle, or oval with the 
same tool or a selection tool displays adjustment 
handles that can be dragged to reshape the object. 
Figure 9.298: Object adjustment handles

Circles have only a radius adjustment, but ovals 
and rectangles can be resized for both length and 
width. Rectangles also have corner handles that 
adjust length and width proportionately.
Rectangles, circles, and ellipses can now be freely 
rotated in three dimensions using the Structure 
Perspective tool. 
Figure 9.299: Perspective rotation of an objects

When an object has been distorted by such rota-
tion, dragging an adjustment point will modify the 
shape while preserving the perspective.
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Figure 9.300: Dragging a distorted drawing object 

Drawing Lines
Lines drawn with the line tool differ in two 
significant ways from bonds drawn with the bond 
tools: 

• They are not included in chemical interpreta-
tion of the drawing

• Lines that cross appear solid
To draw using a line tool:

1. Select a line tool.
Figure 9.301: Line tools 

2. Point where you want the line to start.
3. Drag from one end of the line to the other end.

The Brackets Tools Palette
Brackets includes braces { }, brackets [ ], and 
parentheses ( ).

Drawing Single Brackets
A single bracket can be drawn in any orientation.

To draw a single bracket:
1. Select a single bracket tool.

Figure 9.302: Single bracket tools 
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2. Point where you want the bracket to start.
3. Drag from one end of the bracket to the other 

end.

Drawing Paired Brackets
Paired brackets can only be placed in a vertical ori-
entation. A rectangle or box defines their position.
To draw a paired brackets:

1. Select a paired bracket tool.
Figure 9.303: Paired bracketed tools 

2. Point where you want a corner of the bracket 
to be located.

3. Drag from one corner of the box diagonally to 
the opposite corner.

Drawing Daggers
To draw a dagger:

1. Select a dagger tool.
Figure 9.304: Dagger tools 

2. Point where you want the symbol to be located.
3. Click to deposit the dagger.

NOTE: The size of the dagger symbol is proportional to the 
Atom Label font size specified in the Text Settings dialog 
box.

Framing Objects
You can enclose your drawings or group structures 
with a rectangle, brackets, parentheses, or braces. 
To enclose your object:

1. Select the drawing to enclose.
2. Point to the Add Frame command on the 

Object menu, and choose the type of frame to 
add.
CambridgeSoft
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The frame you selected is inserted in your 
drawing.

The Arc Tools Palette
Use the Arc tools to draw solid or dashed arcs of 
different angles: 90°, 120°, 180°, and 270°.
Figure 9.305: Arc tools palette 

Drawing Arcs
Where you access the arc tools depends on which 
version of ChemDraw you are using.
To draw an arc: 

1. Do one of the following:
• In ChemDraw Std, point to the Arc tool 

 and drag in the palette to select the 
angle. 

• In ChemDraw Pro or Ultra, point to the 
Drawing Elements tool  and drag in the 
tool palette to select the angle.

2. Dragging from left to right creates a convex 
arc; from right to left a concave one.
The Info window shows the length between 
the ends, and the angle the clockwise end 
makes with the X-axis while you draw an arc.

Editing Arcs
To resize or rotate an arc using the Arc tool:

1. Select the Arc tool, and position it over the arc.
Three drag point appear – one on each end and 
one in the middle.

Arcs 94 dpi
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2. Drag either end of the arc to lengthen it.
3. Drag the center point to change the radius.

The arc is resized and rotated. The Info window 
indicates the distance between the ends of the arc 
and the angle the clockwise end makes with the 
X-axis.
You can resize and rotate an arc by dragging the 
Resize or Rotation handle on the Selection rectan-
gle. The resize or rotation occurs around the center 
defined by the Selection rectangle. When you drag 
the Resize handle, the Info window indicates the 
percentage enlarged or reduced. When you drag 
the Rotation handle, the Info window indicates the 
degree rotated. For more information, see “Rotat-
ing Objects” on page 65 and “New Selection Box” 
on page 61.

The Pen Tool
Use the Pen tool to draw shapes that are not pro-
vided in the Arrow, Orbital, or Drawing Elements 
palettes. For example, you can draw irregularly 
shaped arrows, curves depicting graphs or reaction 
coordinate diagrams, and other irregularly shaped 
solids. 
The Pen tool has two modes:

• Drawing—Used to create shapes. The hand 
cursor appears with a “+” sign inside.

• Edit—Used to edit shapes. The hand cursor 
appears without a “+” sign inside. 

NOTE: To enter edit mode directly from drawing 
mode, press the Esc key.

Some examples of shapes that you can draw using 
the Pen tool are shown below.
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Figure 9.306: Drawing shapes with the pen tool 

To toggle between a selection tool and the Pen 
tool do one of the following:

• Press Ctrl+Alt+Tab or com-
mand+option+tab

• Click a selection tool.
The last drawn curve and a selection tool are 
selected.

Drawing Bézier Curves by 
Dragging
A Bézier curve is a curve that is calculated to con-
nect separate points into a smooth line.You can 
draw Bézier curves with the Pen tool by clicking 
and dragging repeatedly to create curved segments.
To draw a Bézier Curve:

1. Select the Pen  tool. 
2. Point to where you want the beginning of the 

curve to appear and click.
An anchor point appears, and the cursor 
changes from a “+” to a hand.

3. Move the cursor to another position and click.
A line connects the two points.

4. Position the cursor on one of the points (the 
“+” in the hand will disappear when you are 
correctly positioned) and drag to create an arc. 

Customized orbitals Unique arrows

Geometric shapesCurves and axes
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Figure 9.307: Drawing Bézier curves with the pen 
tool 

A direction line appears tangentially to the curve. 
Use the direction line to control the “curviness” of 
the segment. The slope of the direction line deter-
mines the slope of the curve. The length of the 
direction line determines the height of the curve. 
Direction points appear at the ends of the direction 
line. Use the direction points to adjust the curve by 
dragging a point. You can further adjust the shape 
by dragging an endpoint of the curve.
Figure 9.308: Adjusting a curve with the pen tool 

Drawing Segments by Clicking
You can draw shapes with corners by clicking 
repeatedly in an outline of the shape you want.
To draw segments:

1. Select the Pen  tool.
2. Point to where you want the beginning of the 

curve to appear.
3. Click to deposit an anchor point.
4. Move the cursor and click again to add a sec-

ond point.
5. Continue until you have the curve you want.

Anchor Point

Direction Line

Direction Point
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Figure 9.309: Drawing line segments with the pen 
tool 

6. Press the Esc key or click another tool. 
NOTE: To place the fewest strategically placed control 
points for obtaining the smoothest curve, work in a magnified 
view.

Editing a Curve
You can edit a curve by selecting it and manipulat-
ing it with the direction lines.
To select an existing curve:

1. Select the Pen  tool.
2. Point at the curve.

The cursor will change from a “+” to an arrow 
when you are positioned correctly.

3. Click to select the curve.
The direction lines appear.

Figure 9.310: Editing curves with the pen tool 

Changing the Shape of a Curve
Use the endpoints of the direction lines to increase 
or decrease the breadth of the curve or change its 
direction.
To change the shape of a curve:

step 3

step 4
ChemDraw 10
1. Select the Pen tool and click the existing curve 
you want to edit.

2. Drag the direction lines to create the shape you 
want.

Figure 9.311: Changing the shape of a curve 

Adding a Segment
To extend an existing curve by adding a segment:

1. Select the Pen tool and click the existing curve 
you want to edit.

2. Point to the endpoint of a curve until the cur-
sor appears as a hand.

Figure 9.312: Adding a segment to a curve 

3. Alt+click or option+click the endpoint.
The cursor appears as a hand with a “+” sign 
inside.

Figure 9.313: Adding a segment; continued 

4. Drag to connect more segments to your curve.

Deleting a Segment
To delete a curve segment, in the edit mode of the 
Pen tool, Alt+Shift+click or option+shift+click 
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the control point where you want to delete a curve 
segment.

The cursor appears as the Eraser tool before 
you click.

You can also delete entire curves using a selection 
tool or the Eraser tool.

Applying a Style to a Shape
All curves are drawn with the last curve style cho-
sen until you change the selections. Certain styles 
are mutually exclusive. For example, if you choose 
Closed, you cannot also choose Arrow at Start.
You can use the Doubled style to represent cell 
membranes. The lines are separated by twice the 
Bold Width setting for the drawing. Doubled lines 
cannot be dashed or include arrows.
To apply a style to a curve:

1. Select a curve using either the Pen tool or a 
selection tool.

2. Choose a style from the Curves menu.

Filled and Closed Styles
Figure 9.314 shows a shape with the Plain style 
applied. Figure 9.315 shows the same shape with 
the Filled and Closed styles applied. If you do not 
want to fill the shape with a solid color, choose 
Faded rather than Filled.
Figure 9.314: Plain style curve 

Figure 9.315: Filled and closed style curve 
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Shaded Style
You can apply shading to any curve, however the 
shaded style works best with convex or slightly 
concave shapes. Shading may not appear as desired 
in extremely concaved shapes. 
Figure 9.316 below shows shapes with the Plain 
style applied. Figure 9.317 shows the same shapes 
with the Shaded style applied.

Figure 9.316: Plain closed curves 

Figure 9.317: Shaded closed curves 

Plain Style
To remove all styles from a curve, with a curve 
selected, choose Plain from the Curves menu.

 The TLC Tool

The TLC Tool is a drawing tool that allows you to 
easily depict Thin Layer Chromatography plates 
within a ChemDraw document. The tool creates a 
rectangular plate with origin line, solvent front, and 
one or more lanes. The lanes can be populated 
with spots of different Rf, size, shape, or color.

To create a TLC plate:
1. Select the TLC tool .
2. Drag in any direction from the point of origin.

The number of lanes is a function of the width 
of the plate you create.

ProPro
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Figure 9.318: Drawing TLC plates 

You can manipulate parts of the plate as follows:

Table 35: TLC plate tool options 

If you want 
to...

then...

Change the height 
or width of the 
plate.

Drag a border or corner. 
The number of lanes will 
not change.

Move the origin or 
solvent front.

Drag the origin or solvent 
front line.

Show or hide the 
origin, solvent 
front, borders, or 
side ticks.

1. Right-click or con-
trol-click in the plate. 

2. Select the appropriate 
action.

NOTE: Use the Transparent 
option if you want to overlay the 
TLC plate on a scanned plate.

Change the order of 
lanes.

Drag the origin tick to the 
new location.
ChemDraw 10
Add, delete, or 
duplicate a lane.

1. Position the cursor on 
the lane you want to 
delete or duplicate (or 
between lanes to add).

2. Right-click or con-
trol-click in the plate. 

3. Select the appropriate 
action.

NOTE: You can also delete 
lanes with the Eraser tool.

Move a spot. Drag the spot. The Rf 
displays as you drag.

Duplicate a spot. Ctrl+drag or option+drag 
the spot.

Delete a spot. Click on the spot with the 
Eraser tool. 

NOTE: If you erase all spots in 
a lane, the lane will be deleted.

Display or set the 
Rf for a spot; add a 
custom spot

1. Right-click or con-
trol-click on a spot.

2. Point to TLC Spots, and 
take the appropriate 
action. 

NOTE: To display Rf for all 
spots, Right-click or con-
trol-click in the plate and select 
Show Rf from the TLC Spots 
submenu.

Table 35: TLC plate tool options 

If you want 
to...

then...
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 Rf Display
When you select Show Rf, a text label appears near 
the spot showing the spot's retention factor value. 
By default, the tag will show the Rf to two decimal 
places. You can change the tag as follows:

•  Select the tag with the Lasso or Marquee tool 
and drag it to a new location, or Right-click or 
control-click on the tag and choose Position...

Change the style or 
color of a spot.

1. Right-click or con-
trol-click on a spot.

2. Choose the style or 
color. 

NOTE: To change the style for 
all spots, Right-click or 
control-click in the plate and 
choose the style from the TLC 
Spots submenu.

Enlarge or “smear” 
a spot.

Shift+drag the spot. When 
you position the cursor on a 
spot and press “Shift”, the 
cursor assumes one of three 
shapes, depending on how 
it is positioned:

1. Cross arrows  . 
used to enlarge a spot.

2. Horizontal arrow  . 
used to widen a spot.

3. Vertical arrow  . 
used to elongate a spot 
or create a crescent.

NOTE: You may want to 
zoom in to make positioning eas-
ier.

Table 35: TLC plate tool options 

If you want 
to...

then...
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• Select the tag with the Text tool and edit the Rf 
value.
If you change the Rf the spot will move to the 
new position indicated. 
If you edit the Rf to have different precision, 
that precision will be preserved.

 Resizing Spots
You can resize spots by holding down the Shift key 
while pointing at an edge of the spot. Dragging the 
left or right sides of the spot will adjust the spot’s 
width only. Dragging from the top will adjust its 
height only. Dragging from the bottom will adjust 
the tail only. Dragging from any of the other four 
corners will scale all three values. By using combi-
nations of these dragging motions, you can repro-
duce any sized or shape spot you want.
Figure 9.319: Editing TLC spots 

 Custom Spots
The TLC tool can create the most common spot 
shapes. Other types of spots, such as smears, can 
be reproduced as custom spots. The Add Custom 
Spot command allows you to insert a graphic file 
for a spot. Typically, these files would be produced 
by scanning a TLC plate and saving the spots in a 
library of spot shapes. 

Solvent front

Crescent-shaped spo

Default spot

Enlarged spot

Elongated spot

Widened spot

Origin

Lanes
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Chapter 10: Page Layout

Overview
The presentation quality of your ChemDraw docu-
ment is determined by how well the chemical 
structures and other objects are placed on the page 
(layout). Effective layout of a drawing includes 
proper alignment of chemical structures and other 
objects, appropriate page size, and page orienta-
tion. The page layout tools include: setup of the 
page and the use of the ruler, and the grouping, lay-
ering, aligning, and distributing commands. You 
can also organize information on the page using 
tables.

Controlling the Drawing 
Area
The size of a document window is not necessarily 
the same as the size of the drawing area of the 
page. A document window, in most cases, actually 
covers only a portion of the drawing area.
The following options allow you to set the drawing 
area displayed on your screen.

• Document Settings and Page Setup from the 
File menu allow you to set the size and orienta-
tion of the page, margins, headers, footers, and 
the document type and size. 

• View menu options: Actual Size, Fit to Win-
dow, Magnify, and Reduce.

• Magnification Controls: enlarge and reduce
• Dragging to enlarge the drawing area.

• Windows: Point to a border or corner of a 
document window and drag to resize.

• Macintosh: Drag the Size box in the lower 
right corner of the document window.
ChemDraw 10
The size of drawing area displayed depends on the 
size and resolution of your monitor. In some cases 
you can see the entire document.
If you magnify a document, the drawing area size 
and drawing objects become bigger. If you increase 
the magnification so that the page size becomes 
bigger than the screen, scroll bars become avail-
able.

Setting up Pages
You can create two types of documents:

Pages—A single document containing one or 
more sheets, each of which is printed on a single 
piece of paper.
Posters—A single large document, composed of 
as many pieces of paper as necessary.

Paged Document Setup
To create a document with one or more page:

1. Click the Document Settings command on the 
File menu.
The Document Settings dialog box appears.

Figure 10.320: Document Settings dialog box

2. On the Layout tab, check that Pages is selected.
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3. Specify the number of pages in the Document 
Size section.
The size of the pages is determined by the Page 
Setup settings. For more information, see 
“Page Setup” on page 151.

4. Type the Margin settings.
The units of the margins are set in the Prefer-
ences dialog box. The paper size minus the 
margins determines the drawing area. 

5. Create Headers and Footers as described in 
“Creating Headers and Footers” on page 150.

6. Click OK.
A document is created using your settings. 

Poster Documents Setup
You can create a poster by creating a single large 
drawing area, which will be printed on as many 
separate pages as necessary. When you set the doc-
ument size and how much each page overlaps, 
ChemDraw calculates the number of pages needed 
and the margin sizes. You can set registration 
marks, which mark the overlap setting on each 
page, to use as a guide when assembling the poster 
from the separate pages.
To create a poster document:

1. Click the Document Settings command on the 
File menu.

2. On the Layout tab, click Poster.
3. Type the Height, Width, and Page Overlap.

The number of pages and the margin dimen-
sions are calculated.

4. Select whether to Print Registration Marks.
5. Create Headers and Footers as described in 

“Creating Headers and Footers” on page 150.
6. Click OK.

An example of a 19-inch by 14-inch poster, con-
sisting of six 8.5-inch by 11-inch pieces of paper 
with a 1-inch overlap is shown below.
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Figure 10.321: Designing a poster document 

Creating Headers and Footers
You create headers and footers in the Document 
Settings dialog box. In poster documents, only one 
header and footer appear for the entire document.
To create headers and footers:

1. Click the Document Settings command on the 
File menu.

2. Click the Footer tab.
Figure 10.322: The Footer tab of Document Settings 

3. Type the value of the position from the edge of 
the page that you want the header or footer to 
appear.

4. Type the text to appear in the header or footer.

1"

1"

8.5"

11"

19" X 14" Poster

1"
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5. Type additional information in the Text box 
from the following table:

6. Position the text horizontally by typing the 
characters in the table below. Any text follow-
ing these characters is appropriately aligned. 

Page Setup 
The Page Setup parameters that affect the size of 
the drawing area are:

• Page size
• Orientation

These parameters are specified in the Page Setup 
dialog box. The Page Setup dialog box and the 
options available vary depending on the printer 
you have chosen. For the Macintosh, the version 

Table 36: Footer additional text codes 

To include the… Type …

file name &f

page number &p

date printed &d

time printed &t

Table 37: Footer formatting codes 

To align the text … Type …

centered &c

right &r

left (default) &l
ChemDraw 10
of the printer driver for that printer is installed in 
your System Folder.
To set the paper size, orientation, and margins:

1. Click the Page Setup command on the File 
menu.
The Page Setup dialog box appears. The dialog 
box appears slightly different depending on the 
printer and platform you have. 
A Windows dialog box for a typical postscript 
printer is shown below.

Figure 10.323: Postscript printer print dialog 

The Macintosh Page Setup dialog box with 
common settings for a LaserWriter is shown 
below.

Figure 10.324: Macintosh print page setup 

2. Select a paper size from the drop-down list.
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The available page sizes vary depending on the 
type of printer. Listed below are common sizes 
available. The page orientation you choose 
determines which of the measurements is 
height and which is width:

Page Orientation
To choose the orientation of the page, click the 
vertical (portrait) or horizontal (landscape) orienta-
tion button.

The orientation of a document window 
changes to the orientation you have chosen. 
This is evident when the rulers are visible.

Reduce or Enlarge
Some printers include an option to reduce or 
enlarge your drawings by a variable percentage (25-
400%). This option scales all objects and text in the 
document window by the percentage specified. 
This is not a change in magnification. The size of 

Table 38: Standard paper sizes 

Paper Type Dimensions

US Letter 8.5 x 11 inches

US Legal 8.5 x 14 inches

A4 Letter 21 x 29.7 cm

B5 Letter 17.6 x 25 cm

Tabloid 11 x 17 inches

International 8.5 x 12 inches 

Computer 14 x 11 inches 
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objects is changed relative to the paper size, mar-
gins, and orientation you have specified. 
The enlarge or reduce option is useful for changing 
the size of the available drawing area, while keep-
ing the images on the screen at the normal size 
when you are drawing. If your document is set so 
that the drawing fills the page on one printer and 
you use another printer that requires larger mar-
gins, the drawing my disappear off the edge of the 
document window. You can reduce the size of the 
drawing with the reduce option so that it fits in the 
document window. 

Saving Page Setup Settings
You can save Page Setup settings in a Style Sheet 
or Stationery Pad. Whenever you open a Style 
Sheet or Stationery Pad, these settings are automat-
ically used. The Page Setup settings are saved in 
addition to the Text settings, Drawing Settings, 
and the Color Palette. 

35mm Slide Boundary 
Guides
If you make 35mm slides from a hard copy of a 
ChemDraw document or from a screen shot, you 
can display boundary lines that appear on your 
screen positioned at 7 inches and 10.5 inches to 
match the 2:3 ratio for the 35 mm slide format. 
These guides help you keep your drawing within 
this region to maintain the proper ratio, but are not 
printed. The drawing area of the page must be at 
least 7 x 10.5 inches for these boundary lines to be 
visible.
To display the 35mm slide boundary lines:

1. Click the Preferences command on the File 
menu.

2. Select the Show 35mm Slide Boundary Guides 
check box.

3. Click the OK button.
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Two 35mm Slide Boundary Guides appear in 
the same orientation you have chosen in the 
Page Setup dialog box. These guides appear in 
every document.

This preference affects all documents.

Changing Perspectives
You can use a close-up view of objects in your 
reaction scheme to make sure they are properly 
positioned. At times, you may want to reduce your 
view so that you can move groups of objects 
around the page. You can change the magnifica-
tion to perform these functions by using the Mag-
nify and Reduce commands in the View menu, the 
Zoom tool, or the magnification controls. 

Magnifying with the View Menu 
When you use the View menu to magnify or 
reduce, the magnification is set to the next higher 
or lower value. You can magnify up to 400% or 
reduce to 25%.

Magnify
To magnify using the View menu:

1. Select the object around which you want to 
magnify your view.

NOTE: If you do not select an object, the last object 
drawn is the center point of the magnification.

2. Click the Magnify command on the View 
menu.
The magnification occurs around the center of 
the selected object. The magnification percent-
age appears in the Magnification drop-down 
list. 

Figure 10.325: Magnification display 

You can continue to magnify your view to a maxi-
mum of 400%. 

Windows Macintosh
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Actual Size
To return to the actual size from any other magni-
fication, click the Actual Size command on the 
View menu.

The view is returned to the original size.

Reduce
To reduce the magnification:

1. Select an object around which you want to 
reduce the magnification.

NOTE: If you do not select an object, the last object 
drawn is the center point of the magnification.

2. Click Reduce on the View menu. 
The reduction in magnification appears in the 
Magnification drop-down list. 

Figure 10.326: Viewing reduced magnification 

You can reduce the magnification until the entire 
page fits on the screen. In the reduced view, you 
can continue to use all of the drawing tools. In par-
ticular, you can use a selection tool to rearrange the 
drawing in order to take better advantage of the 
space available. 

Fit to Window
Fit to Window reduces the magnification until the 
entire page is visible in the document window. 
To view the entire drawing area in a document 
window at once, click the Fit to Window command 
on the View menu.

The Magnification control shows the reduction 
in magnification that was required to have the 
entire page appear on the screen. 

Using the Magnification Control
When you use the Magnification control, you can 
display magnifications from 10% to 999% of the 

MacintoshWindows
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normal size of your page. The magnification con-
trol allows you to select a specific value.
To use the Magnification controls:

Windows:

• Select a value from the drop-down list 
or type a value.

Macintosh:

Do one of the following:

• Select a value from the drop-down list 
.

• Select Other from the drop-down list. In the 
dialog box that appears, type a value and click 
OK.

Arranging Objects 
This section describes methods for positioning, 
aligning, and layering objects in a document win-
dow.

Using Rulers
You can use the rulers to position objects a mea-
sured distance away from some reference point or 
create objects of an approximate size. The units 
used for the ruler are set in the Preferences dialog 
box, where you have the choice of inches, centime-
ters or points. 

Showing Rulers
To display the rulers, click the Show Rulers com-
mand on the View menu.

A check mark appears next to the Show Rulers 
command, and the rulers appear along the top 
and left edges of a document window.
154• Page Layout
Figure 10.327: Displaying rulers 

As you move the pointer, Ruler Guides appear 
on each ruler, indicating the position of the 
pointer.

Figure 10.328: How rulers indicate position 

Ruler guides also appear when you drag selected 
objects. In this case, however, there are two Ruler 
guides that bracket the object. With this bracketing 
you can quickly establish the height and width of 
the selected objects.
Figure 10.329: Using ruler guides to show height and 
width 

Ruler Guides

Ruler Guides
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Hiding Rulers
To Hide the rulers, deselect Show Rulers on the 
View menu.

The check mark disappears.

Using the Crosshair
Use the Crosshair to align objects relative to each 
other, and to space objects a consistent distance 
apart. The axes of the Crosshair can be moved 
within a document window. 

Displaying the Crosshair
To show the Crosshair, click the Show Crosshair 
command on the View menu.

A check mark appears next to the Show 
Crosshair command and the Crosshair appear 
within a document window.

To assist you in aligning objects, the Crosshair 
includes grid lines that extend from the major divi-
sion marks on each axis.
Figure 10.330: Displaying the crosshair grid 

You can also show the Rulers while the Crosshairs 
are displayed so that you can see the unit measure-
ment associated with each of the divisions on the 
Crosshair axes.

Moving the Crosshair
To move the Crosshair:
ChemDraw 10
1. Position the pointer where the Crosshair axes 
intersect.
When the pointer is near to the center of the 
Crosshair, it changes to an arrow. 

2. Drag the Crosshair.
To constrain the movement of the Crosshair to the 
X- or Y-direction, shift+drag the crosshair.

Aligning Objects using the 
Crosshair
To use the Crosshair to align objects do one of the 
following:

• Move the Crosshair axes and align it with the 
object.

• Select an object and drag it until it is aligned 
with either axis of the Crosshair, or a grid line.

In either case, if a bond or side of the object is par-
allel to one of the axis, it disappears when it is 
exactly positioned over a Crosshair axis.
To align another object on the Crosshair:

1. Select a second object.
2. Drag the second object to the Crosshair axis or 

grid line and align it to the first.
You can also move selected objects in small incre-
ments to align them with the Crosshair using the 
Arrow keys available on some keyboards:
To move 1 point in the direction of an Arrow key, 
select the objects and press an Arrow key.
NOTE: 1 point equals 1/72 inch or 0.035 cm.
To move 10 points using the Arrow key, for exam-
ple, to the right, press Alt+Right Arrow or 
option+right arrow.

Hiding the Crosshair
To hide the Crosshair, click the Show Crosshair 
command on the View menu.

The check mark next to the Show Crosshair 
command disappears.
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Centering on a Page
To center an object (or group of objects) at the 
center of the page:

1. Select the object you want to center using a 
selection tool.

2. Click the Center on Page command on the 
Object menu.
The selected objects move so that the center of 
the Selection rectangle is positioned at the cen-
ter of the page.

Aligning Objects
Use the Align commands to align objects relative 
to each other. Examples of the types of alignments 
are shown on the menu.
Figure 10.331: The Align submenu 

To align two or more objects:
1. Select the objects with a selection tool.
2. Choose one of the Align commands from the 

Align submenu of the Object menu. 
156• Page Layout
Figure 10.332: Aligning structures 

NOTE: If you look closely, you can see that the structures 
in Figure 10.332 were aligned on left edges, not centers.
If you select only part of a structure or group with 
a selection tool, only that part is used for the align-
ment operation, but the entire structure or group is 
moved. 

Distributing Objects
Use the distribute commands to distribute objects 
horizontally or vertically and at an equal distance 
apart. For reactants and products with different 
shapes, select the parts of the objects to distribute.
To distribute 3 or more objects:

1. Select the 3 or more objects to distribute.
2. Point to the Distribute command on the Object 

menu, and choose Vertically or Horizontally.
Figure 10.333: Distributing objects 

The space between the objects is equalized. 
The upper, lower, right, and left positions of 
objects in your selection remain unchanged.

Front to Back Ordering
The front to back ordering is a useful method for 
changing the orientation of one object relative to 
another object within the same picture layer. For 

CH3

HO
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MeO

CH3
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CH3
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additional information specific to the layering of 
bonds, see “Changing Bond Crossings” on page 
55.

Send to Back 
To place one object behind another within a layer:

1. Select the object that you want to send to the 
back, in this example, the two upper orbitals.

2. Click the Send to Back command on the 
Object menu. 

Figure 10.334: Moving objects to the back 

The selected object appears behind all other 
objects in the same layer.

Bring to Front 
To place one object in front of another within a 
layer:

1. Select the object that you want to move for-
ward.

2. Click the Bring to Front command on the 
Object menu.
The selected object now appears in front of all 
other objects. 

NOTE: When bonds have 3D coordinates, those coordi-
nates always determine the visible bond crossings. Bring To 
Front and Send To Back have no visible effect in this case.

Creating Tables
You can create tables of ChemDraw objects with 
the Table tool or tables of text with the Text tool. 

Creating Tables with the Table 
Tool
Tables created with the Table tool are containers 
for drawings and data. To place a structure in a 
ChemDraw 10
table, you can draw it directly in the table, or copy 
or drag it into the table.
The Table tool enables you to do the following:

• Create and modify tables
• Customize the borders
• Add or delete rows and columns
• Resize the table and its cells manually 
• Fit a cell around its contents automatically
• Align cell contents

To create a table with the Table tool:
1. Select the Table tool on the Main Tools 

palette.
2. Do one of the following:

• Click and drag in the document window to 
create the table.
The default table has two rows and two 
columns.

• Click in the document window. Type the 
numbers of rows and columns in the Insert 
Table dialog box, and click OK.

Figure 10.335: The Table tool dialog box 

The table appears in the document window.
Figure 10.336: Adding a table to a document 
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To resize the rows or columns:
1. Place your pointer on the border to resize.

The pointer changes to a double-headed arrow.

2. Drag the border to the desired size.

Changed Table tool behavior

Table 39: Table tool behavior in ChemDraw 10

when 
you...

ChemDraw 9 ChemDraw 
10

change the 
width of a 
column:

Table width stays 
the same; columns 
to the right move. 
The result is that the 
right-most column 
also changes width.

Table width 
stays the 
same; only the 
column you 
are adjusting 
changes.

change the 
height of a 
row:

Table height stays 
the same; rows 
below move. The 
result is that the 
bottom-most 
column also 
changes height.

Table height 
changes with 
the change in 
the row. All 
other rows 
stay the same.
158• Page Layout
change the 
width of a 
column 
with the 
shift key:

Table width stays 
the same; only the 
column you are 
adjusting changes.

Table width 
resizes; other 
columns stay 
the same.

change the 
height of a 
row with 
the shift 
key:

Table height stays 
the same; only the 
row you are 
adjusting changes.

Table height 
stays the 
same; only the 
row you are 
adjusting 
changes.

change the 
table height 
(drag the 
top or 
bottom 
border)

Table resizes 
proportionately.

Top: table 
resizes 
proportion-
ately.

Bottom: 
bottom row 
resizes.

change the 
table width 
(drag the 
left or right 
border)

Table resizes 
proportionately.

Left: table 
resizes 
proportion-
ately.

Right: right 
column 
resizes.

Table 39: Table tool behavior in ChemDraw 10

when 
you...

ChemDraw 9 ChemDraw 
10
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To customize the borders of the table:
1. With the Table tool selected, point to a border 

and right-click (Mac: option-click).
2. Click Borders on the context menu.

The Table Borders dialog box appears.
Figure 10.337: The Table Borders dialog box 

change the 
table height 
with the 
shift key

Top: table resizes 
proportionately.

Bottom: bottom 
row resizes.

Top: table 
resizes 
proportion-
ately.

Bottom: 
bottom row 
resizes.

change the 
table width 
with the 
shift key

Left: table resizes 
proportionately.

Right: right column 
resizes.

Left: table 
resizes 
proportion-
ately.

Right: right 
column 
resizes.

Table 39: Table tool behavior in ChemDraw 10

when 
you...

ChemDraw 9 ChemDraw 
10
ChemDraw 10
3. In the Setting section, click the borders to 
which you want to apply the settings.

4. In the Style section, select the style, color and 
width of the border to apply.

5. In the table diagram, click the borders to cus-
tomize.

6. Click OK.
The table tool includes commands for alignment 
of cell contents, fit, adding or deleting cells, and 
clearing cells. In general, to change the whole table, 
work with the right or bottom borders. To change 
only a single row or column, work with the left or 
top borders.
To make a cell fit around its contents, such as in 
the table shown below:
Figure 10.338: Fitting a table cell around the contents

1. Point to a border and right-click.
2. Choose Size To Fit Contents.

The cells resize to fit around the contents.
Figure 10.339: Resizing a table cell

To add rows or columns to the table:

O

OH

O

OH

O

OH

O

OH
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1. Point to the top or left border where you want 
to add the row or column.
The cursor changes as shown below.

Figure 10.340: Table cursor when dragging

2. Right-click or Option-click, and from the 
menu that appears, choose the appropriate 
option:

Table 40: Adding rows and columns to tables 

If you want to … Then choose …

add an empty row 
above the indicated 
row

Add Row Before.

add an empty row 
below the indicated 
row

Add Row After.

add an empty column 
to the left of the indi-
cated column

Add Column Before.

add an empty column 
to the right of the indi-
cated column

Add Column After.

delete the indicated row 
and its contents

Delete Row.
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To align all of the objects in a column or row, point 
to a top or left border, right-click, point to the Align 
command on the context menu, and choose the 
alignment you want.

The cell contents shift and stay in a fixed posi-
tion relative to the cell. The default alignment 
is unaligned.

To align all of the objects in a table, point to a bot-
tom or right border, right-click, point to Align, and 
choose the alignment you want.

Creating Tables with the Text 
Tool
ChemDraw allows you to create tables of text 
using the Tab key with the Text tool.

Creating the First Row (column 
headings)
To create the first row and establish the columns 
of a table:

1. Click the Text tool.
2. Click in a document window where you want 

the table to start.
3. Type a caption.
4. Press Tab.

A second caption box appears.
5. Type a second caption.

The second column is placed 20 points 
(20/72 inch, 0.71 cm) to the right of the first.

delete the indicated 
column and its 
contents

Delete Column.

Table 40: Adding rows and columns to tables 

If you want to … Then choose …
CambridgeSoft
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6. Press Tab again to create a third column, and 
so on.

NOTE: The style, font, and size that you set in each col-
umn are maintained in all the rows that follow. 
Figure 10.341 shows the creation of new columns 
using the Tab key. 
Figure 10.341: Using the Tab key in text tables 

To change the spacing between columns one point 
at a time while editing a caption:

1. Select the caption.
2. Move the caption with the arrow keys.

For more information on moving objects, see 
“Moving Objects” on page 64.

To create another column with this same spacing 
as the previous, press Tab.

A third caption text box appears.

Creating a New Row
To start a new row that is exactly aligned with the 
first, press Tab twice at the end of a row. 

A caption text box appears exactly aligned 
under the first caption positioned exactly 20 
points below the first caption in the first row.

The Figure 10.342 illustrates the creation of a new 
row.
Figure 10.342: Creating a new row in a text table 

To change the spacing between rows as you create 
the table:

1. Select the captions in a row.
2. Move the captions using the arrow keys.

For more information on moving objects, see 
“Moving Objects” on page 64.

Compound MW LogP LD50
ChemDraw 10
To continue and fill in the row with captions, press 
Tab to create another caption in the row, and then 
press Tab twice to begin a new row.

The spacing between the newest row and the 
row directly before it have the same spacing 
that you specified between the previous two 
rows.

Adjusting Row or Column Spacing
To use a selection tool to adjust the spacing in a 
table:

1. Select all of the captions with a selection tool.
2. Shift+drag the caption. 

The movement is constrained to the X-axis or 
Y-axis so that you can maintain the row or col-
umn alignment. 

Moving Around In Tables
To move within an existing table, click the Text 
tool and select a caption.

Press Ctrl+arrow or command+arrow to 
move to the next caption in the direction of the 
arrow.

Alternatively, you can use the key combinations 
shown in Table 41.:

Table 41: Moving around in a text table 

Use … To move …

Tab right

Shift+Tab left

Ctrl+Enter or 
command+return 

down

Ctrl+Shift+Enter or 
command+shift+return

up
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Inserting a New Row
To insert a row:

1. Select a selection tool and select a row of cap-
tions.

2. Shift+drag the selected row.
Shift constrains the movement to the Y-axis to 
maintain the column alignment.

3. Select the first caption in the row above or 
below the space you created.

4. Ctrl+Shift+drag or command+shift+drag 
to create a copy of the caption and position it 
in the empty space you created.
The placement of this copied caption sets the 
position of the inserted row. 

To fill in the inserted row with caption text:
1. Click the Text tool and select the first caption 

in the inserted row.
2. Type new text.

Press Tab to move to the second caption in the 
inserted row, and so on.
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Printing
ChemDraw uses the standard system commands to 
print ChemDraw documents. The options that you 
have available to you depend on the printer that 
you are using. Refer to your printer’s documenta-
tion for more information. 
In general, to print a ChemDraw document:

1. Click Page Setup on the File menu.
2. Make all appropriate selections for the printer 

you are using and click OK.
3. Click the Print command on the File menu.
4. Make your selections in the Print dialog box 

and click OK.
To print a document from Windows Explorer or 
from the Finder:

1. Select the document you want to print. 
2. Click Print on the File menu.

The ChemDraw application is opened and the 
Print dialog box appears.

3. Make your selections in the Print dialog box 
and click OK.
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Chapter 11: Sharing Information

Overview
ChemDraw includes many of the standard system 
commands for transferring information within and 
between ChemDraw documents, and between 
ChemDraw and documents created using other 
applications. 
You can transfer information using:

• the Clipboard
• drag and drop
• file formats

When you drag-and-drop ChemDraw information, 
or use the clipboard, the object you are copying 
can be edited.

Using the Clipboard
You can use the clipboard to transfer part or all of 
the information within an active document win-
dow between applications on the same computer 
or a networked computer. Use the standard 
“Copy-and-Paste” or “Cut-and-Paste” tools to 
transfer information to any application that sup-
ports these tools. The information is transferred as 
a ChemDraw drawing object. Double-clicking on it 
will open ChemDraw and allow you to edit the 
object. See “Embedding Objects (Windows)” on 
page 167 and “Edit Graphic Object (Macintosh)” 
on page 167 for more information on editing 
ChemDraw objects embedded in other documents.
You may also use the Copy As tool to translate a 
selected structure to a SMILES, SLN, or InChI™ 
string.
ChemDraw 10
Figure 11.343: Copy As submenu

If the Clipboard contains ChemDraw structures 
and you are pasting into another ChemDraw docu-
ment, the pasted information is scaled to the set-
tings in the current document. For more 
information, see “Autoscaling” on page 165.
If you are pasting the ChemDraw drawing into a 
document from which you are planning to print to 
a PostScript printer, see“Transferring PostScript 
(Macintosh)” on page 167.

SMILES and SMIRKS Strings
A SMILES string is a way to describe a chemical 
structure in a line of text. Several software pack-
ages use SMILES strings as a way to enter and 
store chemical structure information. 
A SMIRKS string is a way to describe chemical 
reactions in text. If you select a reaction and use 
the Copy As SMILES command, a SMIRKS string 
is copied to the clipboard. If you use the Paste Spe-
cial SMILES command when a SMIRKS string is 
on the clipboard, a reaction is pasted into your 
document.
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Creating SMILES Strings
To create the SMILES string for the following 
structure:

1. Select the structure using a selection tool.
2. Point to the Copy As, command on the Edit 

menu, and choose SMILES.
The SMILES string is transferred to the Clip-
board. 

Figure 11 - 1: Using SMILES strings 

To display the SMILES string, paste the string in a 
document window.
When the SMILES string is on the Clipboard, you 
can transfer it to another application that can inter-
pret and manipulate SMILES strings.
If you select more than one structure in Chem-
Draw, and choose Copy SMILES from the Edit 
menu, the SMILES string for each structure is cop-
ied to the Clipboard and separated from the previ-
ous SMILES string by a period. 
SMILES supports an alternate notation for aro-
matic structures using lowercase letters. Chem-
Draw generates this type of SMILES string for any 
structure drawn with explicit aromatic bonds, 
either by using the Aromatic bond type in the 
Atom Properties dialog box, or by placing a circle 
within any ring structure.

NH2

OH

N[C@@H]1[C@H](O)CCCC1
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Figure 11.2: Aromatic SMILES notation 

 Pasting SMILES from Clipboard
If you have a SMILES string, then you can auto-
matically convert that text string into a ChemDraw 
structure.
To paste a SMILES string as a ChemDraw struc-
ture:

1. Select the SMILES string using the Text tool.
2. Click the Copy command on the Edit menu.
3. Point to Paste Special on the Edit menu, and 

choose SMILES.
The SMILES string is drawn as a structure.

NOTE: Pasting SMILES uses the same routines as the 
Structure CleanUp command. For more information, see 
“Multi-Center and Variable Attachments” on page 73.

 Creating SLN Strings
You can copy a ChemDraw structure to the Clip-
board as an SLN string for export to a Tripos 
application. 
To copy a ChemDraw structure as an SLN string:

1. Select a structure.
2. Point to Copy As on the Edit menu, and 

choose SLN.
The Structure is copied to the clipboard as an 
SLN String.

C1=CC=CC=C1 c1ccccc1

ProPro

ProPro
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Figure 11.3: SLN strings 

 Creating InChI™1 Strings
ChemDraw 10 supports the IUPAC International 
Chemical Identifier (InChI™) protocol. A new 
addition to the Copy As submenu allows structures 
to be copied to other documents as InChI™ 
strings. It is used the same way as the SLN com-
mand.

NOTE: InChI™ is not supported in either BioDraw Pro 
or Ultra.
You may only copy legitimate InChI™ structures. 
If you attempt to copy a structure not supported 
by the InChI™ protocol, a warning appears 
informing you that the structure is not supported.

For more information on InChI™, and on using 
InChI™ strings in publications, see the InChI™ 
project page, http://www.iupac.org/inchi/, or the 
informal FAQ at: 
http://wwmm.ch.cam.ac.uk/inchifaq/.

Using Drag-and-Drop 

You can use the drag-and-drop feature to copy 
objects to place in other documents. To use this 
feature in other applications, they must support 
drag-and-drop. As when using the clipboard, the 
information is transferred as a ChemDraw object 
and can be edited.
You can also use the drag-and-drop feature to cre-
ate clipping files (Macintosh) or scrap files (Win-
dows).

1.  InChI™ is a trademark of the Interna-
tional Union of Pure and Applied Chemis-
try. InChI™ Material in ChemDraw is ©
IUPAC 2005.

C[1]CCCCC@1

ProPro
ChemDraw 10
To create a clipping file or a scrap file:
1. Select an object in a ChemDraw document.
2. Drag the selection out of the ChemDraw doc-

ument window onto the desktop.
A clipping file or a scrap file is created on your 
desktop.

To view the information within a clipping file or a 
scrap file, double-click the file’s icon.

A window appears showing the ChemDraw 
drawing. Click the close box to close the clip-
ping file’s window.

To use the contents of a clipping or scrap file in a 
document, drag the clipping or scrap file into an 
open window of an application that supports the 
drag-and-drop feature.

The contents of the clipping or scrap file are 
copied to the open window. The clipping or 
scrap file is unchanged.

Transferring Between 
ChemDraw Documents
Whether you use the clipboard or drag-and-drop, 
when you move objects into another ChemDraw 
document they will behave in a well-defined way. In 
particular, you should be aware of the behavior of:

• Autoscaling
• Bonds
• Atom Labels
• Captions
• Non-bond Objects and Color
• Pasting to an Empty Document Window

Autoscaling
When you transfer ChemDraw objects using the 
Clipboard or drag and drop from one ChemDraw 
document (the source document) to another 
ChemDraw document (the destination docu-
ment), the objects are automatically scaled to 
Sharing Information • 165
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match the document settings of the destination 
document. Automatic scaling assures that the 
objects being transferred match the settings of the 
current document. 

Bonds
All bonds drawn in the source document using the 
values specified on the Drawing Settings tab of the 
Document settings dialog box can be changed to 
use the Drawing Settings in the destination docu-
ment. 
Any resized bond in the source document is scaled 
in the destination document. The scale factor is 
based on the ratio of the bond’s length after resiz-
ing (source) to the Fixed Length on the Drawing 
Settings tab (source). This scaling process main-
tains the source document proportions in the des-
tination document. All values on the Drawing 
Settings tab are scaled using this method.
For example, the Fixed Length is set to 1.0 cm in a 
source document. A benzene ring is resized in to 
200%. The bond length is then 2.0 cm: a ratio of 
2.0 cm:1.0 cm or a scale factor of 2. In the destina-
tion document, the Fixed Length set to 1.7 cm. 
When the benzene ring is pasted into the destina-
tion document, the bonds are scaled by a factor of 
2 to a final bond length of 3.4 cm.

Atom Labels
Atom labels are scaled the same way as bonds.
For example, in the source document, the atom 
label font size is set to 16 points. One or two atom 
labels in the source document are resized to 8 
points, a ratio of 8:16 or a scale factor of 0.5. The 
destination document has an atom label font size is 
set to 14 points. When the atom label is pasted into 
the destination document, the font size is scaled by 
a factor of 0.5 to give a final atom label font size of 
7 points. 
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Captions
ChemDraw autoscales captions are autoscaled 
using the ratio of the fixed length in the destination 
document to the fixed length in the source docu-
ment times the caption font size. The font size of 
the caption can be any size and is not related to the 
setting in the Settings dialog box. This assures that 
captions are always in proportion to the bonds 
with which they are pasted. 
For example, If the source document has a fixed 
length of 1.0 cm and the destination document has 
a fixed length of 2.0 cm, and the caption you are 
pasting is 12 points, then the resulting caption size 
after autoscaling is (2.0 cm /1.0 cm) x 12 points = 
24 points.

Non-bond Objects and Color
All objects that are not affected by settings in the 
Document Settings dialog boxes, such as arrows 
and boxes, are scaled to maintain the same propor-
tions to bonds that were present in the source doc-
ument. 
With the exception of the foreground and back-
ground color, the other colors present in the selec-
tion to be pasted are added to the destination 
document’s Color Palette if they are not already 
present (up to a maximum of 20 total colors). The 
background color in the destination document is 
unchanged, and all objects colored using the fore-
ground color are changed to match the foreground 
color in the destination document. 

Pasting to an Empty Document 
Window
If you paste a ChemDraw drawing into an empty 
ChemDraw document and the settings between 
the documents are different, the Change Settings 
dialog box appears:
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Figure 11.4: Change Settings dialog box 

To change the settings in the destination document 
to match the settings in the source document, click 
Change Settings.

All of the settings in the destination document 
are changed to match those of the source docu-
ment. All of the colors in the Color Palette of 
the destination document are changed to those 
specified in the source document. 

To scale the objects from the source document to 
the settings in the destination document, click 
Don’t Change Settings.

The settings from the source document are 
scaled to those in the destination document 
using the ratios given above. 

NOTE: If the source document was created in a Chem-
Draw version earlier than 3.0, the name of the document 
appears as “Unknown” in the dialog box.

Embedding Objects 
(Windows)
ChemDraw supports the Object Linking and 
Embedding (OLE) protocol on Windows. This 
allows you to edit ChemDraw structures that are 
pasted in other types of documents. ChemDraw is 
an OLE server, which means it can create OLE 
objects that can be copied and pasted into other 
OLE client applications.
When a drawing is transferred from ChemDraw 
into another document type that supports OLE, 
you can open the drawing and edit it from within 
the client application. 
ChemDraw 10
For example, to edit a ChemDraw drawing inserted 
into Microsoft Word for Windows version 6.0 or 
later, do one of the following:

• Select a ChemDraw drawing in a Word docu-
ment and from the Edit menu, point to 
CS ChemDraw Drawing Object, and choose 
Edit.

• Double-click a ChemDraw drawing in a Word 
document.
The ChemDraw tools and menus replace those 
of Word. Use the ChemDraw tools to edit the 
drawing. 

When you have finished making changes, click in 
another area of the document.

The Word tools and menus are restored.

Edit Graphic Object 
(Macintosh)
ChemDraw supports the Edit Graphic Object 
(EGO) protocol for editing ChemDraw structures 
pasted into other types of documents. When you 
drag an object from ChemDraw into another type 
of document that supports the EGO protocol, or 
copy it with the clipboard, you can double-click on 
the object and it appears in a ChemDraw docu-
ment window. When you close the ChemDraw 
document window, any changes you made are 
reflected in the other document.
NOTE: As of this writing, versions of Microsoft Word 
after 5.0 do not support EGO.

Transferring PostScript 
(Macintosh)
To obtain the highest quality drawings possible on 
a PostScript printer, ChemDraw creates both a 
screen representation and a PostScript representa-
tion of your drawing. PostScript is a page-defini-
tion language used to describe drawings. Many 
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printers, including most Apple LaserWriter print-
ers, use PostScript to create high quality output.
For best print quality under all circumstances, we 
recommend that you leave the Include PostScript 
and Include ChemDraw Laser Prep preferences 
selected (default) when you copy and paste from 
ChemDraw to other applications. The ChemDraw 
Laser Prep option adds approximately 11K to 12K 
to each drawing, but these options give you the 
greatest flexibility if you give your document to 
someone else or later want to print it on a Post-
Script printer.
If you never plan to print to a PostScript printer or 
never plan to give your document to someone who 
uses a PostScript printer, you can turn the prefer-
ences off.
To deselect the PostScript preferences:

1. Click the Preferences on the File menu.
2. Deselect Include PostScript and Include Chem-

Draw LaserPrep.
To transfer only a few drawings to another docu-
ment, select Include PostScript and Include Chem-
Draw Laser Prep in the Preferences dialog box.

The PostScript commands and the 
ChemDraw Laser Prep are transferred with 
each drawing. The transferred drawings can 
be printed independently of ChemDraw. 

If you do not check the Include PostScript check 
box when printing to a PostScript printer Chem-
Draw sends QuickDraw commands to the printer. 
For more information, see “Printing Background 
Color” on page 214.
NOTE: You can also transfer drawings to a document in a 
remote location whose printer cannot be initialized by Chem-
Draw.

To print to a non-PostScript printer, deselect both 
Include PostScript and Include ChemDraw Laser 
Prep on the General tab of the Preferences dialog 
box.
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Importing and Exporting
Many applications can use the information con-
tained within a ChemDraw document and saved to 
another file format. Similarly, ChemDraw can 
import and work with information in a number of 
file formats. Not all formats are supported for 
both import and export. See the individual format 
descriptions for details. File formats are available in 
a pop-up menu at the bottom of the “Open” and 
“Save As” dialog boxes. 
To export a file:

1. Click the Save As command on the File menu.
Figure 11.5: Save As dialog box 

2. In the Save As dialog box, do the following:
a. Type a name for the file and choose a loca-

tion in which to save it. Use the “Go To 
ChemDraw Items” button to quickly locate 
the ChemDraw Items folder.

b. Select a file format from the bottom of the 
dialog box.

c. Click OK or Save.
A copy of the current document is saved in the 
format you specified. The current document 
remains unchanged.

Some file formats do not support atom labels that 
contain nicknames or structural fragments. When 
you save in these formats, ChemDraw automati-
cally expands all atom labels and saves the file 
using the expanded form. For more information, 
CambridgeSoft
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see “Expanding and Contracting Labels” on page 
70. 
The following formats do not support nicknames 
or structural fragments:

• Connection Table
• MSI MolFile
• SMD

Some formats can be saved with different options. 
If a format has no save options, the “Options” 
button is grayed out. The following text-based for-
mats can use the Text Options:

• ChemDraw XML
• CML
• Connection Table
• ISIS/TGF
• ISIS/Reactions
• MDL MolFile
• Molecular Simulations MolFile
• SMD

Figure 11.6: Text File options 

Other format options are noted in format descrip-
tions.

Improved ISIS compatibility
ChemDraw 10 has improved support for the 
ISIS/Sketch (SKC), ISIS/TGF (TGF) and 
ISIS/Reaction (RXN) formats. Support for both 
import and export of the V3000 format has been 
added. 
ChemDraw auto-detects V3000 files on import. 
For export, there are two new entries in the Save 
ChemDraw 10
As drop down menu: ISIS Reaction V3000 (RXN) 
and MDL Molfile V3000 (MOL). If you have used 
features that require the V3000 format, you must 
select it manually; there is no auto-detect on save.

Attached Data
ChemDraw 10 supports associating text fields with 
objects such as atoms and bonds by defining a 
“field name”. The feature is compatible with the 
“Data SGroup” in MDL formats, and will be con-
verted to Data SGroups when saved in MDL for-
mats if: 

• a field name is specified and 
it is attached to:
• a collection of atoms and bonds, or
• a single set of brackets

If it is attached to both a collection of atoms and 
bonds and a set of brackets, it will be converted to 
two different Data SGroups.
To attach data to objects:

1. Select an object.
2. Click the Attach Data command on the Object 

menu.
Figure 11.7: Attach Data command

The Attach Data dialog box appears.
Figure 11.8: Attach Data dialog box
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3. Enter the field name and click OK.

NOTE: Field names cannot be edited in ChemDraw 
after they are created. While ChemDraw will allow any 
field name length, MDL formats have restrictions that 
users should be aware of before creating names. 
Likewise, ChemDraw will allow data to be attached to 
any object. When saving to MDL formats, this data 
will be lost unless the object meets the rules noted above.

4. Enter the data in the text box under the object.

Modifying Attached Data
ChemDraw treats attached data as normal text for 
most purposes. However, two additional com-
mands appear on the context menu when attached 
data is selected.
Figure 11.9: Attached data context menu

• Select Linked Objects changes the selection to 
include all of the objects associated with the 
data.

• Position opens up the same dialog that is used 
to position ObjectTags, allowing you to posi-
tion the data relative to the associated struc-
ture.

NOTE: Positioning information is lost when saving to 
MDL formats. 

Graphics export border 
preference
An explicit preference option allows the user to 
specify the size of the border when exporting pic-
tures. This preference affects the output of all 
graphical formats, including but not necessarily 
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limited to: WMF, PICT, EPS, TIFF, GIF, BMP, 
and PNG. It applies to both the clipboard and 
saved files.
The default value is 2 points (0.278 in; 0.071 cm). 
The value can be zero, meaning that the exported 
image is exactly snug against the objects in the 
graphic. However, this is not recommended 
because a bug in Windows causes clipping at the 
edges of metafiles when they are reduced in size. 
The default value should prevent clipping with 
reductions to about 20% of original size. 

File Formats
ChemDraw supports both import and export 
(except as noted below) of the following file for-
mats. To export a ChemDraw file to one of these 
formats, use the Save As... option when saving. 
Not all formats are supported in all versions of 
ChemDraw, as noted in the table below. For addi-
tional information on importing files, see “Insert-
ing Objects from Other Applications” on page 
177.

Table 42: Import and export of different file formats 

Format Import Export

 ChemDraw (CDX) YES YES

ChemDraw XML (CDXML) YES YES

ChemDraw 3.5 (CHM) YES YES

ChemDraw 2.0 and Chem-
Draw 2.1 (CHM)

YES NO

ChemDraw 
Template (CTP)

YES YES

ChemDraw 
Template Style Sheet (CTS)

YES YES

ProPro

ProPro
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ChemDraw Stationery/Style 
Sheet (CDS)

YES YES

Connection Table 
(CT)

YES YES

Chemical Markup 
Language (CML)

YES YES

Bitmap (BMP) YES YES

Encapsulated PostScript 
(Macintosh)

PostScript (EPS) (Windows)

NO YES

Graphic Image Format (GIF) YES YES

 ISIS (SKC, TGF, 
RXN)

YES YESa

JCAMP (JDX, DX) YES NO

JPEG (JPG, JPEG) YES NO

MDL MolFile 
(MOL)

YES YES

MDL RGFile (RGF) YES YES

(Macintosh) Molec-
ular Simulations MolFile 
(MSM)

YES YES

Table 42: Import and export of different file formats 

Format Import Export

ProPro

ProPro

ProPro

ProPro

ProPro
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Bitmap BMP)
Bitmap (BMP) files store raster graphics in an array 
of individual bits. Bitmap images are the most 
common format for continuous-tone images. 
Because they represent a fixed number of pixels, 
bitmaps are resolution dependent and may appear 
jagged and lose detail if they are scaled on-screen 
or printed on a higher resolution printer than they 
were created for.

ChemDraw Template (CTP, CTR)
Use the ChemDraw Template file format to save 
template documents that appear in the template 
pop-up menu.

ChemDraw (CDX)
The ChemDraw file format is the native format for 
ChemDraw version 4.0 and later. This is a public 

PICT (Macintosh) YES YES

Portable Network Graphics 
(PNG)

YES YES

Standard Molecular 
Data (SMD)

YES YES

Galactic Industries 
(SPC)

YES NO

Windows Metafile
(EMF, WMF)

YES YES

TIFF file (TIF) YES YES

a. May have limitations. See the appropriate section 
in the text.

Table 42: Import and export of different file formats 

Format Import Export

ProPro

ProPro
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tagged file format that stores information about a 
ChemDraw structure in a series of data blocks. 
This format is designed to be easily generated and 
interpreted by other programs. This format accu-
rately stores anything that can be drawn in Chem-
Draw.
NOTE: Imported drawings saved within a ChemDraw file 
created using ChemDraw for Macintosh are lost when the file 
is opened using ChemDraw for Windows. The same applies 
for objects saved in ChemDraw for Windows and opened on 
a Macintosh. However, all ChemDraw specific information 
is preserved. 
Imported drawings include any graphics pasted into a Chem-
Draw document from another Macintosh application. They 
also include Chem3D drawings imported using the Insert 
Object dialog box or the “Get 3D Model” Edit menu com-
mand in ChemDraw for Windows.

ChemDraw XML (XML)
The CDXML file format is an interpreted version 
of cdx that conforms to the XML specification 
unlike binary cdx format. CDXML is text-based 
but contains some data. For information about 
XML in general, see http://www.xml.org.

ChemDraw 3.5 (CHM)
ChemDraw 3.5 file formats are used for saving or 
opening ChemDraw documents using the version 
3.5.x of ChemDraw. These documents can also be 
opened in versions 3.0, 3.0.1, 3.0.2, and 3.1 of 
ChemDraw as long as atom properties are not used 
in the files.
NOTE: When you save a ChemDraw file in one of these 
formats, all features specific to later versions are lost. For 
example, multi-attached atom labels, variable attachment 
points, and multicenter bonds are not be saved.

ChemDraw 2.0 and ChemDraw 2.1 
(CHM) Import Only
ChemDraw 2.0 and ChemDraw 2.1 file formats are 
used for opening ChemDraw documents using the 
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version 2.x file format of ChemDraw for Macin-
tosh. You cannot save files in these formats.

ChemDraw Stationery/Style Sheet 
(CDS)
Use ChemDraw Stationery file format to save doc-
ument settings and other objects.

 Connection Table (CT)
The Connection Table file format is a simple for-
mat that saves a list of atom connectivities in terms 
of an element, serial number, X and Y coordinates, 
bond order, and bond type. For more information, 
see , “Chemistry File Formats” on page 225

 Chemical Markup Language 
(CML)
CML is an extensible, chemically-aware markup 
language based on XML. ChemDraw supports 
both import and export of the format. More infor-
mation can be found at http://www.xml-cml.org/ 
and http://cml.sourceforge.net.

Encapsulated PostScript (Macintosh)
PostScript, EPS (Windows)
Encapsulated PostScript (EPS) files are ASCII text 
files containing the scalable PostScript representa-
tion of a ChemDraw drawing that can be opened 
using other applications and platforms. There are 
two types: one containing text only, and one con-
taining a graphic representation of the drawing. 
The latter are known as Postscript with Preview or 
Postscript Mac. For text only files, programs that 
do not support the display of raw PostScript can 
only print, not view an image on screen.
Use EPS files to share ChemDraw drawings with 
desktop publishing applications such as Adobe 
PageMaker and QuarkXPress.

ProPro

ProPro
CambridgeSoft
Overview

http://www.xml.org
http://www.xml-cml.org/ 
http://cml.sourceforge.net


The Options dialog box allows you to select the 
resolution (in dpi) and color depth of the saved file 
The defaults are 300 dpi and Monochrome. For 
Windows EPS with Preview, there is also a Pre-
view option (default: WMF).
Figure 11.10: EPS Options dialog box.

If you select a color option, all colors are saved in 
the EPS file except for the Background color. To 
save an EPS file with a colored background, create 
a large colored rectangular box using the Drawing 
Elements tool and choose Send to Back before 
saving the file. For more information, see “Draw-
ing Boxes” on page 139 and “Multi-Center and 
Variable Attachments” on page 73. These options 
only affect embedded images. Objects created in 
ChemDraw always output at maximum resolution 
and in full color.
To include correct PostScript font names in Win-
dows EPS files, you must have Adobe Type Man-
ager (ATM) installed. Only ATM fonts are saved in 
the EPS file.
Resolution 
Available resolutions range from 72 (computer 
monitor) to 1440 dpi (high resolution output). 
When choosing a resolution, keep in mind that the 
size of the file increases as the square of the resolu-
tion. 
Color 
You can select from the following color options:

• Monochrome—Forces all objects to black 
and white.

• Grayscale—Translates colors to shades of 
gray. 

• 24-bit RGB —Stores colors using computer 
monitor style of color encoding.
ChemDraw 10
• 32-bit CMYK—Uses printing press style of 
color encoding. Groups each color type 
sequentially. This provides better compression.

GIF Image (GIF)
Graphics interface format (GIF) is useful for 
working with the hypertext markup language 
(HTML) used in displaying information on the 
World Wide Web. A GIF image can be displayed 
directly on a Web page rather than having to 
download the drawing for viewing in a Helper 
application.
The default GIF format conforms to the GIF 89a 
specifications with transparent backgrounds. You 
can change this from the options menu.
Figure 11.11: GIF Options dialog box 

 ISIS/SKC and ISIS/TGF
You can save a ChemDraw document in an ISIS 
file format for export to an ISIS application, or 
import a file created by an ISIS application into 
ChemDraw. 
ChemDraw Pro provides two ISIS file formats: 

• ISIS/Sketch (SKC)—For saving files as a 
binary sketch file for transfer to another ISIS 
application running on the same operating sys-
tem (this format is used on the Clipboard).

• ISIS/TGF (*.tgf)—For saving as an ASCII 
text file (a Transportable Graphics File) for 
transfer to ISIS applications on different plat-
forms.

NOTE: When transferring between ChemDraw and 
ISIS/Draw, if information in a file or on the Clipboard con-
tains only non-bond, unsupported objects, the information is 

ProPro
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imported as a WMF (metafile) or PICT graphic. However, 
if a supported object, such as a bond, is also in the file or on 
the Clipboard, then only the supported object appears.
NOTE: Object types in ISIS not supported in ChemDraw, 
such as polymers, are not transferred. Object types in Chem-
Draw not supported in ISIS are not transferred. However, 
in some cases, such as different arrow types, the arrow is con-
verted to the most similar form.

 ISIS/Reactions (RXN)
The ISIS/Reactions format is an MDL-developed 
format for storing chemical reaction information 
used by the ISIS family of products and others. 
For single step single or multi-line reactions, 
ChemDraw uses the point of the reaction arrow as 
the dividing line to determine which molecules in a 
reaction are reactants and which are products. 
NOTE: You cannot save a reaction with an intermediate 
step accurately in the RXN file format.
Molecules whose centers are behind or above the 
tip of the arrow are considered reactants, and all 
remaining molecules are products. The reaction 
arrow can be at any orientation; it does not have to 
be parallel to the x-axis. If a reaction contains mul-
tiple arrows, then the largest arrow is used as the 
reaction arrow. 
Reaction mapping and reaction center information 
is stored in the RXN output file.

 JDX (JDX, DX) Import Only
The Joint Commission on Atomic and Molecular 
Properties (JCAMP) developed the JDX file for-
mat for spectral data. JDX is a public, but not well 
defined format that has numerous variations. 
ChemDraw supports many of the more common 
spectral variations with uniform x-axis spacing.

ProPro
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ChemDraw also supports Bruker NMR JCAMP 
data, which is saved with a DX file extension
When you import JDX files, they appear in the 
window with a spectrum of a standard size that can 
be re-sized by dragging.
You can export spectral data as part of a CDX file 
only. 

JPEG (JPG, JPEG) Import Only
ChemDraw supports import of digital images com-
pressed with the widely used JPEG (Joint Photo-
graphic Experts Group) algorithm. JPEG images 
are imported as objects, and can be scaled after 
importing. 

 MDL MolFile (MOL)
MDL Information Systems, Inc. MolFile (MDL 
MolFile) file format is used by several other Win-
dows, Macintosh, and UNIX chemical databases 
and drawing applications such as ISIS/Draw™, 
ISIS/Base™, MACCS™, and REACCS™. 
ChemDraw Pro provides two MDL MolFile 
formats:

• MDL MolFile (Text)
• MDL MolFile (Mac) for Macintosh only. This 

file type is saved with an mMol file type and can 
be saved and opened with ISIS.

MDL MolFile files are ASCII text files that can be 
created or edited in common word processing 
applications or text editors. Atom and bond prop-
erty information is stored in the MolFile.
MDL RGFile (RGF) file format is used by several 
other chemical databases and drawing applications. 
The MDL File RGFile supports alternate groups 
whereas an MDL Molfile cannot. When you save a 
ChemDraw file that contains alternate groups as an 
MDL MolFile, it is automatically saved as an MDL 
RGFile. 

ProPro
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 Molecular Simulations MolFile 
(MSM)
Molecular Simulations MolFile format is an ASCII 
text file used by applications such as ChemNote™. 
You can save a ChemDraw Pro document in 
Molecular Simulations MolFile format for export 
to one of these applications.
NOTE: ChemDraw uses the file extension “MSM” for 
Molecular Simulations MolFiles rather than the standard 
“MOL”, used by Molecular Simulation, Inc. ChemDraw 
recognizes files with the “MOL” file extension as MDL 
MolFiles. In addition, the extension “MSI” used in earlier 
versions of ChemDraw is no longer recognized in Chem-
Draw. To open Molecular Simulations MolFiles that have 
a “MOL” or “MSI” extension you must first change the 
extension to “MSM”.

PICT (Macintosh)
PICT files contain a QuickDraw representation of 
a ChemDraw drawing that can be used by various 
drawing applications. You can save a ChemDraw 
document in the PICT format so it can be opened 
by one of these other applications. The PICT file 
format contains ChemDraw structural informa-
tion. PICT files created by earlier versions of 
ChemDraw can be reopened and edited by Chem-
Draw version 8.0. However, the pictures contained 
in PICT files created by versions of CS ChemDraw 
earlier than version 3.5, or by other applications, 
are treated as a single, non-editable, imported pic-
ture.
All colors are saved in the PICT file except for the 
Background color. 

PICT scaled 4X (Macintosh)
PICT scaled 4X files are the same as PICT files, 
except that the drawing is four times larger. When 
these larger files are placed into certain other appli-
cations and shrunk back down to 1/4 size, they 

ProPro
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may provide higher quality output than regular 
PICT files.

PNG file (PNG) 
PNG (Portable Network Graphics) format is an 
alternative to the GIF format for adding graphics 
to web pages. You can save, but not open, files in 
PNG format. The PNG format is fairly new and 
was designed to address many of the shortcomings 
of the GIF format. In particular, the PNG file for-
mat offers true color images, is less prone to trans-
mission errors and offers a full alpha channel for 
specifying background or transparency options.
For additional information about PNG visit: 
http://www.boutell.com/boutell/png

 SMD (SMD)
Standard Molecular Data (SMD) file format, ver-
sion 4.3, is an ASCII text file commonly used by 
programs that search Chemical Abstracts Data-
bases such as STN Express™. You can save your 
ChemDraw document in SMD format and use the 
file for searching in a Chemical Abstracts database.

 SPC (SPC) Import Only
The SPC file format was developed by Galactic 
Industries as part of the GRAMS software, which 
reads spectral data from every type of spectrometer 
and converts them to SPC format. SPC is a 
well-defined, proprietary, but open standard for-
mat for spectral data. 
ChemDraw imports most one-dimensional spec-
tral SPC formats. When you import an SPC file, it 
appears in the window with a spectrum of a stan-
dard size that can be re-sized by dragging.
You can export spectral data as part of a CDX file 
only. 

ProPro
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 Template Style Sheet (CTS)
The Template Style Sheet file format is used for 
saving document settings and row and column 
characteristics for creating ChemDraw Template 
documents.

Windows Metafile (WMF)
The Windows Metafile file format saves the 
Graphic Device Interface (GDI) representation of 
a ChemDraw drawing. Using the WMF file format 
you can transfer ChemDraw drawings to other 
applications, such as Microsoft® Word, that sup-
port that WMF file format on the same or different 
computers rather than using the Clipboard. The 
WMF file format contains ChemDraw structural 
information. 

TIFF file (TIF) 
TIFF format (Tagged Image File Format) is a high 
resolution format commonly used for saving 
graphics for importing into desktop publishing 
applications on the same or on different computer 
platforms. TIFF images can be saved using a vari-
ety of resolution, color, and compression options. 
As TIFF images can get rather large, choosing 
appropriate options is important. The TIFF format 
is for export only.

Resolution 

Available resolutions range from 72 (computer 
monitor) to 1440 dpi (high resolution output). 
When choosing a resolution, keep in mind that the 
size of the file increases as the square of the resolu-
tion. 

Color 
You can select from the following color options:

• Monochrome—Forces all objects to black 
and white.

ProPro
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• RGB Indexed—Stores colors using computer 
monitor style of color encoding. 

• CMYK Planar—Uses printing press style of 
color encoding. Groups each color type 
sequentially. This provides better compression. 
For example: CCCCCC-
MMMMMMYYYYYYKKKKK rather than 
CMYKCMYKCMYKCMYK. This option 
produces far better compression than using the 
PackBits compression method. However, 
many desktop publishing packages do not sup-
port CMYK Planar files.

• CMYK Contiguous—Uses printing press 
style of color encoding. Stores colors non-
sequentially. For example: CMYKCMYK. The 
PackBits compression type provides no com-
pression for this type of file.

NOTE: If objects in your document are black and white 
they are saved black and white regardless of which Color 
options you set. If you import drawings from other applica-
tions and want them to print Black and White you must set 
the Color option to Monochrome.

Compression 
You can select from the following compression 
options:

• PackBits—Used to reduce files size by encod-
ing repeating bytes of information as output 
when using the CMYK Planar color option. 
Below is a highly simplified representation of 
this compression scheme. For a line of color 
information such as: CCCCC-
MMMMMYYYYYKKKKK, the compression 
yields a smaller file by representing the infor-
mation as C46M5Y5K.

• CCITT Group 3—Used for fax transmissions 
of images.

• CCITT Group 4—Used for fax transmissions 
of images.
CambridgeSoft
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• Deflate—Similar to LZW compression. 
Works well with all Color and Resolution 
options.

Setting TIFF options
To set these options: 

1. click the Options button in the Save dialog box 
to display the TIFF options dialog box. 

Figure 11.12: TIFF Options dialog box 

2. Select the options you want and click OK.
NOTE: In the Macintosh version you may want to increase 
the memory allocated to ChemDraw if you are saving large 
TIFF files.

Inserting Objects from Other 
Applications 
You can insert graphics or documents created in 
other applications into ChemDraw. You can edit 
inserted objects using the ChemDraw Edit menu. 
Inserted objects can be resized or rotated using the 
resize and rotate handles of a selected object. You 
cannot flip inserted objects.
To insert a graphic from another application into 
ChemDraw:

1. Click Insert File the Edit menu.
2. In the Open dialog box, select the file type 

from the drop down menu.
ChemDraw 10
Figure 11.13: Inserting a file into ChemDraw

3. Select the graphic and click Open.
The file is embedded into the ChemDraw file.

NOTE: If you select file type “All files” and choose a 
file type that ChemDraw does not support (such as 
TXT) you will get an error message, and the file will not 
be embedded.

(Windows only)
To insert an object from another application into 
ChemDraw:

1. Click the Insert Object command on the Edit 
menu.
The Insert Object dialog box appears.

Figure 11.14: Insert Object dialog box 

InsertObject 155 dpi
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2. Take the appropriate action:

Transferring ChemDraw 
Documents Across Platforms
Use the following procedures to transfer Chem-
Draw documents across platforms. From the fol-
lowing table, determine the versions of the 
ChemDraw software between which you want to 
transfer documents and follow the appropriate 
instructions.
When you transfer ChemDraw files across plat-
forms, fonts are not transferred. If a font in the 
transferred document is not available, ChemDraw 
substitutes fonts for those that are available on the 
new platform.

Transferring from Macintosh to 
Windows
To be able to open a ChemDraw file created on 
the Macintosh in Windows, follow the instructions 

Table 43: Insert object options

If you want to … Then …

create a new object Click Create New.

Select the Object Type.

Click OK.

insert an existing 
graphic

Click Create from File.

Type the path or browse to 
the object to insert.

Click OK.
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for the appropriate versions shown in the table 
below.

Transferring from Windows to 
Macintosh
To be able to open a ChemDraw file created in 
Windows on the Macintosh, follow the instruc-
tions for the appropriate versions shown in the 
table below.

Table 44: Transferring from Mac to Windows 

From 
Mac 
Version 

To 
Window
s 
Version

Instructions

≥ 4.0 ≥ 4.0 Save as ChemDraw 
and add .cdx to the file 
name.

≥ 4.0 3.x Save as ChemDraw 3.x 
and add .chm to the file 
name.

 ≤ 3.5.x = 3.x Save as ChemDraw 
and add .chm to the file 
name.

Table 45: Transferring from Window to Mac 

From 
Windows 
Version

To Mac 
Version

Instructions

≥ 4.0 ≥ 4.0 Save as the default 
ChemDraw (.cdx).

≤ 3.5.x ≥ 4.0 Save as ChemDraw 
3.x (.chm).
CambridgeSoft
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Transferring Files to ChemDraw/Plus 
3.1 for the Macintosh
Use the following procedure to transfer a Chem-
Draw for Windows file to ChemDraw/Plus 3.1 for 
the Macintosh. A file translator such as 
PC Exchange or Apple File Exchange must be 
running on your Macintosh.
To transfer from Windows to ChemDraw/Plus 3.1 
for the Macintosh:

≤ 3.5x ≤ 3.x Save as ChemDraw 
3.x (.chm) and 
follow the instruc-
tions in “Transfer-
ring files to Chem-
Draw/Plus 3.1 for 
the Macintosh” 
below.

Table 45: Transferring from Window to Mac 
ChemDraw 10
1. In ChemDraw for Windows, save the file in the 
ChemDraw (CHM) format. 

2. Insert the disk with the ChemDraw for Win-
dows files into the Mac floppy drive. 

3. If you are using PC Exchange, double click the 
floppy disk icon to display the files. 

4. Select PC Exchange from the Control Panels. 
5. Select Add.
6. Change the DOS suffix to CHM. 
7. In the application selection, find CSC Chem-

Draw on your Mac and click once to highlight 
the selection. 

8. Change the document type to CHMS. 
If you are using a translator other than 
PC Exchange, you need to use an editor such as 
ResEdit or Desktop to change the type and creator 
of the files being transferred. The type should be 
“CHMS” and the creator should be “CHMD.” 
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Chapter 12: ChemDraw/Excel

The ChemDraw/Excel add-in is an extension of 
Microsoft© Excel© for Windows. 
ChemDraw/Excel enables you to:

• Add chemical structures and other data from 
ChemDraw or a ChemFinder database to an 
Excel spreadsheet. 

• Search using the same search features as Chem-
Finder.

• Perform calculations on chemical structures.
See the ChemOffice manual for information on 
other CambridgeSoft add-ins for Excel.
NOTE: Any commands you use operate on the cells, not 
the pictures in the cells.

Setting Up ChemDraw/Excel
When you install ChemFinder, ChemDraw/Excel is 
automatically installed. Before you use Chem-
Draw/Excel for the first time, do the following:

1. Select Add-Ins on the Tools menu. 
The Add-Ins dialog box appears.

2. In the Add-Ins dialog box check the Chem-
Draw for Excel checkbox and click OK.
A ChemOffice menu is added to the Excel 
menu bar and a ChemOffice tool bar appears.

Figure 12.15: ChemOffice menu item and toolbar 

New
worksheet

Import
table Export

table

Import ChemFinder list
Name=Struct

SMILES=Struct

Structure controls:
Load; Save; Cut;
Copy; Paste; Name

Structure controls:
Show; Hide;Resize;
Align

Normal & Similarity search

R-Group analysis
ChemDraw 10
3. Point to Macro on the Tools menu, and select 
Security.

The Macro Security dialog box appears.
4. In the Macro Security dialog box click the 

Security Level tab and set the security level to 
Medium.

NOTE: ChemDraw/Excel no longer requires this 
step. You must set security to Medium only if you will 
be using ChemDraw/Excel worksheets from version 8 
or earlier without conversion.

5. Click OK to save and exit.
To create a ChemOffice worksheet:

• Select New ChemOffice Worksheet on the 
ChemOffice menu, or click .

A ChemOffice worksheet appears. When a 
ChemOffice worksheet is active, Chem-
Draw/Excel appears in the title bar and the 
ChemDraw tool bar is active.

Figure 12.16; A ChemOffice worksheet

Importing Tables
ChemDraw/Excel allows you to import from the 
following sources:

• MDL SDFiles—Imports all records in the 
file. Each structure is given the name stored in 
the SDFile. 
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• ChemDraw databases —Imports all fields 
stored in the main form. Molecular weight and 
formula fields are not imported because Chem-
Draw/Excel calculates them. Each structure is 
named Structure <n>, where n is a unique 
number.

NOTE: In order to import CFW files into Excel, make 
sure you save them with the “allow CAL/OLE Automa-
tion access” security setting checked. See “Setting Security 
Options” in Chapter 3 of the ChemFinder manual for 
details. 
When you import a table, structure data are trans-
formed into structure drawings in the first column, 
and all other fields are imported in separate col-
umns.
To import a table:

1. Select the cell where you want the import to 
start. The upper left corner of the import is at 
this cell. Data is filled down and to the right.

2. Select Import Table on the ChemOffice menu, 
or click .
The Import Table dialog box appears.

Figure 12.17: Import Table dialog box

3. Type or select the file name to import and click 
Open.
All records are added to your spreadsheet.
182• ChemDraw/Excel
Converting and Upgrading
Instead of copying and pasting information from a 
non-ChemDraw/Excel worksheet, you can con-
vert the existing worksheet into a Chem-
Draw/Excel worksheet.
To convert a worksheet:

Select Convert Worksheet from the ChemOf-
fice menu.
The work sheet is converted to a Chem-
Draw/Excel worksheet.

Upgrading Workbooks
ChemDraw/Excel 9.0 improvements made work-
books created with older versions incompatible. 
You can open and maintain old workbook formats, 
but you may get error messages (depending on 
your Excel security settings) and will be asked if 
you want to upgrade each time you open them.
Figure 12.18: Version and macro warnings 

To upgrade a workbook:
1. Point to Macro on the Tools menu, and select 

Security.

2. Click the Trusted Sources tab and make sure 
that CambridgeSoft Corporation is listed as a 
trusted source. Make sure the Trust access to 
Visual Basic Project checkbox is selected. 

3. Select Upgrade Workbook from the ChemOf-
fice menu.

4. To maintain tight security, go back to the 
Macro Security dialog box and deselect the 
Trust access to Visual Basic Project checkbox.
CambridgeSoft



Importing Hit Lists
You can perform a search in ChemFinder and then 
import the hit list structures with data into Excel 
using the Import ChemFinder List command.
To use the Import ChemFinder List command, 
ChemFinder must be open with a hit list present.

Importing a Hit list
To import a hit list:

1. Select Import ChemFinder List on the 
ChemOffice menu, or click the  icon.
A message box similar to the one in Figure 
12.19 appears: 

Figure 12.19: Importing a ChemFinder hit list 

2. Click Yes to import the hit list. 
The records are imported into Excel, starting 
with the currently selected cell and moving 
down and to the right. 

Error Messages
If all conditions required to use the Import Chem-
Finder List command are not met, one of the fol-
lowing error messages may appear.
ChemFinder is not running, would you like to 
start it up? 
ChemFinder is not running. Do the following:

1. Click Yes.
The message “After loading your desired data-
base and performing your search, return to 
Excel and redo the operation.” appears.

2. Click OK.
ChemFinder opens. 
ChemDraw 10
3. Open a database and perform a search.
4. Return to Excel and from the ChemOffice 

menu, select Import ChemFinder List, 
or click .

No database loaded in ChemFinder. Load a 
database and perform your search. Then 
return to Excel and redo the operation. 
ChemFinder is running, but no database is loaded. 
Do the following:

1. Click OK. 
ChemFinder moves to the front. 

2. Open a database and perform a search.
3. Return to Excel and from the ChemOffice 

menu, select Import ChemFinder List, 
or click .

Form has no database or hit list has no 
records. Load a database and perform your 
search. Then return to Excel and redo the 
operation. 

4. Click OK. 
ChemFinder moves to the front. 

5. Open a database and perform a search.
6. Return to Excel and from the ChemOffice 

menu, select Import ChemFinder List, 
or click .

Exporting Tables
ChemDraw/Excel allows you to export tables to 
MDL SDFiles. 
Selected cells are exported to a specified file. If no 
cells are selected, the entire spreadsheet is 
exported. The first column of the area to export 
must have the word “Structure” in its top cell. 
Structures outside the first column will be dis-
carded.
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Figure 12.20: Selecting cells for export 

To export data:
1. Select the information to export:

2. Select Export Table on the ChemOffice menu, 
or click .
The Save Table To dialog box appears.

Figure 12.21: Save Table dialog box 

3. Type the file name and click Save.
The table is saved to the specified file.

Table 12 - 1: Selecting the area to export 

If you want to 
export 

Then 

a specified area of your 
spreadsheet

Select the area to 
export.

the entire spreadsheet Do not make any 
selection.
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Adding Structures
You can add chemical structures from any file for-
mat supported by ChemDraw to a spreadsheet. 
The names of added structures are retained. If the 
structure does not have a name, ChemDraw 
assigns the name: Structure <n>, where n is a num-
ber unique to the worksheet.

Adding Structures with 
ChemDraw
The most direct way to insert a new structure into 
a cell is by using ChemDraw. 
To add a structure with ChemDraw:

1. Double-click in a cell.
The ChemDraw/Excel dialog box appears:

Figure 12.22: ChemDraw/Excel dialog box

2. Click Yes.
ChemDraw opens.

3. Draw the structure in ChemDraw.
4. Click Close and Return to New Molecule on 

the ChemDraw File menu.
The new structure appears in the cell.

Adding a Structure From a File
To add a structure from a file:

1. Select the cell into which you want to add the 
structure.

2. Select Load Molecule on the ChemOffice 
menu, or click .
The Choose Molecule to Load dialog box 
appears.
CambridgeSoft



Figure 12.23: Choose Molecule dialog box 

NOTE: You can use the sample molecule file, 
“SAMPLE.cdx” contained in the ChemDraw system 
directory, or any CDX file to load.

3. Type the file name of the structure to add and 
click Open. 
The information is stored in the selected cell.

Adding a Structure with a SMILES 
String
You can insert SMILES strings into cells and con-
vert them to structures. 
To insert SMILES strings:

1. Type or paste SMILES strings into cells.
2. Select the range of cells or single cell to con-

vert.

NOTE: If you want to keep the original text, copy it 
and paste it elsewhere. 

3. Select Convert SMILES To Molecule on the 
ChemOffice menu, or click . 
ChemDraw 10
If the cell contains a valid SMILES string, it is 
replaced by a structure. The cell will display a 
text string starting with “Structure” and 
followed by a number. To display the structure, 
click the Show Picture  icon.
If the cell did not contain a valid SMILES 
string, the string remains. 

Adding Structures by Name
You can type or paste the names of chemicals into 
cells and convert them into structures as follows:

1. Enter the names into cells.
2. Select the range of cells to convert. 

NOTE: If you want to keep the original text, copy it 
and paste it elsewhere. Note that this command can also 
convert names generated from Excel formulas. 

3. Select Convert Name To Molecule on the 
ChemOffice menu, or click . 
If the cell contains a name supported by Chem-
Draw Name=Struct, the structure corre-
sponding to that name is added to the cell, with 
the given name as the name of the cell. To 
show the structure, select the cell and choose 
Show Picture from the ChemOffice menu. For 
more information about Name=Struct, see the 
ChemDraw User’s Guide.

Saving Structures
You can save a chemical structure to a separate file.

1. In the spreadsheet, select the cell containing 
the structure.

2. Select Save Molecule on the ChemOffice 
menu, or click .
The Save to File dialog box appears.
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Figure 12.24: Save to File dialog box 

3. Select an existing file or enter a new file name, 
and click Save.
The structure is saved with the name and in the 
location you selected. 

Searching
You can perform the same types of searches in 
ChemDraw/Excel as you can in ChemFinder:

• Exact structure searching
• Substructure searching
• Similarity searching

Filter Tables
Filter tables allows you to search for exact struc-
tures and substructures.
To perform a structure search:

1. Select a cell in the data table.
2. Select Filter Table on the ChemOffice menu, or 

click .
The Search Query dialog box appears.
186• ChemDraw/Excel
3. Select the search options: 

5. Click Search.

Table 13: Search options

If you want 
to 

Then 

search for a 
structure

1. To load a structure, 
right-click and select 
Read Structure.

2. To edit the structure, 
double-click it.

3. Select the Search 
Type.

4. Select the Filter Type.

search for a 
formula

1. Type the molecular 
formula or formula 
query in the And/Or 
Formula Query box.

2. select Clear.

search for a 
structure and a 
formula

1. To edit the structure, 
double-click it.

2. Select the Search 
Type.

3. Select the Filter Type.
4. Type the molecular 

formula in the 
And/Or Formula 
Query box.

see the R-
Group Anal-
ysis

click the Show R-Group 
Analysis box. 

see the 
previous query

click Restore Previous 
Query.
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The hit list is displayed in a column named 
Match. Items matching the search criteria are 
labeled as TRUE.

Similarity Searches
You can perform similarity searches to find struc-
tures with features corresponding to your search 
structure. For more information about similarity 
searching, see the ChemFinder User’s Guide.
To search for similarity:

1. Select a cell containing the label Structure.
2. Select Similarity Table on the ChemOffice 

menu, or click .
The Similarity Query dialog box appears.

Figure 12.25: Similarity Query dialog box 

3. Select the Search Type.
4. Select the Similarity Is value.
5. Select the Sort order.
6. Click Search.

The hit list is displayed in a column named 
Match. Items matching the search criteria are 
labeled as TRUE.

Working with Structures
ChemDraw/Excel allows you to rename structures 
and use the clipboard to cut, copy, and paste struc-
tures.
ChemDraw 10
Naming Structures
Excel recognizes certain characters as formulas. To 
prevent the system from interpreting a chemical 
structure name as an Excel formula, you can 
rename a structure.
To name a structure:

1. Select the structure.
2. Select Name Molecule on the ChemOffice 

menu, or click .
The Name Molecule dialog box appears.

Figure 12.26: Name Molecule dialog box 

3. Type the name and click OK.

Using the Clipboard
You can cut, copy, and paste structures using the 
clipboard. After you cut or copy a structure, it is 
placed on the clipboard. You can then paste it into 
another cell or another application.
To cut a structure from a cell:

1. Select the structure.
2. Select Cut Molecule on the ChemOffice menu, 

or click .
The structure is removed from the cell and is 
placed on the clipboard.

To copy a structure from a cell:
1. Select the structure.
2. Select Copy Molecule on the ChemOffice 

menu, or click .
The structure remains in the cell and a copy is 
placed on the clipboard.

To paste a structure:
1. Select the area into which you want to paste the 

structure.
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2. Select Paste Molecule on the ChemOffice 
menu, or click .
The structure is pasted from the clipboard.

Viewing Structures
ChemDraw/Excel allows you to select whether or 
not to display structures in a cell. You can also 
adjust the height and width of cells to display their 
entire contents.

Showing and Hiding Structures
To show structures:

1. Select the cells in which you want to display 
pictures.

2. Select Show Picture on the ChemOffice menu, 
or click .
The structures are displayed in the selected 
cells.

To hide structures:
1. Select the cells in which you do not want to dis-

play pictures.
2. Select Hide Picture on the ChemOffice menu, 

or click .
The structures are hidden and the cells resize.

Aligning Structures
A structure may fall outside the boundaries of its 
cell because it is too big or because it is improperly 
positioned within the cell. Use the Align All Pic-
tures command to enlarge the cell or reposition the 
structure. If the entire structure is within the cell, 
regardless of its position, it is not affected by the 
Align All Pictures.
To align structures:

Select Align Pictures on the ChemOffice menu, 
or click .
The cells adjust to display their entire contents.
188• ChemDraw/Excel
Resizing Structures
To resize pictures use the Resize Picture command.
NOTE: When pictures are resized larger than their cells, 
use Align Pictures to enlarge the cells. Align Pictures does not 
make cells smaller.
To resize pictures: 

1. Select the chemistry cells whose pictures you 
want to resize. 
It is not necessary to only select chemistry cells. 
Non-chemical cells or chemical cells without 
pictures will be ignored. 

2. Select Resize Picture on the ChemOffice menu, 
or click . 
Resize handles appear on the selected struc-
tures. 

3. Click-drag the resize handles to resize a picture.
Any changes you make to a picture is propor-
tionately reflected in the other pictures. 

4. To end resizing, click a cell and the pictures are 
deselected.

Resizing Structures With a Macro
To resize a large number of structures simulta-
neously, create the following macro:

CFXL.xla!CFxlDoSelectPicture
and assign it to an Excel button or menu item.
Then do the following:

1. Select the cells to be resized.
2. Run the macro. 
3. Resize one structure.

All of the selected structures resize by the same 
amount.

4. Select the Structure column and align (see 
“Aligning Structures” on page 188).

For more information on creating and storing mac-
ros, see Excel Help.
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Using ChemDraw/Excel 
Functions
ChemDraw/Excel supplies nine functions that 
return information about chemistry objects in a 
specified cell. Seven of these functions take only 
one argument—the cell to which the function 
refers. The remaining two functions may also take 
a string as an optional second argument. 
The function ISSTRUCTURE is an example of a 
function that takes only one argument. To deter-
mine whether the content of cell A1 in an Excel 
spreadsheet is a ChemDraw/Excel chemistry 
object, you type =ISSTRUCTURE(A1) into a sec-
ond cell. The second cell then displays TRUE or 
FALSE depending on whether A1 contains a chem-
istry object.
The function CHEM.COMPOSITION is one of 
the functions that may take an optional second 
argument. It works in one of two ways:
With First Argument Only—
Without the second argument, it displays elemental 
composition by weight percent of the entire chem-
ical structure in cell A1 when you type 
=CHEM.COMPOSITION(A1) into a second cell. For 
benzene, it displays C, 92.26; H, 7.74. 
With Both Arguments—The second argument 
lets you find the percent composition of a single 
element in the structure. Typing =CHEM.COMPO-
SITION(A1, “C”) returns the weight percent of car-
bon in the structure. For benzene it would display 
0.922582. Notice that the display format for a sin-
gle element is different from that of the whole 
structure.
Table 14 outlines the ChemDraw/Excel functions. 
Only CHEM.COMPOSITION and 
CHEM.NUM.ATOMS take an optional second 
ChemDraw 10
argument. The others only take the reference cell 
argument.

Table 14: ChemDraw/Excel functions

Function Action

ISSTRUCTURE Returns TRUE if cell 
referred to is any 
ChemDraw/Excel 
chemistry object 
including reactions; 
otherwise it returns 
FALSE.

ISREACCTION Returns TRUE if cell 
reference is any Chem-
Draw/Excel chemistry 
object and reaction; 
otherwise it returns 
FALSE.

CHEM.FORMULA Returns formula for 
structure in cell refer-
ence; it returns #N/A 
error if cell doesn’t 
contain a ChemDraw 
structure.

CHEM.MOLWEIGHT Returns molecular 
weight for structure in 
cell reference. Returns 
#N/A error if cell 
doesn’t contain Chem-
Draw structure.
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CHEM.NUM.
HBACCEPTORS

Returns number of 
hydrogen bond accep-
tors based on 
topology. Returns 
#N/A error if cell 
doesn’t contain Chem-
Draw structure.

CHEM.NUM.
HBDONORS

Returns number of 
hydrogen bond donors 
based on topology. 
Returns #N/A error if 
cell doesn’t contain a 
structure.

CHEM.SMILES Returns SMILES 
string for structure. 
Returns #N/A error if 
cell doesn’t contain 
ChemDraw structure.

Table 14: ChemDraw/Excel functions

Function Action
190• ChemDraw/Excel
CHEM.COMPOSITION Returns elemental 
percent by weight for 
all elements in struc-
ture unless optional 
second argument spec-
ifies a single element 
symbol as a string. In 
this case the elemental 
percent is expressed as 
a decimal number 
between 0 and 1. 
(75.1% would be 
0.751) Returns #N/A 
error if the cell refer-
enced in first argument 
doesn’t contain a 
ChemDraw structure, 
or if second argument 
is not a valid element 
symbol.

CHEM.NUM.ATOMS Returns total number 
of atoms in the struc-
ture unless optional 
second argument spec-
ifies a single element 
symbol as a string. In 
this case, it returns the 
number of atoms of 
that element only. 
Returns #N/A error if 
the cell referenced in 
first argument doesn’t 
contain a ChemDraw 
structure or if second 
argument is not a valid 
element symbol.

Table 14: ChemDraw/Excel functions

Function Action
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Using ChemProp Functions
If you are using ChemDraw Pro or Ultra with the 
ChemProp add-on installed, you can calculate 
physical and thermodynamic properties in Chem-
Draw/Excel. For detailed information on the 
properties calculated and how ChemProp calcu-
lates them, see “Viewing Chemical Properties” on 
page 115 and Appendix E “How ChemProp 
Works.”

ChemProp Properties
In ChemDraw/Excel, you can use the ChemProp 
functions to calculate the following properties:

Table 15: ChemProp functions

Property Function

LogP (Ultra only) CHEMPROP.LOGP

Molar Refractivity 
(Ultra only)

CHEMPROP.MR

Henry’s Law 
Constant

CHEMPROP.HENRY.
LAW.CONSTANT

Boiling Point CHEMPROP.BOILING

Freezing Tempera-
ture

CHEMPROP.FREEZING

Critical Tempera-
ture

CHEMPROP.CRITICAL.
TEMP

Critical Pressure CHEMPROP.CRITICAL.
PRESSURE

Critical Volume CHEMPROP.CRITICAL.
VOLUME
ChemDraw 10
NOTE: Using ChemProp requires that you have a version 
of ChemDraw that includes ChemProp installed.

Inserting Functions
To insert a ChemDraw/Excel function into your 
worksheet:

1. Select an empty cell. 
2. Select Function on the Insert menu.

The Paste Functions dialog box appears.
3. Select ChemDraw Functions.

Figure 12.27: Paste Functions dialog box 

4. Select the function to insert from the list and 
click OK.
A dialog box appears.

Heat of Formation CHEMPROP.HOF

Gibbs Free Energy CHEMPROP.GIBBS

Ideal Gas Thermal 
Capacity

CHEMPROP.IDEAL.GA
S

tPSA CHEMPROP.TPSA

Table 15: ChemProp functions

Property Function
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Figure 12.28: Function arguments dialog box 

5. Enter the structure cell reference for which you 
want to calculate properties in the Structure 
box.
192• ChemDraw/Excel
6. If the function takes a second argument, enter 
it in the Element type box. Element type argu-
ments are optional.

7. Click OK.
Each property is calculated using the “best avail-
able” method. For more information about calcu-
lation methods, see the ChemDraw manual. If the 
cell reference argument does not point to a valid 
structure cell, #N/A appears in the cell.
CambridgeSoft



Chapter 13: BioDraw

Overview
BioDraw tools are drawing objects. Before reading 
this section, users should familiarize themselves 
with the general behavior of ChemDraw drawing 
tools by reading Chapter 9, “Drawing Objects” on 
ChemDraw 10
page 131. Pay particular attention to “The Arrow 
Tools Palette” on page 136, and “The Drawing 
Elements Tools Palette” on page 138, as you will 
want to use those tools in your BioDraw pathways.
Figure 13.29: The BioDraw Ultra GUI
ChemDraw 
main tools palette

BioDraw 
tools palette

Text toolbarGeneral toolbar
The BioDraw Tools Palette
The BioDraw tools palette contains tools to draw 
metabolic pathways, such as enzymes and recep-
tors. Standard shapes, such as circles, ellipses, and 
arrows, can be added from the Drawing Elements 
tool palette or the Arrows tool palette. You can 
also use the Pen tool to create custom shapes.
As with ChemDraw Drawing Elements, you can 
change the color of an object with the Color menu, 
and the line and fill properties with the Curves 
menu. You can also rotate, or change the size, after 
selecting it. In general, anything you can do with a 
ChemDraw drawing object you can do with a Bio-
Draw object as well. We would, however caution 
care in the use of shading (“Shaded Style” on page 
BioDraw • 193
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144). The effect of shading applied to irregularly 
shaped objects such as receptors is unpredictable, 
and generally quite unaesthetic. 
You create a BioDraw object by either clicking or 
dragging on the page where you want it to appear. 
Clicking gives you the default size and shape, drag-
ging allows you not only to enlarge the object, but 
to distort it as well by dragging differently on the x 
and y axes. Linear objects elongate in the direction 
they are dragged. The membrane and protein tools 
(DNA and Helix) add more subunits as they are 
dragged and display the subunit count.
Figure 13.30: BioDraw Toolbar

Customizable Objects
Some of the BioDraw objects can be customized 
after being created. Table 16 describes the customi-
zation options. When customizing a BioDraw 
object, you must use the same tool used to create 
it, or a selection tool.

Table 16: Customizable BioDraw Objects

Tool Customization 
Options

1-Substrate  
Enzyme

size of the enzyme “mouth”

Receptor width

1-substrate enzyme
2-substrate enzyme
Receptor
Ion Channel
Helix Protein
Membrane (line)
Membrane (arc)
Golgi Body
Cloud

G-protein (alpha subunit)
G-protein (beta subunit)
G-protein (gamma subunit)
Immunoglobulin
DNA
Micelle
Membrane (ellipse)
Endoplasmic Reticulum
Mitochondrion
194• BioDraw
G-protein,  
gamma subunit

shape

Helix Protein height, width of the strands, 
width of the cylinders, 
spacing

DNA height, width of the strands, 
offset of the second strand, 
spacing

Membrane  
(line)

size of subunit 
(The overall length remains 
constant, and the number of 
subunits changes in inverse 
proportion to the size.)

Membrane  
(arc) 

length, arc, size of subunit

Membrane size of subunit

Micelle  
(ellipse) 

size of subunit

Table 17: Tools that are not customizable

2-Substrate  
Enzyme

G-protein,  
alpha subunit

Ion channel G-protein,  
beta subunit

Immunoglobulin Golgi body 

Table 16: Customizable BioDraw Objects

Tool Customization 
Options
CambridgeSoft
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Drawing a Membrane Line
To create a membrane line:

1. Select the membrane line tool.
2. Drag in the work space.

TIP: You may also click to draw the default size.

When orienting the membrane, note that if the 
Fixed Angles option on the Object menu is 
selected, you are constrained to 15 degree 
increments. You can override the default by 
holding down the Alt or option key as you 
drag.

The membrane line has a single adjustment handle. 
When you place the cursor over the handle, it turns 
into a double-sided arrow. Dragging the handle to 
the right increases the size of each subunit of the 
membrane; dragging to the left decreases the size 
of each subunit. When you change the subunit size, 
the length of the membrane stays constant.
Figure 13.31: Adjustment cursor

Endoplasmic  
reticulum

Mitochondrion 

Cloud 

Table 17: Tools that are not customizable

Regular cursor

Drag cursor
ChemDraw 10
Figure 13.32: Changing the membrane size 

TIP: To change the length of the membrane, select it and 
drag the left or right handle of the selection box. You may 
then deselect it and readjust the subunit size.

Drawing a Membrane Arc
Creating a membrane arc is similar to creating a 
membrane line. Begin by dragging in a straight line, 
then drag in a curve.
Figure 13.33: Creating a membrane arc

The membrane arc tool has three adjustment 
handles: 

• the handle at the starting point controls the 
length

• the center handle controls the subunit size
• the handle at the leading edge controls the arc

Drag to the right

Drag to the left
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Drawing a Helix Protein
To create a helix protein:

1. Select the Helix Protein tool.
2. Drag in the work space.

TIP: You may also click to draw the default size.

When orienting the protein, note that if the 
Fixed Angles option on the Object menu is 
selected, you are constrained to 15 degree 
increments. You can override the default by 
holding down the Alt or option key as you 
drag.

The helix protein has four adjustment handles: 
height, width of the strands, width of the cylinders, 
and spacing. 
Figure 13.34: Helix protein adjustment handles

height

spacing
width of cylinders

width of strands
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Drawing a DNA Molecule
To create a DNA molecule:

1. Select the DNA tool.
2. Drag in the work space.

TIP: You may also click to draw the default size.

When orienting the DNA, note that if the Fixed 
Angles option on the Object menu is selected, 
you are constrained to 15 degree increments. 
You can override the default by holding down 
the Alt or option key as you drag.

DNA has four adjustment handles: height, width 
of the strands, offset of the second strand, and 
spacing
Figure 13.35: DNA adjustment handles

height

offset

width
spacing
CambridgeSoft
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Appendix A: Customizing ChemDraw

Overview
You can customize ChemDraw by configuring 
Preferences and Document Settings.
Preferences allow you to change the default behav-
ior of certain options that apply to every open doc-
ument. Document Settings allow you to change the 
default behavior of options that will affect only the 
active document.

Setting Preferences
Preferences affect the way the ChemDraw applica-
tion works, regardless of the document with which 
you are working.
To open the Preferences dialog box click Prefer-
ences on the File menu.

The Preferences dialog box appears:
Figure A.36: The Preferences dialog box

To restore the CambridgeSoft default settings, 
click the Use Defaults button.

Preferences-Gen 150dpi
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Setting the Default Document 
Location
You can set what file location is shown in the 
Open dialog box by using the Preferences dialog 
box. 
To set the default location:

1. Click Preferences on the File menu.
The Preferences dialog box appears.

2. Click the Directories tab.
3. Click the checkbox next to Use Documents 

Location and type in or browse to the location 
to use.

Figure A.37: Setting the default document location 

If Use Documents Location is not selected, the first 
time you use the Open dialog box your 
My Documents folder is shown. Subsequent uses 
show the last directory used.

Setting the Default Open File Format 
You can set what file format is selected by default 
in the Open dialog box. 
To set the default file format:

1. Click Preferences on the File menu.

 

Default document location
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The Preferences dialog box appears.
2. Click Open/Save.
3. Click Use Default File Format in the Opening 

Files section, and choose the format you want 
from the list

Figure A.38: Using default file format.

If Use Default File Format is not selected, the first 
time you use the Open dialog box the ChemDraw 
format is shown. Subsequent uses show the last 
format used.

Setting the Default Tool
Use the Preferences dialog box to set which tool is 
automatically selected when you open documents.
To set the default tool:

1. Click Preferences on the File menu.
The Preferences dialog box appears.

2. Click the Open/Save tab.
3. In the section labeled Opening Files, click the 

Default Tool to be automatically selected when 
you open a document.

Saving Changes Automatically 
You can configure ChemDraw to save changes to a 
document automatically at the time interval you 
set.
To set the frequency at which ChemDraw auto-
matically saves your changes:

Use Default File Format
198• Customizing ChemDraw
1. Click Preferences on the File menu.
The Preferences dialog box appears.

2. Click Open/Save.
3. Click the checkbox next to Autosave Every and 

type or select the minutes to use.
Figure A.39: Setting Autosave 

The time starts counting down after the first 
change is made.

Undoing Actions
To undo the last action performed, click the Undo 
command on the Edit menu, 

The last action performed is reversed. The 
Redo command changes to reflect the undone 
action. The Undo command changes to reflect 
the next action you can undo.

For example, if you draw cyclohexane, create an 
atom label text box, type a label, and select and 
rotate the structure, you will be able to remove the 
actions as follows: 

1. Remove the rotation.
2. Remove atom label. 
3. Remove the ring. 

At each step, the text of the Undo command indi-
cates the action being removed. 

Autosave
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Redoing Actions
When you undo an action, the Redo command 
becomes active so you can reverse the effect of the 
Undo command. 
To redo the last action undone, click the Redo 
command on the Edit menu,.

The last action undone is reinstated. The Undo 
command changes to reflect that action. The 
Redo command changes to reflect the next 
action that can be redone.

Setting the Default Save File Format 
You can set what file format is selected by default 
in the Save As dialog box. 
To set the default file format:

1. Click Preferences on the File menu.
The Preferences dialog box appears.

2. Click Open/Save.
3. Click the checkbox next to Use Default File 

Format in the Saving Files section, and choose 
the format you want from the list.

Figure A.40: Setting the default save file 

If Use Default File Format is not selected, the first 
time you use the Save dialog box, the ChemDraw 
format is shown. 

SaveFileFormats 150 dpi
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Creating a New Line and Closing 
Text Boxes
The default way to create a new line in a caption 
text box is with the Enter or return key. The 
default way to create a new line in an atom label is 
with Alt+Enter or option+return. To close the 
text box, click outside the text box or select 
another tool. 
To change the default do the following:

1. Click Preferences on the File menu.

TIP: In Mac OS X, the Preferences dialog box is 
found on the ChemDraw menu.

2. Choose the appropriate option on the General 
tab: 

3. Click OK.

Using Bitmap Fonts When 
Available (Macintosh)
When text appears in a document on the screen, it 
can appear using either a bitmap or a TrueType 
font.
To use bitmap fonts if they are available:

1. Click Preferences on the File menu.
2. Select Use Bitmap Fonts When Available.

Table 18: Setting new line options 

To change the 
default for …

Select …

Atom Label text Require Alt+Enter or 
Option+Return to Create 
New Line in Atom Labels.

Caption text Require Alt+Enter or 
Option+Return to Create 
New Line in Captions.
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Text drawn using Bitmap fonts looks better and 
appears more quickly than text drawn using True-
Type fonts. However, the size and position of text 
drawn using Bitmap fonts change somewhat when 
printed. 
For accurate correspondence between what you 
see on the screen and what is printed, deselect Use 
Bitmap Fonts When Available.
This change affects all documents.

Setting the Highlight Box 
Tolerance
You determine the size of the highlight box and 
how close you must get to activate an object by set-
ting the Tolerance. The standard setting for the 
Tolerance is 5 pixels. At this setting, the highlight 
box appears on bonds if the pointer is located 5 
pixels or less from any point on the bond. 
To set the Tolerance:

1. Click Preferences on the File menu.
2. Select or type the tolerance.

This change affects all documents. 

The ChemDraw Items Folder
The ChemDraw Items Folder is located by default 
in the same folder as your ChemDraw application. 
It contains the ChemDraw preferences, hotkeys, 
nicknames, and isotopes files; scripts, and the 
generic nicknames file. It also contains template 
documents and template Stationery Pads. You can 
have multiple ChemDraw Items folders. This is 
useful in corporate installations for maintaining 
personal files such as nicknames as well as standard 
templates.
To add a path to a ChemDraw Items folder:

1. Click Preferences on the File menu.
The Preferences dialog box appears.

2. Click the Directories tab.
3. Click the Add New button, browse to a loca-

tion, and click OK.
200• Customizing ChemDraw
A new path is added to the list.
Figure A.41: Adding a path to ChemDraw Items 

4. To rearrange the search order, use the Move Up 
and Move Down buttons.

5. To delete a path, click the Remove button. To 
delete all added paths, click the Default Paths 
button.

Accessing Documents Quickly
You can access ChemDraw documents quickly by 
placing them in the ChemDraw Items folder and 
then selecting them from the Open Special menu.
You can access open documents quickly by using 
the Window menu.

The Open Special Submenu
To select documents from the ChemDraw Items 
folder, point to Open Special on the File menu and 
select the file to open.

The Open Special submenu, listing documents 
stored in the ChemDraw Items folder, appears.

Document and Object 
Settings
Document and object settings are user-definable 
settings that are applied to the current document. 
Settings include:
CambridgeSoft
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• Drawing settings—set drawing options such as 
the fixed length used to draw bonds

• Caption and label text settings—set text 
options such as the font used for atom labels 
and captions

• Color settings—set available colors for objects 
and the document background 

• Print/Page Setup—set options such as the 
page size used and text displayed in footers

You can apply document settings in the following 
ways:

• Customize settings for the entire document 
using the Document Settings dialog box

• Apply settings to the entire current document 
from an existing document

• Apply settings to selected objects in the current 
document from an existing document

Default Style Sheet or Stationery 
Pad
When you open ChemDraw, the last Style Sheet or 
Stationery Pad used opens as the default. If you 
choose another Style Sheet or Stationery Pad, that 
file becomes the default. 
You can set a default that is not changed:

1. Click Preferences on the File (Mac: Chem-
Draw) menu.

2. Browse to the default Style Sheet (Stationery 
Pad).

3. On the Open/Save tab, deselect the Opening 
Any Style Sheet (Stationery Pad) Changes 
Default checkbox.

To view the default Style Sheet or Stationery Pad, 
click the File menu.

The New menu item displays the name of the 
Style Sheet or Stationery Pad.
ChemDraw 10
Saving Customized Settings as 
Style Sheets or Stationery Pads
Every new document created with ChemDraw 
uses a Style Sheet or Stationery Pad to obtain its 
document settings. Style Sheets or Stationery Pads 
can also contain predefined objects. When you cre-
ate a new document, you actually create an untitled 
copy of the Style Sheet or Stationery Pad. Any 
changes you make to the copy of the Style Sheet or 
Stationery Pad do not affect the Style Sheet or Sta-
tionery Pad itself. 
You can create a Style Sheet or Stationery Pad with 
your own customized setting by saving it as a CDS 
file. If you store the CDS file in the ChemDraw 
Items folder, it appears in the Open Special menu 
so you can access it from the File menu.
To save a document’s setting as a Style Sheet or 
Stationery Pad:

1. Click the Save As command from the File 
menu.
The Save As dialog box appears.

Figure A.42: The Save As dialog box 

2. Name the file and change the type (in OS X: 
format) to CD Style Sheet (cds) or ChemDraw 
Stationery.

3. To save the file in the ChemDraw items folder, 
click the Go To ChemDraw Items button.

SaveAs 200 dpi
Customizing ChemDraw • 201
Overview



A
dm

inistrator
4. Click Save.

Applying Document Settings 
From Other Documents 
To apply document settings to the active window 
that are contained in a different document, point to 
Apply Document Settings from...on the File menu, 
and choose the document from which to apply the 
settings.

The settings in the active document window 
change to those found in the Style Sheet or Sta-
tionery Pad that you choose.

NOTE: When you apply settings, they apply to the current 
document only are not saved as the default for the next docu-
ment. Use Open Special from the File menu if you want to 
change the default document settings.
To apply the document settings from a document 
or style sheet not listed in the menu:

1. Click Other on the Apply Document Settings 
from submenu of the File menu.
The Select document dialog box appears.

Figure A.43: The Select Document dialog box 

2. Open the appropriate folder and select a 
ChemDraw document or Style Sheet / Statio-
nery Pad.

3. Click Open.

SelectSettings 200 dpi
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Applying Object Settings from Other 
Documents
You can apply settings from another document to 
selected objects in the current document. You can 
apply the chosen settings to the selected objects 
only, or to all new objects drawn in the current 
document.
To apply object settings:

1. Select the object.
2. Point to Apply Object Settings from... on the 

Object menu, and choose the document from 
which to apply the settings.
A dialog box appears:

Figure A.44: Apply object settings dialog box 

3. Take the appropriate action:

The settings are applied.

Drawing Settings 
Drawing settings are document settings that affect 
how bonds and other objects are drawn. You can 
configure the drawing settings for an entire docu-
ment or for a particular object as follows:

• For the entire document, use the Document 
Settings dialog box.

Table 19: Applying object settings from other 
documents

If you want to apply 
the settings to the …

Then click …

selected object only No

selected object and any new 
objects you draw

Yes

SetDefaults 150 dpi
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• For an object, use the Object Settings dialog 
box.

Changes made to the drawing settings affect the 
active document window only. Drawing settings 
can be saved in Style Sheets or Stationery Pads.
To apply settings from other documents to your 
document, select “Apply Document Settings 
from...” from the File menu.
The drawing settings are described in the following 
table:

Table 20: Drawing settings 

Adjust 
this… 

If you want to …

Chain Angle Set the angle (from 1 to 179 
degrees) between bonds 
created by the Acyclic chain 
tool or modified by the Struc-
ture CleanUp command.

For more information see, 
“Drawing Acyclic Chains” on 
page 52 and “Structure CleanUp” 
on page 72.
ChemDraw 10
Bond 
Spacing

Set the distance between the 
lines in double or triple bonds. 
The distance is set either as:

• The percent of the length 
of the bond (between 1 
and 100). This allows for 
proportional spacing to be 
used if different bond 
lengths are used in the 
drawing.

An absolute value you choose 
in the units specified for your 
document.

Fixed 
Length

Constrain the length of the 
bonds drawn to the length you 
specify when the Fixed Lengths 
command in the Object menu 
is selected (a check mark is next 
to it). This also adjusts the 
preferred bond length for 
structures modified by the 
Structure CleanUp command.

For more information see 
“Drawing with Fixed Lengths” 
on page 47 and “Structure 
CleanUp” on page 72.

Table 20: Drawing settings 

Adjust 
this… 

If you want to …

10% 14% 18%
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Bold Width Set the width of the line used 
when bold and wedge bonds 
are drawn. The Bold Width 
setting must be greater than the 
Line Width setting. The end of 
a wedge is 1.5 times the bold 
width.

Line Width Set the width of all bonds, lines, 
and arrowheads in the drawing.

Margin 
Width

Change the amount of space 
surrounding all atom labels that 
will erase portions of the bonds 
to which they are attached. The 
margin width also determines 
the amount of white space 
surrounding the front bonds in 
a bond crossing. 

For more information, see 
“Editing Atom Labels” on 
page 59 and “Changing Bond 
Crossings” on page 55.

Table 20: Drawing settings 

Adjust 
this… 

If you want to …

2 Point 4 Point 8 Point

1 Point 1.5 Point0.5 Point
204• Customizing ChemDraw
Configuring Settings for Documents
To configure the drawing settings for an entire 
document:

1. Click Document Settings on the File menu.

Hash 
Spacing

Set the spacing between the 
hashed lines used when wedged 
hashed bonds, hashed bonds, 
dashed bonds, dashed arrows, 
or dashed curves are drawn.

Color Change the color in of selected 
objects. For more information, 
see “Customizing the Color 
Palette” on page 212.

Units Set the units used in the Object 
Settings dialog box to centime-
ters, inches, points, or picas.

Atom and 
Bond Indi-
cators

Set which indicators you want 
to display in your drawings. For 
more information about using 
indicators, see “Atom 
Numbering” on page 75 and 
“Showing Stereochemistry” on 
page 113.

Table 20: Drawing settings 

Adjust 
this… 

If you want to …

2 Point 4 Point 8 Point
CambridgeSoft
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Figure A.45: The Document Settings dialog box

2. Click the Drawing tab and configure the set-
tings.

Figure A.46: Configuring settings on the Drawing tab 
ChemDraw 10
3. Click OK when you are finished.
The settings you chose are applied to the entire 
document.

Terminal Carbon Labels
There is a new Document Setting to automatically 
display terminal carbon labels. The default on 
installation is to not display terminal carbons. 
If you prefer structures to display terminal carbons: 

1. Click Document Settings on the File menu.
2. Select the Atom Labels tab.
3. Check the box next to Show Labels On Termi-

nal Carbons.
Figure A.47: Setting automatic terminal carbons

Configuring Settings for Objects
To configure the drawing settings for a selected 
object:

1. Select the object.
2. Click Object Settings on the Object menu.

The Object Settings dialog box appears with 
the Drawing tab displayed.

Show labels
on Terminal
Carbons
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Figure A.48: The Object Settings dialog box 

3. Configure the settings and click OK.
The settings you chose are applied to the 
selected object only. 

Formatting Text
Text settings affect how captions and atom labels 
for the current document are drawn and formatted.
Formatting options include:

• Font (font type)
• Size (font size)
• Style (font and baseline style)
• Line spacing
• Alignment

These options are described in the following sec-
tions.

Setting Font parameters
Changing text formats in the Document Settings 
dialog box affects the current document only. You 
can also change settings for individual objects by 
using the Object Settings dialog box, the Text 
menu, or the Style toolbar.
206• Customizing ChemDraw
To edit the document text settings for captions and 
atom labels:

1. Click Document Settings on the File menu.
2. In the Document Settings dialog box, click 

Captions or Atom Labels.
Figure A.49: Captions tab 

3. Change the settings if desired. The options are 
described in the following sections.

4. Click OK.
The formatting is applied to the current docu-
ment. 

Setting the Baseline Style
You can specify the following baseline styles: 

• Normal—Use this for standard text.
• Superscript—Reduces the text size by about 

25 percent and raises its baseline.
• Subscript—Reduces the text by about 

25 percent and lowers the baseline.
• Formula—Formats in a way that is appropri-

ate for most chemical formulas, that is, num-
bers are automatically subscripted. You must, 
however, capitalize manually.

You can apply several styles to the same selected 
caption. You can also apply multiple styles to dif-
ferent portions of a single caption.
CambridgeSoft
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If the captions you select have more than one style, 
when you select the text with the Lasso or Mar-
quee tool and select Style from the Text menu, a 
hyphen appears next to each style (other than 
Plain) that is applied to a portion of the selection. 
A check mark appears next to each style that 
applies to all of the selected text. Choosing a style 
other than “Plain” adds the new style to all of the 
selected captions. Previously applied styles are not 
affected—that is, for example, if you select Italic 
for a section that is Bold, it will be Bold Italic.

Specifying Line Spacing
You can specify the three types of line spacing: 

• Automatic—Consistently spaced lines of text 
based on the height of the tallest character in 
the entire caption. This is the default line spac-
ing. 

• Variable—Lines of text with different spacing 
based on the tallest character and the lowest 
descender in each line. 

• Fixed—Consistently spaced lines using a spac-
ing that you specify.

Aligning Text
You can set the alignment of captions and atom 
labels to justify text to suit your needs. The options 
available depend on whether you are aligning cap-
tions or atom labels. Settings are made in the 
Object Settings dialog box.
To open the object settings dialog box, do the fol-
lowing:

1. Select a caption or atom label with the Lasso or 
Marquee tool.

2. Click Object Settings on the Object menu.
The Object Settings dialog box appears.

Captions
You specify the caption justification and line spac-
ing on the Captions tab of the Object Settings dia-
ChemDraw 10
log box. All text in a single caption must have the 
same Justification and Line Spacing. 
There are four available justifications: 

• Flush Left—creates left-justified caption text.

• Centered—creates centered caption text.

• Flush Right—creates right-justified caption 
text.

• Justified—creates right-left justified caption 
text. 

Atom Labels
Use the Centered, Flush Left, Flush Right, Stacked 
Above, or Automatic justifications to create labels 
that identify atoms and functional groups in your 
chemical structure without obscuring any bonds or 
other atom labels.
NOTE: When using Stacked Above justification, enter the 
tokens from top to bottom using Alt+Enter or 
Option+Return to go to a new line. For instance, in the 
example below, enter “OMe Alt+Enter [Option+Return] 
CH2 Alt+Enter [Option+Return] N“. 

If you change the justification after the label is entered, it will 
in most cases generate a warning. 
Examples of the atom label justifications are 
shown below. 
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Figure A.50: Atom label justification 

Automatic Alignment
When you justify Atom labels automatically, 
ChemDraw breaks the label into tokens. A token 
consists of an uppercase letter followed by any 
numbers or lowercase letters. The first token is 
attached to the atom and the rest of the label 
appears without obscuring other parts of the 
chemical structure.
For example, to create N-methylpiperidine, label 
an atom in cyclohexane with the atom label NCH3, 
which contains the three tokens, N and C and H3. 
If you label C3, the tokens are placed from left to 
right because there are bonds to the left of the 
atom.
If you label C5, the tokens are placed from right to 
left because there are bonds to the right of the 
atom:
Figure A.51: Automatic alignment of atom labels 

 In ChemDraw Pro, you can force an 
entire multi-atom label to be a token by defining it 

Stacked Above Centered

Flush Left Flush Right

OMe
CH2
N RNH

N
CH2
OMe

N
CH2

OMe

NCH3 H3CN

ProPro
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as a Nickname. This prevents the label from flip-
ping when applied to the left side of a structure. 
For example, if you define the Nickname CH3, and 
label C5 with the combined label and nickname 
NCH3, the final orientation is CH3N instead of 
H3CN. In this case, the Nickname, CH3, is a token. 
For more examples, see “Using Nicknames” on 
page 81.
If you label C1, the second and third tokens are 
placed above the first token since there are bonds 
below the atom. 
If you label C4, the second and third tokens are 
placed below the first token.
Figure A.52: Using a Nickname as a token 

Changing the Default Caption or 
Atom Label Text Format
Each new caption or atom label uses default docu-
ment settings for the font, size, and style of cap-
tions and atom labels. 
You can change the format by:

• Changing the document settings for subse-
quent drawings in the current document.

• Choosing a new format for an individual cap-
tion or label from the Text menu or toolbar 
before you type.

• Selecting text and applying a new format to an 
individual label after you type.

Specifying Document Settings for New 
Text
To specify the text settings for new captions and 
atom labels in the current document:

1. Click Document Settings on the File menu.

CH3
N

N
CH3
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2. Click Captions or Atom Labels in the Docu-
ment Settings dialog box.

3. Click the appropriate options. 
4. Click OK.

These settings affect all new captions or atom 
labels in the current document. To use these set-
tings in new documents save them in a Style Sheet 
or Stationery Pad. For more information, see “Sav-
ing Customized Settings as Style Sheets or Statio-
nery Pads” on page 201.

Setting an Individual Text Format Before 
Typing
You can set the text format for an individual cap-
tion or atom label before you type. The format 
change is applied to the current text only. 
To set the text format before you type:

1. Click the Text tool and click in the document 
window.
A text box appears.

2. Set the text format in one of the following 
ways:
• Set Font, Style and Size options on the Text 

menu.
• Set the format options from the Style tool-

bar.
3. Type the text in the text box.

The format is applied to the typed text. Any 
subsequent text you type is formatted accord-
ing to the default document settings for the 
current document.

Changing the Spacing of Individual 
Text Objects
You can change the text settings for a specific cap-
tion or atom. The setting change is applied to the 
selected object only. You can also choose whether 
to have the settings applied to the selected text and 
to all subsequent text you type.
ChemDraw 10
To change the text settings for a specific caption or 
atom label:

1. Select the text to change with a selection tool.
2. Set the appropriate options on the Text menu. 

To change only a part of a single caption, select 
part of the caption with the Text tool.
To specify a font and size for selected text, do one 
of the following:

• Choose the font and size from the Text menu.
• Right-click and choose the font and size from 

the right-click menu.
• Select the font and size from the drop-down 

menus on the Style Toolbar.

Fractional Character Widths (Macin-
tosh)
On the Macintosh, you can choose to have the 
spacing between characters as close to propor-
tional as possible. If you are printing to a Post-
Script printer, this option improves the font 
appearance.
To set fractional widths:

1. Click Document Settings on the File menu.
2. Click the Footer tab in the Document Settings 

dialog box.
3. Click Fractional Widths.

Specifying the Margin Width
You can adjust the white space surrounding the 
atom label so that some of the attached bond is 
hidden. 
Figure A.53: Adjusting white space in atom labels 

To adjust the white space:
1. Click Document Settings on the File menu.

The Document Settings dialog box appears.

Cl Cl

0.278 pt 0.6 pt
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2. Click the Drawing tab. 
3. Type a new Margin Width value.
4. Click OK.

The margin width is applied to all subsequent 
drawings in the current document.

Creating HotKeys
To add or edit ChemDraw HotKeys, use a text edi-
tor (Notepad etc.) to open the CS ChemDraw Hot-
keys file in the ChemDraw Items folder. 
You can use any uppercase or lowercase alphanu-
meric key as a Hotkey with the exception of the 
hard coded HotKeys listed previously. If a capital 
and lowercase Hotkey do not exist, the Hotkey is 
assigned to both. If a key is used more than once in 
the file, the one closer to the end of the file takes 
precedence.
To add a Hotkey: 

1. Add a new line and type the key you want to 
use.

2. Type a space.
3. Type the letters to associate with the Hotkey.

HotKeys defined for single elements always 
result in the adding of the appropriate number 
of hydrogen atoms.

4. Save and close the HotKeys file.
To create a new HotKeys file:

1. Create a text file named CS ChemDraw Hot-
keys.

2. Save the file in the ChemDraw Items folder. 
3. Click OK or Save.
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Hard-Coded HotKeys
You cannot edit hard-coded HotKeys. Table 21 
contains a list of hard-coded HotKeys:

NOTE: In earlier versions of ChemDraw, quite a few more 
keys were hard-coded. In ChemDraw 10.0 any key not listed 
above can be customized.

Working with Color
With the color capabilities of ChemDraw, you can 
create full color presentations of your chemical 
drawings to appear on your monitor, print on a 
color printer, or create 35mm slides using a film 
printer.
Most computers can display any of 16 million col-
ors, but the number of colors that can appear at 
any one time may be limited by the particular mon-
itor and display card installed in your computer. 
In ChemDraw, you can choose from a palette con-
sisting of a Background Color, a Foreground 
Color, and up to twenty additional colors for any 
given drawing. A palette is stored in every docu-
ment and Style Sheet or Stationery Pad. You can 
use Style Sheets or Stationery Pads to create a 
series of documents with the same color scheme.
Using color you can:

Table 21: Hard-coded HotKeys 

Hotkey Function

Enter or 
return

Opens the atom label text box.

space Removes an atom label.

Delete or 
Backspace

Deletes objects.
CambridgeSoft
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• Color atoms and bonds in a mostly 
black-on-white drawing to highlight areas of 
interest. 

• Color parts of a structure in a reaction scheme 
to indicate where starting materials end up in 
the products of a complicated mechanism.

• Use colored boxes and circles to highlight 
atoms or molecules.

• Create slides that are easier to view by using 
light objects on a dark background.

Coloring Objects
Any object that you can select with a selection tool 
can be colored. You can color individual bonds, 
part or all of a chemical structure, or objects such 
as boxes, curves, arrows, orbitals and reaction 
mechanism symbols.
The border of objects that are shaded or filled, 
such as white filled s-orbitals in the Orbitals pal-
ette, are the same color as the shading or fill. The 
border of objects that are hollow, such as circles 
and hollow boxes in the Drawing Elements palette 
can be colored, but the inside of the object cannot.
To color an object:

1. Select the object in a document window with a 
selection tool.

2. Do one of the following:
• Click the Color button on the Style toolbar, 

and select the color from the menu that 
appears.

• Choose a color from the Color menu.
• Click the Color button on the Drawing 

tab of the Object Settings dialog box, 
and select the color from the menu that 
appears.

Displaying the Color Palette
You can use the color palette to specify the color 
of objects and text in the document within the 
active window.
ChemDraw 10
To view the Color palette:
1. Click Document Settings on the File menu.
2. Click the Colors tab.

Figure A.54: The Document settings colors tab 

Use the Color tab to specify the following colors:

• Background Color—Fills the background of 
the current document in the active window. 

• Foreground Color—Default color used when 
you draw a new object. 

• Other Colors—Colors available in the Color 
Menu for changing the color of individual 
objects. The colors are represented in the same 
order that they appear in the Color menu. 

You can customize the Color menu. Colors can be 
added, or existing colors can be changed. Changing 
a color, for example Other #2, changes all objects 
that are using the color.
NOTE: If you select an individual or grouped object that 
contains multiple colors, there is a check mark next to each 
of the colors in the Color menu. The purpose of the check 
marks is to alert you that a change would affect more than 
one color.
Customizing ChemDraw • 211
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Customizing the Color Palette 
You can add, remove, or change the default fore-
ground and background color and specify the 
other colors available for coloring objects. 
Changes made to the color palette affect the cur-
rent document only. You can save Color Palette 
settings (foreground, background, and up to 20 
other colors) in a Style Sheet or Stationery Pad. For 
more information, see “Saving Customized Set-
tings as Style Sheets or Stationery Pads” on page 
201.
A summary of each of the options is described in 
the following table. 

Windows Color Settings
To change the palette of colors used in the current 
document:

1. Click Document Settings on the File menu.
The Document Settings dialog box appears.

Table 22: Color palette options 

Option Description

New Color Add a new color box and set its 
color using the Color Picker or 
Color Wheel dialog box. 

Remove Color Delete a color box that you have 
selected in the left side of the 
dialog box. Any objects using 
the removed color are changed 
to the Foreground color. 

Set Color Change the color associated 
with a color box that you have 
selected in the left side of the 
dialog box. Any objects using 
the old color are changed to the 
new color.
212• Customizing ChemDraw
2. Click the Colors tab.
Figure A.55: Document settings Colors tab 

3. Double-click the color to change.
Figure A.56: The Color dialog box 

4. Click a color box in the Basic Colors or the 
Custom Colors section.
A highlighted border appears around the color 
you select. 

5. Click OK.
The color is changed to the new color and 
added to the Color menu.

ColorPalette 150 dpi
CambridgeSoft
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Adding or Customizing Windows 
Colors 
To add colors or create customized colors: 

1. Click Define Custom Colors in the Color dialog 
box.

Figure A.57: Setting custom colors 

2. Click a color in the Color Refiner box to set the 
hue and saturation.
The pointer turns into a Crosshair when you 
click. You can drag to a different region to 
change the hue and saturation.

3. Click in the Luminosity box to set the bright-
ness of the color.

4. If necessary, change the hue, saturation, lumi-
nosity, and RGB components by typing the 
values in the text boxes. 

5. Click the Add to Custom Colors button.

Macintosh Color Settings
To change the palette of colors used in the current 
document:

1. Click Document Settings on the File menu.
The Document Settings dialog box appears.

2. Click the Colors tab.
3. Click New Color.

Color Refiner box Luminosity box
ChemDraw 10
Figure A.58: The Color Picker dialog box 

4. Use one of the icons on the left to select a 
method of defining your color, then select a 
color. 
For more information about the Macintosh 
color options, refer to your System documen-
tation.

5. Click OK.
The new color appears in the Colors tab in 
place of the original color and is added to the 
color menu.

Adding or Customizing Macintosh 
Colors
To add a new color to the Color menu:

1. Click New Color or Set Other Color on the 
Color tab.
The Color Picker dialog box appears.

2. Click a color in the Color Wheel.
3. If necessary, adjust the hue, saturation, bright-

ness, and RGB components by typing in the 
values.

4. Click OK.
The new color is added to the list of Other Col-
ors.

Removing Colors
To remove a color from the Color menu:
Customizing ChemDraw • 213
Overview



A
dm

inistrator
1. Click the color you want to remove.
A highlight box appears around the color.

2. Click Remove Color.
The color disappears from the list of other col-
ors. Objects that were drawn in the removed 
color are changed to the Foreground color

Templates and Color
The background and foreground colors used in a 
template from the template pop-up palette are not 
used when the template is drawn in a document 
window. However, any other colors used in the 
template are added to the color palette of the cur-
rent document if they are not already present. This 
is part of the autoscale feature. For more informa-
tion, see “Autoscaling” on page 165.

Saving Color Palette Settings
You can save the Color Palette in a Style Sheet or 
Stationery Pad. The Color Palette is saved in addi-
tion to other document settings such as Page Setup 
settings, Text settings, and Drawing settings.

Printing
ChemDraw uses the standard system commands to 
print ChemDraw documents. The options that you 
have available to you depend on the printer that 
you are using. Refer to your printer’s documenta-
tion for more information. 
In general, to print a ChemDraw document:

1. Click Page Setup on the File menu.
2. Make all appropriate selections for the printer 

you are using and click OK.
3. Click the Print command on the File menu.
4. Make your selections in the Print dialog box 

and click OK.
To print a document:

1. Select the document you want to print. 
2. Click Print on the File menu.
214• Customizing ChemDraw
The ChemDraw application is opened and the 
Print dialog box appears.

3. Make your selections in the Print dialog box 
and click OK.

Printing Background Color
Print Background Color controls whether the 
Background Color contained in your ChemDraw 
document is printed.
To change whether the Background color is 
printed:

1. Click Preferences on the File menu.
2. Click Print Background Color.
3. Click OK.

Macintosh Print Preferences 
When you print a document, ChemDraw creates 
both a QuickDraw representation and a PostScript 
representation of the document’s contents. 
QuickDraw is the graphical format that is sup-
ported by the Macintosh Operating System. Every 
printer that supports the MacOS can convert 
QuickDraw representations into printed output. 
However, QuickDraw does not support some fea-
tures (for example, high-resolution printing) that 
are available only on some printers.
If you are transferring information to another 
application from which you print ChemDraw pic-
tures, you should consider including PostScript 
commands and the ChemDraw LaserPrep File 
with the pictures. For information about special 
situations to consider, see “Transferring PostScript 
(Macintosh)” on page 167.

Optimize Pictures for High-Resolution 
Non-PostScript Printing 
The Macintosh High Resolution Clipboard sup-
ports high-resolution printers. Most applications 
support the High Resolution Clipboard. Because 
this was not always the case in the past, this prefer-
ence continues to be available for users to turn off 
CambridgeSoft
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if an application being used does not support the 
High Resolution Clipboard.
If you are unsure if the application uses a High 
Resolution Clipboard, try transferring pictures with 
this check box selected and deselected, and see 
which picture prints with higher quality. 
If you are printing to a non-PostScript printer, 
deselect Include ChemDraw LaserPrep and Include 
PostScript to reduce the size of each picture. Do 
not deselect this option if the document will ever 
be printed to a PostScript printer.
Printers that use the PostScript page definition lan-
guage use the PostScript representation. The Post-
Script representation describes objects by using 
mathematical shapes that can be precisely imaged 
at whatever resolution is used by your printer. The 
PostScript representation created by ChemDraw is 
composed of two parts, the PostScript commands 
and the ChemDraw Laser Prep. The ChemDraw 
Laser Prep contains specific instructions that 
enable the printer to interpret the PostScript com-
mands contained in a ChemDraw document. 

Include PostScript 
To transfer ChemDraw pictures to another docu-
ment that will be printed on a PostScript printer:

1. Click Preferences on the File menu.
2. Click Include PostScript.
ChemDraw 10
3. Click OK.
When Include PostScript is deselected, no Post-
Script commands are generated. This usually 
results in lower quality printing, particularly of 
drawings cut and pasted into other applications. 
However, because the representation used for 
printing when Include PostScript is not selected is 
the same as that used for drawing to the screen, 
better correspondence between the screen and 
printed output may be observed. 
For more information, see “Transferring Post-
Script (Macintosh)” on page 167.

Include ChemDraw Laser Prep 
Selecting the include ChemDraw Laser Prep allows 
you to print to a printer that cannot be initialized 
using ChemDraw. If you create drawings with this 
option off, they will not print on PostScript print-
ers without the use of ChemDraw.
To Include ChemDraw Laser Prep:

1. Click Preferences on the File menu.
2. Click Include ChemDraw Laser Prep.
3. Click OK.

NOTE: When you select Include ChemDraw Laser Prep, 
you should also select Include PostScript.
For more information, see “Transferring Post-
Script (Macintosh)” on page 167.
Customizing ChemDraw • 215
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Appendix B: Document Settings

Creating Style Sheets or 
Stationery Pads
To create your own Style Sheet or Stationery Pad:

1. Create a new document. 
2. Enter the settings in the Page Setup, Drawing, 

Text Settings, and Color Palette dialog boxes. 
3. Click Save As on the File menu. 
4. In the Save As dialog box:

d. Select the CD Style Sheet or Stationery Pad 
file format.
e. Type a name for the document.
f. Select the ChemDraw Items folder as the 

location for saving the template.
5. Click OK or Save.

ChemDraw Style Sheets or 
Stationery Pads
This following table contains drawing settings and 
a sample structure for each of the Style Sheets or 
Stationery Pads ChemDraw provides.
ChemDraw 10 Document Settings • 217
Creating Style Sheets or Stationery Pads

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

ACS 1996 • Fixed Length: 14.4 pt

• Bold Width: 2 pt

• Line Width: 0.6 pt

• Margin Width: 1.6 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 18

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 10 pt

• Drawing Area (Width x Height): 540 pt x 720 pt

• Page Size: US Letter

• Reduction (%): 100

N

HO

H

O

ACS 1996

Morphine
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Adv.Synth Catal. • Fixed Length: 17 pt

• Bold Width: 2 pt

• Line Width: 1 pt

• Margin Width: 1.6 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 18

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Times New 
Roman/Times

• Caption Size: 12 pt

• Drawing Area (Width x Height): 540 pt x 720 pt

• Page Size: US Letter

• Reduction (%): 100

J.Chin. Chem. Soc. • Fixed Length: 18 pt

• Bold Width: 2.5 pt

• Line Width: 1 pt

• Margin Width: 2 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 20

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 12 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 12 pt

• Drawing Area (Width x Height): 693 pt x 918 pt

• Page Size: US Letter

• Reduction (%): 80

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

Adv. Synth. Catal.

N

H

HO
O

HO

Morphine

N
H
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O

HO

J. Chin. Chem. Soc.
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J. Mol. Mod. • Fixed Length: 14.4 pt

• Bold Width: 2 pt

• Line Width: 0.6 pt

• Margin Width: 1.6 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 18

• Atom Label Font (Win/Mac): Times New 
Roman/Times

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Times New Roman/Times
• Caption Size: 10 pt

• Drawing Area (Width x Height): 8.5 cm x 25.4 cm (1 
column); 17 cm x 25.4 cm (2 column)

• Page Size: US Letter

• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

N

HO
O

H

J. Mol. Mod.
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New Document • Fixed Length: 30 pt

• Bold Width: 2 pt

• Line Width: 1 pt

• Margin Width: 2 pt

• Hash Spacing: 2.7 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 12

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Times New 
Roman/Times

• Caption Size: 12 pt 

• Drawing Area (Width x Height): 7.5 in x 10 in

• Page Size: US Letter or A4 (as selected)
• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

N

H

OH

O

OH

New Document

Morphine
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New Slide • Fixed Length: 30 pt

• Bold Width: 4 pt

• Line Width: 1.6 pt

• Margin Width: 2 pt

• Hash Spacing: 2.7 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 15

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 12 pt

• Caption Font (Win/Mac): Times New 
Roman/Times

• Caption Size: 16 pt

• Drawing Area (Width x Height): 7.5 in x 10 in

• Page Size: US Letter

• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads
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Phytomedicine • Fixed Length: 20 pt

• Bold Width: 1.33 pt

• Line Width: 1pt

• Margin Width: 1.25 pt

• Hash Spacing: 3 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 8
• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 12 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 12 pt

• Drawing Area (Width x Height): 540 pt x 720 pt

• Page Size: US Letter

• Reduction (%): 100

RSC • Fixed Length: 0.43 cm

• Bold Width: 0.056 cm

• Line Width: 0.016 cm

• Margin Width: 0.044 cm

• Hash Spacing: 0.062 cm

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 20

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 9 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 9 pt

• Drawing Area (Width x Height): 8.9 cm x 25.4 cm (1 
column); 19 cm x 27.7 cm

• Page Size: US Letter

• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads
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Science of Synthesis • Fixed Length: 17 pt

• Bold Width: 2 pt

• Line Width: 0.8 pt

• Margin Width: 2.25 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 18

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 10 pt

• Drawing Area (Width x Height): 19.79 cm x 27.15 cm

• Page Size: A4

• Reduction (%): 100

Synthesis, Synlett • Fixed Length: 17 pt

• Bold Width: 2 pt 

• Line Width: 0.8 pt

• Margin Width: 1.3 pt

• Hash Spacing: 2.5 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length): 18

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 10 pt

• Drawing Area (Width x Height): 12 cm x 26.7 cm

• Page Size: A4

• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

N

HO

H

O

Science of Synthesis

Morphine
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H
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Verlag Helvetica Chimica Acta • Fixed Length: 17 pt

• Bold Width: 2.9 pt

• Line Width: 0.54 pt

• Margin Width: 2 pt

• Hash Spacing: 2 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length):14

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 10 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 12 pt

• Drawing Area (Width x Height): 368 x 720 pts

• Page Size: US Letter

• Reduction (%): 100

Wiley Document • Fixed Length: 17 pt

• Bold Width:2.6 pt

• Line Width:0.75 pt

• Margin Width: 2 pt

• Hash Spacing: 2.6 pt

• Chain Angle (degrees): 120

• Bond Spacing (% of length):18

• Atom Label Font (Win/Mac): Arial/Helvetica

• Atom Label Size: 12 pt

• Caption Font (Win/Mac): Arial/Helvetica

• Caption Size: 12 pt

• Drawing Area (Width x Height): 19.79 x 27.15 cm

• Page Size: A4

• Reduction (%): 100

Drawing, Atom Label, and Caption Text Settings in Journal Style Sheets or Stationery 
Pads

Verlag Helvetica Chimica Acta
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Wiley Document
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Appendix C: Chemistry File Formats

File formats other than ChemDraw may not pre-
serve all of your data. ChemDraw can create many 
types of items—particularly graphical objects such 
as boxes and curves—that cannot be saved into 
chemical file formats. 
Other file formats sometimes contain data that 
cannot be interpreted by ChemDraw. ChemDraw 
always tries to interpret other file formats so that as 
much chemically-relevant data is preserved as pos-
sible, even if that causes the actual appearance of 
the file to change when it is saved and reopened.
Most file formats supported by ChemDraw are 
proprietary or extremely complex and are docu-
mented more thoroughly elsewhere. For example, 
you can find more information about Cambridge-
Soft’s CDX file format at: sdk.cambridgesoft.com

 Connection Table File 
Format
The connection table format file described in this 
section is generated for the cyclohexanol structure 
shown below. All references to atom serial num-
bers are based on the Atom Numbering shown.
Figure C.59: Atom numbering used in the following 
examples 

Table 23 is a sample Connection Table file pro-
duced for cyclohexanol using ChemDraw. The line 

6

5

4

3

2

1

OH7
ChemDraw 10
numbers are added for purposes of discussion 
only.

Each line represents a data record containing one 
or more fields of information about the structure. 
Individual fields are delimited by space(s) or a tab. 
The fields in the Connection Table format file used 
by ChemDraw are discussed below. The field value 
for Carbon 6 from the example file is included in 
parentheses for reference.

• Line 1 is the molecule name. The molecule 
name is the file name when the file was created 
using ChemDraw.

• Line 2 contains two fields: the first field is the 
number of atom labels, and the second field is 
the number of bonds. These fields must be 
separated by at least one space.

Table 23: Sample connection table for cyclohexanol

Line 1 Cyclohexanol

Line 2 7 7

Line 3 0.0000 0.5000 0.0000 C

Line 4 -0.8667 0.0000 0.0000 C

Line 5 -0.8667 -1.0000 0.0000 C

Line 6 0.0000 -1.5000 0.0000 C

Line 7 0.8667 -1.0000 0.0000 C

Line 8 0.8667 0.0000 0.0000 C

Line 9 0.0000 1.5000 0.0000 O

Line 10 1 2 1 1

Line 11 2 3 1 1

Line 12 3 4 1 1

Line 13 4 5 1 1

Line 14 5 6 1 1

Line 15 1 6 1 1

Line 16 6 7 1 1
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• Lines 3. 9 each contain 4 fields describing 
information about the individual atoms: the 
first field is the X Cartesian coordinate 
(0.8667), the second field is the Y Cartesian 
coordinate (0.0000), the third field is the Z Car-
tesian coordinate (0.0000), and the fourth field 
is the atom label (C). 
The spacing of these fields is very important. 
Any data outside the following columns (espe-
cially data overlapping the ranges) may render 
a file unreadable.
• Field 1: Columns 0. 9
• Field 2: Columns 10. 19
• Field 3: Columns 20. 29
• Field 4: Columns 31. end

• Lines 10. 16 each contain four fields describing 
information about the individual bonds 
between the atoms: the first two fields repre-
sent the serial numbers of the atoms that are 
connected by this bond (atom 1 and atom 6), 
the third field is the bond order (1) and the 
fourth field is the bond type (1). 

The bond types for the Connection Table format 
are listed in Table 24:

Table 24: Encoding for bond types 

value bond type

1 Single.

2 Dashed.

3 Hashed.

4 Wedged hash with first atom at 
narrow end.

5 Wedged hash with second 
atom at narrow end.
226• Chemistry File Formats
Double bonds are bit encoded using a bitmask. 
The default value (0) indicates a normal (two solid 
lines) double bond, with the second line on the 

6 Bold.

7 Wedged with first atom at 
narrow end.

8 Wedged with second atom at 
narrow end.

9 Wavy.

10 Hollow wedge with narrow end 
towards 1st atom.

11 Hollow wedge with narrow end 
towards 2nd atom.

12 Dative bond with arrow 
towards 2nd atom.

13 Dative bond with arrow 
towards 1st atom.

14 Any (bond property).

15 Single/Double (bond prop-
erty).

16 Double/Aromatic (bond prop-
erty).

17 Single/Aromatic (bond prop-
erty).

Table 24: Encoding for bond types 

value bond type
CambridgeSoft



right (looking from the first atom to the second). 
Other values are listed in Table 25:

Table 25: Encoding of double bonds 

value bond type/position

1 The second line is on the left 
(looking from the first atom to 
the second).

2 The two lines are centered.

4 A double bond with one 
dashed and one solid line.

8 A modifier to the previous two 
values, indicating that the user 
specifically set the positioning. 
If this bit is not present, Chem-
Draw calculated the posi-
tioning automatically.
ChemDraw 10
So, for example, a bitmask value of 13 (= 1 + 4 + 
8) means a double bond with one dashed and one 
solid line (4), where the user specifically wants (8) 
the second line to be on the left (1).
NOTE: This connection table format is obsolete, and is 
documented here for historical purposes only. This format 
should never be used for critical work where chemical infor-
mation is important.

16 A double bond with one bold 
and one solid line.

32 A crossed bond.

64 A double bond with two 
dashed lines.

Table 25: Encoding of double bonds 

value bond type/position
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Appendix D: ChemDraw Chemistry 

ChemDraw automatically converts lines, charac-
ters, and other symbols into chemically meaningful 
figures as you work. This work occurs in the back-
ground, but you can choose to view this chemical 
data using Check Structure, Analyze Structure, and 
Expand Atom Labels. ChemDraw also uses this 
chemical data when exporting to file formats that 
support only a subset of the notations that Chem-
Draw does.
This appendix describes how ChemDraw inter-
prets what you draw and how you can help Chem-
Draw better interpret what you mean.

Chemical Intelligence in 
ChemDraw
ChemDraw was designed as a tool to aid in chemi-
cal communication. Most chemists would under-
stand AcOo-C6H4COOH immediately, whether or 
not they recognized it as aspirin. Most computer 
programs, however, require what is known as a 
“complete connection table,” in this case, a collec-
tion of 21 atoms connected by 5 double bonds and 
16 single bonds in a specific pattern. ChemDraw 
takes what makes sense to a chemist and converts 
it into what makes sense to another application.
This chemical intelligence can be used as a sophis-
ticated “spelling” checker for chemical com-
pounds. For example, if you’re investigating 
organic acids, a compound with the structural for-
mula CH3COO would probably represent acetic 
acid. Present the same formula in a paper on tran-
sition metal chemistry, and you might be describ-
ing a novel methylated cobalt oxide. If you had 
asked ChemDraw to interpret it beforehand, you 
would have received a message reporting a valence 
ChemDraw 10
error, and you might have been prompted either to 
add a negative charge or to change the capitaliza-
tion. 
ChemDraw can offer only suggestions. If you and 
your audience understand what you are trying to 
depict, then you can ignore these suggestions. In 
many cases, you can teach ChemDraw to under-
stand the notation you’re using. For more informa-
tion, see “Applying Nicknames” on page 82.

Database Conventions
Most databases require not only that you draw a 
structure in a way that makes sense, but that you 
draw it in the way that the database expects it. 
Consider ferrocene, which is represented in at least 
four different ways in major databases:
Figure D.60: Representations of ferrocene 

A successful search in one database might not pro-
duce any hits in another. When in doubt, consult 
the documentation for your database, and see if it 
offers any clues to the conventions used.

Merck Index and 3 other isomers
Beilstein
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Chemical Conventions
The following table describes the chemical conven-
tions understood by ChemDraw.
Table 26: Bond conventions in ChemDraw

Bond Description

Single bond, unspecified stereo-
chemistry.

Single bond, “down” stereochem-
istry (into the plane of the paper, 
away from the viewer), from the first 
drawn atom to the second drawn 
atom.

Single bond, “up” stereochemistry 
(out of the plane of the paper, 
toward the viewer), from the first 
drawn atom to the second drawn 
atom.

Single bond, mixture of “up” and 
“down” stereochemistries in some 
unspecified proportion.

Dative bond. Often used to indi-
cate polar bonds, such as the N-O 
bond in pyridine N-oxide.

Double bond, with cis/trans stere-
ochemistry as drawn.

Double bond, with cis/trans stere-
ochemistry unknown.

Tautomeric bond, either single or 
double according to rules of 
tautomerism.

Aromatic bond, part of a delocal-
ized resonance system.

Triple bond.

Quadruple Bond.
230• ChemDraw Chemistry
A single bond near a closed circle is recognized as 
aromatic:
Figure D.61: Aromatic examples 

Atom Labels
A simple atom label may contain any of the follow-
ing:

When analyzing an atom label, ChemDraw starts at 
the left and continues to the right, applying stan-
dard rules of valence to determine which atoms are 
bound to which. The exception is with an atom 
label in Automatic alignment on the left side of a 
compound. This sort of atom label is displayed 
“backwards” (H3CO instead OCH3) and is there-

Table 27: Atom label examples 

A single element.

An element and some 
number of hydrogen 
atoms.

A nickname.

Repeating units within 
parentheses.

+*/

A series of any combi-
nation of the above.
CambridgeSoft



fore parsed from right to left. Standard valences 
for each atom are defined in the Isotopes Table.
By definition, a “simple” atom label has all bonds 
attached to the first (or last) character. A multi-
attached atom label has bonds connected to more 
than one character, or has all of its bonds attached 
to a specific character in the middle of the atom 
label. Multi-attached atom labels are always parsed 
from beginning to end, but again the beginning 
might be on the right if the atom label was in Auto-
matic style and on the left side of the original struc-
ture:

Multiple fragments within a single label can be 
specified in the following ways:

Table 28: Multi-attached labels 

A multi-attached label that 
is parsed from left to right.

A multi-attached label that 
is parsed from right to left.

A bond attached to the 
open parenthesis of a 
repeating group is treated 
as if bonded to the first of 
those groups.

A bond attached to the 
close parenthesis or repeat 
count of a repeating group 
is treated as if bonded to 
the last of those groups.

Table 29: Multiple fragments 

Implicitly, using stan-
dard valence rules.
ChemDraw 10
Chemically Significant Text
Often it is simpler to write a chemical formula like 
MeOH or H2O than it is to draw out an entire 
atoms-and-bonds structure. ChemDraw correctly 
interprets any unambiguous structural formula. For 
example, CH3COCH2CH3 is recognized as methyl 
ethyl ketone and MeOH is recognized as methanol. 
On the other hand, C6H6 might mean benzene, or 
it might mean one of over 200 other isomers. 
C6H6 is not recognized by ChemDraw, and gener-
ates an error message if you try to analyze it. Gen-
erally, empirical formulas (C2H6 and H2SO4) are 
not recognized, but structural formulas (CH3CH3 
and HOSO2OH) are.

Molecular weight and elemental analyses of empiri-
cal structures is possible, but the Expand Label 
command does not work with them. Empirical 
structures are discarded when they are transferred 
to other applications that require unambiguous 
structures.

Explicitly, using a space, 
period (unsuperscripted 
or unsubscripted), bullet, 
or combination.

An unsuperscripted, 
unsubscripted integer at 
the start of a fragment is 
recognized as a stoichio-
metric multiplier and is 
treated as if the appro-
priate number of frag-
ments were drawn 
explicitly.

Table 29: Multiple fragments 
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Chemically-significant text must be entirely in For-
mula or, for isotopes and charges, Superscript 
style. ChemDraw does not recognize a chemical 
formula embedded within a larger block of text.

Charges
Charges may be created as part of a textual atom 
label or with the appropriate symbol from the 
Chemical Symbols Palette. Charges are always 
assigned to a specific element in the atom label, 
whose acceptable valences become those of the 
similar isoelectronic neutral element.

Table 30: Chemically significant text 

If you draw a bond, add an atom 
label, and then delete the bond, 
you have a chemically mean-
ingful text block whose font, 
size, and style match other atom 
labels.

If you create a caption with the 
text tool and set it to Formula 
style, you have a chemically 
meaningful text block whose 
font, size, and style match other 
captions.

Table 31: Charge examples 

A charge following an element 
is assigned to that element.

 

A charge that does not follow 
an element is assigned to the 
next element.

Charges that follow a monova-
lent element with a repeat 
count are assigned to the 
element before that element.

NH4+

H2O
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Isotopes and Elements
By default, ChemDraw correctly recognizes all iso-
topes in the full Table of the Elements. This data is 
provided by CRC Press, Inc. Isotopes are defined 

Charges that follow other 
repeating units are distributed 
among those units.

Charges may be superscripted.

Multiple charges are recog-
nized appropriately.

Charges may have repeat 
counts as long as both the 
charge and the repeat count are 
superscripted.

A “floating” charge placed with 
the Chemical Symbols Tool is 
assigned to the nearest atom. If 
no atom is within the distance 
set as the Fixed Length, the 
charge is ignored and not 
assigned to any atom.

A “floating” charge placed 
within a delocalized system is 
recognized by the Analyze 
Structure function, but is 
discarded when saved to 
formats that require all charges 
to be associated with specific 
atoms.

Table 31: Charge examples 
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in the Isotopes Table file. You can edit this file to 
add new isotopes in any text editor. 

Radicals
Radicals are indicated with the appropriate symbol 
from the Chemical Symbols Palette. As with 
charges, they are assigned to the nearest atom. 
Radicals always occupy one free valence, in addi-
tion to any charge effects.
Figure D.62: Radical examples 

H-Dot/H-Dash
H-Dot and H-Dash symbols from the Chemical 
Symbols Palette indicate the stereochemistry of a 
single hydrogen atom. These symbols are most 
commonly used in fused systems.
Figure D.63: H-dot example 

Table 32: Isotope examples 

A superscripted number 
before the element 
symbol indicates isotope 
numbers.

Isotopes can be 
included anywhere that 
regular elements can.

Deuterium and Tritium 
can be indicated by their 
one-letter symbols.

Ph
CPh

Ph
C O

H

H

ChemDraw 10
Complexes
Compounds with electron pairs can act as Lewis 
bases, bonding with Lewis acids that are electron-
deficient. Similar behavior can be seen between 
lone pairs and metals. 
The best representation of these types of interac-
tion is with a dative bond from the electron-pair 
donor to the acceptor. With a plain bond instead 
of the dative bond, ChemDraw would report a 
valence error. The dative bond more accurately 
represents the electron donation.
Complexes may also be represented with explicit 
lone pairs and without any bonds.
If you use a plain bond to indicate a complex, you 
may want to set Abnormal Valence to Allowed in 
the Atom Properties dialog.
Table 33: Complexes 

Boron trifluoride-
ammonia complex.

Boron trifluoride-
acetic acid 
complex.

Heme, a 
compound with 
two formal cova-
lent bonds and two 
formal donor-
acceptor pairs.

NH3F3B

HO

O

F
B

F
F

N

N N

N

HO O

Fe
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Multi-center Attachments
Multi-center attachments are meaningful only 
when created using Add Multi-Center Attachment 
from the Structure Menu. This command creates a 
pseudo-atom that is disregarded during chemical 
calculations, but still allows you to create diagrams 
that look meaningful to an experienced chemist.
Figure D.64: η3 or π-Allyl complex

Figure D.65: Ferrocene, a π-Aryl complex

Figure D.66: Cp2TiCl2, another π-Aryl complex

Another represen-
tation of heme.

Table 33: Complexes 

N

N N

N

HO O

Fe

M

Fe

Ti

Cl Cl
234• ChemDraw Chemistry
Figure D.67η-C5H5Mn(CO)3

Stereochemistry
Absolute stereochemistry is calculated for tetrahe-
dral atoms and double bonds according to the 
Cahn-Ingold-Prelog (CIP) priority rules. The CIP 
rules are designed to order ligands by their priority 
and determine a descriptor based on the orienta-
tion of the ordered ligands in space.
A ligand is an entity attached to a stereocenter. For 
example, a tetrahedral carbon has four ligands cor-
responding to its four substituents. When a tetra-
hedral carbon is in a ring, it still has four ligands: 
the two ligands outside the ring, a third consisting 
of the ring “unpeeled” clockwise, and a fourth 
consisting of the ring “unpeeled” counterclock-
wise.
Five rules are used to determine the priority of 
ligands are summarized below in simplified form. 
For more detailed information, see the references. 
They are checked sequentially as follows:

• Rule 1—Higher atomic number precedes 
lower

• Rule 2—Higher atomic mass precedes lower
• Rule 3—cis precedes trans
• Rule 4—Like pairs of descriptors precede 

unlike pairs
• Rule 5—R precedes S

ChemDraw checks differences up to 15 atoms dis-
tant from the stereocenter.

Mn

OC
CO

CO
CambridgeSoft



Stereochemical Indicators
After the ligands are ranked, an indicator is 
assigned as shown in the following table.1

Stereochemical Flags
While the chirality of a specific stereocenter can be 
indicated with the appropriate wedged, hashed, or 
plain bond, sometimes it is useful to indicate the 
relative stereochemistry of a molecule as a whole, 
considering the relationship between all stereo-

Table 34: Ligand ranking in stereochemistry 

Stereocenter Indicator

Double bond Z if the highest ranking ligand 
of each pair are on the same 
side of the bond; otherwise E.

Tetrahedral atom When the lowest-ranking ligand 
is located behind the central 
atom:

• R when remaining 3 
ligands are arranged clock-
wise in descending order

• S when remaining 3 ligands 
are arranged counterclock-
wise in descending order

• r or s is used for pseudo 
asymmetric atoms 

1. R.S. Cahn, C.K. Ingold, and V. Prelog, “Speci-
fication of Molecular Chirality”, Angew. Chem., 
Int. Ed. Engl. 1966, 5, 385-414 (errata: 1966, 5, 
511); Angew. Chem. 1966, 78, 413-447.
V. Prelog and G. Helmchen, “Basic Principals of 
the CIP-System and Proposals for a Revision”, 
Angew. Chem. 1982, 94, 614-631; Angew. Chem. 
Int. Ed. Engl. 1982, 21, 567-583.
P. Mata, A.M. Lobo, C. Marshall, and A.P. 
Johnson, “The CIP Sequence Rules: Analysis and 
Proposal for a Revision.” Tetrahedron:Asymme-
try. 1993, 4, 657-668.
ChemDraw 10
centers. Stereochemical flags apply to the nearest 
structure; if no structure is within the distance 
specified by the Fixed Length value, the stere-
ochemical flag is not assigned to any structure.

Polymer Representations
Brackets are used to enclose repeated structures or 
structural fragments. ChemDraw provides bracket 
properties to specify the orientation and context of 
the repeating units. An explanation of the bracket 
properties is given in “Representing Polymers and 
Other Repeating Units” on page 99.

References 
“Graphic Representations (Chemical Formulae) of 
Macromolecules (Recommendations 1994)” Pure 
Appl. Chem., 66, 2469-2482 (1994).

Table 35: Stereochemical flags 

The Absolute 
flag indicates 
the exact stere-
oisomer as 
drawn.

The Relative 
flag indicates 
the exact stere-
oisomer as 
drawn, or its 
enantiomer.

The Racemic 
flag indicates a 
mixture of the 
exact stereoi-
somer as drawn 
and its enanti-
omer.

COOH

NH2

Abs

COOH

NH2

COOH

NH2

Rel

COOH

NH2

COOH

NH2

OR

COOH

NH2

COOH

NH2

COOH

NH2

AND

Rac
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“Source-Based Nomenclature for Copolymers 
(Recommendations 1985)” Pure Appl. Chem., 57, 
1427-1440 (1985). Also available at: 
http://www.iupac.org/publications/books/pbook/Pur-
pleBook-C7.pdf.
“Basic Definitions of Terms Relating to Polymers 
(1974)” Pure Appl. Chem., 40, 479-491 (1974) Also 
available at: 
http://www.iupac.org/reports/1996/6812jenkins/inde
x.html).
Also see the Guide for the authors of papers and 
reports in polymer science and technology from 
IUPAC.

Query Properties
By their nature, query properties do not represent 
actual chemical features, but describe broad classes 
or groups of features. For information on using 
query properties, see Chapter 5: Query Structures.

Analysis Messages
When ChemDraw is unable to analyze your struc-
ture fully, two general types of messages are dis-
played: 

• Status messages that report a problem that may 
not affect the final analysis
236• ChemDraw Chemistry
• Critical messages that may affect the final anal-
ysis

Table 36: Analysis messages 

Message Description

There are too 
many bonds to 
this unlabeled 
Carbon.

Displayed for every unlabeled 
atom with more than 4 filled 
valences. Filled valences 
include sum of bond orders, 
charge, radicals, and free sites. 
Aromatic bonds count 1.5 
each, rounded down unless it is 
the only bond to the atom. 
Charge is signed and includes 
charge implied by dative 
bonds. The Substituents query 
property treats Free Sites, Up 
to and Exactly the same way: 
an atom with 2 explicit bonds 
and “Substituents: Up To 3” or 
“Substituents: Exactly 3” or 
“Substituents: Free Sites 1” has 
three filled valences.

An atom in this 
label has an 
invalid valence.

Displayed in a variety of cases 
where ChemDraw cannot find 
a place to put a bond or cannot 
find a bond to put on an atom. 
Valid valences for each 
element are listed in the 
Isotopes Table file.

ChemDraw can’t 
interpret this 
label.

Displayed when ChemDraw 
finds text that it cannot identify 
as an element, nickname, 
generic nickname, or alterna-
tive group name.
CambridgeSoft
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Parentheses don’t 
match.

Displayed when parentheses 
cannot be matched into nested 
open-close pairs.

This label has 
conflicting or 
unassignable 
charges.

Displayed when a plus and 
minus charge have been 
assigned to the same element, 
charges have been assigned in 
more than one way, or a charge 
has been assigned to a nick-
name, generic nickname, or 
Alternative Group name.

Formula cannot 
be computed for 
queries.

Displayed for every label that 
contains a generic nickname, 
an element list or an alternative 
group. This is a status message 
only; analysis continues as if 
the problematic label were not 
selected.

Text not in 
Formula style 
won’t be inter-
preted.

Displayed for the first caption 
that is not an atom label or 
Alternative Group name, and 
which contains any text not in 
Formula, Subscript, or Super-
script style. This is a status 
message only, and appears only 
once regardless of how many 
captions are in the selection.

This named alter-
native group 
contains no 
attachment point.

Displayed for any structure 
within an Alternative Group 
Box where the structure lacks 
an attachment point. This is a 
status message only.

Table 36: Analysis messages 

Message Description
ChemDraw 10
This named alter-
native group 
contains frag-
ments with 
inconsistent 
valences.

Displayed for any Alternative 
Group Box whose contained 
structures have varying 
numbers of attachment points. 
Since all structures within an 
Alternative Group Box are to 
be used interchangeably, they 
must have the same number of 
attachments. This is a status 
message only.

This named alter-
native group 
contains no frag-
ment.

Displayed for any Alternative 
Group Box that is empty. This 
is a status message only.

Part of a mole-
cule is outside of 
the alternative 
group definition.

Displayed for any Alternative 
Group Box whose border 
crosses part of a structure. This 
is a status message only.

This isolated 
bond is probably 
not intended to 
have chemical 
significance.

Displayed for unlabeled single 
bonds unattached to other 
bonds. All bonds are inter-
preted chemically, usually as 
C2H6, and may cause unex-
pected results if intended as a 
graphical line only. This is a 
status message only.

The atom is very 
close to another 
atom or bond.

Displayed for any atom that is 
nearly touching another atom 
or bond but not bound to it. If 
a bond really was intended, the 
analysis of the structure 
produces incorrect results. 
This is s status message only.

Table 36: Analysis messages 

Message Description
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The stereocenter 
has no stereo-
bonds specified. 

Displayed for any asymmetric 
center without attached 
wedged, hashed, dashed, or 
bold bonds. This is a status 
message only, and appears only 
when Show Stereochemistry is 
tuned on and there is at least 
one other wedged, hashed, 
dashed, or bold bond in the 
structure. 

There is a valence 
and charge error 
somewhere in 
this aromatic 
system.

Displayed for any 
odd-membered ring drawn as a 
delocalized system (with a 
circle in the middle), where 
there is no corresponding asso-
ciated charge. For example, a 
delocalized representation of 
cyclopentadiene must include 
either a negative charge or a 
multicenter attachment.

The stereocenter 
has conflicting or 
ambiguous stere-
obonds specified.

Displayed for any stereocenter 
(tetrahedral atom, asymmetric 
double bond, etc.) where the 
absolute stereochemistry 
cannot be determined from the 
structure as drawn. For 
example, this message would 
be shown for a carbon atom 
attached by bold bonds to four 
different ligands. This message 
is displayed only when Show 
Stereochemistry is also turned 
on.

Table 36: Analysis messages 

Message Description
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This label has an 
unrecognized 
isotopic mass.

Displayed for every label that 
has a numeric superscript 
immediately preceding an 
atomic symbol, where the 
superscripted number does not 
correspond to a recognized 
isotope. For example, 24CH3.

Table 36: Analysis messages 

Message Description
CambridgeSoft



Appendix E: How ChemProp Works

ChemProp Values
ChemProp enables you to calculate predicted val-
ues of selected physical and thermodynamic prop-
erties for structures of up to 100 atoms. The 
following topics describe how ChemProp obtains 
its values.

LogP
LogP (partition coefficient for n-octanol/water)—
three fragmentation methods are used to predict 
the logP values. 
Method one is based on 94 atomic contributions 
evaluated from 830 molecules by least squares 
analysis. This method works with a standard devia-
tion of 0.47 logP units and can handle molecules 
containing hydrogen, oxygen, nitrogen, sulfur and 
halogens. 

6. Method two is an extension of method one 
that is based on 120 atomic contributions eval-
uated from 893 molecules by least squares anal-
ysis. In addition to the atoms introduced for 
method one, it can handle molecules that con-
tain phosphorus and selenium atoms. This 
method works with a standard deviation of 
0.50 logP units. 

7. Method three is based on 222 atomic contribu-
tions calculated from 1868 molecules by least 
squares analysis. This method allows a calcula-
tion of logP with a standard deviation of 0.43 
logP units and can handle molecules containing 
hydrogen, oxygen, nitrogen, sulfur, halogens 
and phosphorus atoms. If this method is 
applied to molecules with internal hydrogen 
bonds, the standard deviation is 0.83 logP 
units.
ChemDraw 10
Henry’s Law
Henry’s Law Constant—The air to water parti-
tion coefficient that is expressed as ratio of vapor 
pressure to water solubility or as a unitless distribu-
tion coefficient that can be evaluated as a ratio of 
the concentration in air to the concentration in 
water. 
Two methods are used to predict Henry’s Law 
constant.

1. The first is an approach based on the bond 
contribution method. This method uses 59 
bond contribution values and 15 correction 
factors. The contributions were calculated by 
least squares analysis using a data set of 345 
chemicals. This method estimates with a mean 
error of 0.30 units and a standard deviation of 
0.45 units and can handle molecules containing 
carbon, hydrogen, oxygen, nitrogen, sulfur, 
phosphorus and halogens. 

2. In the second method, Henry’s Law constant is 
estimated from an equation found using linear 
regression. Multifunctional compounds were 
omitted from this study. This method should 
not be used for compounds where distant polar 
interaction is present. 

Molar Refractivity
Molar refractivity—Two fragmentation methods 
are used to estimate the molar refractivity value.

1. Method one includes 93 atomic contributions 
evaluated from 504 molecules by using a con-
strained least squares technique. This method 
works with a standard deviation 1.27 cm3/mol 
and can handle molecules containing hydro-
gen, oxygen, nitrogen, sulfur and halogens. 
How ChemProp Works • 239
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2. The second method is an extension of method 
one that includes 120 atomic contributions 
evaluated from 538 molecules by using a con-
strained least squares analysis technique. In 
addition to the atoms introduced for method 
one, this method can handle molecules with 
phosphorus and selenium atoms. This method 
works with a standard deviation of 0.77 
cm3/mol. 

ClogP and CMR
Specific algorithms for calculating LogP and molar 
refractivity from fragment-based methods devel-
oped by the Medicinal Chemistry Project and Bio-
Byte.
For more information, see: http://www.biobyte.com

Topological Polar Surface Area
The polar surface area of a molecule (measured in 
square Angstroms) is an important property that 
can be used for the prediction of pharmaceutical 
transport properties in the body. Historically, this 
property has been calculated using time-consuming 

UltraUltra
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3D techniques, but a recent paper1 has provided a 
remarkably accurate way of predicting it very rap-
idly. ChemDraw implements this algorithm, and 
displays it on the Chemical Properties window.

Other Properties
Heat of Formation, Gibbs Free Energy, Ideal 
Gas Thermal Capacity, Freezing Point, Critical 
Temperature, Critical Pressure, and Critical 
Volume are estimated using Joback’s fragmenta-
tion method. 
Normal Boiling Point and Melting Point—
Estimated in K using two methods. 

1. Joback's fragmentation method.
2. The Joback method as modified by Stein. All 

boiling points are estimated at a pressure of 
1 atm.

1. Ertl, P., Rohde, B., and Selzer, P., 2000. Fast 
Calculation of Molecular Polar Surface Area as a 
Sum of Fragment Based Contributions and Its 
Application to the Prediction of Drug Transport 
Properties. J.Med. Chem.43: 3714-3717.
CambridgeSoft
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Appendix F: How ChemNMR Works

ChemNMR estimates chemical shifts for all hydro-
gen or carbon atoms for which additivity rules are 
available. Following a hierarchical list, it first iden-
tifies key substructures of a molecule. A substruc-
ture provides the base value for the estimated shift. 
For example, benzene would be identified as the 
key substructure of trinitrotoluene.
When a substructure happens to be a ring system 
not available in the data, ChemNMR approximates 
its base shift using embedded rings and, if neces-
sary, it will even disassemble the ring into acyclic 
substructures.
ChemNMR views remaining parts of the molecule 
as substituents of a substructure. Each substituent 
adds to or subtracts from the base shift of the sub-
structure to which it is attached. Additivity rules 
determine the increment of each contribution. If 
an increment for a substituent cannot be deter-
mined, ChemNMR uses embedded substituents—
smaller structural units with the same neighboring 
atoms. Or, it will use increments of identical or 
embedded substituents of a corresponding sub-
structure by assuming that the effects of the sub-
stituents are of the same magnitude. 
ChemNMR provides a detailed protocol of the 
estimation process applied. It gives substructures 
as names, compound classes in most cases, substit-
uents in form of a linear code, respectively.

The data set for the 1H NMR Shift tool currently 
contains 700 base values and about 2000 incre-
ments. The 13C NMR Shift tool is based on 4000 
parameters. It also implements models for ethyl-
enes (cis/trans) and cyclohexanes (equato-
rial/axial).

 ChemNMR Limitations
The program handles the following elements: 
ChemDraw 10
H, D, He, Li, Be, B, C, N, O, F, Ne, Na, Mg, Al, Si, 
P, S, Cl, Ar, K, Ca, Sc, Ti, V, Cr, Mn, Fe, Co, Ni, 
Cu, Zn, Ga, Ge, As, Se, Br, Kr, Rb, Sr, Y, Zr, Nb, 
Mo, Tc, Ru, Rh, Pd, Ag, Cd, In, Sn, Sb, Te, I, Xe, 
Cs, Ba, La, Ce, Pr, Nd, Pm, Sm, Eu, Gd, Tb, Dy, 
Ho, Er, Tm, Yb, Lu, Hf, Ta, W, Re, Os, Ir, Pt, Au, 
Hg, Tl, Pb, Bi, Po, At, Rn, Fr, Ra, Ac, Th, Pa, U, 
Nep, Pu, Am, Cm, Bk, Cf, Es, Fm, Md, No, Lr. 
Functional groups are expanded automatically.
In case of 1H NMR, it estimates shifts of about 
90% of all CHx-groups with a standard deviation 
of 
0.2. 0.3 ppm. The use of polar solvents may 
strongly increase these deviations. It does not esti-
mate shifts of hydrogen atoms bonded to heteroat-
oms because they are significantly affected by 
solvents, concentration, impurities, and steric 
effects.
In case of 13C NMR, it estimates over 95% of the 
shifts with a mean deviation of -0.29 ppm and 
standard deviation of 2.8 ppm.
For more information see:
Fürst, A.; Pretsch, E. Anal. Chim. Acta 1990, 229, 
17.
Pretsch, E.; Fürst, A.; Badertscher M.; Bürgin, R.; 
Munk, M. E. J. Chem. Inf. Comp. Sci. 1992, 32, 291-
295.
Bürgin Schaller, R.; Pretsch, E. Anal. Chim. Acta 
1994, 290, 295.
Bürgin Schaller, R.; Arnold, C.; Pretsch, E. Anal. 
Chim. Acta 1995, 312, 95-105.
Bürgin Schaller, R.; Munk, M. E.; Pretsch, E. 
J. Chem. Inf. Comput. Sci.1996, 36, 239-243.
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Appendix CS-1: Technical Support

Overview
CambridgeSoft Corporation (CS) provides techni-
cal support to all registered users of this software 
through the internet, and through our Technical 
Support department.
Our Technical Support webpages contain answers 
to frequently asked questions (FAQs) and general 
information about our software. You can access 
our Technical Support page using the following 
address: http://www.cambridgesoft.com/services/

If you don’t find the answers you need on our 
website, please do the following before contacting 
Technical Support.

1. Check the ReadMe file for known limitations 
or conflicts.

2. Check the system requirements for the soft-
ware at the beginning of this User’s Guide.

3. Read the Troubleshooting section of this 
appendix and follow the possible resolution 
tactics outlined there.

4. If all your attempts to resolve a problem fail, fill 
out a copy of the CS Software Problem Report 
Form at the back of this User’s Guide. This 
form is also available on-line at:
http://www.cambridgesoft.com/services/mail

• Try to reproduce the problem before con-
tacting us. If you can reproduce the prob-
lem, please record the exact steps that you 
took to do so. 

• Record the exact wording of any error mes-
sages that appear. 

• Record anything that you have tried to cor-
rect the problem. 
ChemOffice 2006/ChemFinderTechnical Support
Overview
You can deliver your CS Software Problem Report 
Form to Technical Support by the following meth-
ods:

Internet: http://www.cambridgesoft.com/ser-
vices/mail

Email: support@camsoft.com 
Fax: 617 588-9360
Mail: CambridgeSoft Corporation
ATTN: Technical Support
100 CambridgePark Drive 
Cambridge, MA 02140 USA

Serial Numbers
When contacting Technical Support, you must 
always provide your serial number. This serial num-
ber was on the outside of the original application 
box, and is the number that you entered when you 
launched your CambridgeSoft application for the 
first time. If you have thrown away your box and 
lost your installation instructions, you can find the 
serial number in the following way:

• Choose About CS <application name> from the 
Help menu. The serial number appears at the 
bottom left of the About box.

For more information on obtaining serial numbers 
and registration codes see: http://www.cambridge-
soft.com/services/codes.cfm

Troubleshooting
This section describes steps you can take that 
affect the overall performance of s Desktop Appli-
cations, as well as steps to follow if your computer 
crashes when using a CS software product.
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Performance
Below are some ways you can optimize the perfor-
mance of CambridgeSoft Desktop Applications:

• In the Performance tab in the System control 
panel, allocate more processor time to the 
application.

• Install more physical RAM. The more you 
have, the less ChemOffice Desktop Applica-
tions will have to access your hard disk to use 
Virtual Memory.

• Increase the Virtual Memory (VM). Virtual 
memory extends RAM by allowing space on 
your hard disk to be used as RAM. However, 
the time for swapping between the application 
and the hard disk is slower than swapping with 
physical RAM. 
Change the VM as follows:
• System control panel, Performance tab.

System Crashes
CambridgeSoft Desktop Applications should 
never crash, but below are the steps you should go 
through to try to resolve issues that cause com-
puter crashes while using a CS software product.

1. Restart Windows and try to reproduce the 
problem. If the problem recurs, continue with 
the following steps.

2. The most common conflicts concern Video 
Drivers, Printer Drivers, screen savers, and 
virus protection. If you do need to contact us, 
be sure to determine what type and version of 
drivers you are using.
244•Technical SupportCambridgeSoft
Overview
• Video Driver related problems: If you are 
having problems with the display of any 
CambridgeSoft Desktop Application, try 
switching to the VGA video driver in the 
display Control Panel (or System Setup, and 
then retest the problems. If using a different 
driver helps, your original driver may need 
to be updated–contact the maker of the 
driver and obtain the most up-to-date 
driver. If you still have trouble contact us 
with the relevant details about the original 
driver and the resulting problem.

• Printer Driver related problems: Try 
using a different printer driver. If using a dif-
ferent driver helps, your original driver may 
need to be updated–contact the maker of 
the driver and obtain the most up-to-date 
driver. If you still have trouble contact us 
with the relevant details about the original 
driver and the resulting problem.

3. Try reinstalling the software. Before you rein-
stall, uninstall the software and disable all back-
ground applications, including screen savers 
and virus protection. See the complete unin-
stall instructions on the CambridgeSoft Tech-
nical Support web page.

4. If the problem still occurs, use our contact 
form at: http://www.cambridgesoft.com/ser-
vices/mail and provide the details of the prob-
lem to Technical Support.



Appendix CS-2: Accessing the Cambridge-
Soft Web Site

Online Menu Overview
The ChemFinder Online menu gives you quick 
access to the CambridgeSoft web site from within 
ChemFinder. With the Online menu, you can:

• Register your software.
• Search for compounds by name or ACX num-

ber and insert the structure in a worksheet
• Use ACX numbers, or names or structures in 

the worksheet, to search for chemical informa-
tion

• Browse the CambridgeSoft website for techni-
cal support, documentation, software updates, 
and more

To use the Online menu, you must have internet 
access.

Registering Online
ChemOffice 2006 applications utilize a new secu-
rity scheme. In order to activate any ChemOffice 
application, you must register with the Cambridge-
Soft website to receive a registration code. Upon 
filling out a registration form, the registration code 
is sent to you by email. This registration scheme 
does not apply to site licenses.
ChemOffice 2006/ChemFinderAccessing the CambridgeSoft Web
Online Menu Overview
If your serial number is invalid for any reason, or if 
you do not have an internet connection, you will 
have to contact CambridgeSoft Support to receive 
a registration code.
You may use your ChemOffice application a lim-
ited number of times while waiting for the registra-
tion process to be completed. Once the application 
times out, you must register to activate the soft-
ware.
In addition to registering your software, you can 
request literature, or register for limited free access 
to ChemFinder.com, ChemACX.com, Chem-
Club.com, and the email edition of ChemNews 
from the Register Online link of the Online menu. 
This link connects you to the CambridgeSoft Pro-
fessional Services page. From this page you can 
link to a registration form.
To register online:

1. From the Online menu, choose Register Online. 
The CambridgeSoft Professional Services page 
opens in your browser.

2. Select the Register tab.

Accessing the Online 
ChemDraw User’s Guide
The Online menu link Browse CS ChemDraw Docu-
mentation opens the CambridgeSoft Desktop Man-
uals page, where you can access current and 

Register tab
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previous versions of the ChemFinder User’s 
Guide.
To access the CambridgeSoft Manuals page:

1. From the Online menu, choose Browse 
CS ChemDraw Documentation. 

The Desktop Manuals page appears. PDF ver-
sions of the CambridgeSoft manuals can be 
accessed from this page.

NOTE: If you do not have a CambridgeSoft User 
account, you will be directed to a sign-up page first.

2. Click version of the manual to view.

Accessing CambridgeSoft 
Technical Support
The Online menu link Browse CS ChemFinder 
Technical Support also opens the CambridgeSoft 
Professional Services page. There are a number of 
links on this page for Troubleshooting, Down-
loads, Q&A (the ChemOffice FAQ), Contact, and 
so forth. 

Finding Information on 
ChemFinder.com
The Find Information on ChemFinder.com menu 
item links your browser to the ChemFinder data-
base record of the compound you have selected.
246•Accessing the CambridgeSoft Web SiteCambridgeSoft
Online Menu Overview
ChemFinder is the public-access database on the 
ChemFinder.com website. It contains physical, 
regulatory, and reference data for organic and inor-
ganic compounds. 
To access ChemFinder.com:

1. In ChemFinder, select a structure you want to 
look up.

2. From the Online menu, choose Find Information 
on ChemFinder.com. 
The ChemFinder.com page opens in your 
browser with information on the selected 
structure. 

In ChemFinder.com you can search for chemical 
information by name (including trade names), CAS 
number, molecular formula, or molecular weight. 
Follow the links to do substructure queries.The 
following illustration shows part of the page for 
Benzene.



Finding Chemical Suppliers 
on ACX.com
The Find Suppliers on ChemStore.Com menu item 
links your browser to the chemacx.com database 
record of suppliers of the compound you have 
selected.
ChemACX (Available Chemicals Exchange) is a 
Webserver application that accesses a database of 
commercially available chemicals. The database 
contains catalogs from research and industrial 
chemical vendors. 
ChemACX allows the user to search for particular 
chemicals and view a list of vendors providing 
those chemicals.
To use Find Suppliers on ChemStore.Com menu 
access:

1. In ChemFinder, select a structure you want to 
look up.

2. From the Online menu, choose Find Suppliers 
on ChemStore.com. 
The ChemACX.Com page opens in your 
browser with information on the selected 
structure. 

For example the ChemACX.com page for Benzene 
is shown below.

For more information on using the ChemACX 
website, see the ChemOffice Enterprise Work-
group & Databases Manual.
ChemOffice 2006/ChemFinderAccessing the CambridgeSoft Web
Online Menu Overview
Finding ACX Structures and 
Numbers
ChemFinder searches ACX and returns informa-
tion about related structures and numbers. You 
can place the returned information in your docu-
ment.

ACX Structures
There are two ways to find ACX structures: by 
ACX number or by name.
To find a structure that corresponds to an ACX 
number:

1. From the Online menu, choose Find Structure 
from ACX Number.
The Find Structure from ACX number dialog box 
appears.

2. Type the ACX registry number.
3. Click the OK button.

The Structure appears in your document.
To find a structure from a name

1. From the Online menu, choose Find Structure 
from Name at ChemACX.com.
The Find Structure from Name dialog box 
appears.
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2. Type in a name. As with ChemFinder.com, you 
can use a chemical name or a trade name.

3. Click the OK button.
The Structure appears in your document.

ACX Numbers
To Find an ACX number for a structure:

1. In a ChemFinder document, select the struc-
ture for which you want to find an ACX num-
ber.

2. From the Online menu, choose Find ACX Num-
bers from Structure.
The ACX number appears in the Find ACX 
Numbers from Structure dialog box.

Browsing ChemStore.com
Browse ChemStore.com opens the ChemStore 
page of the CambridgeSoft web site.
To access Browse ChemStore.com:

From the Online menu, choose Browse Chem-
Store.com. 
248•Accessing the CambridgeSoft Web SiteCambridgeSoft
Online Menu Overview
The ChemStore.Com page opens in your 
browser.

You can search ChemStore.Com for chemicals, lab 
supplies, chemistry-related software, and other 
items you want to buy. You can access 
ChemACX.Com, LabEqwip.Com, and other pages 
from ChemStore.Com.

Browsing 
CambridgeSoft.com 
Browse CambridgeSoft.com opens the Home page 
of the CambridgeSoft web site.
To access the CambridgeSoft Home Page:

From the Online menu, choose Browse Cam-
bridgeSoft.com. 



The CambridgeSoft web site in your browser.
ChemOffice 2006/ChemFinderAccessing the CambridgeSoft Web
Online Menu Overview
Check the CambridgeSoft web site for new prod-
uct information. You can also get to Chem-
Store.Com, ChemNews.Com, and other pages 
through CambridgeSoft.Com.

Using the ChemOffice SDK
The ChemOffice Software Developer’s Kit (SDK) 
enables you to customize your applications.
To browse the ChemOffice SDK:

From the Online menu, choose Browse 
ChemOffice SDK.
The CS ChemOffice SDK page opens in your 
browser.

The ChemOffice SDK page contains documenta-
tion, sample code, and other resources for the 
Application Programming Interfaces (APIs). 
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Index
Numerics
13C, 1H shifts, estimating 128
35 mm Slide Boundary lines 152
3D models 115
3D query properties 94

A
Abnormal valence 90
Abnormally shaped arrows, creating 144
Absolute flag, drawing 96
Actual Size command 153
Acyclic chains

adding 52
changing direction 53
length 53

Add
3D query property 94
chemical names 121
to selection 64

Add Frame 140
Adding

column to template 81
row to template 81
structures in ChemDraw/Excel 184

Adjustment handles 136, 139
Aligning objects

Align Submenu 156
overview 156
rulers 154
with crosshair 155

Aligning Structures 28
Alternative groups

attachment point numbering 104
attachment point symbol 103
attachment Rank indicators 103
defining 102
description 102
ChemDraw 10
Alternative groups (continued)
multiple attachment points 103

Always display and print atom mapping 105
Analysis

information 111
messages 236

Analysis window 18
Anion, drawing 135
Anonymous alternative groups 104
Apply settings command 202
Arc Tool 141
Arcs 141

drawing 137, 141
resizing 141

Arrows
adjustment handles 136
autoscaling 166
changing direction 137
created with curves 144
cursor types 136
disequilibrium, modifying 136
equilibrium 136
hollow arrows 137
new arrow types 136
rotating 138
snapping 138
undo 137

Arrows see also Tools
see also

Assigning
atom mapping 105
structures to spectra 127

Asymmetry, see Stereochemistry indicators
Atom

numbers 75–76
query properties 85

Atom label text boxes, closing 199
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Atom Labels
specification 230

Atom labels
automatic justification 208
creating 58
deleting 59
editing 59
editing with a bond or ring tool 59
justification 207
layering 209
margin width 209
multi-attached 71
overview 56
repeating 60
text boxes, creating new line 199
using HotKeys 60
white space 209

Atom numbers
editing 75
position 75
showing and hiding 75

Atom properties
abnormal valence 90
description 87
implicit hydrogens 87
in query structures 85
reaction changes 89
reaction stereo 89
resetting defaults 86
ring bond count 88
substituents 87
unsaturation 88
viewing 86

Atoms
moving 64

Atom-to-atom mapping 105
Attached data 169
Attachment point

defining 102
numbering 104
symbol 103
ii •
Attachment point (continued)
tool 135

Attachment point tool 102
Attachment points, multiple 103
Attachment points, viewing 74
Attachment rank indicators, showing 104
Auto update 122
Automatic

drawing of structure 122
justification, atom labels 208
mapping 105

Autosave 198
Autoscale

bonds 166
empty document window 166
template color 214
when transferring 165

B
Background color, printing 214
Baseline style, captions 206
Benzene ring tool 50
Benzene ring, changing orientation 52
Benzene rings, drawing 52
Bézier curves 142
Bicyclics, see Other toolbars command
BioDraw 20, 193

drawing a helix protein 196
drawing a membrane arc 195
drawing a membrane line 195
drawing DNA 196

BioDraw objects
color 20, 193
customizing 21, 194
line and fill properties 20, 193

Bitmap fonts, using when available 199
BitMap, see File formats 171
Bitmapped

printing quality 201
BMP, see File formats 171
Boiling point, calculation 240
CambridgeSoft



Boiling point, definition 117
Bold width 204
Bond crossings

white space 204
Bond crossings, changing 55
Bond order, changing 55
Bond properties

defining 90
descriptors 91
reaction center 94
removing 91
topology 93
types 92
viewing 91

Bond query indicators 91
Bond spacing, description 203
Bond tool

repeating a label 60
Bonds

adding to an atom label 72
autoscaling 166
bond orientation for dative or wedged bonds

49
changing orientation 54
changing type 53
double either 93
drawing 47
drawing by clicking 49
drawing by dragging 50
editing 53
fixed angle 48
fixed length 47
layering 55
margin width 204
multi center attachment 73
quadruple 49
selecting 63
types 230

Bonds see also Tools
see also

Border of page 149
ChemDraw 10
Boxes
drawing 139

Braces 140
Bracket

usage 100
Brackets

drawing 140
paired 140
setting properties 99
single 140
tool 140
using to represent polymers 99

Brackets see also Tools
see also

Bring to Front command 157
Bruker JCAMP file format 174

C
Calculating

chemical properties 115
elemental analysis 112
exact mass 112
formula 112
molecular weight 112

Calculations see ChemProp
Caption text boxes

closing 199
creating new line 199

Captions 57
analysis information 112
autoscaling 166
chemical significance of 57
coloring 57
converting to structures 123
creating tables 160
editing 58
formula 206
inserting from structure 121
inserting rows in tables 162
justification 207
setting font, size and styles 208
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Captions 57 (continued)
subscript 206
superscript 206
Table column spacing 161
width 58

Carbon-13 shifts, see 13C, 1H shifts, estimating
Cation, drawing 135
CCITT group 3 and 4 176
CDS, see File formats
CDX see File formats
CDX, see File formats
CDXML, see File formats
Center on Page command 156
Centering objects 156
Chain angle, description 203
Changing

bond orientation 54
default settings 201
perspective 153
settings when transferring 167
tolerance 200

Changing bond type 53
Character Map 19
Charges

specifications 232
symbols, drawing 135

Check structure
overview 111
when copying 111

Checking chemistry 111
Chem3D 115
Chem3D objects, caution when sharing files 172
ChemDraw

2.x file format 172
3.5 file format 172
CDX format 171
CTP, CTR file formats 171
customizing 21, 197
HotKeys file 210

ChemDraw Items folder
isotope table 90
iv •
ChemDraw items folder
description 200
nicknames 81
open special 200
scripts 202
templates 78
window menu 200

ChemDraw laser prep 214
ChemDraw template 171
ChemDraw/Excel

adding structure files 184
adding structures 184
adding structures as SMILES 185
adding structures by name 185
adding structures with ChemDraw 184
aligning structures 188
converting old worksheets 182
exporting to SDFiles 183
get ChemDraw list command 183
import hit list error messages 183
importing tables 181
inserting functions in worksheets 191
naming molecules 187
overview 181
searching 186
starting 181

Chemical Intelligence in ChemDraw 229
Chemical name, structure from 122
Chemical properties

calculating 116
ChemProp 115

Chemical Properties window 18
Chemical properties window 116
Chemical Symbols

palette 134
rotating 136
tool 134

Chemical symbols see also Tools
see also

Chemical syntax checking 55
CambridgeSoft



Chemical warnings 55
suppressing 25, 55

Chemically significant text 231
Chemistry

of ChemDraw 229
Chemistry checking 111
ChemNMR

description 241
using 128

ChemProp
boiling point 240
calculations 239
ClogP 240
CMR 240
critical pressure 240
Critical temperature 240
critical volume 240
description 239
Freezing point 240
Gibbs Free Energy 240
Heat of Formation 240
Henry’s Law 239
Ideal Gas Thermal Capacity 240
logP 239
molar refractivity 239
Thermal Capacity 240
TPSA 240
using 115

ChemProp, using with ChemDraw/Excel 191
Chirality, see Stereochemistry, flags
CHM, see File formats
CIP Rules 234
Circles

resizing 139
Clearing

mapping 106
spectrum-structure assignments 128
stereochemical markers 113

Click to select objects 63
Clipart, see Other toolbars command
ChemDraw 10
Clipboard 163
check structure 111

Clipping files 165
CLogP 117
ClogP 240
Closed style, shapes 144
CML, see File formats
CMR 117
CMYK, planar and contiguous 173
Color

autoscaling 166
menu 211
overview 210
saving settings 214

Color dialog box 212
Color palette 212
Coloring

captions 57
objects 211

Colors, maximum number of 166, 210, 212
Column spacing 161
Commands

new 21
open 22
save 22
save as 22

Compression 176
Conformers, Other toolbars command
Connection Table

example file 225
file format 225

Connection table
file format 172

Contracting labels 71
Conventions 10
Convert name to structure, limitations 122
Convert structure to name, automatic captions
121
Converting

name to structure 123
Converting names to structures 123
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Converting to 3D 115
Copy

and check structure 111
as SLN command 164
as SMILES command 163
with clipboard 163
with drag and drop 165

Copy, see also Duplicating
see also

Creating
atom labels 58
HotKeys 210
mirror images 70
SLN strings 164
tables 160
templates 80

Creating text 56
Critical pressure, calculation 240
Critical pressure, definition 117
Critical temperature, calculation 240
Critical temperature, definition 117
Critical volume, calculation 240
Critical volume, definition 117
Crosshair

displaying 155
moving 155
using to align objects 155

CT, see File formats
CTP, see File formats
CTR, see File formats
CTS, see File formats
Curves

autoscaling 166
for creating arrows 144
segment, deleting 143

Custom templates 79
Customized settings, saving 201
Customizing

ChemDraw 197
saving document settings 201

Customizing ChemDraw 21
vi •
Cycloalkane rings, converting to delocalized rings
51
Cyclohexane chair ring tool 50

orientation 51
Cyclohexane ring tool 50
Cyclooctane ring tool 50
Cyclopentadiene ring tool 50
Cyclopentadiene ring, changing orientation 52
Cyclopentadiene rings, drawing 52
Cyclopentane ring tool 50
Cyclopropane ring tool 50

D
Daggers 140
Data SGroup, support for 169
Database conventions, in structure drawings 229
Databases

support for query structures 85
Dative bonds, drawing 49
Default

atom properties, resetting 86
bond properties, resetting 91
changing 201
document location 197
file format 197
stationery pad 213

Default save file format 199
Deflate compression 176
Delete column, from template 81
Delete row, from template 81
Deleting

atom labels 59
curve segment 143
delete key 65
nicknames 83
objects 65
Pen tool shapes 143

Delocalized rings, drawing 51
Deselecting objects 63
Detecting errors

automatic error checking 55
CambridgeSoft



Detecting errors (continued)
check structure command 111

Disable chemical warnings 25, 55
Discarding changes 22
Displaying

atom mapping 105
cross hairs 155
entire page 153
reaction mapping 105
rulers 154

Dissociation tool 78
Distributing Objects 156
Distributing objects 156
DNA templates, see Other toolbars command
Document

location, default 197
multi-paged 149
posters 150
reverting to last saved 22
Stationery pad settings 217
style sheet settings 217

Document Settings
ACS Document 1996 217
Adv. Synth.Catal. 218
J. Mol. Mod. 219
J.Chin.Chem. Soc. 218
New Document 220
New Slide 221
Phytomedicine 222
RSC Document 222
Science of Synthesis 223
Synthesis/Synlett Document 223
Verlag Helvetica Chimica Acta 224
Wiley Document 224

Document Settings, overview 200
Document Setup

Posters 150
Document setup

multiple-paged documents 149
Document window

drawing area 149
ChemDraw 10
Document window (continued)
enlarging 149
orientation 152
reducing 149

Documents
creating 21
saving 22

D-orbitals, drawing 133
Double bond

changing type 53
Double bond orientation 54
Double bonds, drawing 48
Double either bonds, drawing 49
Drag and drop 165
Drawing

acyclic chains 52
arcs 141
benzene and cyclopentadiene rings 52
bonds by clicking 49
bonds by dragging 50
boxes 139
charge symbols 135
database conventions 229
d-orbitals 133
double bonds 48
double either bonds 49
dz2-orbitals 133
fixed angle bonds 48
fixed length bonds 47
free sites 97
H-Dash Symbol 134
H-Dot Symbol 134
hybrid orbitals 133
mirror images 70
orbitals 131
p-orbitals 133
quadruple bonds 49
radicals 135
resonance delocalized rings 51
rings 50
rings with fixed length 50
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Drawing (continued)
sigma orbitals 132
single bonds 47
single lobe orbitals 132
s-orbitals 132
stereochemical symbols 96
structure automatically from name 122
triple bonds 49
with templates 79

Drawing area 149
Drawing daggers 140
Drawing Elements

color 139
fill patterns 139

Drawing elements
autoscaling 166

Drawing elements see also Tools
see also

Drawing settings
changing defaults 201
margin width, effect on atom labels 209
margin width, effect on bond crossing 204

Duplicate, see also Copy
see also

Duplicating
labels 60

Duplicating objects 65
DX, see File formats
Dz2- orbitals, drawing 133

E
Editing

atom labels 59
atom numbers 75
bond orientation 54
bond type 53
bonds 53
captions 58
embedded objects 167
generic nickname file 97
query indicators 96
viii •
Element
recognized 232

Element lists 98
Element not-lists 98
Elemental analysis

caption 112
description 112

Embedded objects 177
Embedding objects 167
Empirical formulas 231
Enantiomers, describing 114
Encapsulated PostScript, see File formats
Enclosing objects 140
Enlarge

document window 149
page size 152

EPS, see File formats
Eraser see Tools
Eraser tool, changing bond order with 55
Error checking 55
Error Messages 236
Exact mass

caption 112
definition 112

Excel add-in, see ChemDraw/Excel 181
Expanding labels 70
Exporting

checking structure 111
compatibility 107
mapping 107
PNG 175
query properties 107
query structures 107
tiff 176
using file formats 168

F
FAQ, technical support 243
File format

connection table 225
WMF 176
CambridgeSoft



File formats
bitmap 171
CDX 22
CDXML 172
ChemDraw 171
ChemDraw 3.5 172
ChemDraw stationery 172
CML 172
connection table 172
CT 172
CTP 171
CTR 171
CTS 176
DX 174
EPS (text) 172
GIF 173
ISIS 173
ISIS/reactions 174
JCAMP 174
JDX 174
JPEG 174
MDL MolFile 174
MDL MolFile V3000 169
MDL RGFile 174
MSI MolFile 175
native 22
pict 175
Pict scaled 4x 175
PNG 175
rxn 174
SKC 173
SMD 175
SPC 175
stationery pad 172
style sheet 172
template 171
TGF 173
TIFF 176
TPL style sheet 176

File formats, table 170
Files, inserting 177
ChemDraw 10
Filled style, shapes 144
Filtering tables 186
Fit to Window 153
Fixed angle bonds 48
Fixed angles, toggling on/off 48
Fixed length bonds 47
Fixed lengths

description 203
scaling 69

Fixed lengths, toggling on/off 48
Flatten command 76
Flip horizontal command 70
Flip type 102
Flip vertical command 70
Flush left justification 207
Flush right justification 207
Font

imaging speed 199
new captions 208

Font substitution 57
Footers, creating 150
Format

atom labels 207
text 206

Formula command
description 112
using 206

Fragmentation see also Tools
see also

Free Energy, calculation 240
Free energy, definition 117
Free sites

drawing 97
in queries 87

Freezing Point, calculation 240
Front to Back ordering 156
Fusing templates 79

G
G groups 102
Galactic Industries, see File formats, SPC
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Generic groups 102
Generic nicknames 97

description 97
Generic structures, expanding 119
Get ChemDraw/Excel list 183
Getting started tutorial 25
Gibbs free energy, definition 117
GIF, see File formats
GRAMS software 175
Graphical User Interface 13
Grouping objects 68
Grouping orbitals 131
Groups

integral 69
GUI, see Graphical User Interface

H
Hard coded HotKeys 210
Hash spacing, description 204
H-Dash Symbol, drawing 134
H-Dot and H-Dash, specification 233
H-Dot Symbol, drawing 134
Headers, creating 150
Heat of formation, definition 117
Help

Windows 11
Henry’s Law 239
Henry’s law, definition 117
Hide Crosshair command 155
Hide Rulers command 155
Hiding atom numbers 75
Hiding palettes 17
High resolution

non-PostScript printing 201
High resolution printing 214
Highlight box

selecting 63
HotKeys

“sticky” behavior 61
labeling by pointing 61
labeling multiple atoms 61
x •
HotKeys (continued)
labeling the last atom drawn 60
quick reference 10

Hotkeys
creating 210
file 210
hard-coded 210

Hot-linked properties 122
How to use this guide 9
Hybrid orbitals, drawing 133
Hydrogen labels, implicit 60
Hydrogens, implicit 87
Hyphens, font submenu 206

I
Implicit hydrogens 87
Implicit hydrogens, hiding 60
Imported objects, selecting 63
Imported picture 172
Importing

spectral data 174, 175
using file formats 168

Importing tables to ChemDraw/Excel 181
InChI strings, copy as 163
InChI strings, creating 165
Include ChemDraw LaserPrep 168
Indicators

atom numbering 75
query 96
query, editing 96
query, positioning 96
stereochemical 235
stereochemistry 113, 235
stereochemistry, positioning 113

Indicators, stereochemical 96
Info window 18

displaying fixed angles 48
Insert name as structure 122
Inserting

files 177
name as structure 122
CambridgeSoft



Inserting (continued)
objects 177
rows in tables 162

Integral groups, creating 69
IR spectra, see spectra
ISIS

reactions 174
SKC file format 173
TGF file format 173
V3000 support 169

Isotopes
specifications 232

Isotopes table file 90
Isotopes text file 90
Isotopic abundance 90

J
JCAMP, see File formats
JDX, see File formats
Joback’s Fragmentation Method 240
Joining objects 67
Joining structures 67
JPEG, see File formats
Justification

atom labels 207
captions 207

K
Kekule structures 51
Keyboard shortcuts, quick reference 10

L
Labels

automatic terminal carbons 205
auto-update 122
contracting 71
expanding 70

Landscape page orientation 152
Lasso tool

selecting objects 62
ChemDraw 10
Layering
atom labels 209
objects 156

Layout, page 149
Lewis dot symbol, see Lone Pair Symbol
Ligand, defined 234
Limitations, name-to-structure 122
Line width 204
Lines, drawing 140
Link nodes 99
LogP 239
Lone Pair Symbol 134

M
m/z, displaying 112
Magnifying

with Magnification control 153
with View menu 153

Make spectrum-structure assignment 127
Manual mapping

clearing 106
overview 106

Mapping
atom 105
automatic 105
clearing 106
exporting 107
manual 106
reaction 105

Margin Width
description 204

Margin width
adjusting 204
effect on Bond crossings 204
specifying 209

Margin width, specifying 209
Marquee tool 63
Mass fragmentation tool 76
Mass spectra

importing as JDX 174
importing as SPC 175
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mass/charge, displaying 112
Maximize objects 153
MDL MolFile, see File formats
MDL RGFile, see File formats
Melting point, definition 117
Menus

view 17
Menus and toolbars 17
Messages

analysis 236
status 236

Mirror images, creating 70
Molar refractivity 239
Molecular mass, definition 112
Molecular Weight

display in status bar 18
Molecular weight

caption 112
definition 112
how calculated 112

molfile, see File formats
Monochrome 173
Moving

atoms 54, 64
crosshair 155
in tables 161
objects 64

MS, see spectra
MSI MolFile, see File formats
Multi-attached atom labels command 71
Multi-Center Attachments

overview 234
Multi-center attachments 73
Multi-center attachments, see also Variable at-
tachments

see also
Multiple attachment points 103
Multiple Bond tool 48
Multiple selection 62
Multiple-paged documents, setup 149
xii •
N
Name

inserting as structure 122
of structure, inserting 121

Name to structure see Name=Struct
Name, automatic structure from 122
Name=Struct 122

converting 123
limitations 122
paste special 123
with German names 123

Nanotubes, see Other toolbars command
Native file format 22
New color button 212
New template, creating 79
Nicknames 81

applying 82
defining 82
defining peptides 83
deleting 83
generic 97
quick reference 10
troubleshooting 83

Nicknames, generic
description 97

NMR, see ChemNMR, spectra
Non-PostScript printing

high resolution 201
Macintosh 168

Normal view 153
Numbering atoms 75

O
Object

Add Frame 140
Align 28
Distribute 156

Objects
3D rotation 139
adjusting 139
aligning 155
CambridgeSoft



Objects (continued)
centering 156
deleting 65
Distributing 156
distributing 156
grouping 68
joining 67
moving 64
multiple selection 62
ordering 156
reflecting 69
selecting all 64
ungrouping 68
using crosshair with 155
using rulers with 154

Objects, embedding 177
OLE 167
Online Help, see Help
Opening

ChemDraw/Excel 181
Orbitals see also Tools

see also
Orbitals, drawing 131
Orbitals, grouping 131
Ordering objects 156
Orientation

benzene ring tool 52
cyclopentadiene ring tool 52
double bonds 54
of page 152
rings 50

Orientation of cyclohexane chairs 51
Orientation, of templates 79
Orientation, of user-defined templates 80
Original view 153
Other toolbars command 21
Ovals

adjusting 139
Overlap, multipaged documents 150
ChemDraw 10
P
Packbits, compression 176
Page

border 149
layout 149
orientation 152
overlap 150
setup 151

Page definition language
QuickDraw 201

Page Setup
page layout 151
saving settings 152

Paged documents 149
Paired brackets 140
Palette

arcs 141
Brackets 140
Chemical Symbols 134
color 212
orbital tools 131
query tools 95
single bonds 47

Palettes
showing 17
tearing off 17

Paper Size 151
Parentheses 140
Paste special

name as structure 123
SMILES 164

Pen see Tools
Pen tool shapes

deleting segments 143
Pen tool, Bézier curves 142
Pen tool, drawing by clicking 142
Pen tool, selecting shapes 143
Peptides, defining with nicknames 83
Performance, optimizing 244
Periodic Table 19
Perspectives, changing 153
• xiii
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PICT, see File formats 175
Picture layers

atom labels 209
Plain style, shapes 144
PNG, see File formats
Polyhedra, see Other toolbars command
Polymers

flip type 102
repeat pattern 101
source-based 100
structure-based 100

P-orbitals, drawing 133
Portrait page orientation 152
Positioning

atom number indicators 75
by small increments 64
constrained to axes 64, 65
crosshair 155
objects 64
query indicators 96
rulers 154
stereochemistry indicators 113

Posters, setup 150
PostScript

commands 167
EPS (text) 172
printing 202

Preferences
check structure 111
drawing, see Drawing settings 201
include ChemDraw LaserPrep 168
include PostScript 168
initialize PostScript printer 168
overview 197
print 214
require CTRL+ENTER 199
require Option+Return 199
text, see Text settings 201
use bitmap fonts when available 199

Print quality 200
xiv •
Printing
atom mapping 105
background color 214
ChemDraw laser prep 214
drawing elements fill 139
effect of PostScript commands 167
high-resolution non-PostScript 201
orientation (of page) 152
overview 162, 214
page setup 151
paper size 151
PostScript atom labels 214
preferences 214
reaction mapping 105

Properties
atom in searching 85
atom, abnormal valence 90
atom, description 87
atom, implicit hydrogens 87
atom, query 85
atom, reaction changes 89
atom, reaction stereo 89
atom, resetting defaults 86
atom, ring bond count 88
atom, substituents 87
atom, unsaturation 88
atom, viewing values 86
bond 90
bond descriptors 91
bond types 92
bond, reaction center 94
bond, removing 91
bond, topology 93
bond, viewing 91
brackets 99
calculating 116

Proton shifts, see 13C, 1H shifts, estimating

Q
Quadruple bonds 49
CambridgeSoft



Queries
multiple rings 99

Queries, see searching
Query indicators

editing 96
overview 96

Query properties
3D 94
exported 107
overview 236

Query structures
description 85
exporting 107

Query tools palette 95
Quick Reference 10
Quick Reference Card, description 11
QuickDraw

bitmapped image 201
print quality 200

R
R groups 102
Racemic flag, drawing 96
Radicals

drawing 135
specification 233

Reaction atom-atom map tool 105
Reaction atom-to-atom mapping 105
Reaction center 94
Reaction changes 89
Reaction mapping

always display and print 105
automatic 105
clearing 106
exporting 107
manual 106
overview 105

Reaction stereo 89
Rectangles

adjusting 139
Red boxes on objects 55
ChemDraw 10
Redo 199
Reduce

document window 149
object 153
page size 152

Reflection through a plane 70
Registration marks 150
Relative flag, drawing 96
Relative stereochemistry 114
Remove

colors 213
rulers 155

Remove color button 212
Repeat command, rotations 66
Repeating a label 60
Repeating actions 23
Repositioning

query indicators 96
stereochemistry indicators 113

Require ctrl+enter to create new line in atom la-
bels 199
Require ctrl+enter to create new line in captions
199
Requirements

windows 11
Reset defaults

atom properties 86
bond properties 91

Resizing
arcs 141
objects 62
objects, with distortion 62
template panes 81

Resizing see also Scaling
see also

Resolution, tiff 176
Resonance delocalized rings, drawing 51
Retrosynthesis see also Tools

see also
Retrosynthesis tool 78
Reversing actions 23
• xv
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Revert command 22
RGB Indexed color 173
RGFile, see File formats
Ring bond count 88
Ring pointer icon appearance 50
Rings

drawing 50
drawing with fixed length 50
orientation 50

RNA templates, see Other toolbars command
Rotate

chemical symbols 136
command 66
dialog box 66
objects 65

RS, see Stereochemistry indicators
Ruler Guides 154
Rulers

hiding 155
showing 154

RXN, see File formats

S
Save command

default file format 199
Saving

defaults 201
structures in ChemDraw/Excel 185
template documents 81

Saving changes automatically 198
Saving customized settings 201
Scaling

by a percentage 69
fixed length 69
objects 69
when transferring information 165

Scrap files 165
Searching

ChemDraw/Excel 186
databases 85
export compatibility 107
xvi •
Searching (continued)
query properties supported 85

Select All command 64
Selecting

all 64
bonds 63
entire structure 63
pen tool shapes 143
several objects 64
with lasso 62
with marquee 63

Selection rectangle
rotation handle 62

Selection see also Tools
see also

Selection Tool
highlight box 63
selecting several objects 64

Selection tool
deleting 65
deselecting objects 63, 64
joining 67
selecting all 64
using 61

Selection tools 61
Selection, adding to 64
Send to Back command 157
Serial number 243
Set color button 212
Setting

margin width 209
preferences 197

Settings
document 200

Shaded style, shapes 144
Shapes

closed 144
filled 144
plain 144
shaded style 144

Sharing information 163
CambridgeSoft



Shortcuts, see Keyboard shortcuts
Show

atom numbering 75
Show Crosshair 155
Show Page 153
Show Rulers command 154
Show stereochemistry 113
Showing palettes 17
Sigma orbitals, drawing 132
Similarity searching

in ChemDraw/Excel 187
Single bonds, drawing 47
Single brackets 140
Single lobe orbitals, drawing 132
SKC, see File formats
SLN strings 164
SLN strings, copy as 163
SMD, see File formats
SMILES

creating 164
overview 163
paste 164
viewing clipboard 164

SMILES strings, copy as 163
SMIRKS, overview 163
S-orbitals, drawing 132
SPC, see File formats
Spectra

assigning structures 127
exporting 174
importing 174, 175
importing as JDX 174
importing as SPC 175
removing assignments 128

Spectrum-structure assignments
making 127
removing 128
viewing 127

Spiro linkage, templates 79
Squiggly Bond tool see Tools, wavy bond
ChemDraw 10
Starting
ChemDraw/Excel 181

Stationery documents 21
Stationery Pad

saving document settings 199
Stationery pad

default 213
document settings 213
file format 172
Page Setup settings 152

Stationery Pads
creating 217
provided 217

Status bar 18
Status messages 236
Stereochemical symbols, drawing 96
Stereochemistry

drawing mirror images 70
flags 235
how calculated 234
indicators 113, 235
indicators, repositioning 113
removing markers 113
showing 113
terms supported 113

Stereochemistry, relative 114
Stereochemistry, see also Indicators, stereochem-
ical

see also
Stoichiometry grid 118
Stoichiometry grid, editing with the context
menu 119
Stoichiometry grid, setting the limiting com-
pound 118
Struct=Name 121–??, 121, ??–122
Struct=Name, structure types supported 124
Structure

automatic error checking 55
checking 111
cleanup command 72
converting to name 121
• xvii
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Structure (continued)
diagram generation 72
selecting 63
show stereochemistry 113

Structure Perspective tool, using with objects 139
Structure searching, in ChemDraw/Excel 186
Structures

3D 115
Aligning 28
multiple selection 62

Style Sheet
file format 172
Page Setup settings 152
saving document settings 201

Style sheet
document settings 200

Style Sheets
creating 217
provided 217

Style sheets 21
color palette 214

Style, caption 206
Subscript command 206
Substituents 87
Substructure searching, in ChemDraw/Excel
186
Superatom, ISIS 173
Superscript command 206
Suppress chemical warnings 25, 55
Supramolecules, see Other toolbars command
Syntax checking 111
System crashes 244
System requirements 11

T
Table

adjusting rows and columns 159
adjusting the whole table 159
alignment 159
clearing cells 159
fit to cells 159
xviii •
Table tool 157
Tables

column spacing 161
creating 160
creating with Table tool 157
inserting rows 162
moving in 161

Tables see also Tools
see also

TCL spots
crescent 146

Template panels 81
Template tool 78
Templates

autoscaling 79
coloring 214
creating 79, 80
drawing with 79
file format 176
fusing 79
fusing with existing structure 79
orientation 79, 80
overview 78
panel 81
resizing panes 81
reusing 79
saving template documents 81
spiro linkage 79

Templates, see Other toolbars command
Terminal carbons, labeling 59
Text

atom label format 207
atom label textbox 58
atom labels, automatic justification 208
atom labels, editing 59
caption, creating tables 160
coloring 57
creating 56
editing captions 58
formatting 206
types 56
CambridgeSoft



Text box
closing 199
creating new line 199

Text see also Tools
see also

Text settings
captions, font, size, and style 208
changing defaults 201

Text tool
atom labels 58

TGF, see File formats
TIFF

options 176
resolution 176

TIFF, see File formats
TLC see also Tools

see also
TLC spots

custom, about 146
custom, adding 145
display or set Rf 145
enlarged 146
resizing 146
Rf, about 146
tails 146
wide 146

TLC tool 144
Toggling

between tools 61
Toggling fixed lengths and angles 48
Toggling the text tool with lasso tool 60
Tolerance

effect on highlight box 200
Tool

reaction atom-to-atom mapping 105
Toolbars

docking 17
Main Tools Palette 14

Toolbars and Menus 17
Tools

acyclic chain 16, 52
ChemDraw 10
Tools (continued)
alternative group 102
arc 16, 141
arrow 16
attachment point 102
benzene ring 50
BioDraw 20
bold bond 47
bold wedge bond 47
bond 15, 47
Bracket 140
brackets 16
Chemical Symbol 134
chemical symbols 16
cyclohexane chair 50
cyclohexane ring 50
cyclooctane ring 50
cyclopentadiene ring 50
cyclopentane ring 50
cyclopropane ring 50
dashed bond 47
dative bond 47
dissociation 78
Drawing Elements 138
drawing elements 16
eraser 15
hashed bond 47
hashed wedge bond 47
hollow wedge bond 47
lasso 15, 61, 62
marquee 15, 61, 63
mass fragmentation 76
multiple bond 48
multiple bonds 15
orbital 16
orbitals 131
pen 16, 141
query 95
retrosynthesis 78
ring 16
structure perspective 15, 76
• xix
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Tools (continued)
Table 157
table 16
template 16
templates 78
text 16, 56
TLC plate 16
wavy bond 47

Topological Polar Surface Area 240
Topology 93
TPL style sheet, see File formats
Trackball tool 76
Trackball tool see Tools

seetructure perspective
Transferring information

across platforms 178
keeping in scale 165

Translation (query property) 89
Triple bonds, drawing 49
Troubleshooting 243
Tutorial 25
Types of bonds 230

U
Undo 23
Undo command 198
Ungroup command 68
Unsaturation 88
Unspecified atom properties, in queries 87
Up to, in queries 87
Use defaults

atom properties 86
bond properties 91
bracket properties 99

User-defined templates 79

V
V3000, support for 169
View menu 17
Viewing

analysis information 111
xx •
Viewing (continued)
atom properties 86
bond properties 91
chemical properties 116
spectrum-structure assignments 127

W
Warnings, chemical 55
Wedged bonds, drawing 49
What’s New 10
White space, adjusting in atom labels 209
Window

analysis 111
chemical properties 116

Window menu 23
Windows Help 11
Windows metafile 176
WMF, see File formats 176

Z
Zooming, see Changing Perspectives
CambridgeSoft
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C A M B R I D G E S O F T

E-Signatures
IP Protection

E-Notebook
Enterprise

Enterprise

CombiChem
Enterprise

21CFR11
Compliance

DESKTOP TO ENTERPRISE

KNOWLEDGE MANAGEMENT

CHEMICAL INFORMATICS

Research organizations thrive when information is easily captured, well organized, and
readily available. E-Notebook Enterprise streamlines record keeping with rigorous
security and efficient archiving, and facilitates text and structure searching. Reaction
Explorer can display the ancestors and descendants of a particular batch in seconds,
while CombiChem Enterprise provides the power of combinatorial chemistry. 
E-Signatures provides intellectual property protection and 21CFR11 Compliance
implements an organization’s regulatory compliance process.

Just as Chem & Bio Office supports the daily work of the individual scientist,
ChemOffice Enterprise, with Oracle Cartridge, and ChemOffice Workgroup, based 
on SQL Server, help organizations from small workgroups to large enterprises 
collaborate and share information more effectively.

Managing huge data streams is a key challenge. Registration Enterprise organizes
information about new compounds according to an organization's business rules,
while Inventory Enterprise provides complete management of chemical and biological
inventories, including GxP validation. DocManager Enterprise is an important part 
of collaborative research data management. Oracle Cartridge adds chemically 
intelligent searching to Oracle, integrating with ChemOffice Enterprise applications.

E-Notebook Enterprise

Reaction Explorer

CombiChem Enterprise

E-Signatures

21CFR11 Compliance

ChemOffice Desktop toChemOffice Desktop to

WebServer

Registration
Enterprise

KNOWLEDGE 
MANAGEMENT

CHEMICAL 
INFORMATICS

Chem & Bio Office

ChemOffice Workgroup

ChemOffice Enterprise

Desktop

Inventory
Enterprise

GxP
Validation

Inventory Enterprise

GxP Validation

Registration Enterprise

DocManager Enterprise

Oracle Cartridge



The Merck Index

Scientific Databases

ChemACX Database

Sigma-Aldrich MSDS

ChemDraw & Chem3D

ChemFinder & ChemInfo

BioAssay & BioViz

BioDraw

Inventory & E-Notebook

S O L U T I O N S

The Merck
Index

DocManager
Enterprise

ChemACX
Database

Sigma-Aldrich
MSDS

BIOLOGICAL INFORMATICS

DESKTOP SOFTWARE

SCIENTIFIC DATABASES

PROFESSIONAL SERVICES

Good research depends on reference information, starting with the structure-
searchable ChemACX Database of commercially available chemicals and Sigma-
Aldrich MSDS. The Merck Index and other scientific databases provide necessary 
background about chemicals, their properties, and reactions.

BioAssay Enterprise

BioViz

BioSAR Enterprise

BioDraw

Success begins at the desktop, where scientists use ChemDraw, ChemOffice, and
BioOffice to pursue ideas and communicate with the natural language of chemical
structures, biological pathways, and models. Scientists organize information and 
manage data with E-Notebook and Inventory. Chem3D provides modeling, ChemFinder
aids searching, while BioOffice adds BioAssay, BioViz and BioDraw. Integrated with
Microsoft Office to speed research tasks.

Finding structural determinants of biological activity requires processing masses of
biological assay data. Scientists use BioAssay Enterprise and BioSAR Enterprise to set
up biological models and visualize information, to generate spreadsheets correlating
structure and activity, and to search by structure. The BioViz application allows you to
create graphical representations of data.

Enterprise SolutionsEnterprise Solutions

Development
Training & Support

CambridgeSoft's scientific staff has the industry experience, and chemical and 
biological knowledge to maximize the effectiveness of your information systems.

Oracle Cartridge
or SQL DB

Scientific
Databases

BIOLOGICAL
INFORMATICS

SCIENTIFIC
DATABASES

BioAssay 
& BioViz

BioSAR
Enterprise



BioViz/Chem & Bio Finder Win
CombiChem/Excel Win
ChemFinder/Oracle Win
ChemFinder/Office Win
ChemDraw/Excel Win
Struct<=>Name Win/Mac
ChemNMR & ClogP Win/Mac
Stoichiometry Grid Win/Mac
TLC PLate Tool Win/Mac
Mass Fragmentation Tool Win/Mac
Structure Clean Up Win/Mac
Polymer Draw Win/Mac
LabArt & BioArt Win/Mac
Tinker/Chem3D Win
MOPAC Client Win
GAMESS Client Win
Gaussian Client Win
Jaguar Client Win

The Merck Index Win/Mac
*ChemACX Ultra (1 Year) Win
*ChemINDEX Ultra Win
ChemRXN, NCI & AIDS Win

*Available Separately

ChemOffice Ultra

ChemOffice Pro

ChemDraw Ultra

ChemDraw Pro

Chem3D Ultra

E-Notebook Ultra
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Available Suites
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The Merck Index

BioOffice Ultra

Inventory Ultra

BioAssay Ultra

*ChemDraw Ultra Win/Mac
*ChemDraw Pro Win/Mac
*ChemDraw Std Win/Mac
*ChemDraw ActiveX/Plugin Pro Win/Mac
*Chem3D Ultra Win
*Chem3D ActiveX Pro Win
*Chem3D & E-Notebook Pro Win
Chem3D & E-Notebook Std Win
ChemFinder Pro Win
ChemFinder Std Win

*BioDraw Pro (Pathworks) Win
*BioAssay Pro Win
*Inventory Pro Win
*E-Notebook Ultra Win

ChemACX Ultra

BioDraw Ultra

BioViz Ultra



ChemOffice is a powerful suite of software, consisting of ChemDraw, Chem3D, ChemFinder
and ChemACX for chemists, BioOffice, BioAssay, BioViz, and BioDraw for biologists, and
Inventory, E-Notebook and The Merck Index for scientists. ChemOffice and BioOffice are available
for Microsoft Windows.

ChemDraw includes Struct <=> Name, ChemDraw/Excel and ChemNMR. Create stereo-
chemically correct structures from chemical names, and get accurate IUPAC names for structures.
Estimate NMR spectra from a ChemDraw structure with direct atom to spectral correlation.
The ChemDraw ActiveX/ Plugin adds chemical intelligence to your browser for querying databases
and displaying information.

Chem3D provides visualization and display of molecular surfaces, orbitals, electrostatic potentials,
charge densities and spin densities. Chem3D utilizes MOPAC, Gaussian, GAMESS and extended
Hückel to compute molecular properties. ChemProp computes Connolly surface areas, molecular
volumes and properties, including Tinker, ClogP, molar refractivity, critical temperature & pressure.

ChemFinder is a chemically intelligent database manager and search engine. ChemDraw/Excel
creates searchable spreadsheets. ChemFinder/Word searches documents, spreadsheets, and files for
chemical structures and references. ChemFinder includes CombiChem/Excel for combinatorial library
generation in chemical spreadsheets. ChemFinder/Oracle provides enterprise solution integration.

BioOffice is the ultimate suite for management, analysis and visualization of biological data
using BioAssay and BioViz. Use BioDraw for drawing pathways. Includes Chem3D, Inventory
and E-Notebook.

BioDraw, formerly called Pathworks, makes drawing and annotating your biological path-
ways straight-forward and quick, adding a level of uniformity and detail which is unmatched.

BioAssay manages both high and low throughput biological screening data. Designed for
complex lead optimization experiments, the software supports the quick set-up of biological models. 

BioViz offers automated calculations, curve fitting, and customized structure activity reports,
including a user friendly interface for importing, viewing, validating & plotting biological assay data.

Inventory manages your reagent and biological tracking needs. Using MSDE as the desktop
database, you organize, store and search over your inventory. Inventory integrates with the
ChemACX database of available chemicals and ChemMSDX safety data providing chemical
sourcing and purchasing.

E-Notebook is the efficient, accurate way to write lab notebooks. It stores MS Office docu-
ments, ChemDraw structures and reaction drawings, and related data in a notebook searchable
by text or chemical structure. Organize pages by project, experiment, or in your own style. Use
CombiChem/Excel to build libraries.

Databases include The Merck Index and ChemINDEX, including the NCI and AIDS databases.
The ChemACX Database contains nearly 400 catalogs from leading suppliers and ChemMSDX
Database contains over 20,000 material safety data sheets for commonly used laboratory chemicals.

the standard
achieves the

ultimate

computational
chemistry
made easy

screening
data

the ultimate
software suite

for scientists

handle
reagent 

tracking 

efficient 
notebook 

keeping

access info
with ease

draw 
pathways

visualize 
data

desktop to
enterprise
searching

ultimate suite
for biologists

ChemChem && BioBio OfficeOffice
Software Standard for ScientistsSoftware Standard for Scientists

 



E N T E R P R I S E  &  

Includes

EnterpriseUltra

EnterprisePro

EnterpriseStd

WorkgroupUltra

WorkgroupStd

WorkgroupPro

ChemOffice

E-Notebook Enterprise or Workgroup
BioAssay Enterprise or Workgroup
BioSAR Enterprise
BioViz Desktop

Registration Enterprise
Inventory Enterprise or Workgroup
ChemACX Database

ChemINDEX Database
Oracle Cartridge
SQL Server Compatible
ChemFinder Ultra

Chem & Bio Office WorkgroupChem & Bio Office Workgroup
Integrated Research, Discovery, Development,Integrated Research, Discovery, Development,

Research & Discovery - Search for Products
Since the company’s founding, CambridgeSoft’s
desktop software, starting with its industry-leading
ChemDraw, has been the cornerstone application for
scientists who draw and annotate molecules, reactions,
and pathways. The suite of applications has devel-
oped and CambridgeSoft now provides solutions in
virtually all areas of discovery. Researchers can record
and share their experimental information using 
E-Notebook, while protecting intellectual property
with digital signatures and 21CFR11 compliance.
They can design both single experiments or design
combinatorial libraries of compounds. They find
and purchase reagents in ChemACX database, store

and use them from Inventory, record newly made
compounds within a proprietary Registration system,
record the results from biological testing in BioAssay,
analyze the results with BioViz, and generate reports
linking activity and structure with BioSAR.

Virtually every aspect of discovery—from synthesis
planning, library enumeration, reagent selection, 
primary and secondary screening, in vivo testing,
through to analysis of results and reporting is covered
by this integrated application suite.

Development - Converting Leads into Testing
Building on productivity software, CambridgeSoft
created enterprise applications to meet the needs of an
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W O R K G R O U P

and Enterprise Solutionsand Enterprise Solutions
TTrials and Manufacturing Wrials and Manufacturing Workfloworkflow

ever expanding research and development community
that relies on data sharing across scientific disciplines,
research campuses, and even oceans as globalization
has increased demands. Since it is web-based, the
software is deployed readily throughout a research
and development organization. Using Registration, E-
Notebook, BioAssay, and BioViz, in conjunction with
DocManager and DrugDeg, scientific teams are well
armed to solve the daily challenges of development.
These teams include scientists who scale up and
design manufacturing procedures, toxicologists who
determine the metabolic fate of drug candidates, for-
mulation scientists who determine drug dosing and
delivery systems, as well as many others.

Trials & Manufacturing - Last Steps to Success

A suitable drug candidate is one that has the desired
activity to provide disease therapy while still meeting
drug safety requirements, can be manufactured in a
cost effective and reproducible fashion under
21CFR11 and GMP guidelines, and is stable under
normal formulation and storage conditions. With a
drug candidate in hand, the final challenge is to deter-
mine safety and efficacy, beyond the laboratory, in a
patient population.

Manufacturing requires the hand off of data and
batch process records from the pilot plant studies
using Inventory, E-Notebook, and Registration systems
under Good Laboratory and Manufacturing
Processes (GxP).

The handling of materials, including chain of custody
requirements, material documentation, material
workflow, such as availability states and recertification
dates, are tracked and handling by the system. The
systems meet these requirements and provide the
basis to manage materials and records during clinical
trials. Clinicians can design and record results from
protocols, and all of these web based software systems
provide the access required by clinicians who are
removed from the sponsoring company.

ChemOffice Enterprise is a comprehensive
knowledge management and informatics solution,
covering electronic notebooks, biological screening,
chemical registration and more over your intranet.
Enterprise Ultra includes E-Notebook for record keep-
ing, BioAssay for low and high throughput screening
with integrated plate inventory, BioSAR for SAR
reports, Registration system, Inventory for reagents
and ChemACX database of available chemicals.
Technologies include ChemDraw ActiveX and Oracle
Cartridge.

ChemOffice Workgroup is a comprehensive
knowledge management and informatics solution,
covering electronic notebooks, biological screening
and more over your intranet. Workgroup Ultra
includes E-Notebook for record keeping, BioAssay for
low and high-throughput screening, BioViz for 
visualization, Inventory for reagents and ChemACX
database of available chemicals. Technologies include
SQL Server for affordability and ease of administration.
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K N O W L E D G E

E-Notebook, Reaction Explorer,E-Notebook, Reaction Explorer,
Electronic JElectronic Journal and Record Keepingournal and Record Keeping

E-Notebook
E-Notebook provides a smooth web-based interface
designed to replace paper laboratory notebooks, with
a fully configurable, secure system for organizing the
flow of information generated by your organization.
You can enter reactions, Microsoft Word documents,
spectra and other types of data, and search this data
by text, substructure or meta data. You can organize
your electronic pages by projects, experiments or any
other classification that conforms to your workflow.

E-Notebook Enterprise
E-Notebook Enterprise edition integrates notebook
keeping at group and enterprise levels to promote lab
productivity and information sharing. Oracle
Cartridge manages chemical structures in a common
data repository with detailed security and 21CFR11
Compliance. The enterprise edition also works with
procurement and inventory management systems to
save time locating chemicals and entering structures.

E-Notebook Workgroup
E-Notebook Workgroup, intended for use with a
medium number of users, offers much of the func-
tionality delivered in E-Notebook Enterprise while
using SQL Server as the database. Learning to use
and administer the application is quick and straight-
forward. E-Notebook applies various data types to
suit different disciplines with an unlimited number
of workflows.

E-Notebook Ultra
E-Notebook Ultra is the efficient, accurate way to
write lab notebooks entries as you work. It stores
Microsoft Office documents, ChemDraw structures
and reaction drawings, and related data in an elec-
tronic notebook you can search by text or chemical
structure. Organize pages by project, experiment or
your own style with the MSDE database.
CombiChem/Excel builds combinatorial libraries.

Reaction Explorer
Reaction Explorer is a powerful application that
assembles a vast amount of information into a lucid
synthesis map. The map provides reaction informa-
tion, as well as quick access to experiments. Reaction
Explorer displays two types of relationships between
compounds: relationships grouped by batch and
those grouped by compound. Both types of displays
are configurable, allowing scientists to create a look
and feel that they are comfortable with.

• E-Notebook offers custom organization of
notebook pages at personal or enterprise levels

• Quick access to important data by searching
on keywords, dates, chemical structures and
more

• Reaction Explorer can display the ancestors
and descendants of a batch in seconds
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M A N A G E M E N T
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The batch display tracks the history of a particular
entity through several subsequent reactions and
experiments. This might be of interest to a chemical
auditor or patent attorney needing to track down the
original source of material.

The compound display is more general, and shows all
possible pathways to and from a compound. This is
ideal for chemists working to optimize a process, or a
patent attorney trying to link a product to discovery,
or a scientist trying to compile work done by several
other scientists.

Process Chemistry

E-Notebook also provides the capability to scale reac-
tions by virtually any parameter from reagent
amount to vessel size. Individual reactions may be
scaled as well as total syntheses. Batch procedures cre-
ated with E-Notebook can be used to produce auto-
matically batch record worksheets. 

Authenticate Work

Display Ancestors

The objective of process research is
to identify efficient processes for the
synthesis of active pharmaceutical
agents at the scale required for 
clinical trials and commercial use. It
is necessary to provide precise
descriptions of these processes so
that they can be executed by differ-
ent groups in different locations. 
E-Notebook’s process chemistry mod-
ules are designed to support these
dual workflow and regulatory-
compliance needs of process
chemists. After the steps in a synthe-
sis have been optimized, either indi-
vidual steps or the entire synthesis
must be scaled. 
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CombiChem Enterprise
Combinatorial chemistry, in particular the technique
of parallel synthesis, has become an essential element
of the drug discovery process. By using parallel 
synthesis techniques, chemists are able to multiply
their productivity by a factor of between 5 and 100.
CombiChem Enterprise has been developed to provide
the tools required by the combinatorial chemist 
to manage and document parallel synthesis 
experiments.

Flexibility is the key when dealing with databases of
chemical compounds. CombiChem Enterprise can use
reagent lists from a variety of different sources: SD
files, ChemFinder databases, ChemFinder hit lists,
ChemACX Database, or directly from the user via
ChemDraw. Regardless of the source, CombiChem
produces a list of reagents which match a particular
generic reactant.

E-Signatures IP Protection
E-Signatures provides data storage and access func-
tions for electronic records. It is used in conjunction
with E-Notebook as a long-term storage system.
While E-Notebook is intended to capture and record
data as the experiments are carried out, E-Signatures
serves as the repository for finished experiments and
other documents. Electronic records must be 
available indefinitely, and their authenticity must be 
verifiable independently of the E-Notebook system. In
addition to the record, E-Signatures’ long-term
archive includes a digital signature, a timestamp, and

associated metadata. Managers, patent attorneys,
and scientists can retrieve records based on searches
over the metadata.

E-Signatures also manages the signature workflow for
electronic records and documents in process. Digital
signatures are captured at the time of record 
creation, which can later serve to prove the authen-
ticity of the stored electronic records.  Reviewers,
witnesses, and other individuals can countersign
records for various business purposes, including wit-
ness records necessary to meet the needs of 37 CFR
and similar regulations worldwide.

21CFR11 Compliance
Large and growing enterprises are facing a challenge
to their core missions of developing and producing
new products including food, therapeutic pharma-
ceuticals, medical devices, cosmetics or other health

K N O W L E D G E

E-Notebook, Reaction Explorer,E-Notebook, Reaction Explorer,
Electronic JElectronic Journal and Record Keepingournal and Record Keeping

• Highly flexible and configurable to match
an organization’s workflow

• Consulting teams analyze and adapt 
existing procedures to comply with new 
regulations

• Systems include authentication and digital
signatures and adapt to changing 
regulations and demands for intellectual
property protection
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enhancing items. The complexity lies in complying
with government regulations designed to protect
public health and safety. The most notable of these 
is Title 21 of the Code of Federal Regulations 
governing Electronic Records and Signatures
(21CFR11).

Once you have determined how your enterprise will
comply with these new regulations, implementing
those decisions needs to be done quickly, efficiently
and with the understanding that the rules for 
compliance are in flux. In order to succeed, you must
be able to respond to change. CambridgeSoft’s
21CFR11 Compliance consulting has both the tools
and the expertise to provide complete solutions, carry
out integration with existing systems, and help exe-
cute the process as quickly as your organization
demands. 
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• Inventory offers plate handling for high-
throughput experimentation

• Inventory is GxP Compliant with validated
audit trails

• Registration has flexible business rules for
registration, salt handling, and batch fields
with chemical intelligence that includes
advanced stereochemistry

Chem & Bio Inventory
Inventory is an application designed to manage the
chemical and reagent tracking needs of laboratories
and research centers. The system manages data 
associated with both commercially procured and
internally produced chemical substances from 
procurement or initial production through depletion
and disposal. To meet the needs of institutions 
of all sizes, Inventory comes in an Enterprise edition,
a Workgroup edition and two Desktop editions.

Inventory Enterprise is an Oracle-based, ChemOffice
Enterprise product. Designed for large organizations,
it comprises a number of features not included in the
desktop or workgroup versions. Inventory Enterprise
conveniently manages plate information. In addition
to storing, moving, and deleting plates, the applica-
tion allows users to create daughter plates and 
reformat plates. Inventory Enterprise can be tightly
integrated with Registration Enterprise and ChemACX
Database.

Inventory Workgroup is a thick-client SQL Server-
based product. This version is suitable for larger
organizations that do not have the interest or desire to
maintain an Oracle server.

Inventory Ultra is the same MSDE based product,
while also including the ChemACX Database,
CambridgeSoft’s collection of nearly 400 catalogs
from suppliers of chemical reagents.

Inventory Pro is an all-inclusive desktop product. It 
includes Microsoft SQL Server Desktop Edition
(MSDE), the re-distributable database for SQL
Server. No additional licensing is required.

Registration Enterprise
Registration Enterprise includes a robust data model
for pure compounds, batches, salt management, 
automatic duplicate checking and unique ID assign-
ments. Compounds may be entered individually or
through the use of a batch loader. The data model
resides entirely in Oracle and uses Oracle’s security
and transaction framework. Registration is easily
adapted to any workflow.

New compound chemical and non-chemical data is
entered into a temporary storage area through a web
form. When the compound is registered, it is 
compared for uniqueness via a configurable, stereo-
selective duplicate check, and assigned a registry

Inventory, Inventory, Registration,Registration,
Chem and Bio Inventory and RegistrationChem and Bio Inventory and Registration
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number. All information about the compound,
including its test data and other syntheses, is tracked
by the registry number. When a compound is regis-
tered, the structure is checked for novelty. If a dupli-
cate already exists in the database, the user can elect
to register the information as a new batch of the
existing compound, or assign it a unique registry
number.

Registration Enterprise is the only true n-tiered appli-
cation of its kind that is designed around thin clients
and thin servers. This translates into ultimate flexibil-
ity on both the client and server side. Oracle is 
supported on a variety of platforms and operating
systems. Using Oracle keeps your proprietary data

systems are designed for registration of single mole-
cules, with little thought for the world of formulations
and mixtures. CambridgeSoft has developed a system
specifically designed for this registration need called
Formulations & Mixtures.

secure through the use of Oracle’s
role based security and allows all
chemical and non-chemical data to
be stored directly in the Oracle
tables.

Formulations & Mixtures
Formulation scientists face different
challenges from those working with
individual molecules, yet many of
the tools they are forced to use
emerge from the drug-discovery
world, where single-molecule
research is the norm. Take an essen-
tial task such as compound registra-
tion and you will find that most 

Index Documents

Manage your Inventory
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Inventory, Inventory, Registration,Registration,
Chem and Bio Inventory and RegistrationChem and Bio Inventory and Registration

DocManager Enterprise
Web browser based, DocManager Enterprise extends
the capability of standard search engines to include
full free text searching and chemically intelligent
structure searching of electronic documents includ-
ing Text, Microsoft Word, Excel, PowerPoint, and
Adobe PDF.

The DocManager Enterprise interface allows users to
easily submit documents through a series of simple to
navigate web forms. When a new document is 
submitted, DocManager builds a free-text index of
the document, and extracts chemical information
into a chemically-aware, substructure searchable
database. Chemical information can originate from
either ChemDraw or ISIS Draw.

DocManager Enterprise includes a batch loading 
utility for administration level users to load multiple
documents at one time. The system can be 
configured to submit a batch of documents as one
event, or as a reoccurring submission to be executed
daily. The administrator simply specifies a time 
for the submission to take place and the location of 
the files.

DocManager Enterprise utilizes the searching intelli-
gence of the ChemOffice Enterprise suite. In addition
to standard textual and numerical searching,
DocManager searches the submitted documents for
chemical structure or reaction.

Oracle Cartridge
The CambridgeSoft Oracle Cartridge is used by all
ChemOffice Enterprise applications for storing, search-
ing over, and analyzing chemical data. It can also be
used in the development of your custom Oracle
applications. Chemical structure information is 
difficult to manipulate without utilizing special
software. Oracle data cartridges define new, recognized
datatypes. CambridgeSoft’s Oracle Cartridge utilizes
this technology making it possible to manipulate
chemical structure and reaction data from within
Oracle, improving portability and consistency in
applications. Since the Oracle Cartridge is accessed
through Oracle, this allows the programmer to interact
with chemical structure data directly in Oracle. The
CambridgeSoft Oracle Cartridge supports CDX,
CDXML, MolFile, RXN, and SMILES formats
making it flexible enough to be included with both
new and legacy data, without the need for conversion.

• DocManager parses Word, Excel and
PowerPoint documents, including free text

• DocManager has a web based interface and
a file drop folder for quick submissions

• Oracle Cartridge is compatible with Linux,
Solaris, AIX and Windows and includes 
structure searching, property predictions 
and nomenclature
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ChemFinder Enterprise
ChemFinder Enterprise is a multiple-user system
designed for sites with heavy-duty chemical and 
biological data needs. ChemFinder Enterprise contains
its own engine for working with local and shared
databases and it is also delivered with the
CambridgeSoft Oracle Cartridge, the powerful
Oracle-hosted structure engine based on ChemFinder
search technology. So, the face of ChemFinder
Enterprise is the same friendly form-oriented interface
as the desktop version, but underneath is a fast direct
connection to Oracle and the robust, scalable Oracle
Cartridge running on the server.
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BioAssay, BioViz,BioAssay, BioViz,
Assay Screening and VAssay Screening and Visualizationisualization

BioAssay
Biological assay data comes in many forms, from a
scientist’s observations to output from a plate reader.
Software designed to store and analyze this data must
provide a solution for both the ultra-high volume 
laboratories, including laboratory automation, 
calculation, and statistics, as well as the very compli-
cated low and medium throughput assays such as 
animal models and in vivo experiments. Organizing,
analyzing, and sharing data can be a challenge for
screening biologists, regardless of the amount of
automation or manual data manipulation employed.

BioAssay was designed to tackle the needs of high and
low throughput screening biologists alike by provid-
ing an application flexible enough to model any
assay, regardless of complexity, while robust enough
to provide an easy to use interface for importing,
storing and analyzing the data. The software supports
the quick set-up of biological models, automated cal-
culations and curve fitting, data validation, and the
creation of customized structure activity reports.

BioAssay Enterprise offers a scalable, flexible biological 
screening solution utilizing Oracle’s role based securi-
ty and the Oracle Cartridge. As part of ChemOffice
Enterprise, BioAssay is easily integrated with Inventory
Enterprise for plate tracking and management,
Registration Enterprise for the registration of new
compounds and BioSAR Enterprise for customized
reporting.

BioAssay Workgroup, intended for single site deploy-

ment, uses SQL Server as a database, instead of

Oracle. This solution offers affordability and ease of

maintenance, but still remains a robust solution suit-

able for a smaller group’s needs. Organize and share

your biological screening data with minimal admin-

istrative costs.

BioAssay Ultra is designed to deliver much of the func-

tionality of our enterprise level applications, without

a widespread roll out. MSDE database compatible,

BioAssay Ultra, coupled with BioViz, offers a user

friendly interface for importing, viewing, validating,

and plotting your biological assay data from your

desktop.

• BioAssay effectively manages data from com-
plex biological assays involved with lead
optimization

• BioViz provides a flexible reporting and plot-
ting engine for your scientific data

• BioViz integrates with BioSAR for one step in-
depth data analysis from a BioSAR report
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BioSAR & BioDrawBioSAR & BioDraw
Data Mining and PData Mining and Pathway Drawingathway Drawing

BioViz
BioViz, with ChemFinder, transforms the numbers in
your database into graphics on your screen. Retrieve
or search for a set of compounds, choose the data you
want to see, whether it is biological test results in
Oracle tables, physical property values calculated
automatically or prices in a catalog, and BioViz will
generate an interactive window showing a scatterplot,
histogram, or other useful data graphic.

The Plot Window, the key to data visualization in
BioViz, shows two variables plotted against each
other in a scatterplot with each point representing a

Draw Biological Pathways

Plot Assay Data

structure from the current hit list.
If you modify the list, for example
by performing a search, the plot
updates to show the new set of
points. You can drag a rectangle
around a set of points to select
them, or zoom in to see them
more closely.
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BioSAR
BioSAR Enterprise, a strategic must for any discovery 
organization interested in serious data mining, is a
data-dictionary driven structure-activity analysis 
program. Users may choose among assays registered
in the dictionary or search for assays of interest. The
power of BioSAR lies in the researcher’s freedom from
dependence on IT support. Once an assay is 
registered into the data-dictionary, it is automatically
included in the powerful analysis framework. By
reducing the time between question and answer,
BioSAR gives researchers the ability to explore new
ideas, the bottom line for discovery information sys-
tems. Systems that provide answers after questions
have become irrelevant are of no use. BioSAR avoids
this issue by placing application development in the
researcher’s control.

BioSAR Enterprise allows the researcher to create cus-
tom reports and views of their data. You decide what
is displayed, and BioSAR takes care of the rest. While
most SAR tools provide only a table-based interface,
BioSAR provides a both a form view and table view.
The form view provides highly detailed information
about one compound, whereas the tabular view
makes viewing comparisons between compounds
more feasible. There is often a tradeoff between
power and simplicity, and most SAR tools opt for the
former at the expense of the latter. BioSAR, however,
merges the sophistication of a powerful data catalog
technique with knowledge gained through years of

working closely with users. The result is a SAR 
application that is as intuitive as it is powerful.

Security within BioSAR Enterprise is highly granular.
Different roles exist for administrators, publishers,
and browsers. Administrators may add assays to the
data catalog engine, publishers may create reports
and publish them, and browsers may use data query
and analysis. Most data mining tools provide a 
mechanism to store queries, but the interface for 
creating queries is too complex. With BioSAR, each
set of assays is a complete report with a query form,
a view form, and a table view, combining the 
convenience of a ChemFinder or ISIS application with
the power and flexibility of a data catalog-driven 
mining program.

• BioSAR is a catalog driven data mining and
structure- activity analysis program

• BioSAR provides both form and table views
within a simple and powerful web interface

• BioDraw makes it easy to draw and annotate 
biological pathways including common 
elements such as membranes, enzymes,
receptors and DNA
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BioDraw
Reporting on and presenting findings is a task familiar
to every biologist. Making this process easier and
more effective benefits everyone involved. BioDraw,
formerly called Pathworks, is doing for biologists
what ChemDraw has done for chemists for years—
saving time, and resulting in a more professional 
representation of the science at hand.

BioDraw makes drawing and annotating biological
pathways quick and easy, adding a level of uniformi-
ty and detail which is unmatched. Typical drawings
of biological pathways include many elements that
are difficult to draw with the standard presentation
and word processing software that is on the market.
Common pathway elements such as membranes,
enzymes, receptors, DNA and reaction arrows are
built into the BioDraw toolbar. BioDraw also allows
users to import images in GIF, PNG or JPEG format.

Keeping data organized is of utmost importance in
any lab. BioDraw reflects that importance by allow-
ing users to store annotations for each element in a
drawing. Annotation data ranges from manually
entered text to attached documents, restriction maps,
microarrays, sequence information, literature refer-
ences, or links. Any data, regardless of format, is
stored side-by-side with the drawing for future
retrieval.

The drawing and data organization offered by
BioDraw gives any biologist an advantage. Sharing
this advantage assists the community as a whole.
BioDraw offers many ways to share your drawings
and accompanying data. Users can export data to
Microsoft Office applications for inclusion in 
presentations and grant proposals or save data as an
image file for use in journal article submission.
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Structure Drawing and Molecular Modeling Structure Drawing and Molecular Modeling 

• ChemDraw’s improved Struct<=>Name
feature produces names for more types of
compounds

• Live ChemDraw window embedded in
Chem3D application allows simultaneous
2D and 3D editing

• Chem3D brings workstation-quality 
molecular graphics and rigorous 
computational methods to your desktop

ChemDraw Ultra adds Struct<=>Name,
ChemDraw/Excel, ChemNMR, CLogP, tPSA and
ChemFinder/Word to ChemDraw Pro. With rich 
polymer notation, atom numbering, BioArt templates,
and modern user interface, ChemDraw is more 
powerful than ever before. Create tables of structures,
identify and label stereochemistry, estimate NMR
spectra from a ChemDraw structure with structure-
to-spectrum correlation, obtain structures from
chemical names, assign names from structures, and
create multi-page documents and posters.

ChemDraw Pro will boost your productivity
more than ever. Draw publication-quality structures
and reactions. Publish on the web using the
ChemDraw Plugin. Create precise database queries by
specifying atom and bond properties and include
stereochemistry. Display spectra, structures, and
annotations on the same page. Use the Online Menu
to query ChemACX.Com by structure and identify
available vendors.

Struct<=>Name contains the leading compre-
hensive methods for converting chemical structures
into chemical names and names to structures. It can
be used for many types of compounds, including
charged compounds and salts, highly symmetric
structures and many other types of inorganic and
organometallics. Struct<=>Name is available in two
forms: a batch application, and an interactive version
that is also available in ChemDraw Ultra.

ChemDraw/Excel allows the user to create
chemically knowledgeable spreadsheets within the
familiar Microsoft Excel environment. You can build
and manipulate chemical structures within Excel,
compute chemical properties and perform database
searches.

ChemNMR can be used to accurately estimate 13C
and 1H (proton) chemical shifts. The molecule and
the spectrum appear in a new window. The chemical
shifts are displayed on the molecule and the spectrum
is linked to the structure so that clicking on a peak in
the spectrum highlights the related fragment on the
molecule.
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Chem3D Ultra includes a number of molecular
modeling capabilities such as molecular overlay, 
conformational searching and dihedral driver support.
It also includes interfaces for optional use of
MOPAC, Gaussian and GAMESS. The user can also
compute advanced physical properties such as CLogP
and ChemProp. These properties can be used to 
create SAR tables. ChemSAR/Excel can then be used
to explore structure activity relationships. High 
quality Chem3D graphics can be viewed on the web
using the Chem3D ActiveX.

Chem3D Pro brings workstation quality molecular 
visualization and display to your desktop. Convert
ChemDraw and ISIS/Draw sketches into 3D models.
View molecular surfaces, orbitals, electrostatic 

It can also be used to predict a number of chemical
and physical properties. Chem3D contains an 
interface to the MOPAC package.

Gaussian is a collection of semi-empirical and 
ab initio molecular orbital (MO) computational
methods which can be used to predict energies,
molecular structures, molecular properties, as well 
as molecular spectra. Chem3D enables the user to 
transparently create input and analyze output resulting
from Gaussian.

Estimate Spectra

Molecular Modeling

potentials, charge densities and
spin densities. Use built-in extended
Hückel to compute partial atomic
charges. Use MM2 to perform
rapid energy minimizations and
molecular dynamics simulations.
ChemProp estimates physical prop-
erties such as logP, boiling point,
melting point and more. Visualize
Connolly surface areas and molec-
ular volumes.

MOPAC is a semi-empirical
quantum mechanics package which
can be applied to the study of 
chemical properties and reactions.
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ChemFinder Enterprise is a multiple-user 
system designed for chemical and biological data
management. ChemFinder Enterprise contains its own
engine for working with local and shared databases
and it is also delivered with the CambridgeSoft
Oracle Cartridge, the powerful Oracle-hosted 
structure engine based on ChemFinder search 
technology. So, the face of ChemFinder Enterprise is
the same friendly form-oriented interface as the desk-
top version, but underneath is a fast direct connec-
tion to Oracle and the robust, scalable Oracle
Cartridge running on the server.

BioViz, included in ChemFinder Enterprise, provides
a new set of data visualization features. These features
allow you to plot structural and biological data in a
variety of styles, filter plots based on your criteria,
highlight lists and intersecting sets on plots, generate
histograms of data distributions, and more.

ChemFinder Pro is a fast, chemically intelligent,
relational database search engine for desktop, work-
group or enterprise applications. Extended integra-
tion with Microsoft Excel and Word adds chemical
searching and database capability to spreadsheets and
documents.

Today, an ever-increasing number of chemical data-
bases are available in ChemFinder format. Compatibility
with MDL ISIS databases is provided by SDfile and
RDfile import/export. ChemFinder provides network
server workgroup functionality when used with
ChemOffice Workgroup and Enterprise.

The Merck Index is an encyclopedia of chemi-
cals, drugs and biologicals, with over 10,000 mono-
graphs covering names, synonyms, physical proper-
ties, preparations, patents, literature references, ther-
apeutic uses and more.

ChemACX Database includes 500,000 chemi-
cal products from nearly 400 supplier catalogs,
searchable with a single query by structure, substruc-
ture, name, synonym, partial name, and other text
and numeric criteria. ChemSCX is a compilation of
searchable catalogs from leading screening compound
suppliers.

ChemMSDX Database provides material safe-
ty data sheets for 7,000 pure compounds.

ChemINDEX Database includes 100,000
chemicals, public NCI compounds, AIDS data, and
more.

• ChemFinder offers improved searching and
hitlist management, along with new property
generation

• ChemFinder is tightly integrated with
CambridgeSoft’s Oracle Cartridge

• Search ChemACX and other CambridgeSoft 
databases for important chemical information
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ChemFinder & ChemInfoChemFinder & ChemInfo
Structure Searching and Scientific DatabasesStructure Searching and Scientific Databases

NCI Database contains over 200,000 com-
pounds with anti-cancer drug dose-response data.

AIDS Database is an NCI compiled database for
AIDS anti-viral compounds.

ChemRXN Database is a collection of 30,000
fully atom-mapped reactions selected and refined from
the chemical literature. It includes reactions from
InfoChem’s ChemSelect database and ISI’s
ChemPrep database.

ChemFinder.Com is the award-winning web site
with information and WWW links for over 100,000
chemicals. Users can search by name or partial name,
view structure drawings, or use the ChemDraw
ActiveX/Plugin for structure and substructure search-
es. In addition, users can view live ChemDraw files on
Windows and Macintosh clients.
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D E S K T O P

BioAssay Ultra
BioAssay Ultra, the cornerstone of BioOffice, provides
flexible storage, retrieval, and analysis of biological
data. BioAssay easily manages both high and low
throughput biological screening data. Designed for
complex lead optimization experiments, the software
supports the quick set-up of biological models, auto-
mated calculations and curve fitting, and the creation
of customized structure activity reports. BioAssay
brings all of this functionality to your desktop.
BioAssay Ultra, compatible with MSDE database,
offers a user friendly interface for importing, viewing,
validating and plotting your biological assay data. 

BioViz
Combining biological data with the chemical 
structure is of utmost importance in any drug discovery
environment. BioViz allows you to analyze structure-
related data combined with biological data visually.
BioViz, within ChemFinder, provides a graphical rep-
resentation of the data loaded into a ChemFinder
form. Users can search over data and construct a 
scatterplot, histogram, or other useful data charts.
Plots are interactive to allow you to select subsets of
your data.

BioDraw
BioDraw, formerly called Pathworks, makes drawing
and annotating your biological pathways quick and
easy, adding a level of uniformity and detail which is
unmatched. Typical drawings of biological pathways
include many elements that are difficult to draw with

the standard presentation and word processing 
software on the market. Common pathway elements
such as membranes, enzymes, receptors, DNA and
reaction arrows are built into the BioDraw toolbar
and including them in your document is as easy as
including a rectangle. Click on the toolbar shortcut
and drop the element into your document. Resize
and move elements by clicking and dragging and 
create an accurate and concise drawing in minutes.

BioDraw allows the import of images in GIF, PNG
or JPEG format. ChemDraw users are also able to
include ChemDraw structures in drawings without
difficulty.

Keeping data organized is of utmost importance in
any lab. The BioDraw application reflects that impor-
tance by allowing you to store annotations for each

• BioAssay offers flexible storage, retrieval and
analysis of biological data

• BioViz provides a graphical representation of
the data loaded into a ChemFinder form

• BioDraw allows for quick and easy drawing
and annotating of biological pathways, includ-
ing importing of images in GIF, PNG or
JPEG format
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S O F T WA R E

Data Visualization

Notebook Pages

element in your drawing. Annotation data ranges
from manually entered text to attached documents,
literature references, or links. Any data, regardless of
format, is stored side-by-side with the drawing for
future retrieval.

The drawing and data organization offered by
BioDraw gives any biologist an advantage. Sharing
this advantage assists the community as a whole.
BioDraw offers many ways to share your drawings
and accompanying data.
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Inventory Ultra
Inventory is an application designed to manage the
chemical and reagent tracking needs of laboratories
and research centers. The system manages data 
associated with both commercially procured and
internally produced chemical substances from their
procurement or initial production through their
depletion and disposal.

Inventory Ultra is an MSDE based product and
includes the ChemACX Database with nearly 400
catalogs of chemical reagents. The three primary 
entities in an Inventory system are locations, containers,
and substances. Users or administrators configure 
a network of locations, which represent locations
within an organization.

Containers are created to represent actual containers
in your facility. Each container is assigned a unique
barcode, which can be printed, using a customized
template, from the Inventory interface. Each container
stores a substance. Additional text fields are available
to track other chemical contents such as the solvent,
and custom fields may also be defined. To keep 
track of substances, the system maintains its own
internal chemical structure database containing
unique substances that can be associated with 
inventory containers. Advanced duplicate checking is 
incorporated in the system.

Every field in a record, including chemical structure,
molecular formula and molecular weight are search-

able. The application includes a number of specially
designed inventory search forms. Search results are
returned in list form and can be exported into a doc-
ument (PDF, RTF, HTML) using the report engine.

The Inventory interface allows for printing labels as
well as generating elaborate reports. Inventory uses a
report application that incorporates wizards that allow
for the quick creation of simple report and label 
templates that can be shared across an organization. 

Inventory Pro
Inventory Pro contains the same features as Inventory
Ultra without the ChemACX Database.

E-Notebook Ultra
E-Notebook Ultra is the efficient, accurate way to
write lab notebooks entries as you work. It stores

• Inventory manages the chemical and reagent
tracking needs of laboratories and research
centers 

• Inventory maintains its own internal chemical 
structure database with advanced duplicate
checking

• E-Notebook stores Microsoft Office documents,
ChemDraw structures, reaction drawings and
related data in a convenient, searchable format
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Microsoft Office documents, ChemDraw structures
and reaction drawings, and related data in an elec-
tronic notebook that  is searchable by text or chemi-
cal structure. You can organize pages by project,
experiment, or in your own style with the MSDE
database. CombiChem/Excel builds combinatorial
libraries.

E-Notebook is configured exactly like a chemist would
like his or her own notebook to be. Reactions can be
easily drawn into the reaction template by either
selecting from the generous list of preloaded reagents
or by entering or drawing one’s own chemicals.
Commonly used reagents can be stored in a separate
folder for easy access. Another fantastic feature is the
procedural section. This section contains prewritten
procedural sentences with the ability to easily drop in
the specific names of reagent chemicals present in the
reaction. One can also easily add other data to the
notebook page such as spectra and Word or Excel
documents.

CombiChem/Excel
CambridgeSoft provides you with the tools to effec-
tively plan combinatorial chemistry experiments in
Excel. The CombiChem/Excel add-in introduces addi-
tional functionality for handling combinatorial
chemistry. Users can generate products from a reac-
tion and lists of reagents, you can view all the prod-
ucts arising from a given reagent or all the reagents of
a given product, and you can lay out reagent and
reaction plates.
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The Merck Index
Among printed chemical reference works, one that
stands out for its integrity, detail and longevity is The
Merck Index. The Merck Index database is a structure-
searchable encyclopedia of chemicals, drugs, and 
biological agents which includes the complete 
10,250 monographs of the 13th edition, 230 new 
monographs unavailable anywhere else, as well as 540
monographs retired from the 12th Edition.

The Merck Index is available in many forms to suit the 
various needs of both individuals and institutions.
Personal subscriptions are available in one-year and
one-month time periods. A stand-alone package,
requiring no other applications, is also available for
personal use.

The subjects covered include human and veterinary
drugs, biological agents and natural products, indus-
trial and laboratory chemicals, and environmentally
significant compounds. In addition to the standard
searches, compound monographs can be searched by
ChemDraw structure as well as substructure.

Traditional Chinese Medicines
Many of today’s well-known drugs have their origins
from natural sources. Access to this wealth of 
knowledge is now available with the Traditional
Chinese Medicines database. The database consists of
monographs for 10,458 chemicals isolated from 4,625
natural sources used in traditional Chinese remedies.
The monographs feature bio-activity data for many

of the compounds, effects and indications of the 
medicines, English, Latin, and Chinese names for the
natural sources, and over 2,000 references. This 
information is also available as an SD file to facilitate
in silico research.

ChemINDEX
The ability to quickly look up data such as chemical
properties, biological assay results and toxicological
information is no longer a luxury item, but instead a
requirement. Scientists have used the award-winning
ChemFinder.Com database since 1995. Now, the data
on ChemFinder.Com is integrated into ChemOffice as
ChemINDEX. ChemINDEX contains data on over
75,000 compounds including structures, names and
synonyms, physical properties, and Internet links.

The Merck Index, NCI, AIDS,The Merck Index, NCI, AIDS,
Scientific Reference, Chemical Reactions and PScientific Reference, Chemical Reactions and Patentsatents

• The Merck Index offers encyclopedic reference
for over 10,000 chemicals, drugs and 
biological agents

• Traditional Chinese Medicines provides
chemical information and their biological
effects of complex compounds isolated from
natural sources

• All electronic databases are updated, 
contain information unavailable in print, 
and are searchable by structure, as well 
as text and numeric range
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ChemACX & Sigma-Aldrich MSDSChemACX & Sigma-Aldrich MSDS
AAvailable Chemicals and Material Safety Data Sheetsvailable Chemicals and Material Safety Data Sheets

NCI, AIDS & Cancer
Three informative databases have been integrated
into one powerful application with the NCI and
AIDS database collections. The application starts
with a collection of over 200,000 molecules collected
by the National Cancer Institute. Searchable fields
include structure, synonym, CAS RN, formula, and
molecular weight.

ChemReact68
ChemReact68, from InfoChem GmbH, is a database of
sample reactions comprising essential information on
68,000 reactions. These reactions have been selected
because they have greater than 50% yield and have
appeared in more than five example reactions. 
The database consists of reaction information and 
literature references.

ChemRXN 
ChemPrep and ChemSelect are the two reac-
tions databases that make up ChemRXN.
ChemPrep is a reaction database assembled
by the Institute for Scientific Information
(ISI). This reaction database is designed to
help organic chemists find reactions easily.
It includes full literature citations.
ChemSelect, licensed from InfoChem
GmbH, is a reaction database containing
13,000 important organic reactions.

ChemSynth
ChemSynth, from InfoChem GmbH, is a
database of sample reactions comprising
essential information on 180,000 reactions.
These reactions have been selected because
they have greater than 50% yield and have
been sited in leading journals more than
once. The database consists of reaction
information and literature reference.

The Merck Index 11,000 monographs

Traditional Chinese Medicines 10,000 substances

ChemINDEX Database 75,000 substances

NCI, AIDS & Cancer 270,000 substances

Drugs: Synonyms & Properties 8,000 drugs

Medicinal Chemistry 540,000 substances

ChemACX Database 380 catalogs

ChemMSDX Database 23,000 MSDSs

Sigma-Aldrich MSDS 130,000 MSDSs

Scientific Databases

REACTION & SYNTHESIS DATA

SOURCING & SAFETY DATA

REFERENCE DATA

ChemRXN Database 28,000 reactions

ChemSynth 178,000 reactions

ChemReact68 68,000 reactions
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Development, Deployment, Development, Deployment, 
Custom Development and System DeploymentCustom Development and System Deployment

In order to provide our customers with a total 
solution for scientific informatics, CambridgeSoft
offers the following services to assist our clients in
maximizing the productivity of their research and
discovery organizations.

Informatics Planning 
Strategic and Operational Planning

A formal analysis is conducted to provide a roadmap
for successful technology utilization. This process
includes:

·· An analysis of the current state of the science 
technology environment, including architecture and
operational processes

·· A view of the strategic goals and the barriers to
achievement

·· The delivery of a phased technology transition plan

Requirements Analysis & Proof of Concept

CambridgeSoft consultants can create or refine
requirements to produce an environment that will
ensure success. With years of experience meeting the
needs of the scientific community, CambridgeSoft
understands the user. The prototyping process 
allows definition and testing of the functional and
technical feasibility of potential technology solutions. 
The process provides a baseline for the future 
development and deployment of a tailored solution.
Users gain valuable first hand knowledge in 
experiencing how the system can help achieve 
individual and workgroup goals.

Project Readiness Assessment

Is your project set up for success? Is it well defined
into measurable deliverables? Are the roles of project
members clearly defined? CambridgeSoft’s Project
Readiness Assessment has one goal in mind—
to create or assess current plans and make recommen-
dations to ensure that results are achieved.

21CFR11 Compliance

Successfully implemented, a traceable and usable 
system is essential to any organization involved in the
creation and management of data in a regulated 
environment. As an integral part in creating 21CFR11
and GxP validated applications, CambridgeSoft offers
services to:

·· Audit the software and process

·· Create conforming systems design specifications

·· Generate test plans and validation matrices

·· Insure systems compliance with functional guide-
lines

With custom development, CambridgeSoft
works collaboratively with your team to create
a system that meets your needs while executing
our quality driven software development
process. We deliver what you need, on time
and within budget, without surprises.
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Training & SupportTraining & Support
Educational TEducational Training and Training and Technical Supportechnical Support

Product Development
Data Conversion and Integration

When developing a new system, the process of 
converting existing data and creating interfaces with
other data systems is an essential part of the process.
CambridgeSoft’s professional services staff is equipped
to seamlessly incorporate existing data into the devel-
opment of a new enterprise system. Organizations
will be able to capitalize on historical scientific data
while setting the platform for future success.

Strategic/Op
Planning

Requirements
Analysis

Proof of 
Concept

Project
Readiness

Data
Integration

Custom
Application

Development

Systems
Integration

Installation &
Configuration

Systems
Optimization

Pre-Release
Programs

Software
Evaluations

PLANNING DEVELOPMENT DEPLOYMENT MANAGEMENT

Managed
Informatics

Ultra
Services

Plans 

Technical
Support

Remote DBA
Services

21CFR11
Compliance

Product 
Tailoring

Training
Services

Custom Development

You have discovered a unique application
need in your organization, but cannot find a
solution that will meet your functionality or
cost requirements. With custom development,
CambridgeSoft works collaboratively with
your team to create a system that meets your
needs, while executing our quality driven
software development process. We deliver
what you need, on time and within budget,
without surprises.

Systems Integration

The ability to integrate core applications
with other systems in the technology envi-
ronment is a competency required to deliver
the functionality of a new application. 

Product Tailoring

Your organization can see the benefit from
implementing a CambridgeSoft application,

but would like to customize it for a unique environ-
ment. Our professional services teams can provide
those specific features by making custom modifica-
tions that will be supported in the future.

Systems Deployment
Installation and Configuration

CambridgeSoft will install and configure applications 
to meet the needs of your user community. For
unique environments, we build custom installers that
allow us to productively deploy software across an
enterprise.
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Systems Optimization

CambridgeSoft’s systems deployment team will work
with you to make sure that your computing environ-
ment has been optimized for high performance. 
Your systems, networks, applications and databases
are assessed and designed to deliver maximum
achievement.

Beta and Pre-Release Programs

CambridgeSoft is committed to maximizing your 
productivity through the use of our products, as well
as exposing you to the newest technologies. Our beta
and pre-release programs provide you with that
knowledge, allowing CambridgeSoft to improve
applications with your customer feedback.

Pilot Software Evaluations

It often makes sense to pilot an application before a
major commitment for an enterprise wide implemen-
tation is made. CambridgeSoft will work closely with
you to plan the evaluation, deploy the application,
and gather critical feedback regarding systems design,
API’s and technology specifications.

Training

Effective user, administrator and help desk training is
often an afterthought in many systems deployments.
However, the productivity returns generated by 
an investment in systems training can provide 
dramatic returns. CambridgeSoft offers training in
the following ways:

·· On-site “real time” training through our profes-

sional services staff supporting your systems 
environment

·· On-site formal classroom training

·· Webinars for multi-location instruction

·· Off-site at CambridgeSoft facilities

Systems Management
Managed Informatics

There is no longer a need to worry about licensing
fees, maintenance contracts, systems administration
work or database support. Informatics Outsourcing
provides the people, processes and technology to
develop a unique level of service for your organization.
For a monthly fee, CambridgeSoft will deliver the
informatics applications and the technology staff
required to maximize productivity. This service
allows your organization to focus on science, while
CambridgeSoft plans, implements and manages your
technology environment.

Ultra Services

The Ultra Services program is CambridgeSoft’s 
personalized, premium service for supporting our 

Managed Informatics allows your organization
to focus on science, allowing CambridgeSoft to
plan, implement and manage your technology
environment.

Development, Deployment, Development, Deployment, 
Custom Development and System DeploymentCustom Development and System Deployment



S E R V I C E S

customers. Organizations can take advantage of both
telephone and electronic access to CambridgeSoft’s
support scientists who can address:

·· Usage and installation questions

·· Product compatibility and interoperability 
questions

·· Diagnostic review to help isolate the cause of a
problem

·· Configuration assistance

·· Planning information for software updates and
upgrades

·· Assistance with problem resolution

Technical Support & Remote DBA Services

To complete our Management Services offerings,
Technical Support and Remote DBA Services, for
Oracle and SQL Server, are also available.

Training & SupportTraining & Support
Educational TEducational Training and Training and Technical Supportechnical Support
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Web www.cambridgesoft.com Email info@cambridgesoft.com
America 1 800 315–7300 UK +44 1223 464900
Europe 00 800 875 20000 Germany +49 69 2222 2280
Japan 0120 731 800 France +33 1 70 71 98 80

Enterprise Solutions include ChemOffice, with Oracle Cartridge, and ChemOffice Workgroup, based on SQL Server to help 
organizations from small workgroups to large enterprises collaborate and share information more effectively.

Desktop Software includes ChemOffice, a powerful suite of software, consisting of ChemDraw, Chem3D, ChemFinder and
ChemACX for chemists, BioDraw, BioAssay and BioViz for biologists, and Inventory and E-Notebook.

Knowledge Management with E-Notebook, including Reaction Explorer, CombiChem, E-Signatures for intellectual property
protection and 21CFR11 Compliance, streamlines daily record-keeping with rigorous security and efficient archiving.

Chemical Informatics, including Registration, organizes new compound information. Inventory provides complete management
of chemical and biological inventories including GxP Validation. DocManager indexes chemical structures in documents.

BioIogical Informatics scientists use BioAssay, BioViz, BioSAR and BioDraw to set up biological models and visualize 
information, generate spreadsheets correlating structure and activity, search by structure, and draw and annotate pathways.

Scientific Databases include the ChemACX Database of commercially available chemicals and Sigma-Aldrich MSDS. 
The Merck Index and other scientific databases provide information about chemicals, their properties, and reactions.

Professional Services includes custom development, system deployment, educational training, and technical support for 
pharmaceutical, biotechnology, and chemical customers, including government and academia, by experienced staff.
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CS ChemDraw ®

for Windows Quick Reference

SCREEN ELEMENTS

Rotation Handle

Resize Handles

Selection Box

Resize

Object ToolbarMagnification controlsTitle Bar

Menu Bar

Status Bar

Text Style Toolbar

Lasso
Structure Perspective

Solid Bond
Multiple Bonds
Dashed Bond
Hashed Bond

Hashed Wedged Bond
Bold Bond

Bold Wedged Bond
Hollow Wedged Bond

Wavy Bond
Table

Acyclic Chain
Cyclopropane Ring
Cyclopentane Ring
Cycloheptane Ring

Cyclohexane chair 1
Cyclopentadiene Ring

1-substrate enzyme
2-substrate enzyme

Receptor
Ion Channel
Helix Protein

Membrane (line)
Membrane (arc)

Golgi Body
Cloud

Marquee
Fragmentation tools
Eraser
Text
Pen
Arrows
Orbitals
Drawing Elements
Brackets
Chemical Symbols
Query tools
TLC plate
Templates
Cyclobutane Ring
Cyclohexane Ring
Cyclooctane Ring
Cyclohexane chair 2
Benzine Ring
G-protein (alpha subunit)
G-protein (beta subunit)
G-protein (gamma subunit)
Immunoglobulin
DNA
Micelle
Membrane (ellipse)
Endoplasmic Reticulum
Mitochondrion

General
Toolbar
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If you want to …

Add items to a selection

Remove items from a selection

Duplicate a selection

Constrain dragging to X or Y direction

Duplicate and constrain dragging

Switch between selection and another tool

Resize selection excluding atom labels

Resize selection including atom labels

Rotate selection excluding atom labels

Rotate selection including atom labels

Distort aspect ratio of selection

Resize without distortion

Free Resize

Open Rotate or Resize dialog box

Draw a first bond

Add a bond to a structure

Label an atom using a bond or ring tool

Label an atom using the Text tool

Label an atom using a HotKey

Draw a double bond (solid, dashed, bold only)

Draw a triple bond (solid only)

Reduce bond order using Eraser tool

Change double bond alignment

Change double bond type

Move an atom

Change bond type

Change bond layering using bond tool

Draw a ring

Create a spiro-linkage

Create a fused ring

Change size of non-bond object

DRAWING TECHNIQUES

WORKING WITH SELECTIONS
Here’s how …

SHIFT+select items not currently selected

SHIFT+select items currently selected

CTRL+drag Selection Rectangle

SHIFT+drag Selection Rectangle

SHIFT+CTRL+drag Selection Rectangle

CTRL+ALT+TAB

Drag Resize handle of Selection Rectangle

CTRL+drag Resize handle of Selection Rectangle

Drag Rotation handle of Selection Rectangle

CTRL+drag Rotation handle of Selection Rectangle

Drag sides of the Selection Rectangle

Drag corners of the Selection Rectangle

SHIFT + drag corners of the Selection Rectangle

Double-click Resize handle or Rotation handle

Drag to draw the bond

Click an atom or drag from an atom

Double-click an atom (triple-click to repeat last label)

Click an atom (double-click to repeat last label)

Point at an atom and press a HotKey (e.g., “c”)

Select bond type from context menu

Select bond type from context menu

Click once

Click center of double bond using any bond tool

Click center of double bond using different bond tool

SHIFT+drag an atom using a bond tool

Click center of bond using different bond tool

Double-click center of bond you want forward

Click or drag using a Ring tool

Click or drag from an atom using a Ring tool

Click a bond using a Ring tool

Drag starting point of object (e.g., arrowhead)
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Rotation Handle

Resize Handles

Selection Box

Resize

Object ToolbarMagnification controlsTitle BarMenu Bar

Text Style Toolbar

Lasso
Structure Perspective

Solid Bond
Multiple Bonds
Dashed Bond
Hashed Bond

Hashed Wedged Bond
Bold Bond

Bold Wedged Bond
Hollow Wedged Bond

Wavy Bond
Table

Acyclic Chain
Cyclopropane Ring
Cyclopentane Ring
Cycloheptane Ring

Cyclohexane chair 1
Cyclopentadiene Ring

1-substrate enzyme
2-substrate enzyme

Receptor
Ion Channel
Helix Protein

Membrane (line)
Membrane (arc)

Golgi Body
Cloud

Fragmentation tools

Eraser
Text
Pen
Arrows
Orbitals
Drawing Elements
Brackets
Chemical Symbols
Query tools
TLC plate
Templates
Cyclobutane Ring
Cyclohexane Ring
Cyclooctane Ring
Cyclohexane chair 2
Benzine Ring

G-protein (alpha subunit)
G-protein (beta subunit)
G-protein (gamma subunit)
Immunoglobulin
DNA
Micelle
Membrane (ellipse)
Endoplasmic Reticulum
Mitochondrion

General
Toolbar

Scroll bar
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If you want to …

Add items to a selection

Remove items from a selection

Duplicate a selection

Constrain dragging to X or Y direction

Duplicate and constrain dragging

Switch between selection and another tool

Resize selection excluding atom labels

Resize selection including atom labels

Rotate selection excluding atom labels

Rotate selection including atom labels

Distort aspect ratio of selection

Resize without distortion

Free Resize

Open Rotate or Resize dialog box

Draw a first bond

Add a bond to a structure

Label an atom using a bond or ring tool

Label an atom using the Text tool

Label an atom using a HotKey

Draw a double bond (solid, dashed, bold only)

Draw a triple bond (solid only)

Reduce bond order using Eraser tool

Change double bond alignment

Change double bond type

Move an atom

Change bond type

Change bond layering using bond tool

Draw a ring

Create a spiro-linkage

Create a fused ring

Change size of non-bond object

DRAWING TECHNIQUES

WORKING WITH SELECTIONS
Here’s how …

SHIFT+select items not currently selected

SHIFT+select items currently selected

APPLE+drag Selection Rectangle

SHIFT+drag Selection Rectangle

SHIFT+APPLE+drag Selection Rectangle

CTRL+APPLE+TAB

Drag Resize handle of Selection Rectangle

APPLE+drag Resize handle of Selection Rectangle

Drag Rotation handle of Selection Rectangle

APPLE+drag Rotation handle of Selection Rectangle

Drag sides of the Selection Rectangle

Drag corners of the Selection Rectangle

SHIFT + drag corners of the Selection Rectangle

Double-click Resize handle or Rotation handle

Drag to draw the bond

Click an atom or drag from an atom

Double-click an atom (triple-click to repeat last label)

Click an atom (double-click to repeat last label)

Point at an atom and press a HotKey (e.g., “c”)

Select bond type from context menu

Select bond type from context menu

Click once

Click center of double bond using any bond tool

Click center of double bond using different bond tool

SHIFT+drag an atom using a bond tool

Click center of bond using different bond tool

Double-click center of bond you want forward

Click or drag using a Ring tool

Click or drag from an atom using a Ring tool

Click a bond using a Ring tool

Drag starting point of object (e.g., arrowhead)
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SCREEN ELEMENTS

TOOLBAR

Title bar

1

1. New ChemDraw Worksheet — Create a new 
worksheet.

2. Import Table — Import an SDFile or a
ChemFinder database.

3. Export Table — Export selected cells or the entire
spreadsheet to an SDFile or ChemFinder database.

4. Import ChemFinder list — Import an open hitlist.

5. Load Molecule — Load a single molecule from a file.

6. Save Molecule — Save a single molecule to a file.

7. Cut Molecule — Remove a molecule and place it
on the clipboard.

8. Copy Molecule — Copy a molecule and place it on the
clipboard.

9. Paste Molecule — Paste a molecule from the clipboard.

10. Name Molecule — Name a molecule.

11. Show Pictures — Display molecules.

12. Hide Pictures — Hide molecules.

13. Resize Pictures — Resize molecules using
the resize handles.

14. Align All Pictures — Enlarge cells or reposition the 
molecules within the cells.

15. Normal Search — Search for exact structures and
substructure using the Search Query dialog box.

16. Similarity Search — Search for similar structures using
the Similarity Query dialog box.

17. R-Group Analysis — Shows groups attached to the query
structure.

18. Convert SMILES to Molecule — Convert a valid
SMILES string to a molecule.

19. Convert Name to Molecule — Convert a name
into a molecule.

Excel menu bar

ChemDraw
toolbar

Excel toolbar

ChemDraw menu ChemDraw for Excel functions

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19

ChemDraw 
structure
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